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About the Name

Why the name Eudora?
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I Live at the P.O.,” and named the program after the author of the story, Eudora Welty. “Why I Live at the P.O.” can be found in a 
collection entitled A Curtain of Green and Other Stories (Harcourt Brace & Co.). Ms. Welty’s stories are funny, sad, and fascinating; 
she’s surely one of the great American writers.
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Introducing Eudora Email

Welcome to Eudora® Email 7.1! Eudora Email, hereafter referred to as Eudora, is a 

comprehensive electronic mail (email) software program that accesses your Internet Service 

Provider (ISP) or network to receive and send your email messages. 

In Eudora, you can write messages and send them with custom stationery and signatures. You 

can send files, both text and graphic, created in other programs and "attach" them to your 

email messages. You can forward messages, redirect them, or reply to all recipients of a 

message.

You can set up mailboxes and folders for your mail and build "filters" to sort messages, alert 

you, and even send an automatic reply.

All your favorite addresses can be stored in your personal address book, or you can let Eudora 

search for addresses for you. And if you use more than one ISP, Eudora allows you to create 

"multiple personalities," to send and receive mail to multiple accounts.

Also, you can use Eudora in one of three modes: Sponsored, Paid, or Light. For more 

information on Eudora’s modes, see  Operating Eudora in One of Three Modes on page 25.

There are many more Eudora features and functions described later in this manual.

System requirements

In order to install and use Eudora, you must have the following:

• IBM PC or compatible

• Microsoft Windows 98/ME/XP/2000. It is recommended that you have the latest 

service pack for each operating system.

• A mail account with an Internet Service Provider (ISP)

• Access to your mail account via a modem or Internet-style network connection.
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What’s New in Eudora Email 7.1

The following new features and functions have been added to Eudora in version 7.1: 

• Recent mailboxes - A virtual folder of recently used mailbox for conveniently getting 

to your most often used mailboxes

• Expanded Media for Alert Sounds - Play a Sound functionality on New Mail arrival 

and filters has been expanded from .wav files to allow for other media files such as 

.mp3

• Saved Searches - Save the search criteria of your Ultra Fast searches to use them 

again and again

• Minimize to Windows System Tray - Manage Eudora tasks from in icon in the 

system tray

• Insert Downloadable Picture - Include references to graphics stored on web 

servers

For details on other changes in Eudora 7.1, refer to the README and RELNOTE text files that 

reside in the directory where Eudora 7.1 is installed.

Where do I find information?

If you can’t find the information you are looking for in this user manual, it may be in the Eudora 

Quick Start Guide, or in the online help program in Eudora. This user manual is an online user 

manual; that is, it provides the basic procedures for using Eudora. The online help is primarily 

procedures and definitions.

The manual’s topics are linked. When you see a page number associated to a topic in the 

Table of Contents, the Index, or a cross-reference, just click the page number and the topic 

appears.

If you prefer, you can print the PDF manual. From the File menu in Acrobat Reader, choose 

Print. 
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Eudora Quick Start Guide

The Eudora Quick Start Guide is included as an electronic file in you Eudora directory. The 

Quick Start Guide shows you how to install Eudora and allows you to begin using the basic 

functions of Eudora immediately. The Guide provides only simple descriptions, so for more 

details, refer to this document. 

Information provided in the Eudora Quick Start Guide is as follows:

• Finding Information

• System Requirements

• Getting Started

• Installing Eudora

• Opening and Configuring Eudora

• Importing Mail and Address Book from another Email Application

• Operating Eudora in One of Three Modes

• Choosing a Eudora Mode

• Registering Eudora

• Technical Support

• Creating and Sending a Message

• Checking for and Receiving Mail

• Replying to a Message

• Forwarding a Message

• Redirecting a Message

• Shortcuts

The functions listed above, except for Getting Started and the Eudora installation sections, are 

described more thoroughly in this manual. 
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Online Help

There are several ways to get online Help with Eudora.

• To find out what something on the screen does, use context-sensitive help.

• For instruction on how to perform certain tasks, use the help topics.

• To receive daily tips on assorted Eudora features each time you open Eudora, read 

the Tip of the Day.
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 Context Sensitive Help 

You can perform context sensitive help by any of the following methods:

• Choose Context Sensitive Help from the Help menu. Then click the item in 

question. A brief description of the item appears. Click anywhere to close the 

description window. 

• Click the Help button . Then click the item in question. A brief description of the 

item appears. Click anywhere to close the description window.

• Press the F1 key. Select the option, command or field item in Eudora you want to 

know about, or use the Tab and arrow keys to move keyboard focus to that item. 

Then press F1. Keyboard focus is indicated by a dashed highlight box, a highlighted 

entry or item, or a flashing insertion cursor. 

If the item is in a tabbed window, move the mouse arrow to a field and press F1. The entire 

procedure for the window appears.

Help Topics

For instructions on how to do certain tasks, choose Topics from the Help menu. The Help 

Contents are displayed, and you may either browse the contents or use the Find and Index 

options.

For more information, see  Help Menu on page 289. 

Tip of the Day

After you set up Eudora, the Eudora Tip of the Day dialog box appears each time you open 

Eudora showing you the Tip of the Day. You can display the following and previous tips by 

clicking the Next Tip and Previous Tip buttons. To prevent the Tip of the Day dialog box from 

being displayed on startup, uncheck the “Show Tips at Startup” check box. You can always 

display the Tip of the Day from the Help menu.

To close the Tip of the Day dialog box, click the Close button.
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About Eudora

About Eudora displays the software version, registration information, and the credits for those 

who worked on or contributed to this version of Eudora.

Importing from Other Email Programs

You can import settings, address books, and mail from Netscape Messenger 4.x versions, 

Microsoft Outlook Express 4.0 and 5.x versions, Outlook 98, and Outlook 2000. 

It may take a long time for the migration to occur depending on the amount of mail, the 

complexity of your settings, and the size of your address book that you are importing into 

Eudora. During the migration, if the process stops because of a corrupt message, you must 

go into your importing application and delete the corrupt message to resume the migration.

When the migration is occurring, notice in the Mailbox window that a mailbox tree begins to 

form. For example, you will see the folder “Outlook” and all its mailboxes listed underneath. A 

plus sign (+) next to the folder name indicates that other folders/mailboxes are contained within 

this folder. Your imported settings are immediate, and your mail is migrated.

To import from another program

1. From the File menu, choose Import. 

The Import Mail and Addresses dialog box appears.



Import Mail and Addresses dialog box

TIP: In the dialog box previously shown, only the programs that appear in the text box are 

detected. Just select them, choose to import your mail and address book and click OK. However, 

if you don’t see the programs you want to import, click Advanced to display the Advanced Import 

dialog box where you can look for the files. 

Importing from Outlook Express 

NOTE: Before you begin the import, empty the Deleted Items folder in Outlook Express. Also, if 

the Import Mail and/or Import Address Book Entries option is dimmed, Eudora cannot find the 

messages and/or address book.

To import from Outlook Express 

1. From the File menu, choose Import. 

The Import Mail and Addresses dialog box appears.

2. In the dialog box, choose Outlook Express. 

If you don’t see Outlook Express, go to step 3.

3. Choose Import Mail and/or Address Book then click OK. 

Outlook Express should begin importing into Eudora. 

4. Click Advanced. 
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The Advanced Import dialog box appears.

Advanced Import dialog box (showing Outlook Express required fields)

5. Choose Outlook Express.

6. In the Please Locate your Folders.dbx or Folders.nch file, click Browse and look 

for the Folders.dbx (for Outlook Express 4.x) or Folders.nch (for Outlook Express 

5.x) file in you Outlook Express folder. Make sure the file appears in the text box.

7. In the Please Locate your WAB file, click Browse and look for your Windows 

Address Book. Make sure the file is visible in the text box. (The WAB file has the 

.wab extension. You can search for it using Windows Explorer.)

8. When finished, click OK. 

Importing from Mircrosoft Outlook

NOTE: Before you begin the import, empty the Deleted Items folder in Microsoft Outlook. 

In Microsoft Outlook, make sure its your default email program before you import it into 

Eudora. Once the migration is complete, close Eudora and restart. Only then can you make 

Eudora your Windows default email program. 



23

Introducing Eudora Email

To import from Mircrosoft Outlook

1. From the File menu, choose Import. 

The Import Mail and Addresses dialog box appears.

2. In the dialog box, choose Microsoft Outlook. 

If you don’t see Microsoft Outlook, go to step 3.

3. Choose Import Mail and/or Address Book then click OK. 

Microsoft Outlook should begin importing into Eudora. 

4. Click Advanced. 

The Advanced Import dialog box appears.

Advanced Import dialog box (showing Microsoft Outlook required field)

5. Choose Microsoft Outlook.

6. In the Please Locate your PST file, click Browse and look for the .pst file. Make 

sure the file appears in the text box. (The PST file has the .pst extension. You can 

search for it using Windows Explorer.)

7. When finished, click OK. 
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Importing from Netscape Messenger 

Before you import your Netscape Address Book, you must first save it in LDIF format. LDIF 

means LDAP Data Interchange Format. To save your address book in LDIF format, follow the 

instructions to import Netscape into Eudora.

To import Netscape

1. Launch Netscape Messenger.

2. From the Communicator menu, choose Address Book.

3. From the File menu in Netscape Messenger, choose Export. 

The Save dialog box appears.

4. Name the file while retaining the .ldif extension and save it on your computer.

5. In the dialog box, choose Netscape Navigator. If you don’t check Import Address 

Book from LDIF file, the Browser button is dimmed. Click OK. 

6. If you don’t see Netscape Navigator in the dialog box, click Advanced. 

The Advanced Import dialog box appears.

Advanced Import dialog box (showing Netscape required fields)

7. In the Please Locate your Prefs.js file, click Browse to look for the Prefs.js file. 

Make sure the file appears in the text box. The Prefs.js file should be in your 

Netscape folder.
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8. In the Please Locate your LDIF file, click Browse to locate the address book file 

you just saved. 

9. When finished, click OK.

Operating Eudora in One of Three Modes 

You can choose one of three operating modes on how you wish to use Eudora. They are as 

follows:

• Paid mode—This mode provides the full-featured Eudora desktop email client 

without advertising, and limited person-to-person technical support.

• Sponsored mode—This mode provides the full-featured Eudora desktop email 

client at no charge, supported by sponsors' advertising. It includes all of the features 

that are in the Paid mode except for BossWatch, Fast Search, SpamWatch, 

• Light mode—This is an upgrade to the freeware version formerly known as Eudora 

Light. It includes fewer features than the other modes and may include a sponsor 

image or logo.

NOTE: For more information about technical support options, see  Technical Support on 

page 27 or http://www.eudora.com/techsupport/options/ on the Eudora Web site.

Changing Eudora Modes

If you bought Eudora from a web site, Eudora installs in Paid mode. However, if you would like 

to change the operating mode, for example to Sponsored mode, you can do so right in the 

Eudora program. 

To change the Eudora operating mode after you install Eudora 7.0

1. From the Help menu, choose Payment & Registration. 

The Payment and Registration window appears.

http://www.eudora.com/techsupport/options/
http://www.eudora.com/techsupport/options/
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Payment and Registration Window 

2. In the Which Eudora is right for you? section: 

• To use Eudora in Sponsored mode, click Sponsored Mode (free, with ads).

Eudora displays the ad window. 

• To use Eudora in Paid mode, click Paid Mode (costs money, no ads). 

Eudora displays the Eudora web site for you to purchase Eudora.

• To use Eudora in Light mode, click Light Mode (free, fewer features). 

Eudora changes to Light mode by shutting down certain features. The features 

that will be off are listed in the Light mode dialog box.

3. In the Keeping Current section:

• To add or change your profile, click Profile. 

Eudora displays a web site where you can provide information about yourself to 

help in customizing which ads would be of interest to you.

• To find the most current version of Eudora, click Find the Latest Versions. 

The Eudora web site displays where you can retrieve the latest version of 

Eudora and lets you know if there is a cost to upgrade.
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NOTE: You can tell which mode you are in because that button is grayed out. To 

find out more information about the modes, click Go to the Eudora web site for 
more information.

4. To exit the dialog box, click Close.

Registering Eudora

If you are using Eudora in Paid mode, you need to register to be eligible for technical support 

Also, you need to be registered to upgrade to newer version of Eudora and stay in Paid mode. 

See subscription information at www.eudora.com/email/subscription_faq.html. If you don’t 

register and/or use Eudora in Sponsored or Light mode, you are not eligible for technical 

support.

NOTE: If you switch from one mode to another, you must register in that mode even though 

you registered in your previous mode. For example, if you are a Paid mode registered user, 

and you wish to get a refund and use Sponsored mode, you must reregister in Sponsored 

mode. 

To register your copy of Eudora

1. From the Help menu, choose Payment & Registration. 

The Payment and Registration window appears.

2. In the Keeping Current section, click Register with Us. 

Eudora takes you to Eudora’s registration web page.

3. Enter your information, click Submit Registration. 

An email will be sent to you confirming your registration. 

Technical Support

For information on Eudora’s basic functions, refer to the procedures provided in this guide and 

to your online help, which you can access from the Eudora Help menu.

http://www.eudora.com/email/subscription_faq.html
http://www.eudora.com/email/subscription_faq.html
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Many common issues can be solved by visiting the Eudora technical support web site 

www.eudora.com/techsupport/win. The technical support web site provides online answers to 

your technical questions about QUALCOMM’s Eudora software products. Go to the Technical 

Support web site to get valuable “how to” information and step-by-step interactive tutorials 

www.eudora.com/techsupport/tutorials. Also, you will be able to retrieve most current Eudora 

products and documentation. (Sponsored and Light mode users may use the Eudora web site 

technical support and tutorials.)

In addition, you can learn from other Eudora users by searching the archives or posting a 

question to the Eudora User Forums. The forums are a free online community of Eudora users 

helping one another.

If you still need help after reviewing all of the available materials: the User Manual, this Quick 

Start Guide, the README files, the Online Help, and the Technical Support Web Site, contact 

your ISP or email administrator, or the Eudora Technical Support group. Before you call 

technical support, you need to register your copy of Eudora in Paid mode. Be sure to register 

as soon as possible to avoid any delays in receiving technical support.

Person to person support by phone or email is available to Paid mode users who have a valid 

registration code. Eudora tech support reps are available Monday - Friday from 8 A.M. to 5 

P.M. Pacific Time using the following phone number and email address:

Phone: (858) 658-1292 (Paid mode users only)

Email: eudora-support@qualcomm.com (Paid mode users only) When sending email, 

make sure to include your Paid Mode registration code in the Subject field or in the body of 

your message. 

About security (Sponsored and Paid modes only)

Eudora supports Secure Sockets (SSL), a security protocol for transferring information. SSL 

allows you to authenticate the server that sends and receives your email messages. Also, SSL 

is used to encrypt mail transfers so no one can read your messages while they are being sent 

to or received from your mail server. 

SSL uses a security certificate system, just as most web browsers, to authenticate and encrypt 

your messages. Valid certificates should be present for SSL to work properly. These 

certificates are included in SSL and are usually updated by your ISP, email administrator, or 

Eudora. Valid certificates come with Eudora, and more will be provided to you as needed.

http://www.eudora.com/techsupport/win/
http://www.eudora.com/techsupport/tutorials/
http://eudorabb.qualcomm.com/forumdisplay.php?f=6
mailto:eudora-support@qualcomm.com


29

Introducing Eudora Email

For your dominant personality, Eudora supports SSL through the Checking Mail and Sending 

Mail options window.

For any other personality, Eudora support SSL through the Account Settings dialogs accessed 

from the Personalities window. When you set up a new personality, Eudora will be able to 

detect if the POP, IMAP, or the SMTP server for that personality supports SSL depending on 

which SSL setting you choose.

For information about using SSL for your other personalities, see Using SSL for Your 

Personalities on page 131.

Using SSL for your Dominant Personality

To access SSL settings for your dominant personality

1. From the Tools menu, choose Options. 

2. For SSL when receiving mail, scroll and choose Checking Mail. 

The Checking Mail options window appears. 

3. For SSL when sending mail, scroll and choose Sending Mail. 

The Sending Mail options window appears.

Checking Mail options window

Secure Sockets
when Receiving
drop-down menu
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Sending Mail options window

In the Secure Sockets when Receiving (or Sending) field, click the down arrow to 

display the drop-down menu.  
Following is a description of each option on the SSL drop-down menu:

Never— Do not use SSL for server authentication and mail transfer security, even 

if SSL is available on the server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail 

transfer security by having Eudora automatically invoke the STARTTLS command 

method to start SSL, that is, if the server supports STARTTLS. If your server 

doesn’t support STARTTLS, mail transfers will occur successfully, but they will not 

be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer 

security by having Eudora automatically use the older style alternate port method 

for starting SSL. If your server does not support SSL on the appropriate ports, mail 

transfers will fail. 

Required STARTTLS— Use SSL for server authentication and mail transfer 

security by having Eudora automatically invoke the STARTTLS command method 

to start SSL. If your server does not support STARTTLS, mail transfers will fail. 

NOTE: If you use SSL and cannot make a connection when receiving or sending 

mail, you may need to check with your ISP to update any invalid SSL certificates. 

However, to override any issues with SSL when retrieving or sending mail, choose 

Never from the drop-down menu to make a successful connection.

Secure Sockets
when Sending
drop-down menu
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4. To display the most current information for an SSL connection between a server 

and Eudora since the last time you started Eudora, click Last SSL info. 

The Eudora SSL Connection Information Manager window appears with SLL and 

certificate information. 

CAUTION: If you display the SSL information windows, make certain you don’t 

change any of the field information unless you are familiar with SSL.

NOTE: If you get an error messages that states SSL Negotiation failed, click Last 
SLL Info and then click Certificate Information Manager. If you see a certificate 

with a skull image to left of it, that means the certificate is not trusted. To make it 

trusted, click Add to Trusted. This will add the non-trusted certificate to the trusted 

list.

NOTE: On the first SSL negotiation for an email account, Eudora will report if a 

certificate is not trusted. If the user agrees to trust the certificate, Eudora will add 

the certificate to the trusted list.

Starting and Quitting Eudora

To start Eudora

1. From the Start menu under Programs, choose Eudora 

2. Choose Eudora again. 

Eudora launches.

To quit Eudora

1. From the File menu, choose Exit or press Ctrl+Q. 

Eudora closes.

If you have queued messages or timed messages due to be sent in the next 12 hours, you are 

given the option to send them. See the sections  Queueing a Message to Send Later on 

page 67 and  Queueing a Message to Send at a Certain Time on page 68. 

The Trash mailbox is emptied if the Empty Trash when exiting option is selected in the 

Miscellaneous options. See  Miscellaneous on page 356.
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Creating an Outgoing Message

An outgoing message is a message you send to someone else. 

To create an outgoing message

• From the Message menu, choose New Message or click the New Message icon 
on the main toolbar: 

The composition window appears.

Using the Composition Window

The composition window consists of the title bar, the toolbar, the message header, and an area 

for the message body.

Headers and Composition Window

Title Bar

When completed, the title bar provides information about the message, including the name of 

the addressee, the time and date the message was sent, and the message subject.
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Text Toolbar

The text toolbar is of a series of buttons and menus displayed just under the title bar. It allows 

you to control the priority of your message, override some of your default options for the 

current message, send or queue the message, and apply text styles. 

You can select or turn off each feature for the current message by clicking a button on the 

toobar. (A feature is selected when the button is depressed, and turned off when the button is 

raised.) You can set some of the defaults for the toolbar in the Sending Mail options. See 

Sending Mail on page 302. 

The drop-down lists and buttons on the top row of the text toolbar are described.

Priority drop-down list

This lets you indicate that your message is of higher or lower priority than a normal 
message. For most messages, this is just an empty box (normal priority). For details, 
see  Setting the Message Priority on page 42. 

Signature drop-down list

This lets you automatically append one of your signatures to the end of a message. For 
details, see Using a Signature on page 105. 

Attachment type drop-down list

This lets you select the encoding format for attachments. For details, see Attaching a 
File to a Message on page 49. 

Quoted-Printable Encoding

If this button is on, quoted-printable encoding is used when sending messages that 
contain special characters or long lines of text. It is used for all plain-text attachments. 
We recommend that you always keep this feature selected.

Text As Attachment

If this button is on, plain text files are attached to messages, not incorporated into the 
message as part of the message body.
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Word Wrap

If this button is on, a carriage return is not required at the end of each line. When the 
message is sent, the text is automatically “wrapped,” meaning that carriage returns are 
inserted at the end of each line of text, with roughly 76 characters per line.

Tabs in Body

If this button is on, pressing the Tab key within the message body inserts a tab. If this 
button is off, pressing the Tab key within the message body returns the cursor to the To 
field of the message header.

Format Painter (Sponsored and Paid modes only)

If this button is on, clicking a word or phrase copies its text and paragraph formatting. 
Click elsewhere to transfer the formatting.

Return Receipt (Sponsored and Paid modes only)

If this button is on, the message to your recipients includes a Notify Sender button that, 
when clicked, creates a message notifying you that the original message was viewed. 
This function does not work in all cases. For details, see Requesting a Return Receipt 
(Sponsored and Paid modes only) on page 42. 

Show Text Symbols

If this button is on, invisible text symbols such as carriage returns, tabs, and spaces 
appear in the message.You can see these symbols only in your composition window. 
They do not appear in the message you send. 

S/MIME Signer

If this button is on, Eudora will use your S/MIME certificate to digitally sign your 
outgoing message. 

NOTE: You must have an S/MIME certificate installed on your machine to use 

this feature.
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The drop-down lists and buttons on the bottom row of the text toolbar are described below. 

Note that the text styles and attributes controlled by this row can also be accessed via text file 

windows and signature windows.

S/MIME Encrypter

If this button is on, Eudora will use the public S/MIME certificate(s) of your recipient(s) 
to digitally encrypt your outgoing message. 

NOTE: You must have the S/MIME public certificates for your recipients 

installed on your machine to use this feature.

MoodWatch™ (Sponsored and Paid modes only)

ice cube—There is no offensive language in the message.

1 chili—There may be a slight bit of offensive language in the message.

2 chilies—There may be offensive language in the message.

3 chills—There is offensive language in the message.

Send or Queue

This button lets you send a message immediately or put it in the queue to send later. If 
the “Immediate Send” option is selected in the Sending Mail options, the button is 
labeled Send. If the option is not checked, the button is labeled Queue. For details, see 
Sending Mail on page 302 and Sending Messages and Checking Mail on page 67. 

Font drop-down list

Make the selected text a specific font (typeface).

Size

Make the selected text a specific size.

Bold

Make the selected text bold.

Italics

Make the selected text italic.
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Underline

Make the selected text underlined.

Strikeout

Make the selected text strikeout. Use strikeout text to show the text has been changed 
(editing). 

Color (Sponsored and Paid modes only)

Make the selected text a specific color. Note that “Automatic” is the default for text on 
your computer (usually black). 

NOTE: When typing a message, your text color defaults to Automatic (typically black). 
However, you can change the color as you type or by selecting text.  If you change the 
text color, this button will now retain and display that color.  When you want to change 
colors, click this button and choose the color from the drop-down menu. Note that if you 
change the text color to Automatic, this button will not change color. You can also 
ignore the color change by pressing the Shift key while changing colors.

Typewriter (Sponsored and Paid modes only)

Make the selected text the fixed-width (typewriter-style) message font set in the Fonts 
options. See Fonts on page 313. 

Align Left (Sponsored and Paid modes only)

Align the selected paragraph to the left margin.

Align Center (Sponsored and Paid modes only)

Align the selected paragraph to the center of the page.

Align Right (Sponsored and Paid modes only)

Align the selected paragraph to the right margin.

Indent In (Sponsored and Paid modes only)

Indent the selected paragraph indented once to the left.
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Message Header

Outgoing mail headers consist of six fields: To:, From:, Subject:, Cc:, Bcc:, and Attached. Each 

field is described below. The To:, Subject:, Cc:, and Bcc: fields can be directly edited. To move 

the cursor from field to field, press the Tab key or click in the desired field with the mouse.

To resize the header region of the outgoing message composition window, drag the separator 

up or down. This change applies to the current message only.

Indent Out (Sponsored and Paid modes only)

Remove one left indent from the selected paragraph.

Bulleted List (Sponsored and Paid modes only)

Make the selected text a bulleted list.

Make Hyperlink (Sponsored and Paid modes only)

Make the selected text or graphic a clickable hyperlink to a Uniform Resource Location 
(URL), so that when the recipient clicks the item, he or she is immediately taken to the 
URL.

Clear Formatting

Remove all the formatting from the selected text or paragraph.

Insert Object (Sponsored and Paid modes only)

Insert a specified picture file or a horizontal line at the current cursor position in body 
text. For details, see Inserting Objects in Message Text (Sponsored and Paid modes 
only) on page 47. 

Last Emoticon (Sponsored and Paid modes only)

This lets you add a graphic emoticon at the position of the insertion point in the 
message body. For details, see Sending Emoticons on page 50. 
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To:—The intended recipients’ email addresses or nicknames you have defined. Multiple 

addresses and nicknames must be separated by commas. See Using the Address Book on 

page 233. To select a name from a list, see Using Automatic Name Completion (Sponsored 

and Paid modes only) on page 39. 

From:—The sender’s email address. This is usually your incoming email account plus your 

real name. You can use a return address other than your incoming mail account by entering 

the address in the Return address field of the Getting Started options. See Getting Started on 

page 293. 

If you have Alternate personalities set up, you can select the appropriate personality in the 

From: field drop-down list. See Using Multiple Personalities (Sponsored and Paid modes only) 

on page 115. 

Subject:—Some brief text indicating the contents of the message. This field can be left blank 

although it is considered a point of email etiquette to include a Subject with each message. By 

default, Eudora warns you when you send a message with no subject.

Cc:—The email addresses or nicknames of people to whom a copy of the message is to be 

sent. These recipients are displayed in the message header for all recipients to see. Multiple 

addresses must be separated by commas. This field can be left blank. Cc means “carbon 

copy.” To select a name from a list, see Using Automatic Name Completion (Sponsored and 

Paid modes only) on page 39. 

Bcc:—The email addresses or nicknames of people to whom a blind copy of the message is 

to be sent. These recipients are not displayed in the message header, and the recipients in the 

To and Cc fields will not know that a copy went to these addresses. Use Bcc to send a copy 

of a message to someone without showing the other recipients. Multiple addresses must be 

separated by commas. This field can be left blank. Bcc means “blind carbon copy.” To select 

a name from a list, see Using Automatic Name Completion (Sponsored and Paid modes only) 

on page 39. 

The Bcc field can also be used to put a copy of the message in one or more of your mailboxes. 

To do this, right-click in the body of the message to display the drop-down list. From the drop-

down list, choose your mailbox from the Fcc menu (equivalent to the Transfer menu). The 

name of the mailbox is inserted into the Bcc field preceded by the expression “ƒ\.” 

Repeat the procedure to Fcc to multiple mailboxes. Eudora automatically separates the entries 

with commas. When the message is sent, a copy is placed in each specified mailbox. Fcc 

means “folder carbon copy.”
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Attached:—A list of documents being attached to and sent along with the message. See the 

section Attaching a File to a Message on page 49 for instructions on how to add attachments. 

To delete an attachment from an outgoing message, select it and press the backspace or 

delete key. This field can be left blank.

Message Body

After filling in the header fields, move the insertion point to the space below the message 

header. Type the body of the message here. For information about formatting your message 

text, see Formatting Text (Sponsored and Paid modes only) on page 43. Also see Text Toolbar 

on page 33. 

You can insert pictures and horizontal lines into message text. For details, see  Inserting 

Objects in Message Text (Sponsored and Paid modes only) on page 47. 

Using Automatic Name Completion 
(Sponsored and Paid modes only)

Similar to the “Finish Address Book Entry” command (see Finish Address Book Entry 

Command on page 249), Auto-Completion allows you to enter a portion of a name in the To:, 
Cc:, or Bcc: field, and Eudora automatically completes the name for you. Just start typing and 

Eudora will attempt to complete the name. If multiple past recipients match the text you’ve 

entered, a list of names from your history file and address book appear in a drop-down name 

list (provided both the history file and address book are selected in the new Auto-Completion 

option window explained later in this section). Select the correct name, and the name and 

email address appear in the field. 

The history file consists of names and email addresses of people you have previously sent or 

forwarded messages to, or to whose messages you have replied within Eudora. 

The address book consists of the nicknames you have entered for each person in your 

address book. 



40

Creating Messages

In the example below, you want to send Barb a message. Previously, you had to enter her 

nickname from your address book, or if she wasn’t in your address book, you had to enter her 

full email address. To use the auto-completion feature, just enter B in the To: field, and Eudora 

displays a drop-down name list of names beginning with “B” for you to choose from. (You can 

also press Esc to prevent the drop-down name list from appearing.) If you had typed BA, 

Eudora would have displayed a drop-down name list with all names beginning with “Ba.” Scroll 

through the name list and click or press Enter to select the correct name. The name is now 

entered into the header field. 

Name auto-completion in a new message

If you have only a “Barb” and a “Beth” as names in your address book or history file, Eudora 

completes the first alphabetical name. So when you type B, “Barb” would appear first on the 

list (if Names should appear in alphabetical order is selected in the Auto Completion 

options window explained later in this section).

 indicates that the name came from your address book. If the name is from your address 

book, only the nickname appears in the drop-down name list.

 indicates that the name came from your history file. If the name is from your history file, 

both the username and email address appear in the drop-down name list as you type. 

To complete the name in the field, select the correct name from the drop-down list. If you want 

to add another name in the To: field, type a comma (,) after the first recipient’s name. Then you 

can begin to add another recipient’s name as shown in the example below.
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Second name auto-completion in the To: field

The example below shows auto-completion in the Cc: field.

Name auto-completion in the Cc: field

NOTE: If you don’t want Eudora to auto-complete your email address as you type it, you can 

just type one letter, and all email addresses that start with that letter from your address book 

and history list appear in a drop-down list for you to choose from. Just turn on the Don’t auto-
complete, just list matches option in the Auto-completion window in Options under the Tools 

menu. 

To turn the name auto-completion feature off, go to the Tools menu, choose Options, and then 

select Auto-completion. Turn off Address Book and History File and click OK.

To delete an auto-completion entry

• From the auto-complete drop-down list, choose the name you want to delete 
and press the Delete key.
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Setting the Message Priority

You can assign a priority to incoming and outgoing messages. The priority identification is only 

for you and your recipients; it does not affect the way mail transport systems handle the 

messages.

There are five priority levels available, with 1 being the highest and 5 being the lowest. Each 

is represented by a small symbol in the Toolbar of a message window and the Priority column 

of a message summary. Priority 3 (normal) is used for messages that have no assigned 

priorities, and it is not displayed. The highest priority symbol, a double-caret, is red; the lowest 

priority symbol, an inverted double-caret, is blue.

New messages are created with a normal priority. To change the priority of the current 

message, use the Priority drop-down list.

 Selecting a priority for a message

NOTE: To set up Eudora to default to the sender’s priority on your replies, turn on the “Copy 

original’s priority to reply” option in the Replying options. See Replying on page 309 for more 

information. You can always change the priority in the message window.

Requesting a Return Receipt 
(Sponsored and Paid modes only)

You can request that your recipients notify you when they have seen your message. To do this, 

click  in the message toolbar.
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When your recipients open the message and then close it, a dialog box appears asking them 

to create a notification message now, later, or never. If you sent yourself a copy of the 

message, you will see the request for notification. If a recipient chooses to create a notification 

message, it is sent to you and tells you when the recipient opened your message.

Request for notification

To respond to a request for notification:

• Click Now to queue the notification message in your Out mailbox. It will be sent 
the next time queued messages are sent. 

• Click Later to close the message without sending a notification. Note that each 
time you open the message and then close it (or if you try to delete it), the 
notification request will appear until you click either Now or Never. 

• Click Never to cancel the notification request without ever sending a request for 
notification message. 

• Click Cancel to dismiss the request for notification request from the screen 
while the return receipt message is open. Note that if you close the message, 
the notification dialog box will appear again.

The Return Receipt options may or may not work as described, depending on your recipients’ 

email software.

Formatting Text 
(Sponsored and Paid modes only)

You can use standard text-editing options to format the text of your outgoing messages, your 

text files, and your signatures. The formatting is delivered to your recipients using text-editing 

standards in common use today. In Eudora, styled and plain text formatting is delivered to your 

recipients using the Hypertext Markup Language (HTML) format. This enables you to 

compose and send messages styled with different fonts, colors, font sizes, etc. However, the 

formatting your recipients see depend on how well their email packages support this standard.
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HTML is the text formatting standard used in the World Wide Web by Web browsers and newer 

email applications. As well as allowing you to use enriched text, HTML also lets you embed 

pictures and create bullet lists in the messages you send.

It’s important to remember that you cannot completely control what happens on your 

recipients’ computers. Depending on the type of computers they are using, their installed fonts, 

their options or preferences, etc., they could end up viewing something other than what you 

had intended. Also, the formatting changes you make are sent to your recipient, but your 

default text settings are not. Any text that you did not make changes to appears using your 

recipient’s default text settings, which may be different from yours.

To select preferences for sending text in your messages

1. From the Tools menu, choose Options. 

2. Scroll through the category list and select Styled Text. 

3. In the Styled Text options window, you can select whether you want Eudora to send 

your messages with both plain and styled text, with styled text only, or with plain 

text only. Also, you can set a warning each time you send a message with styled 

text. However, the default is to send both styled and plain text. For details, see 

Styled Text on page 322. 

Text in outgoing messages, text files, and signature files can be formatted using the 

commands on the Edit menu, the Text submenu, and the formatting toolbar. See Text Toolbar 

on page 33 for information on using the formatting part of the toolbar. The following Text 

submenu commands are described.

Text Editing Menu Commands

To format text, use the commands on the Text submenu of the Edit menu. If text in the 

message body is selected, the menu command applies the formatting to that text. If no text is 

selected but the cursor is in the message body, then the font-related commands apply the 

formatting to the next text you type, and the margin-related commands apply the formatting to 

the current paragraph; that is, the paragraph containing the cursor.

You must place the cursor in the composition window to activate the options, otherwise the 

options are inactive (grayed out).
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The formatting options are:

Font—Make the text a certain font by choosing from the fonts available on your system. 

Remember that your recipient may not have the same fonts.

Bold, Italic, Underline—Make the text bold, italic, or underlined. The default is plain text.

Color—Make the text black or the selected color.

Typewriter—Set the text to the fixed-width (typewriter-style) message font selected in the 

Fonts Options.

Size—Make the text the selected size: Very Small, Small (the default), Medium, Large, Larger, 

Very Large, and Humongous. The increase or decrease is based on the next or previous 

standard point size.

Remember that you are viewing the text based on your default settings in the Fonts Options, 

but your recipient’s settings and fonts will be different. For example, if your recipient’s default 

font size is larger than yours and you send a message with text set to “Humongous,” your 

recipient will see text even more humongous than yours!

Left, Right, Center—Align the selected or current paragraph to the left, the right, or the center 

of the current indent.

Margins: Indent In, Indent Out—Indent the selected or current paragraph’s left margin in one 

level, or “outdent” the left margin: remove one level of indent. You must have text highlighted 

to activate this option. 

Bulleted List—Convert the selected text to a bulleted list, or begin a bulleted list at the 

insertion point.

Make Hyperlink—Convert the selected piece of text, or the selected graphic, to a clickable, 

underlined hyperlink to a URL you specify; when your recipient clicks the hyperlink, he or she 

is immediately taken to the URL. You must select text or a graphic to activate this option.

Clear Formatting—Clear all formatting and go back to the default settings. This option is not 

active if you have no formatting in your message.
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Insert Object—Insert objects in the body of a composition message. Includes the commands 

“Picture” (insert an embedded graphic file), “Downloadable Picture” (inserts a link to a graphic 

on a web server), and “Horizontal Line” (insert a horizontal rule as a separator).

Other Formatting Options

If you select the Word Wrap button in the message toolbar, a carriage return is automatically 

inserted at the end of each line of text with roughly 76 characters per line when the message 

is sent. This makes the message legible on your recipient’s computer.

It is a good idea not to include your own carriage returns within paragraphs if you have the 

Word Wrap option selected. Use carriage returns only to create new paragraphs in the 

message.

To manually wrap text

1. Select and highlight the text you want to wrap.

2. From the Edit menu, choose Wrap Selection. 

• To unwrap text, select the text you want, then hold down the Shift key and from 
the Edit menu, choose Wrap Selection.

• To copy wrapped text without taking the carriage returns, that is, to copy and 
unwrap, hold down the Shift key and choose Copy from the Edit menu.

Using Format Painter  
(Sponsored and Paid modes only)

By using Format Painter, you can copy text and paragraph styles from one place to another. 

To copy styles

1. Select or click in the text whose styles you want to copy.

2. Click the Format Painter button  on the toolbar.

The cursor changes to an I-beam with a paintbrush indicating that Format Painter 

is turned on. 

3. By clicking the word or highlighting the text, the style is immediately applied when 

you release the mouse button. 
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The style of the text, such as font, size, color, bold, italic, underlined, etc. as well 

as the paragraph styles, such as alignment, bullets, indenting, etc. are copied.

4. Click and Format Painter turns off.

Inserting Objects in Message Text 
(Sponsored and Paid modes only)

To insert pictures and horizontal lines into the body of a message, use the Insert submenu 

under the Edit menu, or use the Insert Object button on the message toolbar. See Text Toolbar 

on page 33. 

You can insert an object in the middle of a line of text or between lines of text in the message 

body.

To insert a picture in message text

1. Move the cursor to where you want the picture.

2. From the Edit menu, choose Insert.

3. From the Insert submenu, choose Picture. 

A dialog box appears.

4. In the dialog box, select an image file and click Open. 

The picture is inserted into the message body at the cursor position. You can continue typing 

text. Once the picture is inserted in your message, you can drag it to where you want it in the 

message. Your recipient will see the picture right in the message body. 

With QuickTime 4.0 or later installed on your computer, you can insert a variety of graphics 

files into your outgoing messages using the Insert Picture command. You can insert formats 

that are supported by QuickTime, for example, JPEG, GIF, BITMAP, TIFF, PNG, BMP, PICT, 

QTIF, SGI, TARGA, FPX, PHOTOSHOP and more.

NOTE: What your recipient sees may depend on whether the receiving computer and email 

package support the display of inline images embedded in message text.

To insert a downloadable picture in message text

1. Move the cursor to where you want the picture.
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2. From the Edit menu, choose Insert.

3. From the Insert submenu, choose Downloadable Picture

The Insert Downloadable Picture dialog appears

Insert Downloadable Picture dialog

4. Enter the location of the downloadable picture into the URL of picture field.

5. Optionally enter alternative text for the picture (displayed when the recipient cannot 

view the picture, or when the mouse is held over the image).

6. Optionally enter a URL to launch when the image is clicked on.

The picture is displayed into the message body at the cursor position. You can 

continue typing text. Once the picture is inserted in your message, you can drag it 

to where you want it in the message. Your recipient will see the picture right in the 

message body. 

To insert a horizontal line in message text

1. Move the cursor to where you want the line.

2. From the Edit menu, choose Insert.

3. From the Insert submenu, choose Horizontal Line. 

A horizontal rule is inserted immediately above the line on which the cursor resides.
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Attaching a File to a Message

Any file can be attached to and sent with a Eudora message. Most of the time, an attached 

document functions like a “rider” to the email message, and does not appear within the 

message text. Instead, the name of the document appears automatically in the Attached field 

of the message header.

To attach a file to an outgoing message

1. From the Message menu, choose Attach File. 

The Attach File dialog box appears. 

Attach File dialog box

Locate the file you want, select it, and click Open to attach the document to the current 

message or to open a new message with the file attached. You can add as many attachments 

as you want to a message.

You can also drag one or more files from either the desktop or the File Browser window onto 

the message window to attach them. See File Browser Window on page 221. 

To detach an attached document before the message is sent, select the document name in the 

Attached field; then press either the backspace key or the Delete key.

When the message is sent, if the chosen document is not a plain text (ASCII) file, it is encoded 

in the selected attachment type. This allows you to send any kind of document through the 

mail, even applications.
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If the document is an ASCII file, you can put it in the body of the message by turning off the 

Text as Attachment button in the message toolbar, or by turning on the “Put text attachments 

in body of message” option in the Attachments options. See Attachments on page 311. The 

toolbar button applies to the current outgoing message; the Attachments option applies to all 

outgoing messages.

The attachment types include the following:

MIME—This is best for recipients with MIME-compliant email readers, regardless of what 

operating system they are using. For more information on MIME, see “MIME and Mapping in 

the extended online user manual. 

BinHex—This is best for recipients on a Macintosh with an email reader that is not MIME-

compliant.

Uuencode—This is best for recipients using PC or UNIX systems that are not MIME-

compliant.

Manually Decoding Attachments

If you send an attachment and your recipient’s email program does not automatically decode 

it, it will probably be included in the body of the message in the chosen attachment format 

(MIME, BinHex, or Uuencode).

If you receive a large message consisting largely of indecipherable text, it is probably an 

attachment that was not automatically decoded. Usually this is because the attachment 

headers are formatted incorrectly.

To decode an attachment that was not automatically decoded, open the message and choose 

Save As from the File menu to save the message as a text file. Then run the decoding utility 

appropriate for the encoding method that the sender used. Decoding utilities can be found at 

various shareware sites on the Internet.

Sending Emoticons

Emoticons are characters used to indicate an emotion or expression. In internet 

communication, emoticons such as smiley faces can add an extra level of context to email 

messages.
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There are three ways to put emoticons in an outgoing email message. You can type the 

emoticon characters directly into your message, you can use the emoticon pull-down menu, 

or you can use the “Insert Emoticon” command under the Edit menu.

To type an emoticon

1. When composing a new email message, click your cursor in the body of the 

message.

2. Type the emoticon characters. Eudora will automatically replace the characters 

with a graphic emoticon.

Emoticons

For example if you type the characters :-) in a new email message, Eudora will 

replace :-) with the happy face graphic icon.

To choose an emoticon from a pull-down menu

1. When composing a new email, click your cursor in the body of the message.

2. From the formatting toolbar above your new message window, click the 

button.
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The emoticon submenu appears with the list of available emoticons.

3. From the list, click on an emoticon.

The emoticon appears in the outgoing email message.
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To use the Insert Emoticon command

1. When composing a new message, go to the Edit menu.

The menu appears below the Edit menu.

2. Choose Insert Emoticon.

A menu appears displaying the emoticons.

3. From the list, click on an emoticon. 

The selected emoticon will appear in the outgoing message.

NOTE: Emoticon display is controlled by the program reading the email message. Emoticons 

are not sent as image files with your outgoing email, so if the recipient of your email message 

is not using Eudora 6.2, their emoticons may display differently.
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Including a URL in a Message 
(Sponsored and Paid modes only)

To include a hot link also known as a Uniform Resource Locator or URL in a message, enclose 

it with less than and greater than signs (angle brackets) to ensure that your recipient’s email 

application can identify it as a URL, for example, <http://www.eudora.com> is a hot link.

URL in a message

Creating a Hyperlink in a Message 
(Sponsored and Paid modes only)

Eudora lets you create a hyperlink in an outgoing message; that is, it converts a piece of text 

or a graphic into a link to a URL. When your recipients click the text or graphic, their browsers 

open and take them to that URL.

To create a hyperlink

1. Type the text you want to link in your outgoing message, for example “Click here.”

2. Select the text to highlight it. 

Or, insert a graphic file by choosing Insert then Picture from the Edit menu and 

select the inserted graphic. 

3. Either choose Make Hyperlink from the Text submenu under the Edit menu, or 

click the Make Hyperlink button on the message toolbar. See Text Toolbar on 

page 33. In the URL field of the Hyperlink dialog box, enter the full address of the 

URL, for example http://www.eudora.com

4. Click OK. 

http://www.eudora.com
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The text or graphic is now linked and is highlighted and underlined in the message. When your 

recipients receive the message, open it, and click the text or picture you hyperlinked, their 

browsers or other applications will open and go directly to the URL you specified.

For example, if you hyperlinked “Click here” to the Eudora Web site www.eudora.com and 

when your recipient clicks “Click here,” your recipient’s browser opens and the Eudora Web 

page appears.

Checking Your Spelling Automatically 
(Sponsored and Paid modes only)

Automatic spell check is the inline spell check feature of Eudora. If automatic spell check is 

turned on, misspelled words are double-underlined in the message body after you type them 

and press the spacebar. To correct the word or display a drop-down word list from which to 

choose the correct word, right-click the underlined word. 

Before you start using the automatic spell check feature, you must turn on this feature. 

To turn on the automatic spell check

1. From the Tools menu, choose Options.

2. Scroll and select Spell Checking. 

The Spell Checking options window appears.
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 Spell Checking options window

3. Select Automatically as you type.

4. Click OK. 

Your automatic spell check is on.

When you type in your message and misspell a word, the word is immediately underlined after 

you press the spacebar as shown in the example.

New message with automatic spell check
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To correct the misspelled word

1. If you want to choose the correct word from the drop-down word list, right-click and 

the drop-down word list appears as shown.

 Drop-down word list

2. From the drop-down word list, choose the correct word. Your misspelled word is 

replaced by the correct word. 

NOTE: Notice in our example that “p.m.” is double-underlined indicating that it’s misspelled 

according to the spell checker. From the drop-down word list, you can choose Ignore All to 

ignore the perceived error or Add to add the word to your dictionary. If you add the word, it will 

not display as a misspelled word in future messages. 

Checking Your Spelling Manually 
(Sponsored and Paid modes only)

If you prefer not to use the automatic spell check, Eudora has a manual spell checker. It can 

be used to check for misspellings in the Subject field and body of current message 

composition windows, text files, and signature files. It includes a built-in dictionary and also 

allows for the creation of a custom user dictionary. Additionally, it can be configured to ignore 

capitalized words, words in all capital letters, words with numbers, and mixed-case words; to 

report doubled (repeated) words; and to suggest alternative spellings.

Changes to the spelling options can be made in the Spell Checking options window. To open 

this window, from the Tools menu, choose Options. Scroll the category list and select Spell 
Checking. For details, see Spell Checking (Sponsored and Paid modes only) on page 324. 
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For information on how to get dictionaries for languages other than U.S. English, see Spelling 

Dictionaries on page 427. 

To automatically check spelling when you send or queue a message, turn on the “Check when 

message queued/sent” option in the Spell Checking options. If this is on, the message is 

checked for spelling errors when you send or queue it. If you complete the spell-checking 

process, the message is automatically sent or queued. If you click Cancel instead, or leave 

spelling errors in the message, a dialog box appears asking you if you still want to send or 

queue the message. If you don’t want that dialog box to be displayed, turn on the Don’t warn 

me anymore option in the Spell Checking options.

To check the spelling of a current composition window, text file, or signature file, click Check 
Spelling in the main window toolbar or choose Check Spelling from the Edit menu (Ctrl+6). 

If there are no misspellings, the “No misspellings found” alert appears.

For an alternate way to check your spelling, use the Shift+Check Spelling option on the Eudora 

main window toolbar, which lets you see all misspelled words at once and change only those 

you want to. See Saving a Message for Later Changes on page 65. 

Also, if text is selected, Eudora checks the spelling only of the selected text. Otherwise, it starts 

the spelling check from the beginning of the message body or text file and checks the entire 

text.

If a misspelled, unknown, or repeated word is found, the Check Spelling dialog box appears 

with the word listed in the Unknown field. If you want to send (or queue) the message without 

correcting the misspelled word, click Just send.

The following dialog box appears only if the Warn me when sending/queueing message with 

misspellings option is turned on. See Spell Checking (Sponsored and Paid modes only) on 

page 324. 

Check Spelling dialog box
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To correct the misspelled word

• Type the correct spelling of the word in the Change To field (if it is not already 
there) and click Change. 

• Select the correct word from the Suggestions list and click Change.

• Double-click the correct word in the Suggestions list. The spelling checker then 
proceeds with the check.

Check Spelling Dialog Box

The Check Spelling dialog box allows you to ignore an unknown word, change it, suggest the 

correct spelling, add the word to your user dictionary, edit your dictionary, or change the 

spelling options via the Options button. Each of the fields and buttons is described.

Just Send/Queue—Click to send or queue the current message that contains the 

misspellings. The misspellings are not corrected before they are sent or queued.

Unknown—An unknown word is one that is not found in Eudora’s built-in dictionary or your 

own custom dictionary. You can act on an unknown word using the Ignore, Ignore all, Change, 

Change all, or Add buttons as described below.

Change To—This field works in conjunction with the Change and Change all buttons. It allows 

you to modify the unknown word by either typing its correct spelling in this field or selecting a 

suggested alternative spelling from the Suggestions field, and then clicking the Change or 

Change all button, as described below.

Suggestions—This field lists Eudora’s suggestions for the correct spelling of the unknown 

word. If the Suggest words option is selected, all suggestions are listed here by default. If the 

option is deselected, click the Suggest button to display Eudora’s suggestions.

Ignore—This button causes the spelling checker to ignore this occurrence of the unknown 

word.

Ignore all—This button causes the spelling checker to ignore this occurrence and all 

subsequent occurrences of the unknown word.

Change—This button substitutes the contents of the Change To field for the unknown word.

Change all—This button substitutes the contents of the Change To field for this occurrence 

and all subsequent occurrences of the unknown word.
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Suggest—This button causes the Suggestions field to display a list of Eudora’s suggestions 

for the correct spelling of the unknown word.

Add—This button adds the unknown word to your custom user dictionary.

Edit Dictionary—This button displays the Edit User Dictionary dialog box.

Edit User Dictionary

The Edit User Dictionary dialog box lists all of the words in your user dictionary in the 

Dictionary field. It also allows you to add words to or delete words from your personal user 

dictionary, or even to clear the entire dictionary.

NOTE: Words in the user dictionary are saved in all lower case.

To add a word to the dictionary using this dialog box, type the correct spelling of the word in 

the Word field and click Add. The word is then added to the dictionary and displayed in the 

Dictionary field.

NOTE: The Add button in this dialog box works the same as the Add button in the Check 

Spelling dialog box.

To remove a word from the user dictionary, first type it in the Word field or locate it in the 

Dictionary field and single-click it to display it in the Word field. Then click Delete.

To delete the entire user dictionary, click Clear. You will then be prompted to confirm the 

deletions. If you click Yes, all of the words will be deleted from the user dictionary.
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Spelling Options dialog box 

The Spelling Options dialog box lists the spell-checking options. A check mark in the box next 

to the option name indicates that the option is selected.

The spelling options can also be modified in Options under the Tools menu. For details, see  

Spell Checking (Sponsored and Paid modes only) on page 324. 

The options are:

Ignore capitalized words—The spelling checker ignores words that start with a capital letter, 

such as proper nouns.

Ignore words with all capitals—The spelling checker ignores words that contain all capital 

letters, such as acronyms.

Ignore words with numbers—The spelling checker ignores words that contain numbers.

Ignore words with mixed case—The spelling checker ignores words that contain a mixture 

of uppercase and lowercase characters.

Report doubled words—The spelling checker reports words that appear twice in sequence 

in text and identifies them as Doubled words.

Suggest Words—The spelling checker displays Eudora’s suggestions for the correct spelling 

of an unknown word. You can select any combination of the suggestion options: Phonetic 

words, Split words, Typographic words.
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Using BossWatch

Have you ever used Reply-All and wished you hadn’t? The new BossWatch feature will alert 

you to the presence of email addresses that you have designated, giving you an extra chance 

to think twice before you click Send.

Using BossWatch for Outgoing Messages

When you compose a new message, or reply to a message you received, BossWatch will alert 

you if any of the recipients match the criteria specified by your BossWatch settings. 

New message composition window with BossWatch alerts

Eudora can alert you when you are about to send a message to email addresses on your 

BossWatch list by underlining the addresses, outlining the Send/Queue button with a custom 

color, displaying a dialog, speaking the address or any combination of these options. See  

BossWatch (Paid mode only) on page 365
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Using MoodWatch (Sponsored and Paid Modes only)

MoodWatch is a Eudora feature that monitors incoming and outgoing messages for offensive 

text. A new options window has been added for MoodWatch so you can determine how you 

wish to use MoodWatch.

MoodWatch works similarly to a spell checker. MoodWatch scans and determines what words 

or phrases in a message or a header may be offensive. One, two, or three red chili peppers 

appear to indicate the severity of the offensive text. If you are sending or queueing a message, 

a warning appears letting you know that text in your message may be offensive to your 

recipient.

Less offensive text in the message is underlined with a green squiggly line. More offensive text 

in the message is underlined with both a green and red squiggly line.

Using MoodWatch for Outgoing Messages

When you open a new composition window to begin writing a new message, MoodWatch 

scans each word and phrase you type and determines if it might be offensive to your recipient. 

The level of offensiveness is indicated by the appearance of one, two, or three red chili 

peppers, with three red chilies being the most offensive and one the least. As you write, chili 

peppers appear next to the Send or Queue button.

After you click Send or Queue, a warning appears indicating there is offensive text in your 

email message. Following is the warning you would get if three chili peppers are displayed.

There is no offensive language in the message.

There may be a slight bit of offensive language in the message.

There may be offensive language in the message.

There is offensive language in the message.
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Three chili warning dialog box

To send the message despite the offensive text, click Send Anyway. Your message is sent. If 

you have Eudora set to Queue messages for later transmission, you can still retrieve the 

message in the Out mailbox to edit or delete it. You can then send the message or requeue it. 

To return to the composition window without sending or queueing the message, click Cancel.

Using MoodWatch for Incoming Messages

By changing the options in the MoodWatch options window, you can have MoodWatch scan 

your incoming messages for offensive text as well. The indicators are one, two, or three chili 

peppers appearing in the mailbox message summary column, as shown.

MoodWatch scanning incoming mail

Also, by turning on an option in the MoodWatch settings, you can have MoodWatch scan and 

display chili peppers on all of your stored mail. See the section, MoodWatch (Sponsored and 

Paid modes only) on page 351 for more information.
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Saving a Message for Later Changes

Sometimes it is convenient to save an outgoing message either as a safeguard when typing 

long messages, or so you can return to it later to make changes.

To save the current message

1. From the File menu, choose Save. 

Saved messages are put in the Out mailbox, and if at least one recipient is entered 

in either the To: or the Bcc: field, the saved message is shown with a bullet (•) in 

the Status column. If both the To: and Bcc: fields are empty, the Status column is 

blank. The bullet indicates that the message not only has been saved, but is also 

ready to be sent or queued.

Saved (and sendable) message in the Out mailbox

You can continue making changes to the message or close it. If you try to close an outgoing 

message window without saving that version of the message, an alert appears asking if the 

message should be saved or the changes discarded. If you select Discard and the message 

has never been saved, the message is deleted.
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Sending or Queueing a Message

After you compose a message, you can send it immediately or put it in a queue to be sent later.

NOTE: Most outgoing (SMTP) servers do not require a password to send mail. For information 

about setting up a password check for sending mail, see Troubleshooting on page 479. 

Sending a Message Immediately

If you want to send your messages immediately instead of putting them in a queue to send 

later, be sure the “Immediate send” option is turned on in the Sending Mail options window. 

For information on the Sending Mail options window, see Sending Mail on page 302. 

To send the current message

• From the Message menu, choose Send Immediately, or click .

A Task Status window can appear to show the progress of the transmission. See Task Status 

Window on page 225. 

If you have the “Immediate send” option on, but want to put the current message in the queue, 

hold down the Shift key and click the Send button. The Change Queueing dialog box appears, 

and you can set detailed instructions. For more details, see Queueing a Message to Send at 

a Certain Time on page 68. 

Queueing a Message to Send Later

If you want to put your messages in a queue (in the Out mailbox) to send all together at a later 

time, be sure the “Immediate send” option is off in the Sending Mail options. For information 

on the Sending Mail options window, see Sending Mail on page 302. 
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You can set up Eudora to warn you if you try to delete a queued message, or try to quit Eudora 

with queued messages. To do this, turn on those options in the Extra Warnings options 

window. See Extra Warnings on page 341. 

To put the current message in the queue

• From the Message menu, choose Queue For Delivery or click .

 The message window is closed, the message is saved in the Out mailbox marked 

Q (meaning it’s ready to be sent), and the date and time are placed in the Date 

column.

Queued messages in the Out mailbox

To send all of your queued messages

• From the File menu, select Send Queued Messages. 

If you have the Task Status window displayed, you can see the progress of the transmission. 

See Task Status Window on page 225. 

If you have the “Immediate send” option turned on, but want to send a message immediately, 

hold down the Shift key and click the Queue button. The Change Queueing dialog box 

appears, and you can select “Send Message Right Now.” However, if you select this option, 

all messages that are queued in the Out box will be sent.

Queueing a Message to Send at a Certain Time

You can specify that a message be sent at a certain time in the future. 

To queue an outgoing message to send a certain time

1. From the Message menu, choose Change.

2. From the Change submenu, choose Queueing. 
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The Change Queueing dialog box appears.

3. Change Queueing dialog box

4. If you choose Right now, the message is sent immediately when you click OK. 

If you choose Next time queued messages are sent, the message is sent the 

next time queued messages are sent.

If you choose On or after, you can use the Time and Date fields to fill in the time 

and date at which the message should be sent. The message is saved in the Out 

mailbox with a clock icon  in the Status column, and with the specified date and 

time in the Date column. The message is sent when the specified time arrives.

NOTE: For the message to be sent at the correct time, Eudora must be running at 

that time. If Eudora is not running, the message is sent the first time Eudora is run 

after the specified time has passed.

If you choose Don’t send for a message that has never been queued, nothing 

happens. The message is held in the Out mailbox until it is either deleted or re-

queued and sent.

NOTE: When exiting Eudora with queued messages or timed queued messages 

(sent within the next 10 hours), Eudora gives you a warning and a chance to send 

these messages.

Editing a Queued Message

To edit a queued message

1. Open the Out mailbox.

2. Click to select the message summary. 

3. Make the necessary edits and save it. 
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The message is kept in the Out mailbox. 

If you close the changed message without saving it, an alert appears asking you to 

verify the changes.

Taking a Message Out of the Queue

To unqueue a queued message

1. Open the Out mailbox and select the desired message summary. 

2. From the Message menu, choose Change Queueing and click Don’t send. 

This changes the message status from queued (Q) to sendable (•). The message 

is held in the Out mailbox until it is either deleted, re-queued, or sent.

Sending Queued Messages When Checking Mail

If the Send on check option in the Sending Mail options window is on, every time Eudora 

checks for mail (automatically or manually), all queued messages are automatically sent. See 

Sending Mail on page 302. 

Sending Messages with Special Server Instructions

To send your queued messages with special instructions for the incoming server

1. Hold down the Shift key and from the File menu, choose Send Queued Messages. 

The Mail Transfer options dialog box appears.

 Mail Transfer Options dialog box
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2. Set the options you want and click OK. 

All the actions you have requested are completed. 

Sending Mail Through One Account (SMTP Relay) 

The Internet Service Provider (ISP) with whom you have your primary email account may not 

allow you to send messages through any other Simple Mail Transfer Protocol (SMTP) server 

but their own. If you have accounts at other ISPs or third-party email services, you may not be 

able to send mail from those accounts unless you use your primary ISP's SMTP servers. The 

SMTP relay feature allows you to send all your mail through your primary ISP's server. 

To use SMTP relay 

1. From the Tools menu, choose Options. 

2. Scroll and click Sending Mail. 

The Sending Mail dialog appears.

Sending Mail options window

3. In the SMTP Relay Personality field, choose the personality previously set up for 

the SMTP relay from the drop-down menu. None is the default. 

4. Click OK. 
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All messages sent from each of your personalities will use the account information 

for the selected personality. 

For example, if you bring your computer to a friend's house or your office, you can easily 

change your SMTP relay to a personality that uses a different ISP to send mail. Or, you can 

set the relay personality to None so that you can send all mail directly to the servers for each 

personality. 

Using SMTP Authentication 

SMTP authentication operates automatically in Eudora.

Eudora can log in to an SMTP server when sending mail, just like it does for receiving mail. 

Not all SMTP servers require or allow such authentication. Eudora will attempt authentication 

to servers that allow it. The preferred SMTP authentication method is CRAM-MD5. If CRAM-

MD5 is not available, LOGIN or PLAIN will automatically be used. Once Eudora discovers that 

your SMTP server allows authentication and when you send messages, a dialog appears that 

prompts you to enter a password.

To not allow logging into your SMTP server

1. From the Tools menu, choose Options, then Sending Mail. 

The Sending Mail options window appears.

2. Turn off Allow Authentication.

3. Click OK. 

NOTE: If you turn off the Allow Authentication option, you may not be able to send 

mail. Please check with your email administrator or ISP if you have any difficulties.

Keeping Copies of Outgoing Messages

To keep copies of your outgoing messages

• To put a copy of the current outgoing message in the Out mailbox, select  Keep 
Copy button in the Composing Mail options dialog box. See Composing Mail on 
page 305.

• To put a copy of the current outgoing message in a particular mailbox, right-click 
in the body of the message and select the mailbox from the Fcc submenu.
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In all these cases, when the messages are sent, they are put in the specified 

mailbox with a checkmark ( ) in the Status column, indicating that the message 

has been sent.

If none of these options are used, outgoing messages are put into the Trash mailbox after they 

have been sent.

NOTE: You can also set up a filter to save outgoing messages in particular mailboxes based 

on information contained in the message. See on Filtering Messages on page 161 for more 

information. 

Checking for Incoming Mail

The incoming mail server is where your mail is received and stored until it is transferred by 

Eudora to your PC. You can use several different mail accounts with Eudora. Your main 

account, or “dominant personality,” is specified in the Getting Started options. Additional mail 

accounts, or “multiple personalities,” are set up in the Personalities window and the Account 

Settings dialog box. For more information on personalities and the Account Settings dialog 

box, see Using Multiple Personalities (Sponsored and Paid modes only) on page 115 and 

Account Settings Dialog on page 125. 

NOTE: To better understand how the incoming mail server functions with Eudora, see Mail 

Transport on page 410. 

There are two ways to check your incoming mail server and transfer mail to your PC: 

automatically or manually. These are described in the sections below.

You can also control how your mail is transferred from the server, and what happens to it on 

the server. For details, see  Managing Your Mail on the POP Server on page 86 and Managing 

Your Mail on the IMAP Server on page 91. 

Checking for Mail Automatically

To set up Eudora to automatically check your incoming mail account and transfer 
new mail

1. From the Tools menu, choose Options.

2. Scroll through the category list and choose Checking Mail. 
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The Checking Mail option window appears. 

For more information, see Checking Mail on page 295. 

3. In the Check for mail every _ minutes field, enter the number of minutes that you 

want between mail checks. 

NOTE: Fifteen minutes is a good minimum interval because checking mail more 

frequently puts an unnecessary load on your incoming mail server. If the field is 

empty or is set to 0, mail is not automatically checked.

If automatic checking is set, the Check Mail command under the File menu shows 

you the next scheduled time for an automatic check.

4. From the Tools menu, choose Personalities. 

The Personalities window opens. 

See Personalities Window on page 115 for more information. 

5. For each personality you want automatically checked, right-click the personality to 

display the drop-down context menu.

6. From the context menu, choose Properties. 

The Account Settings dialog box appears.

7.  Turn on the Check Mail option for that personality.

The Check Mail option also specifies that an account should be checked for new 

mail when a manual mail check is done.

Checking for Mail Manually

To manually check for new mail at any time:

•  From the File menu, choose Check Mail or click .

Any account that has the Check Mail option turned on in the Account Settings 

dialog box is checked. If you haven’t successfully entered your password since 

opening the Eudora program, a prompt appears for each personality being 

checked. A Task Status window can also appear indicating retrieval of your 

incoming mail. See Task Status Window on page 225. 
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Stopping a Mail Check

To stop a mail check in the middle of the process:

1. On the Eudora status bar, right-click on the progress indicator or envelope. 

A drop-down context menu appears.

Task indicator’s context menu 

2. From the drop-down list, choose Stop All Tasks to stop the mail check.

To resume mail check, right-click on the progress indicator and choose Process 
All Waiting Tasks.

Using Your Password

Each time you open Eudora and check mail for the first time, you need to enter a password for 

each incoming mail account that you have. This password is required by the incoming mail 

server before it will transfer your mail, so that no one else can get your mail from the server.

NOTE: This does not protect your mail once it is on your computer. Unless a message has 

been sent with some type of security, it is just plain text, which many applications can read. If 

you are interested in securing the messages on your computer, you may want to consider a 

disk driver that can encrypt hard disk data.

If you need to enter a password, the Eudora Password dialog box appears. Enter your 

password and click OK. If you make a mistake before clicking OK, simply backspace and re-

enter the password correctly.

NOTE: Your incoming mail account password is case-sensitive, so the uppercase and 

lowercase characters must be typed in exactly. Be sure that Caps Lock is off. If the Caps Lock 

key is on, the word “Caps” will appear on the bottom-right of the main Eudora window.
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Password dialog box

If your password is rejected, an error message appears indicating you have entered the wrong 

password. Choose Check Mail from the File menu to redisplay the password dialog box.

As long as Eudora is running, it remembers all of your passwords. If you don’t want it to 

remember (for example, if you are away from your PC), choose Forget Password(s) from the 

Special menu. The next time you check mail for any account, Eudora prompts you for your 

password again.

NOTE: If you have more than one personality, a window appears listing the names of your 

personalities. You can select the personalities whose passwords you want Eudora to forget. 

All the personalities are selected by default. Deselect the personalities you don’t want Eudora 

to forget.  

Forget Passwords window (multiple personalities only)

You can also make Eudora remember all of your passwords from one session to the next, 

which means you never have to enter passwords again, even if you quit and restart Eudora. 

You want to do this only if your PC is in a secure location, where there is no possible chance 

of someone else having access to it. To use this option, turn on Save password in the Checking 

Mail options. See Checking Mail on page 295. 
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Changing Your Password

To change the password for one of your personalities

1. From the Special menu, choose Change Password. 

2. Select the personality whose password you want to change. 

3. At the prompt, enter your old password once, and your new password twice. 

Depending on the server you are using, the password can be up to 30 characters, 

but normally it is only 7 or 8.

NOTE: This works only if the incoming mail server is running a compatible 

password-change server. For information about these servers, see Sources on 

page 425. 

When you choose a new password, try not to use real words, names, dates, familiar acronyms, 

etc. Some systems require at least one number or symbol in your password, and you may want 

to do that even if it is not required.
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Receiving New Mail

When Eudora does a mail check, you can be notified of new mail in one or all of the following 

ways: an alert dialog box, the opening of the mailboxes to which new mail is delivered, and a 

special “New Mail” sound. These options are turned on or off in the Getting Attention options. 

For information, see Getting Attention on page 334. Also, an envelope appears on the 

Windows taskbar indicating mail is waiting. See Background Tasks on page 336. 

When you receive notice that new mail has arrived, select Eudora from the Windows task bar. 

Mail usually arrives in the In mailbox (unless you are using filters to transfer messages). If the 

In mailbox is not already open, select In from the Mailbox menu. The messages are listed in 

the order they are received, with the most recent message listed last. Unread messages are 

designated by a bullet (•) in the Status column of the message summary.

Double-click anywhere on a message summary to open the message. You can also view 

messages using the message preview pane at the bottom of the mailbox window while the 

message summary is highlighted.

Incoming messages are saved indefinitely in the In mailbox (or the mailbox into which they are 

filtered) until they are deleted or transferred to another mailbox.

Incoming Message Window

To open an incoming message, double-click on its message summary in a mailbox window, or 

if the message summary is current (highlighted), press the spacebar or the Enter key.
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 Incoming message window

NOTE: You can also view the message in the message preview pane. See Working with 

Mailboxes on page 139 for more details. 

The incoming message window consists of the title bar, toolbar, and message body.

Title Bar

The title bar provides information about the message, including the name of the sender, the 

time and date the message was delivered, and the message subject.

Toolbar

The toolbar consists of buttons and menus displayed just under the title bar.

Move Message

This can be used to move any current message into a different mailbox. In an 
opened message, hold the mouse button down on the icon and drag it to an open 
mailbox or a mailbox in the Mailboxes window.

Fixed Width

Click this button to convert the message text to the fixed-width (typewriter-style) 
message font set in your Fonts options. This lets you view aligned text, such as 
columns and tables, more easily.
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Message Body

The message body contains the message header and text information, as well as the name 

and icon of each attachment. Attachments can be opened from within the message window by 

clicking on the attachment icon or name or you can drag and drop the attachment from the 

message to any folder.

BLAH BLAH BLAH

If this is on, all the message headers appear.

Pencil

If this is on, you can edit the message.

Delete From Server 

If this is on, the message will be deleted from the server the next time mail is 
checked (POP servers only). This icon appears only if you have the “Leave Mail on 
Server” option selected in the Incoming Mail options window. See Leaving Mail on 
the Server on page 86. 

Retrieve From Server (Fetch) 

If this is on, the message is retrieved (fetched) from the server the next time mail 
is checked (POP servers only). This icon appears only if you have the “Leave Mail 
on Server” option selected in the Incoming Mail options window. See Leaving Mail 
on the Server on page 86. 

Priority drop-down list

This lets you indicate that the message is of higher or lower priority than a normal 
message. For most messages, this is just an empty box (normal priority). For 
details, see the section Setting the Message Priority on page 42. 

Subject: Subject

This is the subject that was assigned by the sender, and is shown in the message 
summary. For instructions on changing this subject, see Editing Incoming 
Messages on page 84. 
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Eudora lets you view incoming mail with advanced formatting, graphics, multimedia, and the 

like. Additionally, if you have the Use Microsoft’s viewer option turned on in the Viewing Mail 

options, and you have Microsoft Internet Explorer 3.0 or later installed and available on your 

system, then Eudora lets you take full advantage of the viewing capabilities of a Web browser. 

You can view directly in the email message itself, or linked to the Internet, without having to 

open your Web browser. See Viewing Mail on page 317. 

You can also download web-based images that are embedded in your receiving messages 

when you check mail if you have Automatically download HTML graphics turn on in the Display 

options window. See Display on page 315.  

Printing an Incoming Message

To print the current message

• From the File menu, choose Print. 

Eudora automatically prints headers and footers on each page, giving the 

window title, page number, and your return address.

Receiving Attachments

Unless you have specified a particular directory for your incoming attachments (see Specifying 

an Attachment Directory on page 83), they are automatically decoded and saved in the Attach 

Directory in your Eudora Directory. If you receive multiple attachments with the same name, a 

number is added to the end of each duplicate name, in the order they are received.

Attachment names appear at the bottom of incoming messages and the message preview 

pane. 

To open an attachment from the open message window or the message preview pane, click 

on the attachment name or its icon. If you have the application that the attachment was created 

in, that application launches and the attachment opens.

You can now drag and drop attachments from your message to other directories. Use this 

feature to easily file the documents you receive.



83

Receiving and Responding to Messages

If you open a received attachment outside of Eudora, for example directly from the 

Attachments directory or from a Eudora Sharing Protocol (ESP) directory, a warning alerts you 

to be careful when opening the attachment in case it’s a malicious file. You can turn the 

warning, Launch a program externally, on or off in the Extra Warnings options window found 

under Options in the Tools menu. See Extra Warnings on page 341.

If you receive a large message consisting largely of indecipherable text, it is probably an 

attachment that was not automatically decoded. Usually this occurs because the attachment 

headers are formatted incorrectly. 

To decode an attachment that was not automatically decoded

1. Open the message.

2. From the File menu, choose Save As to save the message as a text file. 

3. Run the decoding utility appropriate for the encoding method that the sender used. 

Decoding utilities can be found at various shareware sites on the Internet. Also see 

Attaching a File to a Message on page 49. 

Specifying an Attachment Directory

To not use the default Attach Directory to receive your attachments

1. From the Tools men, choose Options.

2. Scroll through the category list and select Attachments. 

3. Beneath the Attachment directory prompt, click on the large bar button. 

A standard file dialog box appears.

4. Double-click on the name of the directory you want to use (its name appears above 

the list).

5. Click Use Directory. 

The dialog box closes, leaving the Attachments options window opened. The name 

of the folder you just selected appears in the “Attachment directory” bar button.
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Attachments options window

NOTE: If at any time Eudora cannot find your selected directory, Eudora will use the Attach 

Directory in the Eudora Directory for attachments until you designate a new directory.

Editing Incoming Messages

You can edit the message body in an incoming message if you select the Pencil button in the 

toolbar. You can also edit the Subject in the Toolbar (this is the subject shown in the message 

summary), and you do not need to select the Pencil button to do this.

To edit an incoming message, click on the Pencil button to turn it on, then edit the message 

body. When you are done, save your changes and close the message. See Formatting Text 

(Sponsored and Paid modes only) on page 43 for details on how you can edit the message 

text. 

To edit the subject of an incoming message, open it and edit the subject in the toolbar, not in 

the message body. When you are done, click elsewhere in the message, or close it. The new 

subject appears in the message summary. The contents of the Subject field of the message 

header remain unchanged.
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NOTE: If you reply to the message, the original subject is used for the reply, not your changed 

subject.

Using Active URLs

(Sponsored and Paid modes only)

Any string of text that Eudora recognizes as a hot link or URL (Uniform Resource Locator: http, 

ftp, mailto, gopher, ph, finger, etc.) to the Internet is active. Click a URL to open a World Wide 

Web location, transfer a file, do a gopher search, use the finger tool, etc. URLs are highlighted 

and underlined to show that they are active.

ScamWatch (URL Protection)

Many email scams use misleading URLs to trick users to click on their links. What appears to 

be a legitimate web site address often hides a malicious URL link.

Eudora now features ScamWatch, which makes it very easy to quickly determine if the URL is 

legitimate before you click on it.

Using ScamWatch

To use ScamWatch, move your mouse over the URL link in any incoming email message.

If the URL is suspicious, Eudora will display a warning message in the help tag.

Eudora displays a warning message and the true URL
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If you click on a suspicious URL, a new window will appear with another warning message.

Warning Message

Click Cancel and the suspicious URL will not be opened. Otherwise, click Visit to open the 

URL in your preferred web browser.

Managing Your Mail on the POP Server

During a mail check, your incoming messages are normally transferred from your account on 

the POP server to your computer, and then deleted from the POP server. But this can be 

awkward if you want to read mail from two or more computers and keep your mail organized 

at the same time.

There are several options you can use to control your mail transfers and the storage on the 

server. Some of these options are available in the Incoming Mail options, for your dominant 

account only, and the Account Settings dialog box, for any of your personalities. Some of the 

options are available in the Mail Transfer options. For more information, see on Checking for 

Mail with Special Server Instructions on page 89 and on Account Settings Dialog on page 125. 

Leaving Mail on the Server

If you use the POP protocol for your incoming server to retrieve mail, your mail is normally 

deleted from the server once it is delivered to Eudora. However, most POP incoming servers 

allow you to indicate that you wish to keep your mail on the server so you can retrieve it from 

several different computers at various times. 
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Facts you should know if you decide to leave your mail on the server:

• Some mail servers won’t allow you to keep mail on them.

• Your system administrator may not allow you to keep mail on the server even though 

you have the option turned on. Usually administrators do not like to keep too much 

mail on the server because of space concerns.

• Keeping a lot of mail on the server may slow down the mail checking process.

• If you check mail from several computers at different times, you can end up reading 

your messages two or more times. However, if you delete mail from your Trash 

folder, the message is deleted on the server.

Eudora has an option that allows you to leave your email messages on the server for a 

specified number of days. 

To transfer all of your new messages from the incoming server to Eudora and 
also leave copies of those messages on the server

1. From the Tools menu, choose Options.

2. Scroll through the categories and select Incoming Mail.

3. In the Incoming Mail options window, turn on the Leave mail on server option. This 

option is available only if you are using POP.

4. Select the Delete from server after _ days box and set the maximum number of 

days that copies of your email messages should be kept on the server. This number 

is determined by the time it takes for you to check mail from all of your computers. 

If this number is too small, copies of your mail will not be delivered to all of your 

computers. 

CAUTION: Make sure the settings in steps 3 and 4 are identical on all of the 

computers from which you will be receiving your mail. If you don’t, one computer 

will delete the mail from the server before you can receive it at another computer.

5. Click OK and close the window.

At the next mail check from that computer, Eudora ignores the copies of those previously read 

messages and looks for new ones. However, if you check mail from another computer, those 

messages are treated as new and are transferred to that computer. For more information, see 

Incoming Mail on page 298. 
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NOTE: The Leave mail on server option can also be set for each alternate personality you 

have. To do this, use the Account Settings dialog box, accessed from the Personalities 

window. See Account Settings Dialog on page 125. 

CAUTION: The Leave mail on server option should be used with care, since it can result in a 

buildup of messages on the POP server.

Deleting a Message from the Server

To delete a message that has been left on the server (without retrieving it again), click the 

Trash button in the message toolbar or set the message summary’s server status to Delete, 

then check mail again. Or use the Delete all messages that have been retrieved option in the 

Mail Transfer Options dialog box as described in Checking for Mail with Special Server 

Instructions on page 89.

Skipping Messages Over a Certain Size

To stop Eudora from transferring incoming messages that are too large, select the “Skip 

messages over _ K in size” option in the Incoming Mail options window, and specify a size. 

Only the first few lines of the messages that exceed that size are transferred, with a note at 

the bottom stating that the whole message has not been transferred. See also Incoming Mail 

on page 298. 

The Skip messages over _ K in size option can also be set for each personality you have. To 

do this, use the Account Settings dialog box, accessed from the Personalities window. See  

Account Settings Dialog on page 125

If you decide you want to transfer the whole message, click on the Fetch button in the incoming 

message window, or select the Fetch server status in the message summary, then check mail 

again. Also, you can use the Trash button or the “Fetch then Delete” server status so that the 

message is deleted from the server after it is transferred.

If you decide you don’t want the message and want to delete it from the server, click the Trash 

button in the incoming message window, or select the “Delete server status” in the message 

summary, then check mail again. The message will be deleted from the server without ever 

being retrieved.
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Checking for Mail with Special Server Instructions

To check your mail and give special transfer and storage instructions to the POP 
server

1. Hold down the Shift key and from the File menu, choose Check Mail. 

The Mail Transfer Options dialog box appears. 

Mail Transfer Options dialog box

NOTE: If you only have one personality (dominant), only the left side of this dialog 

box appears. 

2. Set the options you want and click OK to continue checking for mail.

The Mail Transfer Options fields are described.

Retrieve new mail—Transfer your new mail from the POP server to your 

computer.

Send queued messages—Send all the queued messages (marked Q) in your Out 

mailbox.

Delete messages marked for deletion—Delete from the POP server the 

messages that are marked Delete in Eudora. This is for messages that were 

retrieved only in part, either with:

• Leave mail on server or Skip messages over _ K in size options found in the 
Incoming Mail options window for your main account or the Account Settings 
dialog box for your multiple personalities. 

• Or the Fetch all message headers to In mailbox option found in the Mail Transfer 
options window.
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Retrieve messages marked for retrieval—Retrieve from the POP server the 

messages that are marked “Fetch” or “Fetch then Delete” in Eudora. This is for 

messages that were retrieved only in part with:

• Skip messages over _ K in size option found in the Incoming Mail options 
window for your main account or the Account Settings dialog box for your 
multiple personalities. 

• Or with the Fetch all message headers to In mailbox option found in the Mail 
Transfer options window.

To mark a message “Fetch,” “Delete,” or “Fetch then Delete,” either click the 

buttons in the incoming message window, or select an option from the Server 

Status drop-down list of the message summary.

Delete all messages that have been retrieved—Delete all of the messages from 

the POP server that have already been fully transferred to the computer you are 

using. Messages that have been partially downloaded are not deleted from the 

server.

Delete all messages on server—Delete all of your messages from the POP 

server even the messages that have never been downloaded. Be absolutely sure 

this is what you want to do, because there is no way to undo it!

Fetch all message headers to In mailbox—Retrieve from the POP server the 

header and the first few lines of every new message. If you select this option, the 

messages are not filtered. Set the Server Status in the message summaries to 

specify what you want to do with the messages the next time you check mail.

CAUTION: If you delete the message header, and you have the “Delete from 

server when emptied from Trash” option on in either the Incoming Mail options 

window for your main account or the Account Settings dialog box for an alternate 

personality, the message is gone completely from Eudora and the POP server.

How should checking/sending be performed—If you have multiple 

personalities, you can check or send mail based on the options on the left of the 

Mail Transfer Options (turn on Using options at left), or as specified in the Incoming 

Mail options window for your dominant account. To set options for any of your 

personalities, access the Account Settings dialog box from the Personalities 

window. You can also specify the personalities that you want to check or send with 

this mail transfer. Hold down the Shift key to select multiple personalities in 

sequence, or the Ctrl key to select them out of sequence.
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NOTE: Another way to check mail for multiple personalities, regardless of your settings 

elsewhere, is to open the Personalities window, select your desired personalities, right-click 

on the selection, and select Check Mail from the drop-down list. See Using Alternate Email 

Accounts on page 115. 

Managing Your Mail on the IMAP Server

If your incoming mail server uses the Internet Message Access Protocol (IMAP), you manage 

your mail, mailboxes, and folders on the server, not on your computer. When you create 

mailboxes and folders, you create them on the server. However, you can see them in the 

Mailboxes window in Eudora. When you launch Eudora, you retrieve your mailboxes and 

folders from the server. When you check mail, the mail you retrieve is filtered on the server 

although your filters are created in Eudora. This is beneficial if you have to retrieve mail from 

different computers. Your mail remains on the server for you to retrieve at anytime on any 

computer.

During mail checks, partial messages or full messages are transferred to your computer, with 

or without attachments, depending on the options you specify in the Incoming Mail options 

window for your main account (see Incoming Mail on page 298). This is beneficial if you use 

a computer with limited disk space or a slow network connection. To specify options for your 

personalities, access the Account Settings dialog box from the Personalities window (see 

Account Settings Dialog on page 125). 

When a message is transferred, either in part or in full, from the IMAP server to your computer 

during a mail check, a copy of the message remains on the server until you actively delete it. 

Downloading Minimal Headers vs. the Full Message

By default, the “Minimal Headers Only” option is selected in the Incoming Mail options for an 

IMAP account. As a result, when you check mail for an IMAP account and the incoming mail 

is delivered to Eudora, only a minimal amount of information about each message is 

transferred to your computer. This consists of the information you would see in the message 

summary of a mailbox window: the sender, the date and time of the message, the subject, etc. 

When you open or preview the message, the full set of message headers and the entire 

message body is transferred to your computer. Whether or not any attachments to the 

message are also transferred depends on your setting for the “Full message except 

attachments over _ K” option.



92

Receiving and Responding to Messages

If you always want the full message to be transferred to your computer during mail checks, 

with or without attachments as specified separately, rather than just the minimal headers, then 

turn off the “Minimal Headers Only” option. See Incoming Mail on page 298 with IMAP 

selected. 

Full Message Except Attachments Over _ K

To prevent Eudora from transferring large attachments to your computer during mail checks, 

turn on the “Full message except attachments over _ K” option and specify a size. You can set 

this option in the Incoming Mail options for your main account, or in the Account Settings dialog 

box for any of your personalities. If you enter zero, the attachment, regardless of its size, will 

be retrieved.

Each time mail is then checked for the account, any attachments larger than the specified size 

are not transferred to your computer with the message. The rest of the message is transferred 

including the complete message body. Any attachments within the specified size are also 

transferred. Enter a large number to transfer most or all attachments to your computer.

Attachments not transferred during mail checks can still be retrieved. When you open or 

preview the message associated with the attachment, an icon for the attachment appears in 

the incoming message window or the message preview pane. 

To retrieve the attachment

• Click the icon to retrieve the attachment from the IMAP server. Or right-click on 
a message to display the drop-down list, and from the drop-down list, choose 
Fetch then Include Attachments.

If you wish to re-retrieve a message at any time

1. Right-click on a message to display the drop-down list. 

2. From the drop-down list, choose Fetch. 

3. Either choose Include Attachments or Use Defaults. If you want to delete the 

local copy of a message, right-click on the message to display the drop-down list. 

From the drop-down list, choose Remove Cached Contents. 

The message still exists on the server if you want to re-retrieve it. 

If the Full message except attachments over _K option is turned off, only the attachment 

headers are transferred to your computer.
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NOTE: In IMAP, your attachments download to the Attach folder, which is in the IMAP folder. 

However, if you have previously set up a directory in the Attachments options window to where 

you want your attachments to go, all attachments (POP and IMAP) go to that directory. See 

Attachments on page 311. 

Deleting a Message from the Server

If you have the When I delete a message, move it to Trash option turned off in the Incoming 

Mail options window (see Incoming Mail on page 298), all new messages are delivered to your 

IMAP server and are kept there until you actively delete them. 

Also, whenever you retrieve a message, either in part or in full from the IMAP server to your 

computer, a copy of the message is kept on the IMAP server until you actively delete it. 

Therefore to delete an IMAP message, you must delete it from the IMAP server. To delete 

messages from the IMAP server, you must perform two steps. 

• Mark the message for deletion. 

• Remove all marked messages.

To mark a message for deletion

1. Open the IMAP mailbox or folder containing the message.

2. Select or open the message.

3. From the Message menu, choose Delete. Or press the Delete key. 

To unmark a marked message so that it won’t be deleted from the IMAP server, 

select or open the message and from the Message menu, choose UnDelete. Or 

right-click to display the drop-down list, then choose UnDelete.

To remove all messages from the IMAP server marked for deletion, from the 

Message menu choose Purge Messages. The messages are completely removed 

both from the IMAP server and from your computer.

WARNING: Once you remove marked messages using the Purge Messages command, these 

messages are completely gone and cannot be restored. Therefore, use this command with 

caution.
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Resynchronizing an IMAP Mailbox or Folder

Keeping your mailboxes and folders remotely on an IMAP server lets you perform operations 

on them from different computers. For a particular IMAP mailbox, you may delete some 

messages from the mailbox from one computer, check mail from another computer, resulting 

in new messages being transferred to the mailbox, and change the status of some of the 

messages from a third computer.

Each computer has no idea what has been done to the mailbox from the other computer until 

you resynchronize the mailbox, which updates all operations performed on the mailbox from 

all computers that have access to the mailbox. In some situations, others may have access to 

these same mailboxes.

To resynchronize an IMAP mailbox or folder

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window’s tab if it 

is the inactive window in a tabbed group. 

The Mailboxes window appears.

2. Right click an IMAP mailbox

A drop-down menu appears.

3. From the drop-down list, choose Resynchronize Mailbox. 

TIP: When using the Resynchronize mailbox on every mailcheck, the icon of the 

mailbox changes to easily tell which mailboxes will resynchronize on every 

mailcheck.

The mailbox Scarlett is set to Resync mailbox on every mailcheck.  The other 

mailboxes have the normal icon because they must be resynchronized manually.

General mailbox and folder management for POP and IMAP servers is performed from the 

Mailboxes window. For more information, see on Using the Mailboxes Window on page 150. 



95

Receiving and Responding to Messages

Refreshing Your List of IMAP Mailboxes and Folders

If you have shared folders set up, you and other users can access and change messages 

stored in mailboxes and folders you keep stored remotely on an IMAP server. However, users 

may access shared folders only, your personal folders cannot be accessed. The Mailboxes 

window does not reflect the “real-time” status of the IMAP mailbox list. So between mail 

checks, a disparity can grow between what appears in the list and what is actually on the IMAP 

server, as new mailboxes are added and existing ones are changed or removed.

To refresh your list of mailboxes and folders on the IMAP server, as it appears in 
the Mailboxes window

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window’s tab if it 

is the inactive window in a tabbed group. 

The Mailboxes window appears.

2. Right-click on the top folder in the IMAP tree to display the drop-down list.

3. From the drop-down list, choose Refresh Mailbox List. 

The mailbox list is updated according to what actually appears on the IMAP server 

at that time. Also, the Mailbox and Transfer menus are updated with the current 

IMAP mailbox configuration.

Using IMAP Tasks Offline 

If you use IMAP as your incoming server, you can perform certain tasks offline. Being offline 

is the preferred method when you are using a laptop away from home or office.

When you are offline, you are disconnected from the server. 

To go offline

1. Move your mouse pointer to the taskbar and right-click. 

A context drop-down list appears.

2. From the context menu, choose Offline. 

You are now disconnected from your IMAP server.

When you are offline, you can perform these tasks:

• Disable timed mail checks
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• Manually check for mail

• Transfer and delete messages after they are retrieved. However, a dialog box 

appears asking you to connect for as long as it takes to transfer and delete your 

messages. Once the tasks are completed, you immediately disconnect from the 

server. 

Replying to a Message

To reply to the current message

• From the Message menu, choose Reply or click . 

A new message window appears, with the original sender’s address automatically placed in 

the To: field of the header. All of the sender’s original text is quoted in the message body. This 

text can be edited as needed. Additional text can be added to the reply just as to any outgoing 

message, and the reply can then be sent or saved for further changes.

If the sender’s text is quoted with a left sidebar, also called an “excerpt bar.” See the following 

example:

Sender’s text showing excerpt bar

Messages that have been replied to are identified with a left arrow  in the Status column of 

their message summary.

Using the Reply Options

There are several options that you can use when replying to messages.

To include everyone who received the original message

• From the Message menu, choose Reply to All or click .

To include yourself as a recipient, select the “Include yourself” option in the Replying options. 

See Replying on page 309. This works only if you are using “Reply to All.” 
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To determine who you are for the “Include yourself” option, Eudora uses the “me” nickname. 

If you do not have a “me” nickname set up in your Address Book, Eudora uses the contents of 

the Mail Server (Incoming), Login Name, and Return address fields from the Getting Started 

options. (Incoming mail accounts are usually of the form loginname@mailservername.) 

The “me” nickname is particularly useful if you have multiple addresses and don’t want replies 

to go to any of those addresses.

To put the addresses of the other recipients of the original message in the Cc: field (instead of 

the To field), select the “Put original To: recipients in Cc: field” option in the Replying options 

window. Only the original sender’s address is put in the To: field. This works only if you are 

using “Reply to All.” See Replying on page 309. 

To copy the original message’s priority to your replies, select the “Copy original’s priority to 

reply” option in the Replying options window.

To change the keyboard shortcut Ctrl+R from its normal function of “Reply” to “Reply to All,” 

turn on the Map Ctrl+R to “Reply to All” option in the Replying options window. The change is 

reflected on the Message menu.

Reply with Selected Text

If you receive a message from someone, and you would like to reply to this message by using 

a selected part of the message, you can do so by just highlighting the text you want to appear 

in your reply. 

To select text to include in a reply

1. In a received message, click and drag to highlight the text you want to include in 

your reply.

2. Once the selected text is highlighted, choose Reply from the Message menu or 

click . 

The selected text now appears in your message reply.                        

3. Add more response, if needed.

4. To send, click Send (or Queue). 
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Forwarding a Message

Any message can be forwarded to someone else. You forward a message to someone who 

would consider the message as important as you do. 

To forward the current message:

• From the Message menu, choose Forward or click .

A new message window appears with your address in the From: field, the original subject 

preceded by “Fwd” and a space in the Subject: field, the original sender’s text quoted in the 

message body, and any original attachments in the Attached: field. For details on how text is 

quoted, see the section Replying to a Message on page 96. Make any changes or add any 

comments you want, and enter the recipient’s address in the To: field. The message can then 

be sent or saved for further changes.

NOTE: If you forward an outgoing message (a message you sent), the attachments are not 

automatically included.

Messages that have been forwarded are identified with a right arrow  in the Status column 

of their message summary.

Other ways to forward a message:

• With the desired message open or selected in a mailbox window, open the  
Personalities window, right-click on a personality, and choose Forward As from the 

Message submenu of the drop-down list.

• Set up a filter that uses the Forward To filter action. For more information, see 

Filtering Messages on page 161 and Filter Actions on page 170. 

Redirecting a Message

Incoming messages can be sent to a new recipient “by way of” you, maintaining the original 

sender’s address in the From: field. You should redirect a message that should have gone to 

someone else. 

To redirect the current message

• From the Message menu, choose Redirect or click .
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A new message window appears with the original sender’s address in the From: field with the 

statement “by way of” followed by your real name and/or return address, the original sender’s 

text in the message body, and the original attachments in the Attached: field. Make any 

changes you want, and enter the recipient’s address in the To: field. The message can then 

be sent or saved for further changes.

NOTE: You may want to enclose any changes in brackets [  ] so that you don’t confuse the 

recipient about who wrote what.

Redirected message

Messages that have been redirected are identified with a diagonal arrow pointing up and right 

 in the Status column of their message summary.

Other ways to redirect a message:

• With the desired message open or selected in a mailbox window, open the 

Personalities window, right-click on a personality, and choose Redirect As from the 

Message submenu of the drop-down list.

• Set up a filter that uses the Redirect To filter action. For more information, see 

Filtering Messages on page 161 and Filter Actions on page 170. 

Turbo Redirecting

You can redirect a message to someone on your recipient list, queue the new message 

(without displaying it), and delete the original message, all with one command. To do this, 

choose the Turbo redirect by default option in the Miscellaneous options window. Then, when 

you select a recipient from the Redirect To submenu under the Message menu, a turbo redirect 

will be performed automatically. For more information, see Miscellaneous on page 356. 



100

Receiving and Responding to Messages

Redirect and Signatures

When you use Redirect or Redirect To, your signature is not added to the message when it is 

sent, unless you originally created the message. Eudora considers the message to be 

originally from you if the address in the From: field exactly matches either your return address 

or one of the addresses belonging to your nickname called “me,” if you have one. See Using 

a Signature on page 105. 

Sending Rejected Messages Again

If for some reason an email message can’t be delivered to a recipient, mail transport agents 

return the message to the original sender (you). A message is typically rejected because of an 

error in the recipient’s address, although many other reasons are possible.

The return message usually includes cryptic information that may let you determine the reason 

the message was rejected. It also includes the text of the original message.

You can easily recover the original message, make any corrections, and resend it. 

To recover, make corrections, and resend the current message

• From the Message menu, choose Send Again. 

This eliminates the inserted extra text and reformats the message as it originally appeared. 

You can then make changes or additions and send the message again.

The Send Again command is useful for resending saved messages from your Out box, such 

as messages you’ve copied to yourself to save yourself retyping. You can send the same 

message to another recipient to avoid having to retype the whole message, or you can send 

a different message to the same recipients to avoid having to retype their addresses in the 

header.

To send again (alternate) 

1. With the desired message open or selected in a mailbox window, from the Tools 

menu, choose Personalities, or select the Personalities tab if it is the deselected 

window in a tabbed group. 

The Personalities window appears.

2. Right-click on a personality. The drop-down context menu appears.
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3. From the context menu, choose Message. 

The Message submenu appears.

4. From the Message submenu, choose Send Again As. 

The message is sent again but from the selected personality, which may or may 

not be the same as the personality under which it was originally sent.

Using the Content Concentrator (Sponsored and Paid modes only)

This feature allows you to concentrate text inside a single message by trimming redundant 

headers and text in the message window. You can also group threaded messages and view 

them with trimmed headers and text all at once in the preview pane of a mailbox. Threaded 

messages are messages you receive that were either sent, forwarded, or redirected to you 

about the same subject or from the same sender. 

To concentrate text inside a single message

1. From the Tools menu, choose Options.

2. Scroll and choose Content Concentrator.

The Content Concentrator options window opens.

3. In the Single Message Profiles, choose Compact or Terse for each field (preview 

pane and/or message window) from the drop-down menu. See Content 

Concentrator (Sponsored and Paid modes only) on page 363 for more information.

Concentrated messages in a single message window (Compact setting)
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To group threaded messages and view them in the preview pane 

1. In the selected mailbox, select and highlight the message you want to group. 

2. Press the Alt key and click on the message. 

NOTE: You can group messages in two ways, by sender or by subject. Click the 

sender's name or subject when pressing the Alt key. The messages are grouped 

by sender or by subject. 

All messages that are threaded to the selected message appear together.

Group threaded messages (by sender - Terse setting)

All the highlighted messages in the thread appear with abbreviated headers in the 

preview pane. 

NOTE: The messages appear concentrated as a single message in the preview 

pane.

Changing the concentration level in the preview pane

Content Concentrator allows you to change the level of concentration right from the preview 

pane.  Instead of setting the level of concentration in your Eudora Options, you can now 

change the level for each mailbox.
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To change the level for each mailbox

1. Click the Content Concentrator button directly above the Preview Pane in the 

middle of the mailbox, between the "Mailbox Size Display" and the horizontal 

scrollbar.

A contextual menu appears.

The Contextual Concentrator 

2. Choose one of the options from the contextual menu. If a single message is 

highlighted, the default is Compact. If multiple messages are highlighted, the 

default is Terse. 

3. Choose one of the following options:

• None - This turns off Content Concentrator. There is no change in the message  
format.

• Compact - Message is truncated; that is, excess headers and text are removed  
and replaced with ellipses and a snip indicator. Only the To:, From:, Subject:,  
and CC: headers appear in the message.

• Terse - Message is truncated further; only the From: field of the header  appears 
in the message and the concentrated body of the message.

For information on the Content Concentrator settings, see Content Concentrator in the Eudora 

Manual.
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For more information, see Content Concentrator (Sponsored and Paid modes only) on 

page 363.
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Using a Signature

A signature is a few lines of text that are automatically added to the end of an outgoing 

message when it is sent. A signature can be whatever you want, but it is mostly used to give 

contact information (telephone, address, etc.). You use only one signature at a time in a 

message, but you can create as many different signatures as you want. Also, you can choose 

to have your signature display or not display when writing an email. See Composing Mail on 

page 305. 

NOTE: If you are using Eudora in Light mode, you are allowed only one signature.

Signatures are created and managed from the Signature window. 

Signature Window

Use this window to manage and apply signatures.

To open the Signature window

• From the Tools menu, choose Signatures. Or, if the Signature window is in a 
visible tabbed window, click its tab.

Sample Signature window
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The Signature window displays a single-column list of your signature files.

NOTE: You can select only one item at a time in the list; you cannot select multiple items.

If you right-click a signature in the list, a drop-down context menu appears with the following 

commands (the standard Eudora window-management commands appear at the bottom):

• New—Create a new signature. Eudora prompts you for the name of the new 

signature, then opens an editing window for you to type the signature text. Save the 

text with the File menu “Save” command, or close without saving to discard it.

• Edit—Open an editing window for the selected signature. (Double-click a signature 

as a shortcut for this command.) Save your changes with the File menu “Save” 

command, or close the window without saving to discard your changes.

• Delete—Delete the selected signature. Eudora asks you to confirm the deletion. Use 

the Delete key as a shortcut for this command.

• Rename—Rename the selected signature. Use the F2 key as a shortcut for this 

command, or click the signature item’s name box, then edit the name right in the box.

You can also display the drop-down context menu and create a new signature by right-clicking 

anywhere in an empty Signature window or by right-clicking anywhere off a signature item in 

a Signature window that is not empty.

Adding a New Signature

Following is the basic procedure for creating a new signature in the Signature window, 

followed by additional information on managing signatures and sending them with messages.

Eudora comes with a default signature called Standard. This is an empty signature file that you 

fill with signature text. Instructions for editing signature files appear after the procedure below.

To create a new signature

1. From the Tools menu, choose Signatures or click the Signature window’s tab if it 

is the inactive window in a tabbed group.

2. Right-click anywhere inside the Signature window to select the drop-down context 

menu.

3. From the context menu, choose New. 
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Eudora displays the Create New Signature dialog box, asking you for a name.

4. In the dialog box, enter a signature name and click OK. 

A signature window appears.

5. Enter your signature text in the signature window. You can format the text with 

styles; see Formatting Text (Sponsored and Paid modes only) on page 43 and Text 

Toolbar on page 33. 

Entering a new signature

6. To save the signature, from the File menu, choose Save.

7. Close the Signature window.

Modifying a Signature

To change a signature

1. Right-click the signature in the Signature window to display the drop-down context 

menu.

2. From the context menu, choose Edit. 

The signature window appears for that signature. 

3. Make the changes.

4. To save the signature, from the File menu, choose Save.

5. Close the Signature window.
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Deleting a Signature

To delete a signature

1. Select the desired item in the Signature window and press the Delete key. Or right-

click the signature item and from the drop-down context menu, choose Delete. 

2. When you are prompted to confirm the deletion, click Yes to delete it.

Using a Signature in a Message

To include a particular signature in an outgoing message, select the signature you want from 

the Signature drop-down on the message toolbar.

Selecting a signature for a message

To include a particular signature in all of your outgoing messages—unless you are using 

stationery, select a signature from the Signature drop-down list in the Composing Mail options 

window for your dominant account only, or in the Account Settings dialog box for any of your 

personalities. You can change this for a particular message by selecting a different signature 

or None from the Signature drop-down list on the message toolbar. For more information, see 

Composing Mail on page 305 and Account Settings Dialog on page 125. 

You can indicate if a signature with styled text can be sent with a message that has no styled 

text. If not, the signature is included but the style is removed. See Styled Text on page 322. 
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To hide or show your signature while composing a message. go the Composing Mail options 

window and turn on or off the Show signature while composing option. See Composing Mail 

on page 305.

Also, you can include your default with all replies. Go the Replying option to turn the option on. 

See Replying on page 309. 

Note that if you open a new message with stationery, or if you have default stationery set for 

all new messages, then the signature stored with that stationery file is the one used with the 

new message, overriding any default signature. However, you can always make the final 

decision about what signature to send with a new message by choosing it from the Signature 

drop-down on the message toolbar. For more information on stationery, see the next section, 

“Using Stationery.”

Using Stationery 
(Sponsored and Paid modes only)

Stationery files are templates for outgoing messages. If you find yourself repeatedly sending 

the same message, save the message as a stationery file and send it whenever you need to 

with the “New Message With” or “Reply With” commands. This way you don’t have to copy and 

paste text into a message; you can just open a pre-written message and edit it as necessary.

Stationery Window

Stationery files are created and managed from the Stationery window. You can also open a 

new stationery message from the Stationery window.

To open the Stationery window

• From the Tools menu, choose Stationery. Or, if the Stationery window is in a 
visible tabbed window, click its tab.
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Sample Stationery window

The Stationery window displays a single-column list of your stationery files.

NOTE: You can select only one item at a time in the list; you cannot select multiple items.

If you right-click a stationery item in the list, a drop-down context menu appears with the 

following commands.

• New—Create a new piece of stationery (a new stationery file). An untitled stationery 

window opens that you can fill out and choose “Save As Stationery” from the File 

menu.

• Edit—Open an editing window for the selected stationery item. Make your changes 

and choose “Save As Stationery” from the File menu, or close without saving to 

discard your changes.

• Delete—Delete the selected stationery item. Eudora asks you to confirm the 

deletion. Use the Delete key as a shortcut for this command.

• Rename—Rename the selected stationery file. Use the F2 key as a shortcut for this 

command, or click the stationery file’s name box, then edit the name right in the box.

• New Message With—Create a new message with the selected stationery. As a 

shortcut for this command, either select the stationery item and press Enter, or just 

double-click the stationery item.

• Reply With—Reply with the selected stationery to the sender(s) of the received 

messages that are currently selected.

• Reply to All With—Reply with the selected stationery to the sender(s) and all 

recipients of the received messages that are currently selected.
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You can also display the drop-down context menu and create new stationery by right-clicking 

anywhere in an empty Stationery window or by right-clicking anywhere off a stationery item in 

a Stationery window that is not empty.

Creating New Stationery

Following is the basic procedure for creating a new stationery file in the Stationery window and 

additional information on creating and sending stationery messages.

To create a new stationery file

1. From the Tools menu, choose Stationery or click the Stationery window’s tab if it 

is the inactive window in a tabbed group. 

The Stationery window appears.

2. Right-click anywhere inside the Stationery window to display the drop-down 

context menu.

3. From the context menu, choose New. 

Eudora opens a composition window to be used for stationery. 

NOTE: The Send/Queue button is inactive in the window; the message cannot be 

sent or queued.

4. Put the text you want into the message body, fill in the headers as appropriate 

(subject, copies, etc.) and make any desired setting in the toolbar.

5. From the File menu, choose Save As Stationery. 

The Save as Stationery dialog box appears.

6. Enter a file name and click Save to save the stationery file. 

The file is saved to your Stationery folder.

7. Close the stationery message.
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Modifying Stationery

To change a stationery file

1. In the Stationery window, right-click the stationery item to select and display the 

drop-down context menu.

2. From the context menu, choose Edit.

3. Make your changes.

4. From the File menu, choose Save As Stationery to save.

Deleting Stationery

To delete a stationery file

1. Select the desired item in the Stationery window and press the Delete key; or right-

click the stationery item and from the drop-down context menu, choose Delete. 

2. When you are prompted to confirm the deletion, click Yes.

Using Stationery in a Message

To send a stationery message 

1. From the Message menu, choose New Message With or Reply With.

2. From either the New Message With or Reply With submenus, select a stationery 

file. 

A composition window appears containing the header and body from the stationery 

file. If you are replying to a message, the stationery information is added to the 

reply. You can edit and send this new message just as you would any other 

message.

You can also send a new stationery message by double-clicking on a stationery item in the 

Stationery window, or by selecting the stationery item and pressing Enter. In either case, a new 

composition window opens containing the selected stationery.
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To use a particular stationery file for all of your outgoing messages, select a stationery from 

the Stationery drop-down in the Composing Mail options for your dominant account only, or in 

the Account Settings dialog box for any of your personalities. Most new messages use this file, 

unless you create the message using the “Redirect,” “Send Again,” “New Message With,” or 

“Reply With” command. For more information, see Composing Mail on page 305 and Account 

Settings Dialog on page 125. 

You can also set up a filter to reply with a stationery message. See Filtering Messages on 

page 161 for more information. 

Replying with Stationery  
(Sponsored and Paid modes only)

To reply to a message with stationery

1. From the Message menu, choose Reply With. 

2. From the Reply With submenu, select a stationery file. 

The stationery file is opened as a message and is addressed as appropriate. 

You may also reply to message with stationery in the following ways:

With the desired message open or selected in a mailbox window:

• Open the Stationery window, right-click a stationery item, and from the drop-down 

list, choose Reply With.

With the desired message open or selected in a mailbox window:

• Open the Personalities window, right-click a personality, and choose Reply As from 

the Message submenu of the drop-down list. The default stationery assigned to that 

personality is used in the reply.

With the Personalities window open: 

• Drag an open message by clicking  or drag selected message summaries in a 

mailbox window, onto a personality in the Personalities window. A reply is initiated 

from that personality, and the stationery stored with that personality is used in the 

reply.
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Set up a filter that uses the Reply with filter action. For more information, see Filtering 

Messages on page 161 and Filter Actions on page 170. 
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Using Alternate Email Accounts

You can set up alternate “personalities” in Eudora for each email account you have. For 

example, if you have work, home, and school email accounts, you can set up Eudora to send 

and receive email from each of these accounts, all without having to quit and restart Eudora. 

That is, you can check mail for all your accounts at once or for selected accounts at once, and 

you can do the same for sending mail.

To set up a personality, you use the Personalities window, New Account Wizard, and the 

Account Settings dialog box as described in this section. Your “dominant” personality, or 

principal email account, is set up when you install Eudora and can also be modified via the 

Account Settings dialog box.

Personalities Window

You use the Personalities window to manage, access, and apply your e-mail accounts — 

“personalities” — when you use more than one account.

To open the Personalities window

• From the Tools menu, choose Personalities. Or, if the Personalities window is in a 

visible tabbed window, click its tab.

Sample Personalities window
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The Personalities window displays two columns of data:

• Persona—The identifying name assigned to the personality. <Dominant> indicates 

your principal email account, which is the account Eudora uses whenever you don’t 

specify otherwise and is the account associated with all mail stored before you 

began using alternate personalities.

• Account—The incoming mail account assigned to the personality. This is generally 

in the form loginname@incomingmailserver. See Account Settings Dialog on 

page 125. 

To resize the column widths, position the pointer over the divider line between the column 

headings, until a splitter cursor appears. Then just drag the divider to left or right. Note that it 

is possible to completely collapse the Persona column.

NOTE: You cannot manually sort the information in the Personalities window. Clicking on a 

column heading does sort the column.

If you select one or more personalities in the Persona column and right-click the selection, a 

drop-down context menu appears with the following commands.

TIP: You can select multiple items in the Persona column to perform some of the operations 

listed below. Hold down the Shift key to select a consecutive range of items, and hold down 

the Ctrl key to make non-consecutive selections.

• Check Mail—Check mail now for all selected personalities.

• Send Queued Messages—Send messages queued by all selected personalities 

now.

• Message—This submenu lets you perform message-creation functions using only 

one selected personality. The submenu is unavailable if multiple personalities are 

selected in the Persona column.

– New Message As—Create a new message as the selected personality. As a 

shortcut for this command, double-click a personality in the Persona column, or 

select the personality and press Enter.

– Reply As—Reply as the selected personality to the sender(s) of the one or more 

received messages that are currently selected.

– Reply to All As—Reply as the selected personality to the sender(s) and all 

recipients of the one or more received messages that are currently selected.
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– Forward As—Forward as the selected personality the one or more received 

messages that are currently selected.

– Redirect As—Redirect as the selected personality the one or more received 

messages that are currently selected.

– Send Again As—Resend as the selected personality the one or more received 

or composition messages that are currently selected.

• New—Create a new personality. See Adding a New Personality on page 117 for 

more information. When you select this command, Eudora walks you through the 

New Account Wizard, that is the name, return address, login name, and incoming 

email server. Change these settings as desired, and when you are complete, the 

new account is created. Once created, the personality will be checking mail. 

• Properties—Modify the properties of the selected personality. You can modify only 

one personality at a time. When you select this command, the Account Settings 

dialog box displays, with its fields filled in with the information associated with that 

personality. See the description of this dialog box later in this chapter.

• Delete—Delete all selected personalities. Note, however, that you cannot delete the 

<Dominant> personality. You are prompted to confirm the deletion for each 

personality you have selected to delete. Note that these deletions are permanent 

and cannot be undone! When you delete a personality, any messages associated 

with that personality are reassigned to your Dominant personality. You can use the 

Delete key as a shortcut for this command (you will still get the confirmation 

requests).

You can also display the drop-down context menu and create a new personality by right-

clicking in a blank area of the Personalities window, off all personality items, when none of the 

items are selected. When creating a new personality this way, you are walked through the New 

Account Wizard as in the description of the “New” command above.

If you drag one or more received messages to a personality item in the Personalities window, 

Eudora will “Reply As” that personality to the messages (hold down the Shift key to Reply to 

All As).

Adding a New Personality

Following are the basic procedures for setting up alternate accounts, followed by additional 

information on using personalities to send and receive mail. There are three types of new 

personalities you can add.
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• Brand-new personality—see “Creating a New Personality” below. 

• Personality migrated from Netscape Messenger™, Microsoft® Outlook Express™, 

or Outlook 98™—see “Migrating to Create a New Alternate Account” on  Importing 

Settings to Create a Personality on page 123. 

Creating a New Personality

To create a new personality (alternate email account)

1. From the Tools menu, choose Personalities, or click the Personalities window’s 

tab if it is a deselected window in a tabbed group. The Personalities window 

appears.

2. Right-click anywhere inside the Personalities window to display the drop-down 

context menu.

3. From the context menu, choose New. 

The first New Account Wizard window, Account Settings, appears.

New Account Wizard Account Settings window

4. Select Create a brand new email account and click Next. 

The next New Account Wizard window, Personality Name, appears.



119

Using Multiple Personalities (Sponsored and Paid modes only)

 New Account Wizard Personality Name window

5. In the Personality Name text box, enter the name to identify this Personality only, 

for example “Business.” Click Next. 

The next New Account Wizard window, Personal Information, appears. 

New Account Wizard Personal Information window 
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6. In the Your Name text box, enter your name. Click Next. 

The next New Account Wizard window, E-mail Address, appears. 

New Account Wizard E-mail Address window

7. In the E-mail Address text box, enter your full email address and click Next. 

The next New Account Wizard window, Login Name, appears. This is your return 

address.
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New Account Wizard Login Name window

8. In the Login Name text box, enter your login name. This is the account name you 

use to gain access to your email from your Internet Service Provider (ISP). Click 

Next. 

The next New Account Wizard window, Incoming Email Server, appears.

New Account Wizard Incoming Email Server window
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9. In the Incoming Server text box, enter the name of your incoming server. Your ISP 

or system administrator should provide you with the name of this server for this 

account. 

10. At the bottom of this window, select the type of incoming server you will be using, 

POP or IMAP. Click Next. 

The next New Account Wizard window, Outgoing Email Server, appears.

New Account Wizard Outgoing Email Server window

11. In the Outgoing Server text box, enter the name of your outgoing server. If you do 

not want authentication when sending mail, uncheck the Allow authentication 

box. See Using SMTP Authentication on page 72. This server is sometimes the 

same as your Incoming server name. Click Next. 

The Success window appears.

12. Click Finish. 

You have successfully entered your new personality. 

Your new personality will be checking mail whenever you retrieve mail. 

To change any of your personalities settings, go the Account Settings Dialog on page 125. 
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Importing Settings to Create a Personality

To set up a newly migrated account from Netscape Messenger 4.x and later, 
Microsoft Outlook Express 5.0, Outlook 98, and Outlook 2000 as an alternate or 
multiple personality account using the New Account Wizard

1. From the Tools menu, choose Personalities, or if the Personalities window is in a 

visible tabbed window, click its tab.

2. In the Personalities window, right-click to display the drop-down context menu. 

Choose New. 

The New Account Wizard window, Account Settings, appears.

New Account Wizard Account Settings window

Several dialog boxes appear for you to choose Netscape or Microsoft’s email applications for 

you to import from. For more information and procedures, see Importing from Other Email 

Programs on page 20. 
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Adding a Personality via the Account Settings Dialog

You can add a new personality without going through the New Account Wizard series of 

windows, but via the Account Settings dialog box. Instead of entering information per window, 

you enter all the information on two tabbed panels in one dialog box, the Account Settings 

dialog box. 

To add a personality via the Accounts Settings dialog box

1. From the Tools menu, choose Personalities, or if the Personalities window is in a 

visible tabbed window, click its tab.

2. In the Personalities window, right-click to display the drop-down context menu. 

Choose New. 

The New Account Wizard window, Account Settings, appears.

New Account Wizard Account Settings window

3. Select Skip directly to advanced account setup. 

The Account Settings dialog box window appears, and you begin to enter 

information into the fields. 

To continue, see the next section “Account Settings Dialog.” 
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Account Settings Dialog

This tabbed dialog box appears when you select “Skip directly to advanced account setup” 

from the New Account Wizard Account Settings window, or when you right-click on a 

personality in the Personalities window and choose Properties from the drop-down context 

menu. When you display the dialog box, enter the information in the fields. If you are modifying 

an existing personality, the fields are filled in with the information associated with the 

personality you have selected.

After you make your changes in the dialog box, click OK to save them, Cancel to discard them, 

or Help for more help.

NOTE: Any changes you make to your dominant personality in this dialog box are also 

changed where they are mirrored in relevant options of the Options dialog box. The same is 

true in reverse; changes you make in the Options dialog box are carried over here, when you 

next open this dialog box.

Generic Properties

This dialog box window contains the general characteristics associated with this personality.

Sample Account Settings (Generic Properties panel)

Following are option descriptions for the Generic Properties panel.
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Personality Name—Enter a descriptive name to describe the personality (for example, 

Business or My PC Account). <Dominant> indicates your dominant personality.

Your dominant personality is your principal email account. All of your initial email settings are 

for your dominant personality. If you do not specify a personality, your dominant personality is 

used.

Note that the name shown here may be different from the Real Name associated with the 

personality (see below).

Real Name—Enter the real name of this personality—generally a first and last name. The text 

you enter here is included in the From: field of all your outgoing messages from this personality 

and identifies the source to your recipients. It appears before your return address in the 

message header.

Email Address—Enter the email address used in outgoing messages and recipients’ replies 

for this personality, if this address is different from the personality’s incoming mail account. The 

address you enter here is included in the From: field of all your outgoing messages from this 

personality, and when a recipient replies to a message from this personality, the reply is sent 

to this address. If you do not enter an address in this field, Eudora uses the personality’s 

incoming mail account as the email address. Incoming mail accounts are usually of the form 

username@incomingmailserver. For example, suppose your incoming mail account is 

jcamp@pop.myfirm.com but your email address is slightly different jcamp@myfirm.com. 

You would then enter jcamp@myfirm.com in this field.

If you do enter an address in this field, first test the address to be sure that mail sent to it is 

indeed delivered to you. If you use an invalid email address, no one will be able to reply to mail 

sent from this personality.

User Name—Enter the name you use to login to this email account. For example, in the 

incoming mail account jcamp@pop.myfirm.com, the login name is jcamp. The part after the 

at-sign “@” is the name of the incoming mail server. See Incoming Mail on page 298. 

SMTP Server—Enter the name of the outgoing-mail server for this personality. SMTP stands 

for Simple Mail Transfer Protocol. Outgoing messages you send are routed through this 

server. If the computer selected by this personality’s incoming mail account also runs on an 

SMTP server, you can leave this field blank. See Sending Mail on page 302. 
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Allow Authentication—Eudora can log in to an SMTP server when sending mail, just like it 

does for receiving mail. Not all SMTP servers require or allow such authentication. Eudora will 

attempt authentication to servers that allow it. The preferred SMTP authentication method is 

CRAM-MD5. If CRAM-MD5 is not available, LOGIN or PLAIN will automatically be used. See 

Using SMTP Authentication on page 72.

Default Domain—Enter the domain name that Eudora automatically adds to an unqualified 

name addressed in messages sent from this personality. An unqualified name is a name that 

doesn’t have an “@” sign followed by a domain name. This can be used to save time when 

addressing large numbers of messages to users in the same domain. Also, different 

personalities can be used to send messages to different domains. For example, you can use 

one personality to send work-related messages to the domain myfirm.com, and another 

personality to send personal messages to the domain in your home email address or to your 

school account (for example, myschool.edu).

Default Stationery—Select the stationery to use for all outgoing messages sent from this 

personality from the drop-down list, or select <No Default> for no default stationery. For more 

details about using stationery with alternate personalities, see Linking a Signature and 

Stationery to a Personality on page 134 and Sending Mail on page 302. 

Default Signature—Select the signature to use for all outgoing messages sent from this 

personality from the drop-down list. If you select a signature, Eudora automatically attaches 

that signature to the end of all outgoing messages sent from this personality. You can always 

change the signature in a particular outgoing message using the Signature drop-down list in 

the composition window. For more details about using signatures with alternate personalities, 

see Using a Signature on page 105 and Sending Mail on page 302. 

NOTE: If the stationery you chose has a signature attached to it, that signature will override 

the signature you select here.

Secure Sockets when Sending—See the next section, Using SSL for Your Personalities on 

page 131.

Check Mail—If this is selected, mail checking is activated for this personality in the following 

ways:

• If you have specified a number in the “Check for mail every _ minutes” option in the 

Checking Mail options window, then when automatic mail-checks are performed at 

these intervals, mail for this personality is checked as well.
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• Each time you do a manual check for mail by choosing the Check Mail command 

from the File menu or via another method, mail is checked for this personality as well. 

When you create a personality, this option is checked by default. 

If the Check Mail option is turned off, mail for this personality is not checked during manual or 

automatic mail checks unless you override the setting. To override and check the mail for the 

personality, choose Check Mail from the drop-down context menu (right-click) in the 

Personalities window.

Incoming Mail

This panel contains settings that identify and configure the incoming mail server to be used in 

receiving mail for this account.

When Configuration = POP:

Sample Account Settings (Incoming Mail panel, POP configuration)

Following are option descriptions for the Incoming Mail panel (POP configuration).

Server—This is the name of the incoming-mail server for this personality. All incoming 

messages to this personality are routed through this server.
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Configuration—This indicates which email protocol the incoming mail server uses: POP 

(Post Office Protocol) or IMAP (Internet Message Access Protocol). Ask your email 

administrator which one to use, if you are not sure.

The settings in the rest of this panel depend on whether you’ve chosen POP or IMAP in this 

field. Settings for both configurations are described below.

Leave mail on server—If selected, then during mail checks, incoming mail for this personality 

is left on the incoming mail server and a copy is transferred to your PC. If this turned off, then 

when mail is checked, incoming mail for this personality is deleted from the incoming mail 

server after it is transferred to your PC. For more details, see Managing Your Mail on the POP 

Server on page 86. 

Delete from server after _ days—This option has a check box for turning on or off and an 

edit box for specifying the number of days mail that was left on the POP server should be 

saved before being deleted. It is a good idea not to leave copies of your messages on the POP 

server indefinitely, as this will create mail storage problems on the server.

Delete from server when emptied from Trash—If selected, any messages that are deleted 

from your Trash mailbox are also deleted from the POP server. Messages are retained in your 

Trash mailbox until deleted. For details, see Managing Your Mail on the POP Server on 

page 86. 

Skip messages over _ K in size—If selected, messages over the specified size are 

downloaded only in part. These messages include the first few lines, and a statement that says 

the message is not complete. This can be useful on slow connections. For details, see 

Managing Your Mail on the POP Server on page 86. 

Authentication style—This specifies which POP account authentication technology to use 

for this personality: Passwords, Kerberos, APOP, or RPA. Ask your email administrator which 

one to use. If you use Eudora at home, most likely your Authentication Style is Password. 

CompuServe users should use the RPA authentication method.
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When Configuration = IMAP:

 Sample Account Settings (Incoming Mail panel, IMAP configuration)

Following are option descriptions for the Incoming Mail dialog box (IMAP configuration).

IMAP Mailbox Location Prefix—This specifies the mailbox location prefix that IMAP will use 

when locating your mailboxes on the incoming mail server. An example prefix is /usr/mail. 

Ask your email administrator what to enter here, if you are not sure.

For new mail, download—These two settings let you control the way incoming mail is 

downloaded from the IMAP server. One setting will always be marked.

Minimal Headers Only—If selected, only a limited set of message headers is 

downloaded for each incoming message. The message’s status, From: field, 

date/time, server status, and subject are initially retrieved. Typically, you will see 

an open diamond for the server status, which indicates a partial retrieval. Opening 

or previewing the message retrieves the message body. If you have a non-text 

attachment, then opening it will retrieve the attachments. 

Full message except attachments over _ K—If this setting is selected and a 

number is entered in the edit box, any attachments larger than the specified size 

will not be downloaded with the message. If the setting is zero (default), all 

attachments are downloaded, regardless of size.
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When I delete a message—These options (you must choose one) let you control the way you 

want your deleted messages handled.

Mark it as deleted—Select this option to mark your messages on the IMAP for 

deletion. These messages are not removed from the server until you choose to 

remove them. See Deleting a Message from the Server on page 88. 

Move it to (mailbox)—Select this option to move your deleted messages to a 

specific mailbox. The default is your Trash mailbox.   

Automatically purge deleted messages—Deleting an IMAP message marks it for deletion 

on the server, but it is not removed from the mailbox until the mailbox is purged.

Never—Select this option to leave messages marked for deletion until you 

manually select to purge the mailbox.

Always—Select this option to automatically purge the mailbox of deleted 

messages when you mark a message for deletion. No deleted messages will be 

kept in the mailbox.

When __% of messages are deleted—Select this option to trigger purging of 

deleted messages when the percentage of deleted messages in your mailbox 

exceeds the number entered into this setting. For example, if you entered 20, your 

mailbox would be automatically purged when more than 20% of the messages 

were marked for deletion.

Authentication style—This specifies which IMAP account authentication technology to use 

for this personality: Passwords, Kerberos, or CRAM-MD5. Ask your email administrator which 

one to use. The default is CRAM-MD5. If CRAM-MD5 is not being used, then it will use 

passwords. 

Secure Sockets when Sending (or Receiving)—See the next section.

 Using SSL for Your Personalities

For information about Secure Sockets Layers (SSL), refer to About security (Sponsored and 

Paid modes only) on page 28.

To access SSL settings for a personality

1. From the Tools menu, choose Personalities. 
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The Personalities window appears. 

2. For an existing personality, highlight the personality and choose Properties from 

the context menu. 

For a new personality, right-click anywhere in the Personalities window to display 

the context menu. Choose New and then choose Skip directly to advanced 
account setup. 

The Account Settings dialog appears.

3. For SSL when sending mail, choose the Generic Properties tab.

4. For SSL when receiving mail, choose Incoming Mail tab. 

5. In the Secure Sockets when Sending (or Receiving) field, click the down arrow to 

display the drop-down menu. 

 

 
Following is a description of each option on the SSL drop-down menu:

Never— Do not use SSL for server authentication and mail transfer security, even if SSL is 

available on the server. 

If Available STARTTLS (default)— Use SSL for server authentication and mail transfer 

security by having Eudora automatically invoke the STARTTLS command method to start 

SSL, that is, if the server supports STARTTLS. If your server doesn’t support STARTTLS, mail 

transfers will occur successfully, but they will not be secured with SSL.

Required, Alternate Port— Use SSL for server authentication and mail transfer security by 

having Eudora automatically use the older style alternate port method for starting SSL. If your 

server does not support SSL on the appropriate ports, mail transfers will fail. 

Secure Sockets
drop-down menu
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Required STARTTLS— Use SSL for server authentication and mail transfer security by 

having Eudora automatically invoke the STARTTLS command method to start SSL. If your 

server does not support STARTTLS, mail transfers will fail. 

NOTE: If you use SSL and cannot make a connection when receiving or sending mail, you 

may need to check with your ISP to update any invalid SSL certificates. However, to override 

any issues with SSL when retrieving or sending mail, choose Never from the drop-down menu 

to make a successful connection.

To display the most current information for an SSL connection between a server 
and Eudora since the last time you started Eudora 

1. Click Last SSL info. 

The Eudora SSL Connection Information Manager window appears with SLL and 

certificate information. 

WARNING: If you display the SSL information windows, make certain you don’t 

change any of the field information unless you are familiar with SSL.

Modifying a Personality

To modify an existing personality

1. From the Tools menu, choose Personalities, or if the Personalities window is in a 

visible tabbed window, click its tab.

2. Open the Personalities window and right-click the desired personality to display the 

drop-down context menu.

3. From the context menu, choose Properties. 

The Account Settings dialog box appears. 

4. Make your changes in the Account Settings dialog box. 

See Account Settings Dialog on page 125. 

All options other than those specified in the New Account Wizard or the Account Settings 

dialog box cannot be changed for alternate personalities; they are effective for all. If you want 

to change other options for a personality or use a separate set of mailboxes for an account, 

see the section Mail Transport on page 410. 
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Deleting a Personality

You may delete any account except your dominant personality. 

To delete a personality

1. From the Tools menu, choose Personalities, or if the Personalities window is in a 

visible tabbed window, click its tab.

2. Open the Personalities window and select the personality you want to delete.

3. Press the Delete key. 

A warning appears asking you if you’re sure you want to delete this personality. 

4. Click OK.

The selected personality is deleted. 

Linking a Signature and Stationery to a Personality

In Eudora, you can link a signature and a stationery to an existing personality via the Account 

Settings dialog box. For example, if you have a “Business” personality, you can link your 

“Business” signature and “Business” stationery to this personality. For creating signatures and 

stationery, refer to Adding a New Signature on page 106 and Creating New Stationery on 

page 111.

NOTE: Before you can link a signature and stationery to a personality, you need to create them 

first. 

To link a signature and stationery to a personality

1. From the Tools menu, choose Personalities or if the Personalities window is in a 

visible tabbed window, click its tab.

2. Select the personality and right-click to display the drop-down context menu.

3. From the context menu, choose Properties. 

The Accounts Settings’ Generic Properties panel for this selected personality 

appears.
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Account Settings Generic Properties panel

4. In the Default Stationery drop-down list, select the stationery for this personality.

5. In the Default Signature drop-down list, select the signature for this personality. 

Note that if the stationery you just selected has a signature linked to it, this 

signature overrides any signature you select here.

6. Click OK. 

This personality is now linked with the stationery and signature you chose from the 

drop-down lists.

Selecting a Personality in a Message Header 

You can select the account you want to use directly in the header of your outgoing email 

message. Just click the arrow to the left of the From: field, and a drop-down list appears 

showing your different personalities. Select the personality you want to use for this message. 

The current personality will have a dot next to the personality’s name. Also, to display the 

personalities drop-down list, press Alt + R. 

See the following example.
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Personality drop-down list in a message header

Using a Personality in a Message

The easiest way to create an outgoing message from a specific personality is to choose the 

one you want from the From: field’s drop-down list. See the previous section “Selecting a 

Personality in a Message Header. However, there are several other ways to do it. 

To use a personality in a message (alternate method) 

1. From the Tools menu, choose Personalities or select the Personalities window 

tab if grouped in a displayed tabbed window.

2. In the Personalities window, right-click the desired personality to display the drop-

down context menu.

3. From the context menu, choose Message.

4. From the Message submenu, choose New Message As. Or, select the desired 

personality and press Enter. Or, simply double-click the desired personality. 

A new message opens from that personality.

When the composition window opens in response to any of the three message-creation 

methods as previously described, the default signature for the selected personality is used. 

But if a stationery file was selected or a default stationery file is specified in the account’s 

options, then the signature stored with the stationery file is used. However, you can always 

change the signature drop-down list in the composition window. For details, see Using a 

Signature on page 105. 

Once you open a new composition message from a particular personality, you can change 

your message’s personality.
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To change your message’s personality 

1. In an open message, click the From: header or right-click to display the drop-down 

context menu. 

2. In the From: field of the message header, choose the personality. Or from the 

context menu, choose Change Personality. From its submenu, select a new 

personality. 

The From: field of the message header changes to the information associated with 

the new personality for that message.

NOTE: If you are composing a message and decide to change the personality, the signature 

and stationery assigned to that personality in the Account Settings dialog box change as well.

When Eudora changes a personality as it responds to a message, it assigns the same 

personality under which it received the message. For example, if you receive a message sent 

to your Home account, your replies to that message are sent from your Home account.

There are two ways to change the personality of a response. The first is to initiate the response 

and then change the personality, using the drop-down context menu’s Change Personality 

submenu.

The second way is to change the personality associated with the original message to which 

you are responding. Open that message and change its personality using the Change 

Personality submenu. From then on, all of your replies to that message will be sent from the 

newly assigned personality. The message does not have to be open. Just right-click on a 

message or set of messages in a mailbox’s TOC. Select Change Personality and select the 

desired personality.

NOTE: You can also set up a filter to automatically assign a desired personality to incoming or 

outgoing messages that satisfy the filter criteria. See the Make Personality action under Filter 

Actions on page 170. 



138

Using Multiple Personalities (Sponsored and Paid modes only)



139

Working with Mailboxes

Opening a Mailbox

To open a mailbox, select it from the Mailbox menu, or double-click it in the Mailboxes window.

NOTE: The unread message icon appears in the Mailbox menu whenever a mailbox or folder 

contains unread messages that are less than five days old. Also any mailboxes or folders in 

the Mailboxes window that contain unread messages are displayed as bold.

Understanding the Components of a Mailbox

Mailbox windows contain all of your incoming and outgoing message summaries. If the “Show 

message preview pane” option is selected in the Viewing Mail options window, mailbox 

windows also show the message preview pane, the bottom half of the window in the figure 

below. See Viewing Mail on page 317.

To open a mailbox

• From the Mailbox menu, choose the mailbox you want to open, or double-click 
its icon or name in the Mailboxes window.

 Mailbox window
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Message Summaries

Each line in the list portion of a mailbox window represents a message and is called a message 

summary. Outgoing messages that are in any mailbox other than Out are shown with italicized 

message summaries.

To select one or more message summaries, use one of the following options: 

• To select one summary, click it.

• To select a consecutive range of summaries, select a summary, hold down the Shift 

key, and select another summary. Or, drag the mouse over the summaries to select 

them—as long as you begin on an unselected summary.

• To select all of the summaries that have the same information in a particular column, 

hold down the Alt key and click one column in the summary. For example, if you click 

the Status column for one summary, all of the summaries with that status are 

selected.

• To make non-consecutive selections, hold down the Ctrl key and select summaries.

• To find messages by name or subject, type the first few letters of a name or subject, 

and Eudora selects the message.

Each message summary is divided into columns. The column names are shown below with 

the corresponding icons that appear in the column headings.

Status

Junk score

Priority

Attachments

Label

Sender/Recipient (Who) 
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You can show or hide these columns using the Mailboxes options window. See Mailboxes on 

page 320.

A message’s Status, Priority, Label, Personality, and Server Status can be changed directly in 

the mailbox window. To do this, select the messages you want to change and click the right 

mouse button inside the selection. Select an option from the drop-down list to make your 

change.

To select the display of lines in the message summaries portion of mailbox windows—

horizontal lines to separate summaries and vertical lines to separate columns—select the 

Show mailbox lines option in the Mailboxes options window.

Status Column

This column displays the message status, which is one of the following:

Date 

Size 

Server Status

MoodWatch

Subject

Message has not been read (all mailboxes except Out), or is queueable or sendable 
but has not been queued or sent (Out mailbox only).

<blank> Message has been read (all mailboxes except Out), or is not yet able to be queued or 
sent because it has no recipients in the To or Bcc: fields (Out mailbox only).

Message has been replied to.
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You can change the status of one or more selected messages, or an open message, from 

Read (blank) to Unread ( ) or from Unread to Read by pressing Shift+Space (all mailboxes 

except Out).

Priority Column

This column displays the message priority. You can use the drop-down list to set a particular 

priority.

Message has been forwarded.

Message has been redirected.

Message has been sent (outgoing messages only).

Message is queued to be sent (outgoing messages only).

 
Message is saved and not sent.

Message is queued to be sent at a specified time (outgoing messages only).

Message was transferred from the Out mailbox before being sent.

Message is being processed for sending.

Message cannot be sent because of an error. Usually the error is in the recipient’s email 
address. 

Highest priority

High priority
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For more information on message priorities, see Setting the Message Priority on page 42.

Attachments Column

If a message has attached documents, this column displays the attachment icon, a paper clip 

holding a sheet of paper. 

Label Column

This column displays the message label. You can assign labels to messages, either manually 

or automatically using filters. See the section Filtering Messages on page 161 When a 

message summary is assigned a label, the entire summary changes color to match the label 

color.

To assign a label to an existing message

1. Select the message in the TOC you want to label.

2. Right-click to display the drop-down list.

3. From the drop-down list, choose Change Label. Or from the Message menu, 

choose Change then Label. 

The Label submenu appears.

4. Choose the label you want for this message.

NOTE: Label colors and titles are assigned using the Labels options. See Labels on page 331

Sender/Recipient Column (Who)

This column shows the sender of the message (for incoming messages) or the intended 

recipients (for outgoing messages).

<blank> Normal priority

Low priority

Lowest priority
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Date Column

This column displays the date and time the message was composed, or, for timed messages, 

the date and time the message is scheduled to be sent. Date formats, including age-sensitive 

indications such as the day of the week or “Today,” are set in the Date Display options window. 

See Date Display on page 328.

Size Column

This column displays the size of the message in kilobytes, K (1 K = 1,024 bytes). Also, an 

indicator in the Size column indicates if the body of the message is empty.

Server Status Column (POP)

This column displays the action that is done to the corresponding incoming message on the 

server. The next time you check mail, the server status you requested is automatically 

completed.

NOTE: To control the mail transfer for a POP server, you can also use the Mail Transfer 

options window. For details, see Checking for Mail with Special Server Instructions on page 89 

and Checking Mail on page 295.

Fetched

Not 
fetched

Don’t change the message on the server. A solid diamond indicates that the 
message has been fetched; an open diamond indicates that the message has 
not yet been fetched.

Fetch Retrieve the whole message from the server.

Delete Delete the message from the server.

Fetch then
Delete

Retrieve the whole message, then delete it from the server.
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Server Status Column (IMAP)

This column displays the action that is done to the corresponding incoming message on the 

server. The next time you check mail, the server status you requested is automatically 

completed.

MoodWatch Column

MoodWatch scans each word and phrase in each message in the mailbox for offensive 

language. The level of offensiveness is indicated by the appearance of one, two, or three red 

chili peppers, with three red chilies being the most offensive and one the least. 

Less offensive text in the message is underlined with a green squiggly line. More offensive text 

in the message is underlined with both a green and red squiggly line.

Fetched The message has been fetched.

Headers
Only

Retrieve message headers from the IMAP server, but body and attachments 
have not been fetched.

Delete Delete the message from the server.

Fetched 
Body, but 
no Attach-
ments

Retrieve the whole message, including attachments.

There is no offensive language in the message.

There may be a slight bit of offensive language in the message.

There may be offensive language in the message.

There is offensive language in the message.
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Subject Column

This column displays the subject of the message. The sender originally typed this information 

into the message header, but you can modify it. See on Editing Incoming Messages on 

page 84.

Displaying and Resizing Columns

To indicate which columns you want displayed in your mailboxes

1. From the Tools menu, choose Options.

2. Scroll through the category list, and select Mailboxes. 

The Mailboxes options window appears.

3. In the Show Mailbox Columns list, select the column boxes you want to display. If 

you don’t want to display a column, just deselect the box. See Mailboxes on 

page 320.

To resize a column in a mailbox window, move the mouse pointer until it is over the column 

heading divider to the right of the column you want to resize, then drag the divider to the 

position you want. The column divider moves to the new location, and the mailbox is redrawn.

You can shrink a column only as far as its left divider. If you do that, a double divider line 

appears in place of the column, and its contents are hidden. To redisplay the column, drag the 

right divider line to the right.

Using the Mailbox Size Display

In the lower left corner of the message summary part of each mailbox window, three numbers 

show the size information for that mailbox. The first is the number of messages in the mailbox; 

the second is the total amount of space those messages require; the third is the amount of disk 

space that is wasted with the mailbox.

Mailbox size display

Wasted space is created when messages are deleted or transferred from a mailbox.

TIP: Check Show count of selected messages in Size box under the Mailboxes options to 

display 4 sets of numbers. The first number will be the selected message count.
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To manually clean up the wasted space in all mailboxes

• Click the mailbox size display (for that mailbox only), or from the Special menu, 
choose Compact Mailboxes for all mailboxes. 

TIP: Try not to keep too many messages in your In, Out, or Trash mailboxes because it slows 

down your system’s performance. If you wish to keep these messages, it’s better to transfer 

them to other mailboxes.

Message Preview Pane

If the “Show message preview pane” option is selected in the Viewing Mail options window, 

then the message preview pane appears in roughly the bottom half of the mailbox window. See 

Viewing Mail on page 317.

The message preview pane shows the key headers and the message body of the currently 

selected message in the message summary list. If the full message body is not visible in the 

preview pane, scroll bars are displayed, allowing you to view the rest of the message. Only 

one message in a mailbox can be previewed at a time.

To move the keyboard focus from the message summary list to the message preview pane 

and back again, press Tab or F6. Or simply click in the preview pane to put the focus there.

When keyboard focus is in the preview pane, you can do any of the following, as you can in 

an open incoming message window.

• Press the spacebar to page down through the message.

• Use the arrow keys, as set in the Miscellaneous options window (unmodified or with 

Ctrl or Alt), to switch to the next or previous message in the mailbox. See 

Miscellaneous on page 356.

• Use standard keyboard shortcuts such as Ctrl+R for Reply, Ctrl+D for Delete, etc. 

See Eudora Shortcuts on page 397.

• Right-click anywhere in the preview pane to display a drop-down list with commands 

appropriate for the previewed message.

• Click an attachment icon or name to open the attachment.

• Click a URL (hot link) to launch the application for that URL.

• Press Ctrl + Shift + F to open the Find dialog box in a highlighted message.



148

Working with Mailboxes

If the “Show message preview pane” option is selected in the Viewing Mail options window, 

you can press F7 to show and hide the preview pane within the current mailbox only. However, 

this does not control the visibility of the preview pane in other mailboxes. Also, you can do this 

by clicking on the separator bar between the message list and the preview pane.

You can change the height of the preview pane relative to the message summary list. Just 

position the mouse pointer over the separator bar between the list and the preview pane and 

drag the bar up or down.

If the “Show message preview pane” option is turned off in the Viewing Mail options window, 

only the message summaries are shown in any mailbox window.

If the preview pane option is selected and the “Mark previewed messages as read after _ 

second(s)” option is selected in the Viewing Mail options window, the current message is 

marked as read (blank in the Status column) after the specified number of seconds. You can 

always change the message’s status back to Unread (•) by pressing Shift+Space while the 

message is selected or open (press again to change back to Read). If the “Mark previewed...” 

option is turned off, previewed messages are never automatically marked as read. For more 

information, see Viewing Mail on page 317.

NOTE: Eudora performs the auto-marking behavior only when you manually select or preview 

messages, not when it performs actions such as automatic mail checks or filtering.

Creating Mailboxes and Folders

Eudora lets you create mailboxes to hold messages, and folders to hold mailboxes. 

There are three ways to create mailboxes and folders.

• Using the New command from the Mailbox menu and folder submenus.

• Using the New command from the drop-down context menu in the Mailboxes 

window. See Using the Mailboxes Window on page 150.

• Using the New command from the Transfer menu. See Transferring Messages on 

page 158.
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NOTE: Depending on whether your incoming mail server uses the POP or IMAP protocol, 

there are some differences in the way mailboxes and mail folders are created, stored, and 

managed. For more information, see Mailbox and Folder Management: POP vs. IMAP on 

page 152. 

Creating a Mailbox or Folder Using the Mailbox Menu

To create a new mailbox or mail folder

1. From the Mailbox menu, choose New, or from a mail folder submenu (to put the 

mailbox in that folder). 

The New Mailbox dialog box appears.

New Mailbox dialog box

2. To create a mailbox, type in the new mailbox name and click OK. The mailbox is 

created and added to the Mailbox and Transfer menus and to the Mailboxes 

window.

3. To create a mail folder, type the name of the new mail folder and select the Make 
it a folder option. Click OK to create the folder. 

The New Mailbox dialog box appears again. 

4. Type the name of a mailbox to create within the new folder, then click OK. The new 

folder and its mailbox are displayed in the Mailbox and Transfer menus and in the 

Mailboxes window.
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Using the Mailboxes Window

The Mailboxes window lets you create new mailboxes and folders, remove and rename them, 

and move mailboxes among folders. Mailboxes or folders that are bolded have unread 

messages.

By default, the Mailboxes window is provided as the first window in a five-window tool group 

docked vertically to the left side of the main Eudora window.

To manage mailboxes and folders from the Mailboxes window

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window’s tab if it 

is part of a visible tabbed window group. 

For more information on how to manipulate the Mailboxes window alone and as 

part of a tabbed window group, see Managing Windows in Eudora on page 197.

Mailboxes window

2. To open a mailbox or folder within the window, double-click it, or click it once and 

press Enter. You can move among the folders and mailboxes using the up and 

down arrow keys, or close or open folders using the left and right arrow keys. 

3. You can start typing the name of the mailbox or folder you want, and it is highlighted 

when you have typed enough unique characters to identify it (the item must be 

displayed, so a mailbox that is in a closed folder cannot be selected).
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4. Right-click any item in the Mailboxes window and a drop-down list appears whose 

commands let you, depending on the item, create, find messages, remove, and 

rename mailboxes and folders, open existing mailboxes and folders, and empty the 

trash from the Trash mailbox.

The folder trees displayed in the Mailboxes window, and some of the operations available from 

the drop-down list, depend on what protocol your mail server uses, POP or IMAP. For more 

information on these differences, see Mailbox and Folder Management: POP vs. IMAP on 

page 152. 

Creating a New Mailbox or Folder

To create a new mailbox or folder in the Mailboxes window

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window’s tab if it 

is part of a visible tabbed window group. 

2. Right-click a folder.

3. From the drop-down list, choose New. 

A dialog box appears requesting the name of the new mailbox or folder.

4. Type in the new name and select the Make it a folder option if you want to make 

it a folder; click OK. If you chose to make it a folder, enter the name of the mailbox 

within the new folder when the dialog box appears again, and click OK. 

The new mailbox or folder appears in the lists and is added to the Mailbox and 

Transfer menus.

Renaming a Mailbox or Folder

To rename a mailbox or folder

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window’s tab if it 

is part of a visible tabbed window group. 

2. Click the name of the mailbox or folder, pause, then click again to highlight the 

name. Or, right-click the item and choose Rename, or click once on the item and 

press F2.

3. Type in the new name. Press Enter to accept your change, or Esc to cancel it.
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Moving a Mailbox from One Folder to Another

To move a mailbox from one folder to another

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window’s tab if it 

is part of a visible tabbed window group. 

2. Click to select the mailbox you want to move.

3. Drag it to where you want it.

Removing a Mailbox or Folder

To remove a mailbox or folder 

WARNING: You cannot undo this deletion.

1. From the Tools menu, choose Mailboxes, or click the Mailboxes window’s tab if it 

is part of a visible tabbed window group. 

2. Right-click it and choose Delete from the drop-down list, or click once on it to 

highlight it and then press the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder in which other 

mailboxes or folders are stored, you are prompted to confirm the deletion for each such item 

selected. Click Remove it to delete the current item for which you are being prompted, or click 

Remove all to remove all items selected for deletion and no further prompts will appear. Or 

click Cancel to cancel the deletion. If you delete a non-empty mailbox or folder, all messages, 

mailboxes, and folders contained within the mailbox or folder are also deleted. 

Mailbox and Folder Management: POP vs. IMAP

The location of your mailboxes and mail folders depends on whether your incoming mail server 

for your account uses the POP or IMAP protocol.

If your incoming mail server uses POP, then all of your mailboxes and mail folders are created 

and stored on your computer. If your incoming mail server uses IMAP, then all of your 

mailboxes and mail folders are created and stored on the IMAP server.

The parallel situation holds true if you have multiple email accounts: mailboxes and folders for 

all of your POP accounts are stored on your computer; mailboxes and folders for all of your 

IMAP accounts are stored on the respective IMAP servers.
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Mail folders stored on an IMAP server can contain not only mailboxes, but also messages. Mail 

folders stored on a POP server can contain only mailboxes, not messages.

You create an IMAP server account using the New Account Setup wizard for your dominant 

personality, or using the Account Settings dialog box accessed from the Personalities window. 

See Getting Started on page 293 and Using Multiple Personalities (Sponsored and Paid 

modes only) on page 115.

The Mailboxes window is the main tool for managing your IMAP mailboxes and mail folders. 

In the Mailboxes window, right-click one of the folders or mailboxes in an IMAP hierarchy and 

select an item from the drop-down list. See Using the Mailboxes Window on page 150 for more 

information.

NOTE: The additional commands for IMAP are Refresh Mailbox List and Resynchronize 

Mailbox.

Some mailboxes stored on your IMAP server may have been created by others and made 

accessible to you. For some of these mailboxes, you may have both “read and write” 

permission; that is, you can read the messages stored in them, can change or delete the 

messages. Other mailboxes may give you only “read” permission; you can only read the 

messages, not change or delete them.

If you have multiple personalities (email accounts) and the incoming mail servers for all of them 

use POP, then you will have only one top-level mail folder, named “Eudora Mail” by default. If 

the incoming mail server for at least one of your personalities uses IMAP, then you can have 

multiple top-level mail folders; one to hold mail from all of your POP account, and one top-level 

folder for each of your IMAP accounts. The name of a top-level IMAP folder is the personality 

name for that IMAP account.

For more information on managing your mail on POP and IMAP servers, see Managing Your 

Mail on the POP Server on page 86 and Managing Your Mail on the IMAP Server on page 91.
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Deleting a Message

As a safeguard against inadvertent deletions, two steps are used to delete a message from 

your computer: first put the message in the Trash, then empty the Trash. If your incoming mail 

server uses IMAP, the procedure is slightly different, as described later.

POP Procedure

To put a message in the Trash

1. Click to select the message.

2. From the Message menu, choose Delete, or from the Transfer menu, choose 

Trash. Also, you can just press the Delete key or click the Delete toolbar button.

The message is transferred to the Trash mailbox.

NOTE: To cancel a deletion to the Trash, from the Edit menu, choose Undo.

To delete the messages in the Trash mailbox (that is, remove them permanently 
from your computer)

• From the Special menu, choose Empty Trash. Or, if the Mailboxes window is open 

on your desktop, right-click on the Trash mailbox in the window and choose Empty 
Trash from the drop-down menu.

You can set up Eudora to warn you if you try to delete unread, queued, or unsent messages. 

To do this, use the Extra Warnings options windows to select those options. See Extra 

Warnings on page 341. 

Quitting Eudora empties the contents of the Trash mailbox when the Empty Trash when exiting 

option in the Miscellaneous options is selected. See Miscellaneous on page 356. 
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If you want to delete just a few messages from the Trash mailbox, open the Trash 
mailbox, and do the following

1. Click to select the desired messages.

2. From the Message menu, choose Delete, or press the Delete key. Deleting a 

message from the Trash removes it completely.

IMAP Procedure

Deleting a message on an IMAP account requires two steps: first mark it for deletion, then 

purge the deleted message from the server.

To mark for deletion a message stored in an IMAP mailbox or folder

1. Click to select the message.

2. From the Message menu, choose Delete. 

The message disappears from your mailbox.

To view messages that have been marked for deletion in an IMAP mailbox or 
folder

1. From the Tools menu, select Mailboxes

The Mailboxes window opens. (Appears docked on the left side of the Eudora 

window by default).

2. In the Mailboxes window, right click on the IMAP mailbox.

A context menu appears.

3. Place a check mark next to Show Deleted Messages

Messages that are marked for deletion have a red X in the server status column.

To unmark the message for deletion 

1. Follow the steps above to show deleted IMAP messages.

2. Click to select the message. 

3. From the Message menu, choose UnDelete, or right click on the message and 

select Undelete message. 
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To remove all messages marked for deletion in the current IMAP mailbox, choose Purge 
Messages. The messages are completely removed not only from your PC but also from the 

IMAP server.

TIP: Once you remove marked messages using the “Purge Messages” command, these 

messages are gone and cannot be restored; so use this command with caution.

Automatically Purging IMAP deleted messages

Eudora can be configured to automatically purge deleted IMAP messages. 

To configure Eudora to automatically purge deleted IMAP messages

1. From the Tools menu, select Personalities.

The Personalities window appears.

2. Right click on your IMAP personality.

A context menu appears

3. Select Properties.

The Account Settings Dialog appears.

4. Click to select the Incoming Mail tab.

5. Select one of the three options under Automatically Purge deleted messages:

Never—Select this option to leave messages marked for deletion until you 

manually select to purge the mailbox.

Always—Select this option to automatically purge the mailbox of deleted 

messages when you mark a message for deletion. No deleted messages will be 

kept in the mailbox.

When __% of messages are deleted—Select this option to trigger purging of 

deleted messages when the percentage of deleted messages in your mailbox 

exceeds the number entered into this setting. For example, if you entered 20, your 

mailbox would be automatically purged when more than 20% of the messages 

were marked for deletion. 
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Automatically Deleting Attachments

When you delete messages, you can have their attachments automatically deleted. To do this, 

select the “Delete attachments when emptying Trash” in the Attachments options windows. To 

do this, be sure the attachments are still in the Attach Directory or the directory you have 

specified for attachments. If you have this option selected, and want to delete a message but 

save its attachment, move the attachment into another directory before deleting the message. 

See Attachments on page 311. 

Transferring Messages

You can transfer messages to any of your mailboxes. There are several ways to do this.

• Click to select the message(s) you want to transfer, then choose a mailbox from the 

Transfer menu.

• Click to select the message(s) you want to transfer, then right-click on the selection 

and choose a mailbox from the Transfer drop-down menu.

• Drag a message summary to an open mailbox window or to a mailbox icon in the 

Mailboxes window.

To put a copy of a message in another mailbox instead of transferring the message, hold down 

the Shift key and use one of the transfer options above. This is useful if you want to file a 

message in more than one mailbox.

If you try to transfer a message to the Out mailbox, an alert appears informing you that some 

header information may be removed from the message during transfer. Click Yes to transfer 

the message. 

TIP: Don’t forget to clean out your Out mailbox once in awhile to increase your system 

performance.

NOTE: You can undo mailbox transfers using the “Undo” command from the Edit menu.
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Using the Transfer Menu

The Transfer menu is one way to transfer messages among your mailboxes. With a current 

message open, or message summaries selected, choose a mailbox from the Transfer menu. 

The messages are transferred from their previous mailbox to the mailbox you selected.

Dragging Messages

You can drag messages from one mailbox to another using the message summaries or by 

clicking  in an open message window.

To drag a message summary to another mailbox

1. Click to select the message summary or summaries.

2. Drag the summary into any open or minimized mailbox window, or any mailbox in 

the Mailboxes window. 

When you release the mouse button, the message is transferred.

To drag an open message to another mailbox, click  and drag the message into any open 

mailbox or any mailbox in the Mailboxes window. When you release the mouse button, the 

message is transferred.

When dragging to the Mailboxes window, pause over a closed folder. The folder temporarily 

opens making its mailboxes visible so that you can complete the drop operation. The folder 

closes again when you complete or cancel the drop.

NOTE: You can only drag messages around if the “Allow drag and drop transfers” option is 

selected in the Mailboxes options window. See Mailboxes on page 320. 

Creating a Mailbox or Folder During Transfer

To create a mailbox and transfer the current message into it at the same time

• From the Transfer menu, choose New instead of the name of a mailbox. 

The New Mailbox dialog box appears.

You can create a new mailbox or mail folder. For details, see Creating Mailboxes and Folders 

on page 148. When you are done, the current message is transferred into the new mailbox.
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To create the new mailbox without transferring the message into it, select the Don’t transfer, 
just create mailbox.

Contextual Filing (Sponsored and Paid modes only)

You can highlight a word or part of a word anywhere in a message and transfer the message 

to a mailbox that contains that word within the mailbox name.

For example, if you have a mailbox named “Old Newsletters,” you can highlight the word 

"Newsletter" and transfer the entire message to the Old Newsletters mailbox.

To perform a contextual filing

1. Highlight the word (or words).

2. Right-click the word.

The contextual filing submenu appears showing the mailbox(es) with similar 

name(s).

Contextual filing submenu
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Filtering Messages

NOTE: If you are using Eudora in Light mode, you have access to fewer features when using 

Eudora’s Filtering functionality.

Many of the email management functions in Eudora can be done automatically using filters. 

For example, you can automatically reply to a request for information, transfer all the 

messages from your children into a personal mailbox, and label all the messages from your 

customers as “Hot.”

A filter can be thought of as a personal “valet” or “butler” that takes your mail and does certain 

things to it that you specify. One kind of valet might watch for particular mail from a mailing list 

and move it into a mailbox, open the message, and play a sound. Another might look for other 

kinds of mail and give it a label color, a high priority, and a new subject line. You can create as 

many of these “valets” or “butlers” as you like, and you can give each of them from one to five 

instructions on what to do with your mail that fits a certain set of criteria, based on information 

in the header of the message and the message body.

Quick and Simple Filters with the Make Filter Command

The simplest filters are those that transfer incoming messages to a particular mailbox based 

on the sender of the message or one or more of the recipients. For example, each time you 

check your mail, you may want to have Eudora take all of the incoming messages it receives 

from your friend Joe and automatically transfer them into a mailbox you’ve called “Mail from 

Joe.” To get Eudora to do this, you set up a simple filter.

For new users, the Make Filter dialog box provides an easy way to learn how to use filters. 

Once you are comfortable with the simple filters created this way, you can go on to make more 

complex, powerful filters using the Filters window. Experienced users will find that the Make 

Filter dialog box provides a rapid, convenient method for making a simple transfer filter.

To open and use the Make Filter dialog box

1. Open an incoming or outgoing message containing the information you want in 

your filter, or select one or more message summaries in a mailbox.

2. From the Special menu, choose Make Filter. Or right-click in the body of the open 

message, or in the selection of message summaries, or in the preview pane for a 

single-selected message, and choose Make Filter from the drop-down menu. 

The Make Filter dialog box appears.
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Make Filter dialog box with sample filter

Match Conditions

The Match Conditions area of the dialog box helps you set up the criteria that will determine 

whether a particular message will be acted on by this filter. 

You can specify that the type of messages you are interested in should be Incoming and/or 

Outgoing. You can also specify that this should be a Manual filter (described below). You can 

check and uncheck any combination of the three boxes: Incoming, Outgoing, and Manual.

NOTE: If the messages you selected when you chose Make Filter were in any mailbox other 

than your Out mailbox, the Incoming and Manual check boxes are checked automatically. If 

the messages you selected were in your Out mailbox, the Outgoing and Manual check boxes 

are checked automatically.

• Incoming—If this box is selected, then any incoming message that satisfies the 

content match condition you specify will be acted on according to the action you’ve 

specified in this filter.

• Outgoing—If this box is selected, then any outgoing message that satisfies the 

content match condition you specify will be acted on according to the action you’ve 

specified in this filter. The matching and action occurs after the message has been 

sent.
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• Manual—If this box is selected, then when you select one or more message 

summaries in a mailbox window and choose Filter Messages from the Special menu, 

the incoming and/or outgoing messages selected that satisfy the content match 

condition you specify will be acted on according to the action you’ve specified in this 

filter. This option is useful when testing your filter or manually filtering messages that 

you have already received or sent.

NOTE: If Incoming or Outgoing is selected (or both), the filter is automatic; that is, Eudora 

performs the filter operation behind the scenes, automatically, when you send or check mail. 

If you now also select Manual, the filter becomes both automatic and manual, meaning, you 

can now manually perform the filter operation by selecting Filter Messages from the Special 

menu while message summaries are selected in a mailbox window—but Eudora still filters the 

messages automatically during mail sends and checks. In short, checking Manual does not 

“turn off” Eudora’s automatic filtering for that filter.

Also, making a filter manual also gives you a good way to test the filter to your needs as soon 

as you set it up, rather than having to wait until the next time you send or check mail. After 

creating a manual filter with the Make Filter dialog box, check to see that it does what you want 

by selecting Filter Messages from the Special menu. Your open message or selected message 

summaries are immediately filtered according to the new filter.

You can choose one of three content matches: From, Any Recipient, or Subject.

From (selected by default)—Select to match the message against the From: field—the 

sender—of the messages you selected. You can then edit the field. The From: field of a target 

message must contain the information in this box but does not have to exactly equal it. Note 

that if you selected multiple messages and they do not have a common sender, the From: field 

is unselectable and is left blank.

Any Recipient—Select to match the message against any of the recipients in the messages 

you selected (recipients are contained in the To: and Cc: fields and, in an outgoing message, 

the Bcc: field). Choose one recipient from the drop-down menu (accessed from the menu 

button next to the field), or edit the text in the field. Note that the information you enter in the 

field must be contained in any of the recipient fields of the target message but does not have 

to exactly equal any recipient field.

Subject—Select to match the message against the Subject: field of the messages you 

selected. If you have selected multiple messages and they do not have a common subject, this 

field is left blank. In either case you can edit the field. The subject line of a target message 

must contain the information in this box but does not have to exactly equal it.
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Action Area

The Action area of the window lets you determine the one action that will be performed on 

messages that satisfy the Match Conditions you’ve specified for this filter. The three action 

choices are all message-transfer actions; they transfer the filtered message to a mailbox. For 

messages that satisfy your match conditions, your simple filter will transfer the messages to 

either a new mailbox, an existing mailbox, or your Trash mailbox.

Transfer to New Mailbox—Select to transfer the filtered message to a new mailbox that you 

will specify. The text field is filled in with a suggested new-mailbox name based on your 

selected content match condition (From, Any Recipient, or Subject). You can change this 

name if you like. The In Folder field is a label showing you the folder in which your new mailbox 

will be created. By default, this is the same folder that holds the mailbox containing the 

messages you’ve selected. The new mailbox is created as soon as you create this filter.

You can set the value of the “In Folder” field to your own desired default folders based on the 

chosen match condition: From, Any Recipient, or Subject. Use the three Eudora.ini file entries 

FilterFromFolder, FilterRecipFolder, and FilterSubjectFolder, respectively. Enter the path as it 

appears on the mailbox window. For example: FilterFromFolder=mail-lists\entertainment. See 

Eudora.ini File on page 445. 

Transfer to Existing Mailbox—Select to transfer the filtered message into one of your 

existing mailboxes. Select the mailbox from the button next to the field. The default mailbox is 

the In box. When you click the button, a version of the Transfer menu appears, letting you 

choose the mailbox from the Transfer menu. 

NOTE: Also, you can create a new mailbox in the Filters window by choosing New from the 

drop-down mailbox menu. This is handy for creating a new mailbox within another folder.

Delete Message (Transfer to Trash)—Select to delete the message that satisfies the filter 

match conditions, transferring it to your Trash mailbox. This feature is useful for deleting junk 

email, or “spam” as it is called in the Internet world. Test this filter to make sure messages you 

really want to keep don’t go to the Trash mailbox.
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Buttons

• Create Filter—When you have set up your match conditions and filter action, click 

Create Filter to create the filter. The filter is added to the bottom of your filters list in 

the Filters window (discussed below). The filter is available immediately and will act 

on messages that satisfy the conditions at the next mail check, mail send, or 

selection of the “Filter Messages” command, as appropriate. Filters are processed 

from top to bottom of the filters list.

• Add Details—Alternately, after setting up the filter information, click Add Details to 

both create your filter and also open the Filters window. You can add additional 

information to your new filter and make it more powerful or just change it. The filter 

is added to the bottom of your filters list and is immediately available in the form in 

which it was set up in the Make Filter dialog box. Any changes you make in the Filters 

window must be saved before they become effective. Following is more information 

on the Filters window.

• Cancel—Click Cancel to cancel the filter if you change your mind. The filter is 

cancelled and your changes are not saved.

Detailed Filters with the Filters Window

The Make Filter dialog box, discussed previously, lets you create quick, simple filters that 

perform one operation—a mail transfer—based on one match condition—a piece of header 

information. The Filters window lets you create more complex, powerful filters that use multiple 

match conditions and perform multiple filter actions. You can also use the Filters window to 

create simple filters such as those created by the Make Filter dialog box.

To open the Filters window to create or modify a filter

1. From the Tools menu, choose Filters, or click on the Filters window’s tab if it is part 

of a visible tabbed window group. The Filters window appears, and any filters you 

have created are listed on the left. For more information on how to manipulate the 

Filters window alone and as part of a tabbed window, see Managing Windows in 

Eudora on page 197. 
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 Filters window showing an example filter

2. To add a new filter, click New or to modify a filter, click an existing filter to select it.

3. Select the options for how you want the filter to be used: as an automatic filter to 

be invoked on any Incoming and/or Outgoing mail and as a Manual filter that can 

be invoked when you choose Filter Messages from the Special menu. Any 

combination of these options works.

4. Define the criteria for the filter by using the header item drop-down menus and the 

text fields to specify which header items should include a particular string of text. 

You can define two related terms for the criteria so that your filter is as specific as 

possible. For details, see Filter Criteria (Match Area) on page 167. 

5. Define the action or actions to be taken on messages that fit the criteria and save 

the filters. For details, see Filter Actions on page 170. 

Eudora places a small icon to the left of the filter in the list for some action you have selected 

for that filter—up to five icons/actions per filter.

NOTE: Filters are automatically named based on the first term of the criteria for the filter. You 

can reorder them by dragging a filter up or down in the list.
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You should reorder your filters to indicate what order you want your messages filtered, and 

grouping your filters will make them easier to find.

When the filters are invoked (automatically or manually), each message is matched against 

each filter in order from top to bottom. If the message meets a filter’s criteria, the actions are 

done as specified until there are no more actions. Then the message is matched against the 

next filter. If at any point a “Skip Rest” action is done, the remaining actions for that filter (if 

there are any) are performed on that message, the rest of the filters in the filters list are skipped 

for that message. The next message is filtered, again going from top to bottom down the filters 

list.

Filter order matters when a message addressed to you is also sent to a mailing list you’re on. 

If you have a filter that always places messages addressed to you into a personal mailbox, 

then you want Eudora to perform the filter for your personal mailbox before any other filtering.

You can change the width of the filters list to create more or less space for your list. To do this, 

put the arrow over the vertical “splitter” bar to the right of the list and drag the line to the left or 

right.

The next two sections refer exclusively to the Filters window. For information on the match 

conditions and filter actions in the Make Filter dialog box, see Quick and Simple Filters with 

the Make Filter Command on page 161. 

Filter Criteria (Match Area)

Each filter in the Filters window can use one or two “terms” as its criteria, connecting them as 

appropriate with the conjunction drop-down menu.

Header—Use this field to specify which message header items you want the filter to search. 

You can choose an option from the drop-down menu or enter one yourself. This is helpful if 

you want to use a header item that does not appear on the menu, such as X-Priority. The 

selections are as follows:

• To:

• From:

• Subject:

• Cc:

• Reply-To:
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• «Any Header»

• «Body»

• «Any Recipient»

• «Personality»

• «Junk Score»

The «Any Header» option searches all message headers (including hidden headers that are 

shown with the BLAH BLAH BLAH option). The «Body» option searches the message body. 

The «Any Recipient» option searches all possible recipient items (To:, Cc:, Bcc:). The 

«Personality» option searches the name of the personality (email account) associated with the 

message. You will most likely want to search for both the To: and Cc: fields when receiving 

mail. If so, you should use <<Any Recipient>> instead of To: or Cc:.

Use the match type (“contains” is the default) drop-down menu to control how the header item 

is matched with the text string in the text field. The match options are as follows:

contains or doesn’t contain—If the specified header item contains or does not contain the 

text string, filter the message. It allows other text to surround the text string.

is or is not—If the specified header item is or is not an exact match of the text string, filter the 

message.

starts with or ends with—If the specified header item starts with or ends with the text string, 

filter the message. The starts with item refers to the first non-whitespace character after the 

colon, so any spaces after the colon are ignored.

appears or doesn’t appear—If the header item appears or does not appear in the message, 

filter the message (the text field is ignored). This is useful for filtering messages based only on 

the types of fields they contain. For example, some messages contain a Reply-To: header, 

some don’t.

intersects nickname—If the text string is included in a nickname, whether it is a full address 

or a nickname within the nickname, filter the message. In other words, the filter looks in all of 

your address books for the nickname that appears in the header of the message. If it finds it, 

it filters the message accordingly.

doesn’t intersect nickname—If the text string is not included in a nickname, whether it is a 

full address or a nickname within the nickname, filter the message.
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intersects address book—If the text string or nickname is included in any one of your 

address books, whether it is a full address or a nickname within the nickname, filter the 

message. In other words, the filter looks in all of your address books for all nicknames. If the 

nickname that appears in the header of the message is in the address book, Eudora filters the 

message accordingly. This match criterion is good to use if you wish all messages that are not 

from the entries in your address book to go in other mailboxes. This is an alternate method to 

control SPAM. 

doesn’t intersect address book—If the text string or nickname is not included in an address 

book, whether it is a full address or a nickname within the nickname, filter the message.

matches regexp (case insensitive) (Sponsored and Paid modes only)—If the specific item 

matches the regular expressions characters with case insensitivity, filter those messages. 

Regular Expressions is an advanced and complex method of searching for text. For more 

information, see Regular Expressions (Sponsored and Paid modes only) on page 173.

Regular Expression is a search string that uses special characters to match text characters. 

For example, if you are filtering messages sent to you by two people, choose From in the first 

drop-down options list, then choose matches regexp. Then type their usernames between 

parentheses separated by a vertical slash, for example (bobclark)|(janedoe)in the text 

box. Eudora searches and displays all messages from these two people. For more information 

on regular expressions, refer to the readme.txt file in your Eudora folder or click on the 

following Web site URL 

http://sansecus.usc.es/unixpages/concepts_regexp.html

matches regexp (Sponsored and Paid modes only)—If the specific item matches the regular 

expressions characters, filter those messages. 

is greater than—If Junk Score is selected in the Header field, filter the message if the junk 

score is greater than the score you enter in the following field. For information about Junk 

scoring, see Junk Mail (Paid mode only) on page 359.

is less than—If Junk Score is selected in the Header field, filter the message if the junk score 

is less than the score you enter in the following field. 

Enter text in the text field boxes to specify the text strings that the filter is searching for.

It is recommended that the contents of the text boxes be kept as specific and brief as possible. 

The greater the complexity, the less likelihood of a match.

http://sansecus.usc.es/unixpages/concepts_regexp.html
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Be sure not to enter a header label in the text box as part of the text string. For example, to 

filter all messages from Justine, do not enter “From: Justine” in the text box. Rather, select 

“From:” in the Header field, and enter simply “Justine” in the text box. 

Use the conjunction drop-down menu (“ignore” is the default) to link the two terms. The 

conjunction options are as follows:

ignore—Ignore the second term. If the message matches the first term, filter the message.

and—If the message matches both the first and second terms (but not just one alone), filter it.

or—If the message matches either term (or both), filter it.

unless—If the message matches the first term, filter it unless the message also matches the 

second term, in which case do not filter it. (This lets you exclude certain variations of the first 

term.)

Filter Actions

For a filter you’re creating or modifying in the Filters window, all messages that match the filter 

criteria are acted on as specified with the Actions drop down menus. Each filter can do up to 

five things to a message that matches the criteria. You can use the same action twice if it does 

not directly affect the original message. For example, “Copy To” can be used twice, but not 

“Transfer To.”

Some filter actions have an associated icon. For these actions, Eudora places the action icon 

next to the filter in the filters list. Up to five icons can appear per filter.

The Action options are as follows:

None—No action.

Make Status—Assigns the selected status to message summaries.

Make Priority—Assigns the selected priority level to messages. If you select a set level from 

the drop-down menu, messages are set to that priority. If you select Raise or Lower, messages 

are raised or lowered one priority level based on their pre-filter level.

Make Label (Sponsored and Paid modes only)—Assigns the selected label to messages. 

Label colors and names are set in the Labels options window. See Labels on page 331. 
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Make Personality (Sponsored and Paid modes only)—Assigns the selected personality to 

messages. For outgoing messages, the message is not sent from the assigned personality. 

For incoming messages, all your responses to the message will be from the assigned 

personality until you change the personality associated with the incoming message or your 

response. For more information, see Using Multiple Personalities (Sponsored and Paid modes 

only) on page 115. 

Make Subject—Assigns the new subject to message summaries (does not affect the subject 

in the message itself). If you choose this option, the entire subject of the message is replaced 

with the new subject. Use the “&” symbol to stand for the old subject if you want to add the new 

subject to the old subject. For example, entering New Subject [was &] results in New 

Subject [was Old Subject].

Play Sound (Sponsored and Paid modes only)—Plays the selected sound when messages 

are filtered.

Speak (Sponsored and Paid modes only)—Plays a voice to alert you of a message being 

filtered. Who and Subject fields display as well as a drop-down list where you can choose a 

voice type. Check Who to hear the voice read the sender’s name and Subject to hear the voice 

read the subject line.

NOTE: After you select Speak, the Who and Subject fields and a drop-down voice list appear. 

If these fields are grayed out, you must install Microsoft’s Speech Engine applications. For 

more information and to retrieve the applications, please refer to the following website: 

www.eudora.com/download/other

Open (Sponsored and Paid modes only)—Opens the mailbox and/or message when a 

message is received. If you set a previous action to filter messages into a mailbox, then that 

mailbox is opened.

Print (Sponsored and Paid modes only)—Prints one copy of each message.

Notify User (Sponsored and Paid modes only)—Notifies you “As Normal” and/or “In Report” 

when messages are received. The “As Normal” option notifies you based on the options you 

have selected in the Getting Attention options. The “In Report” option notifies you by opening 

the Filter Report window and displaying in that window a filter report that details what filter 

actions have been done. See Filter Report Window on page 220. 
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Notify Application—Notifies the selected application when messages are received, and 

provides information from the message. Specify the application to use and the part of the 

message to be included.

Use the Browse button  to select an application, or enter the command line yourself. The 

command line should include the path to the executable, any options, and the following 

substitution variables, all separated by blank spaces:

%1 Date 
%2 To 
%3 From 
%4 Subject 
%5 Cc 
%6 The entire message

For example, the command line to send the subject of a message to a pager might look like 

this:

C:\apps\pager.exe -c %4

Forward To (Sponsored and Paid modes only)—Forwards messages to the email address 

given. Forwarded messages are placed in the queue in the Out mailbox and sent the next time 

you send queued messages.

Redirect To (Sponsored and Paid modes only)—Redirects messages to the email address 

given. Redirected messages are placed in the queue in the Out mailbox and sent the next time 

you send queued messages.

Reply with—Replies to messages with the selected stationery message. Replies are placed 

in the queue in the Out mailbox and sent the next time you send queued messages. One 

typical use of this action is to reply to specific senders with stationery telling them that you’re 

on vacation: “I’m out till the 10th. I’ll reply to your message when I get back.” For more details, 

see Using Stationery (Sponsored and Paid modes only) on page 109. 

NOTE: For filter actions Forward to, Redirect to, and Reply with, the resulting new message 

will always be queued regardless of your sending mail settings. If you want the message sent 

automatically, you need to have the Checking Mail settings set to “Automatically check mail 

every _ minutes” and “Send on check” enabled. See Checking Mail on page 295. 
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Server Options (Sponsored and Paid modes only)—Sets the message’s server status to 

Fetch and/or Delete. Use this only if POP is your incoming server type. 

Copy To—Copies messages to the selected mailbox. 

Transfer To—Transfers messages to the selected mailbox.

Skip Rest—Stops filtering for the message. The message is not matched to the rest of the 

filters in the filter list.

Regular Expressions (Sponsored and Paid modes only)

When searching for messages or defining a filter in Eudora, an option you can use is regular 

expressions. Following is a description of regular expressions and how they are used in 

Eudora.

There are two functions in Eudora where you can use regular expressions:

• Filters window—Located in the drop-down list where you indicate the relationship 

between a mail header and a piece of text (for example, the “Subject” contains 

Eudora, “Any Recipient” is joe@xyz.com, and so on). There are two regular 

expression criteria in that list, namely "matches RegEx" and "matches RegEx (case 

insensitive)."

• Find Messages window—Located in the center drop-down list. The option 

"matches regexp" appears. In the Find Messages window, regexp is not case 

sensitive.

There are various standard implementations of regular expressions, but Eudora uses the 

POSIX implementation. Following are symbols that are supported in Eudora.

Symbol Character representation

. (period) represents any one character.

[ ] (brackets) contain a set of characters from which a match can be made. It corresponds to one 
character in the search string.

\ (backslash) is an escape character which means that the next character will not have a special 
meaning.

* (asterisk) is a multiplier.  It will match zero or more of the previous character. (Note that it's not a 
wildcard character as in file names.)
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Here are a few examples:

You can find further information on regular expressions on the web, for example the following 

web site: http://www.regular-expressions.info/.

Creating an Auto-Reply Message 
(Sponsored and Paid modes only)

You can create an email message that can be sent to people automatically when you are on 

vacation or away from your computer. This message is called an auto-reply. You create an 

auto-reply by using Eudora’s stationery and filter functions. 

? (question mark) is a multiplier.  It will match zero or one of the previous character. (Note that it's 
not a wildcard character as in file names.)

+ (plus) is a multiplier. It will match one or more of the previous character.

{ } (squiggly brackets) contain a number which specifies an exact number of the previous character.

[^] (brackets containing caret and other characters) means any characters except the character(s) 
after the caret symbol in the brackets.

^  (caret) is the start of the line.

$ (dollar) is the end of the line.

\< represents the start of a word.

\> represents the end of a word.

[:alpha:] represents any alphabetic letter.

[:digit:] represents any single-digit number.

[:blank:] represents a space or tab.

| (pipe) is OR. It requires that the joined expressions have parentheses around them.

Symbols What they match

E.*a     matches Eudora, Etcetera, Ea

ho+p     matches hop, hoop, hoooop, but not hp

etc\.    matches etc. but not etc

e.a      matches eta, eda, e1a; it only matches Eta if the matching is case-insensitive

[eE].a   matches eta and Eta

Symbol Character representation

http://www.regular-expressions.info/
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Before you create the auto-reply, make sure that the Check for mail every _ minutes (the value 

you enter must be greater than 0) and Send on check options are turned on in the Checking 

Mail options window. See Checking Mail on page 295. 

Also, make sure you have entered your incoming mail server’s password for your current 

session or have Eudora save your password.

To create an auto-reply

1. Write your auto-reply message using Eudora’s Stationery functions. Once the 

auto-reply message is written, name and save it in stationery. See Creating New 

Stationery on page 111. 

2. From the Tools menu, choose Filters. 

The Filters window appears.

3. In the Match section, choose a header from the Header drop-down list. Select a 

header that matches the header in the messages to whom you want to send your 

auto-reply. <<Any Recipient>> is the most common for an auto-reply. 

NOTE: If you choose <<Any Recipient>>, all recipients including mailing list you 

subscribe to will receive your auto-reply. 

For example, to set an auto-reply only to messages sent to your user name, just 

select <<Any Recipient>>, then choose “contains.” In the text box, enter your user 

name. You can match others as well, but it may cause a large number of emails to 

be auto-replied.

4. In the Action section, choose Reply with in the first drop-down list.

5. In the text box to the right of the first drop-down list, enter the name of the 

stationery.

6. Click OK. 

The stationery message you created will be sent to the people you indicated in this 

filter.

TIP: Remember to delete this filter when you want your auto-reply message to 

stop.
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Using the Junk Mail Filter for Incoming Messages  
(Paid mode only)

Once you install Eudora, Eudora asks you if you want to install a new mailbox called Junk to 

hold junk email messages (spam). The Junk mailbox appears in your mailbox list. The Junk 

mailbox is a special mailbox like the In, Out, and Trash mailboxes. It cannot be deleted or 

renamed. 

sample Junk mailbox

When you check for mail, Eudora recognizes which incoming messages are junk, and those 

messages are filtered into the Junk mailbox. Your incoming mail goes through the Junk filter 

before any other filter you may have set up. After a certain number of days (30 days is the 

default), Eudora automatically deletes these messages. 

Occasionally, messages Eudora filters into the Junk mailbox may, in fact, not be junk mail. 

There is a new option on the Message menu that allows you to transfer wanted mail to the 

appropriate mailboxes.

To manage messages in the Junk mailbox that are not junk

1. Scan the messages in the Junk mailbox and select those that you consider not junk 

mail. 

2. From the Message menu, choose Not Junk. Or right-click on the message and 

choose Not Junk from the context menu.
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Message menu with Not Junk option selected

By choosing the Not Junk command, the messages you selected are automatically 

filtered to go to the designated mailboxes you have previously set up. 

NOTE: With time, Eudora learns which messages are not junk and filters them to 

your designated mailboxes automatically. 

Conversely, if you find Junk mail in your other mailboxes, just choose Junk from the Message 

menu, and these messages are transferred to the Junk mailbox. With time, Eudora eventually 

learns to recognize these messages as junk and filters them into the Junk mailbox.

Sorting Messages Within Mailboxes

When you check your mail and new messages come into your In box or are filtered into other 

mailboxes, the new messages are placed in their mailboxes in the order in which they arrive. 

By default, these new messages appear at the bottom of the message summary list in the 

mailbox window. Note that this is not necessarily a strict date order, since occasionally 

messages may arrive out of date order. (The date indicates when the message was sent, not 

when you receive them.)
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Similarly, when you transfer messages to another mailbox, those messages appear at the 

bottom of the message summary list in that mailbox.

You can sort messages in a mailbox by status, priority, attachment, label, sender, date, size, 

server status, subject, and group by subject. You can sort these messages in either ascending 

or descending order one column at a time or by combining several columns in the sort.

Simple Sorting

You can access Eudora’s sort feature to perform a simple sort in three ways:

• By clicking the column header you want to sort. For example, if you click the Who 

column, senders of your messages are sorted in alphabetically order. 

• By right-clicking anywhere on the column headings. The context menu appears for 

you to choose a sort criteria for that column. For example, if you choose the item to 

sort in descending order, the mailbox sorts from top to bottom. 

• By choosing the Sort from the Edit menu. The Sort submenu appears for you to 

choose a column heading to sort.

NOTE: The normal sort order is ascending, for example, with the most current dates at the 

bottom of the list. If you hold down the Shift key and click the column header, the sorting 

becomes descending. You can mix ascending and descending sorts when sorting more than 

one column at a time.

Following is the context menu that appears when you right-click the Who column heading. 

Mailbox sorting context menu

In each column heading, you can choose if that heading has no sort, is sorted in ascending 

order, or sorted in descending order. Also, you can group subjects together by choosing 

Group by Subject, which keeps messages with the same subject together all the time.

Messages (including replies) with the same subject, such as a work project are kept together 

in the mailbox regardless of whether you sort by Date, Sender, and so on. A checkmark next 

to the Group by Subject option in the context menu indicates that the option is active.
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New messages that come into a sorted mailbox will automatically be placed in the correct 

sorted order. For example, if you have a mailbox sorted by date, and you want all of the 

messages to be grouped by subject, any new messages will be grouped with other messages 

containing the same subject in a chronological. 

NOTE: You can also sort message in the Find Messages window when the Results panel is 

active. 

Complex Sorting

You can perform complex sorting by holding down the Ctrl key and click one column, then 

another column, and so on. The columns are sorted in the order you clicked on them. For 

example, if you click the Subject column first and then the Date column, the subjects in this 

mailbox sort alphabetically and then chronologically. You will notice numbers in each column 

header indicating the order of the sort. See the following example.

Complex sorting by subject and then date

To perform a complex sort, you can click two columns or all eight! To cancel the sort, just click 

on the column that displays 1. All the sort criteria will cancel.

Using the Find Command

Eudora incorporates a Find command that searches for specific text within a single message, 

multiple messages, or even multiple mailboxes. 

To display the Find submenu of commands

• From the Edit menu, choose Find.
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 Find submenu (under the Edit menu)

Finding Text Within One Message

To search for text within a single message

1. Open a message. 

2. From the Edit menu, choose Find or in an open message or in the preview pane, 

press Ctrl + Shift + F. 

3. From the Find submenu, choose Find Text. 

The Find dialog box appears, with the blinking insertion point located in the text 

field.

Find dialog box

4. In the text field, type the text you want to find. 

5. Check Match whole word only to match the text as whole word (not embedded in 

another word). Check Match case to match the case of the entered text. 

6. When finished, click the Find Next button.

7. To continue searching in the same message for the next occurrence of the text, 

click the Find Next button in the Find dialog box, or choose the Find Text Again 

command from the Find submenu. 

These commands are equivalent and limit the search to the same message. 

Repeating these commands cycles through the matches in the open message 

only.

Starting at the cursor’s current position in the message, Eudora searches the current message 

for the specified text. If no match is found, the not found alert appears.
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If the search is successful, the message is scrolled to the first point where the match is found 

and the matching text is highlighted.

NOTE: You can search for text in the messages summaries area of a mailbox. Just place your 

cursor in the summaries window and choose Find from the Edit window. Choose Find Text 
and enter the text you want to find in the Find Text dialog box. Eudora will highlight the first 

occurrence of the text. 

Stopping a Find

If you want to stop Eudora from continuing a search, click the Stop button in the progress 

window, or press the Esc key.

Find Messages 

NOTE: If you are using Eudora in Sponsored or Light mode, you have access to fewer features 

when using Eudora’s Search functionality.

You can perform complex searches through messages in all or a selected number of 

mailboxes or folders. Once your search is complete, you can sort, delete, and view the 

resulting messages. You can search for a specific piece of information in all your mail or just 

search for a particular item that matches the criteria you set. Set up the criteria for your search 

by selecting options from the drop-down lists and by entering text. 

To set up criteria for a message search

1. From the Edit menu, choose Find or press Ctrl+F. 

The Find submenu appears.

2. From the Find submenu, choose Find Messages. 

The Find Messages dialog box appears. 
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Find Messages dialog box

In the Find Messages dialog box, your mailboxes appear along with check boxes. 

If the boxes are checked, Eudora will perform a search in these mailboxes 

according to the criteria you are about to set up. To omit a mailbox from the search, 

just un-check the box. If you had a mailbox selected when opening the Find 

Messages dialog, Eudora will default to only that mailbox being checked. 

Otherwise, all mailboxes are checked by default.

If you right-click in the Find Messages window, a context menu appears allowing 

you to clear all the check marks so you can select the mailboxes to search. Choose 

Clear All to clear the check marks or choose Check All to check all the mailboxes.

Find Messages context menu (right-click)

The top part of the dialog box is where you select and enter criteria for your search. 

Each search can use up to five “terms” and “verbs” as its criteria, connecting them 

as appropriate. Eudora remembers the previous criteria if you close and reopen the 

Find Messages dialog box. The drop-down and verb lists displaying the criteria you 

can select are shown below: 
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Find Messages drop-down and verb options lists

3. In the drop-down criteria list (Anywhere is the default), choose where in the 

message you want Eudora to search for text. Following is a description of each 

option.

Anywhere—Choose this option to search everywhere in the message including all 

header fields and message body. This includes headers that are normally exposed 

only with the Blah Blah Blah icon button turned on.

Headers—Choose this option to search only in the header fields of the message. 

This includes headers that are normally exposed only with the Blah Blah Blah icon 

button turned on.

Body—Choose this option to search only in the body of the message.

Attachment Name(s)—Choose this option to search only attachment names in 

the message.

Summary—Choose this option to search text entered in only the header From: and 

Subject: fields of the message.
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Status—Choose this option to search for messages by status. A status drop-down 

options list displays (the default is Unread). You can choose from Unread, Read, 

Replied, Forwarded, Redirected, Sent, Sendable, Unsent, Queued, Time-Queued, 

Unsandable, or Recovered. The verb field defaults to is. 

Priority—Choose this option to search for messages by priority. A priority drop-

down options list displays (the default is Highest). You can choose from Highest, 

High, Normal, Low, or Lowest. The verb field defaults to is.

Attachment Count—Choose this option to search the number of attachments 

joined to each message. A counter appears for you to select the desired number, 

or you can type the number in the text box. The verb field defaults to is. 

Label—Choose this option to search for messages by label. Choose Label, and 

the labels drop-down options list displays (the default is None). You can choose 

from the labels you previously set up. The verb field defaults to is. 

Date—Choose this option to search for messages by date. Once selected, today’s 

date appears. Click the down arrow to display the current month’s calendar. Using 

the arrows on the calendar, you can display the preceding or succeeding months 

and years. Choose the date to or from where you want the search to begin. 

Size—Choose this option to search for messages by their file size (in kilobytes). A 

counter appears for you to select the desired number of kilobytes, or you can type 

the number in the text box. The verb field defaults to is. 

Age—Choose this option to search for messages by age (in days). A counter 

appears for you to select the desired number of days, or you can type the number 

in the text box. The verb field defaults to is. 

Personality—Choose this option to search for messages by account. A drop-down 

list displaying your previously set up personalities appears. Select the desired 

personality.

Mailbox Name—Choose this option to search for messages in a specific mailbox. 

Enter the name of the mailbox in the text box. This works well if you selected 

several mailboxes but only wanted certain mailboxes that matched the criteria you 

selected.

To—Choose this option to search text entered in only the To: header field of the 

message.

From—Choose this option to search text entered in only the From: header field of 

the message.
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Subject—Choose this option to search text entered in only the Subject: header 

field of the message.

CC—Choose this option to search text entered in only the Cc: header field of the 

message.

BCC—Choose this option to search text entered in only the Bcc: header field of the 

message.

Any recipient—Choose this option to search text entered in only the To:, Cc:, and 

Bcc: header fields of the message.

In the example below, Headers was selected from the drop-down options list as the 

first criteria.

4. After you select the option from the drop-down list, select a verb to link the first 

option with the text you you want to find. The verb drop-down lists are shown below:

Verb drop-down lists

Following is a description of each verb option in the drop-drop list. 

contains—If the specific item contains the text string, search and display those 

messages. This allows for other text to the right of the text string.

contains whole word—If the specific item contains the exact word, search and 

display those messages. This does not allow for other surrounding text.

does not contain—If the specific item does not contain the text string, search and 

display those messages.

Date 

Age

Anywhere
Headers
Body
Attachment Name (s)

Mailbox Name
To
From
Subject
CC
BCC
Any Recipient

Summary

Status
Label
Personality

Size
Priority 
Attachment Count
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matches x1 query—If the specific items matches the x1 formatted query string, 

search and display those messages. This allows for complex queries to be 

performed within a single search criterion. For details on x1 query syntax, please 

see X1 Search Queries on page 436. 

NOTE: The following options are available only when Indexed Search is turned off:

Verb drop-down lists

is—If the specific item is an exact match, search and display those messages.

is not—If the specific item is not an exact match, search and display those 

messages.

starts with—If the specific item starts with the text string, search and display those 

messages.

ends with—If the specific item ends with the text string, search and display those 

messages.

matches regexp (case insensitive)—If the specific item matches the regular 

expressions characters with case insensitivity, search and display those 

messages.

Date 

Age

Anywhere
Headers
Body
Attachment Name (s)

Mailbox Name
To
From
Subject
CC
BCC
Any Recipient

Summary

Status
Label
Personality

Size
Priority 
Attachment Count
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Regular Expression is a search string that uses special characters to match text 

characters. For example, if you are searching for messages sent to you by two 

people, choose From in the first drop-down options list, then choose matches 
regexp, then type their usernames between brackets separated by a vertical pipe 

symbol, for example (bobclark)|(janedoe) in the text box. Eudora searches 

and displays all messages from these two people. For more information 

concerning regular expressions, refer to the readme.txt file in the Eudora folder, or 

go to the following URL: http://www.regular-expressions.info/ 

NOTE: Regular Expressions is an advanced and complex method of searching for 

text. 

matches regexp—If the specific item matches the regular expression string of 

characters, search and display those messages. is after/is before (Date only)—If 

the date is after or before the date displayed, search and display those messages.

is greater than/is less than (Age, Size, Priority, Attachment Count only)—If the 

specific item is greater than or less than the number indicated, search and display 

those messages. 

5. Once you have chosen the verb, enter the text string that you are searching for, or 

choose a value from the drop down list if one appears. In the text box, you can enter 

as much text as you want. In the following example, a username was entered.

http://www.regular-expressions.info/
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Example of search criteria for a one-level search

In the above example, if you click Search, Eudora will search through all of your 

mailboxes for every message that contain the text Ron anywhere in the header 

portion of the message.       

6. To continue adding a second level of criteria (you can add up to five levels), click 

More. Choose and enter more criteria to further streamline the search as in the 

following example. You can also select Match All or Match Any to include or 

differentiate the criteria from one level to the other. “Match All” will find messages 

that match all of the criteria you entered; “Match Any” will find messages that match 

any of the criteria you entered.
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Example of search criteria for a two-level search

In the above example, if you click Search, Eudora will search for every message 

through every selected mailbox that contains the word speaker anywhere but only 

if the text Ron is somewhere in the header.

7. To continue adding a third level of criteria, click More. Choose and enter more 

criteria to further reduce the search. Click Search to display the messages that 

contain the criteria you entered. Although the following example shows three levels 

of criteria, you can click More to continue entering more criteria; click Fewer to 

return one level back. The Search button is disabled if you have a blank text box.
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Example of search criteria for a three-level search with results

In the above example, if you click Search, Eudora will search for every message 

through every mailbox that contains the word message in the message body, the 

text Ron somewhere in the headers, and the word speaker anywhere in either 

the message headers or the body.

To select all the messages in the Results window, choose Select All from the Edit 
menu or press Ctrl + A.

The messages that fulfill the search criteria appear in the Results window.

The Search feature will not work if you have any text boxes blank. You can click 

Fewer to reach a level where all text boxes are filled to conduct your search.
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Search context menu (right-click)

• To sort the messages, click a column heading to sort by that column. To sort in 
descending order, click the column header again. 

• To open a message, select and double-click the message, or right-click to 
display the context menu. Choose Open Message. 

• To open the mailbox where this message resides, highlight the message, right-
click to display the context menu. Choose Open Mailbox.

• To transfer the message to another mailbox, highlight the message, right-click 
to display the context menu. Choose Transfer and then select the mailbox you 
want.

• To reply to the message, highlight the message, right-click to display the context 
menu. Choose Reply.

• To reply to everyone on the message, highlight the message, right-click to 
display the context menu. Choose Reply to All.

• To forward the message to someone else, highlight the message, right-click to 
display the context menu. Choose Forward.

• To redirect the message to someone else, highlight the message, right-click to 
display the context menu. Choose Redirect.

• To delete a message, highlight the message and press the Delete key, or right-
click to display the context menu. Choose Delete.
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Using Web Words

Web Words provide you with two easy ways to access search engines:

• Clicking a word or words in your email to activate a contextual search

• Typing your search query in your toolbar.

You can now highlight a word or words anywhere in a message (header or text) and search 

the Internet for that topic. For example, you can highlight the word "flowers" anywhere in the 

message and search the Internet for all topics relating to flowers.

Or you can type your search query in your toolbar and search the Internet for that topic.

To search using the toolbar

1. Click in the Search text field on your toolbar.

Toolbar Search Field

2. Type the text that you wish to search the Internet for.

The text that you type appears in the Search Web field. 

Toolbar Search Field

3. Press the Return key.

Eudora launches your web browser and initiates a search for the topic.

To search using a drop-down menu

1. Highlight a word or words in an email.

2. Right-click the word.
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A contextual submenu appears showing the option to Search for your topic. 

Web Words submenu

3. Choose one of the search options:

• Search Web - Eudora launches your web browser and initiates a search for the 

highlighted text.

• Search Eudora - Eudora searches all your mailboxes for the text you entered 

in the search field.

• Search Mailbox - If you have a mailbox opened, Eudora searches that mailbox 

for the text.  If you have a message opened, Eudora searches the mailbox that 

the message is in.

• Search Mailfolder - If you have a mailbox opened, Eudora searches all the 

mailboxes in the same mail folder as the open mailbox. 

TIP: If you want to search on a single word only, you do not have to highlight the 

word.  Simply press the Control key and click or right-click on the word to start a 

search.
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Searching in Eudora

The search field on your toolbar can also be used to search inside Eudora.  Type 

the words you wish to search for, then click on the arrow to the right of the field.

A submenu appears with further search options.

Submenu

Choose one of the following search options:

• Search Web (default) - Eudora launches your web browser and initiates a 

search for the text you entered in the search field.

• Search Eudora - If you have an item open in Eudora (such as a mailbox or an 

email), Eudora searches it for any text you entered in the search field.  If you 

do not have anything highlighted, it searches all your mailboxes in Eudora.

The submenu also displays your most recent searches at the top of the search 

menu.

Recent Searches
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Saving a Message to a File 

To save a message to a separate text file on your computer

1. Open or select the messages you want to save. 

2. From the File menu, choose Save As. 

The Save As dialog box appears.

Save As dialog box

3. Enter the name you want to give the text file and select the appropriate options.

4. In the Save as type drop-down menu, choose Text Files.

When selected, Include Headers retains the first message’s header information in 

the saved document. If this is not checked, only the body of the messages is saved.

When selected, Guess Paragraphs removes extraneous carriage returns from the 

message and leaves returns only at the ends of paragraphs. It also converts 

multiple spaces into tabs.

5. Once you’ve made all of your choices, click Save.

If you select multiple messages from a mailbox window and choose Save As, all 

of the messages are saved to a single file.
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Window States and Tabbed Windows

Every window in Eudora exists in one of three states.

• Normal

• Docked

• Floating

You can use these different window states to set up Eudora the way you want to see it on your 

screen. These states are described below and in the following sections.

A tabbed window is a collection of windows combined into a single window in which each 

window has its own tab, for activating and dragging. A tabbed window can exist in any of the 

above three window states: normal, docked, or floating. Tabbed windows are discussed 

separately below.

NOTE: Only tool windows, those windows accessible from the Tools menu, except the Options 

dialog box, can exist as docked windows, floating windows, and tabbed windows. All other 

windows in Eudora, particularly the mailbox TOC windows and message windows, exist only 

in the normal state and cannot be combined into tabbed windows.

The tool windows that can be docked, floating, or tabbed are as follows, in their order down 

the Tools menu.

• Filters

• Filter Report 

• Mailboxes

• File Browser 

• Stationery 
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• Signatures 

• Personalities 

• Task Status 

• Task Errors 

• Address Book

• Directory Services

• Link History 

NOTE: If you minimize and then restore the main Eudora window, then all normal, docked, and 

floating Eudora windows, including tabbed windows, are also minimized and restored with it.

Closing a tool window does not erase its contents, unless the contents are saveable and you 

choose to discard changes. When you close a tool window or a tabbed window, the content, 

state, and position of the window or of all windows in the tabbed window are preserved. The 

preservation of content is useful for “persistent data” such as filter reports and directory service 

queries. If you try to close or de-activate a tool or tabbed window with unsaved changes, 

Eudora asks if you want to save the changes.

NOTE: If you are using Eudora in Sponsored mode, an ad window appears at the left-hand 

bottom of your screen. The ad window is the minimum size that corresponds to the ad being 

displayed, and this window can be moved. 

Normal Windows

A window is in the normal state if it is restricted to the window work area of the main Eudora 

window and cannot be dragged out of the main window.
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Sample normal windows inside the main Eudora window

Normal windows can be moved around within the window work area. They can also be 

minimized, and can be maximized to completely fill the visible window work area. When a 

normal window is maximized, its title bar partially blends with the main window title bar.

Normal windows can overlap other normal windows and are obscured by both docked and 

floating windows.

The title bar of a normal window contains the window-menu icon (far left) and three standard 

window buttons (far right): minimize/restore, maximize/restore, and close.

A tool window in the normal state, whether alone or in a tabbed group, can be dragged out of 

the confines of the main Eudora window, but it must first be converted to a dockable or floating 

window. 
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To convert a normal window to a docked or floating window

1. To display the drop-down context menu, right-click the window’s border or tab. 

2. To turn the command off, from the context menu choose Float In Main Window.

The checkmark disappears.

3. To turn the command on, from the context menu choose Allow Docking. 

A check mark appears.

A non-tool window in the normal state, such as a mailbox window or a message window, can 

never be dragged out of the confines of the main Eudora window.

To convert a docked or floating window to a normal window, right-click the docked or floating 

window’s border or tab, and choose Float In Main Window from the drop-down context menu.

Docked Windows

A window is dockable if it is capable of being attached to one of the four edges of the main 

Eudora window. A window is said to be in the docked state if it is currently attached to one such 

edge.
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Sample windows docked to the main Eudora window 

NOTE: Some application programs identify the docking feature by using terms such as 

“gravity,” “snap,” “glue,” “sticky,” “join,” and the like.

Only tool windows, whether alone or tabbed, are dockable. All other windows in Eudora, 

particularly message windows and mailbox windows, are not dockable.

NOTE: The main toolbar, although not a window, is also dockable to any edge of the main 

Eudora window or to another dockable window.

Dockable windows can be docked to any edge of the main Eudora window and to each other. 

You can also dock multiple windows along a single edge of the main window.

When you dock a window to the main window, the visible window work area is reduced. 

Docked windows cannot be obscured by normal windows, but they can be obscured by 

floating windows.
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To make a window dockable

1. To display the drop-down context menu, right-click the window’s border or tab. 

2. To turn off the command, from the context menu choose Float In Main Window.

The check mark disappears.

3. To turn on the command, choose Allow Docking. 

A check mark appears.

4. To then dock the window, drag the window to an edge of the main Eudora window 

or to another docked window. When the ghosted docking rectangle appears, 

indicating that the window will be docked, release the mouse button. The window 

attaches to the main window edge or the other window.

Some windows are more convenient to use when docked vertically (tall-and-narrow), while 

others are more convenient to use when docked horizontally (short-and-wide). Examples of 

windows that work better as tall-and-narrow windows are the Mailboxes window and the File 

Browser window. Examples of windows that work better as short-and-wide windows are the 

Task Status window and the Filter Report window.

Following are descriptions of the controls in docked windows.

Gripper Bar

The gripper bar, also called the grab handle, is the double line at one edge of the docked 

window. Drag the window by the gripper bar to undock it from the main window frame. The 

window now floats; you can leave it as a floating window, or you can dock it to any edge of the 

main window or to another docked window.

NOTE: The toolbar has a gripper bar.

Zoom Button

When two or more windows are docked on the same edge of the main window, Eudora 

activates each window’s zoom button. This button appears next to the “x” close button and 

contains a small triangle. Click the zoom button to minimize, maximize, or restore the width or 

height of that docked window relative to the other docked windows adjacent to it.
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Close Button

The close button contains an “x” and appears next to the zoom button. Click the close button 

to close the docked window.

Resize Bar

When two windows are docked side by side along one edge of the main window, a bar appears 

between them, called the resize bar. Drag this bar up or down, or to the left or right, as 

appropriate, to enlarge one of the docked windows and reduce the other.

Floating Windows

A window is in the floating state if it floats above the main Eudora window and can be placed 

anywhere on the desktop, including outside the main Eudora window. In this way, a floating 

window is a standard Windows Always on Top window, like tool palettes in paint programs.

Sample floating windows
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Only tool windows, whether alone or tabbed, can be made to float. All other windows in 

Eudora, particularly message windows and mailbox windows, cannot be made to float.

NOTE: The main toolbar, although not a window, can be made to float by undocking it from 

the main Eudora window using the gripper bar.

All windows in Eudora can be thought of as “living” in one of three layers or areas.

• Normal windows live in the window work area, the bottom layer.

• Docked windows live at the level of the main Eudora window’s border, the middle 

layer.

Floating windows live at the level above the main Eudora window, the top layer.

Therefore, a floating Eudora window floats above all other Eudora windows except other 

floating windows.

The title bar of a floating window contains, in addition to the title, only the Close button. This 

distinguishes the window from a normal window when both appear to be in the window work 

area. A normal window’s title bar contains the window-menu icon and three standard buttons. 

Note that a floating window can be dragged outside of the main Eudora window, whereas a 

normal window cannot.

You can diagonally resize any floating window in Eudora. Simply position the pointer over any 

window corner, and click and drag to enlarge or reduce.

To convert a window to a floating window, either undock it from the main window, 
if it is docked

1. To display the drop-down context menu, right-click the window’s border or tab.

2. To turn off the command, from the context menu choose Float In Main Window.

The checkmark disappears.

3. Then choose Allow Docking to turn off the command. The checkmark disappears. 

For a docked window, you can also temporarily override the Allow Docking 

command and suspend docking by holding down the Ctrl key while dragging the 

window. The window drags as a floating window.
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Tabbed Windows

A tabbed window is a collection of tool windows combined into one window. Each tool window 

in the tabbed window has its own window tab.

Sample tabbed windows

A window tab has two purposes: 

• It lets you bring the window to the front of the group to display it by clicking on the tab. 

It serves as a “drag handle” that lets you drag the tool window from one tabbed window to 

another, so that you can reorganize your tabbed windows and create new tabbed windows.

Only tool windows, those windows accessible from the Tools menu, except the Options dialog 

box, can be combined into a tabbed window. All other windows in Eudora, particularly mailbox 

windows and message windows, cannot be combined into a tabbed window.

A tabbed window can be normal, docked, or floating. You can convert a tabbed window from 

any state to any other state.

If a tabbed window shows a title bar, the title in the bar is the name of the active window in the 

group.
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Eudora’s Default Tabbed Windows

Eudora comes with three default tabbed windows, shown in the previous figure, which together 

include all eleven tool windows.

The first default is a vertically oriented tabbed window that is docked to the left side of the main 

window and contains the following five tool windows, with tabs in left-to-right order. 

• Mailboxes 

• File Browser 

• Stationery 

• Signatures 

• Personalities 

The second default tabbed window is a normal window that contains these five tool windows, 

with tabs in left-to-right order. To display this window, choose one of the member windows from 

the Tools menu.

• Directory Services 

• Address Book

• Filters 

• Filter Report 

• Link History

The third default tabbed window is a docked window that contains two tool windows, with tabs 

on the left side in top-to-bottom order. To display this window, display one of the member 

windows from the Tools menu.

• Task Status

• Task Errors

NOTE: The far-left window is the default window that will appear. To change this default 

window, select the window you want to appear as the default, and drag it to the far-left tabbed 

window grouping. See Reorganizing Tabbed Windows on page 207 for more information. 
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As described later in this section, you can reorganize these default tabbed windows any way 

you like. Your newly arranged tabbed window will be preserved when you quit and restart 

Eudora.

NOTE: Due to file format incompatibilities, if you upgrade from a pre-4.0 version of Eudora, 

you will lose the previous docking state of your Mailboxes window and toolbar. Eudora will 

reset the toolbar and docking states to the default configuration noted above. However, 

customized toolbar information is preserved; only the size and location of your toolbar may 

change.

Opening and Activating Tabbed Windows

To open a tabbed window that’s hidden, open any of its member windows by selecting the 

appropriate command from the Tools menu. The tabbed window opens with the selected 

window as the active (frontmost) window.

If the tabbed window is already visible and you wish to display one of its member windows that 

is currently not active, simply click the member window’s tab. You can also select the 

appropriate item from the Tools menu. The desired window comes to the front of the tabbed 

group.

You can also use the tool window’s keyboard shortcut, if it has one, to open or activate the tool 

window in its tabbed window.

Reorganizing Tabbed Windows

You are not restricted to the default tabbed window arrangements supplied with Eudora. You 

can mix and match tabbed windows any way you like.

At one extreme, you can have each of the tool windows in its own container with its own tab. 

At the other extreme, you can have all tool windows combined into one tabbed window. In 

between, you can have multiple tabbed windows open at once, mixed and matched to suit your 

purposes.

To move a window from one tabbed group to another, drag the window tab from the first group 

and drop it onto the second.

While the drag operation is in progress, the cursor changes and Eudora displays a small 

ghosted rectangle when you are over a valid drop location.
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If you drop the window tab onto another tab in the second group, the new window tab is 

inserted at that position and the other tabs are displaced to accommodate it. If you don’t drop 

the tab onto an existing tab, Eudora adds the new tab at the “end” of the group of existing tabs. 

The end depends on the location of the tabs in the tabbed window: top, bottom (the default), 

left, or right. For example, with tabs along the bottom, the “end” is the far right.

Note that the relocated window takes on the window state — normal, docked, or floating — of 

the destination tabbed window.

To reorganize the left-to-right or top-to-bottom order of tabs within a tabbed window, just drag 

the tabs left and right or top and bottom. The drop scheme is the same as that described 

above.

Creating a New Tabbed Window

To create a new tabbed window, drag one of the tabs from an existing tabbed window and drop 

it onto an exposed portion of the window work area. If the window work area is completely 

obscured — a normal window is maximized, for example — then drop the tab onto the status 

bar.

The dropped window converts into a normal tabbed window with a single tab. 

To convert the window to docked or floating

1. To display the drop-down context menu, right-click the tab or the window border

2. To turn off the command, from the context menu choose Float In Main Window. 

The check mark disappears. 

3. To turn on the command, choose Allow Docking. 

The check mark appears. 

4. While dragging the floating or docked window, you can hold down the Ctrl key to 

temporarily suspend docking behavior. When you release the key, docking 

behavior resumes.

Tab Display in Single-Tabbed Windows

If a tool window is in a tabbed window by itself, with one tab, you can hide or show the tab.
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To hide or show the tab

1. To display the context menu, right-click the tab or the window border. 

2. From the Tab Location submenu, choose Show Single Tab.

NOTE: You cannot hide the tabs in a tabbed window with two or more tabs.

Tab Contents, Location, Auto-Activation

• Tab Contents—A window tab contains both the icon and the text label associated 

with that window. If there is room enough in the tabbed window, both the icon and 

the label appear on each tab. If there is not enough room, only the icon appears for 

each tab. If only the icon is visible, pause the mouse pointer over the tab icon and 

Eudora will display the tab text in a Tooltip.

• Tab Location—By default, Eudora arranges window tabs along the bottom edge of 

a tabbed window. Sometimes, however, it is more convenient to have the tabs 

appear along a different edge. For example, in a short-and-wide tabbed window (one 

that is docked horizontally), you can improve the visibility of the window’s contents 

by moving the tabs to the left edge. To change the location of the tabs in a tabbed 

window, right-click one of the tabs or on the window border, and choose a new 

location from the Tab Location submenu of the context menu.

• Tab Auto-Activation—During a drag and drop operation, if you pause the mouse 

pointer over the tab of an inactive window in a tabbed window, that window becomes 

active (is brought to the front), and you can complete the drop. For example, if you 

drag received messages to the Mailboxes window when it is inactive in a tabbed 

window, and pause the pointer over the Mailboxes window’s tab, the window 

becomes active and you can drop the messages in a mailbox. Note that tab auto-

activation is disabled when you are dragging a tool window tab.

Closing Tabbed Windows

To close a tabbed window, click the “x” close button in the upper-right corner of the window.

Alternately, right-click any tab in the window or on the window border, and choose Hide from 

the drop-down context menu.
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Note that when you close or hide a tabbed window, the contents of all member windows, and 

the state and position of the tabbed window, are all preserved. When you redisplay the tabbed 

window, the active window shows its prior contents and the tabbed window appears in its prior 

state and position.

However, if you attempt to close or hide a tabbed window in which the active window contains 

unsaved changes, or you attempt to deactivate that active window by making another window 

active in the group, Eudora asks you if you want to save your changes.

Window Context Menu

If you right-click the tab or border of a single tool window, or on any tab or the border of a 

tabbed window, Eudora displays a context menu containing window-management commands.

Window context menu

Tab Location

This submenu is always available on the window context menu. It lets you change the location 

of the tabs in a tabbed window and lets you show and hide the tab in a single-tabbed window.

By default, Eudora places window tabs at the bottom of a tabbed window. Choose Top, Bottom, 

Left, or Right from this submenu to move the tabs to the top of the tabbed window, the bottom, 

or the left or right side. Eudora places a bullet (radio button) next to the current tab location 

selection.

Changing tab locations can sometimes increase the visible space within a tabbed window. For 

example, a short-and-wide tabbed window (one docked horizontally) might show more content 

if you move the tabs to the left side.

“Show Single Tab” is available in a single-tabbed window and lets you show or hide the tab. A 

checkmark next to the command indicates that the tab is shown (the default). This command 

is not available in a tabbed window containing two or more tabs; you cannot hide the tabs in 

such a window.
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Allow Docking

This command controls the dockability of floating and docked windows. It is available only 

when the “Float In Main Window” command is deselected. It is not available for normal 

windows when “Float In Main Window” is selected.

A checkmark next to the command indicates that it is selected.

When this command is on for a docked or floating window, the window can be docked to any 

edge of the main Eudora window.

When “Allow Docking” is deselected for a docked window, the window is converted to a floating 

window and cannot be redocked. When the command is turned off for a floating window, the 

window cannot be docked.

Even with “Allow Docking” selected, you can hold down the Ctrl key while dragging a docked 

or floating window to suspend dockability until you release the key.

Hide (command)

This command is always available on the context menu.

Choose Hide to close the tool window or tabbed window. “Hide” performs the same function 

as the “Close” command (Ctrl+F4) on the standard MS Windows window context menu.

Note, however, that when you hide or close a tool window, its content, state, and position are 

all preserved. And when you hide or close a tabbed window, the content, state, and position 

of all member windows are preserved. Thus, if you hide and redisplay a floating tabbed 

window, the window floats in its same position.

If you attempt to hide or close a tool window that contains unsaved changes, or a tabbed 

window in which the active window contains unsaved changes, Eudora asks if you want to 

save your changes.

To redisplay a tool window after you’ve hidden it, choose it from the Tools menu. To redisplay 

a tabbed window after you’ve hidden it, choose one of its member windows from the Tools 

menu. The tabbed window redisplays with the selected window active. You can use keyboard 

shortcuts to reappears hidden tool or tabbed windows where appropriate.
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Float In Main Window

This command is always available on the drop-down context menu.

Selecting this command (indicated by a checkmark next to the command) converts a docked 

or floating window to a normal window. Deselecting this command converts a normal window 

to a docked or floating window.

Note that the availability of the “Allow Docking” command depends on the state of this 

command. “When Float In Main Window” is selected (checked), “Allow Docking” is unavailable 

(the window is normal). When “Float In Main Window” is deselected, “Allow Docking” is 

available.

Eudora Toolbar

The main toolbar is a strip of buttons that gives you easy access to your frequently used 

Eudora commands.

Main Toolbar

The toolbar can be moved to wherever you want it on the screen. Just hold down the left 

mouse button on the gripper bar, which is the double-line at one end, and drag the toolbar 

around until you find a place you like. You can dock it to any edge of the Eudora window (left, 

right, top, or bottom), or you can dock it to another dockable window, or you can put it 

anywhere on your desktop in the floating state.

The descriptions of the default icons are listed below.

Trash

Opens In box.

Opens Out box.
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Checks for mail. 
See Checking for Mail Manually on page 74. 

Creates new message. 
See Creating an Outgoing Message on page 32. 

Replies to sender’s message. 
See Replying to a Message on page 96. 

Replies to all recipients of the message including the sender. 
See Replying to a Message on page 96. 

Forwards the message.
See Forwarding a Message on page 98. 

Redirects the message. See Redirecting a Message on page 98. 

Opens next message.

Opens previous message.

Attaches a file to the message. 
See Attaching a File to a Message on page 49. 

Checks spelling. 
See Checking Your Spelling Automatically (Sponsored and Paid modes 
only) on page 55. 

Open the Find Messages window. See Find Messages on page 181.  

Opens address book. 
See Using the Address Book on page 233. 

Sends the message to the printer.

Activates context sensitive help.
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Viewing the Main Toolbar

To show or hide the main toolbar, select or deselect the Show toolbar option in the Display 

options window. See Display on page 315. 

If the “Show cool bars” option is selected in the Display options window, the toolbar buttons 

have a flat look, and a button appears raised only when you position the mouse pointer over 

it. If this option is deselected in the Display options, the toolbar buttons always appear raised.

To see a description of each toolbar button, position the mouse pointer over the button; a 

description appears in the status bar at the lower-left of the main Eudora window if the “Show 

status bar” option selected in the Display options windows. If the “Show toolbar tips” option is 

selected in the Display options, a toolbar tip appears when you pause the mouse pointer over 

a toolbar button.

Adding, Moving, and Removing Toolbar Buttons 
(Sponsored and Paid modes only)

To add buttons to the main toolbar

1. Right-click anywhere on the toolbar, even on a button, to display the drop-down list. 

2. From the drop-down list, choose Customize. 

The Customize toolbar window appears.

Opens new message and displays QUALCOMM’s PureVoice 
recorder/player.
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Customize toolbar window

The Customize window contains six tabbed panels: General, Mailboxes, Plugins, 

Recipients, Stationery, and Personalities. Each of these panels lets you add 

toolbar buttons for functions related to the tab title.

NOTE: The procedures for adding a toolbar button from each panel are similar. 

3. In each panel, choose an item from the categories list on the left, and the 

corresponding button icons for that category are shown in the Buttons section on 

the right. 

4. Click to select one of the button icons and view a description of the button’s function 

in the Description field at the bottom of the panel. These descriptions also appear 

in the status bar of the main Eudora window if the bar is currently displayed when 

you position the mouse pointer over the button icon. In this case, you don’t have to 

click the button.

NOTE: In these button descriptions, any instruction to hold down the Shift key 

means to do so when you are actually using the button from the toolbar, not when 

you are adding the button to the toolbar, and not when you are clicking on the 

button in the Customize window to view its description. For example, if you click the 

New Message button in the main toolbar, a new composition window opens. If you 

hold down the Shift key and click the New Message button in the main toolbar, the 

Message Options dialog box appears, allowing you to select options for creating a 

new message (Personality and Stationery).

5. Drag the button icon to your desired position on the toolbar.
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NOTE: If you need help at any time during toolbar customization, click the Help 

button in the Customize dialog box.

6. When you are finished adding toolbar buttons, click the Close button to close the 

Customize dialog box.

Following are specific instructions for the tabbed panels of the Customize window:

• General—The Categories list contains names of menus and submenus. The buttons 

correspond to commands on these menus and submenus. For more information on 

the functions of these commands, see Using Menu Commands on page 277. 

• Mailboxes—The Mailboxes list shows the same view as your Mailboxes window, 

open it by choosing Mailboxes from the Tools menu. To add a toolbar button for a 

mailbox, click the mailbox and drag the appropriate button to the toolbar. If the 

mailbox is in a closed folder, double-click the folder icon to open it and display its 

contents (or click the plus-sign [+] to open the folder), then click the mailbox and drag 

the desired button to the toolbar. Note that you cannot add a toolbar button for a mail 

folder. For more information on the Mailboxes window, see Using the Mailboxes 

Window on page 150. 

• Plugins—The Plugins list shows installed message and resource plug-ins. You can 

add a plug-in button to the toolbar so that just by clicking on the button, you launch 

the plug-in application. Note that if you elected to install QUALCOMM’s PureVoice 

voice-messaging software plug-in when you installed Eudora, Eudora automatically 

adds a toolbar button for the PureVoice plug-in at the extreme right of the toolbar. 

See Plug-ins (Extended Messaging Services) on page 407 for more information on 

installing and using plug-ins. 

• Recipients—The Recipients list on the left shows all recipients that are listed on 

your Quick Recipient List, which is the list of recipients to whom you frequently send 

mail. See Using the Recipient List on page 252 for more information.  The buttons 

correspond to functions you can perform when addressing and sending mail to 

recipients on your list: New Message To, Forward To, Redirect To (all on the 

Message menu), and Insert Recipient (on the Edit menu). If there are no recipients 

on your Quick Recipient List, the Recipients area of this dialog box panel is empty.

• Stationery—The Stationery list shows all of your stationery files. The buttons 

correspond to stationery-related commands: New Message With, Reply With, and 

Reply to All With, all under the Message menu. For more information on using 

stationery, see Using Stationery (Sponsored and Paid modes only) on page 109. 
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• Personalities—The Personalities list shows all of your email accounts if you use 

multiple personalities (multiple accounts). The buttons correspond to personality-

related commands, such as the Message menu Change Personality command. For 

more information on using multiple personalities, see Using Multiple Personalities 

(Sponsored and Paid modes only) on page 115. 

Moving a Toolbar Button

To change the placement of a button on the main toolbar, hold down the Alt key and drag the 

button to where you want it.

Removing a Toolbar Button

To remove a button from the main toolbar, hold down the Alt key and drag the button off the 

toolbar.

Adding and Removing Separators

To add a separator line between two toolbar buttons where no line currently exists, first 

determine which button is farther from the gripper bar when the toolbar is docked. Now hold 

down the Alt key and carefully drag that button a little bit in the direction opposite the gripper 

bar. A separator line will be inserted between the two buttons. Be sure to drag the button less 

than one button-width away from its position; if you overdrag it, you will hop over the adjacent 

button and reposition the dragged button on the toolbar.

To remove a separator line from between two toolbar buttons, again determine which of the 

two buttons is farther away from the gripper bar when the toolbar is docked. Now hold down 

the Alt key and drag that button toward the gripper bar. The separator line is removed. 

Alternately, you can hold down the Alt key and drag the other button slightly in the direction 

away from the gripper bar, and that will remove the separator line. Again, be careful not to drag 

either button too far, or you will reposition it past the adjacent button on the toolbar.
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Eudora Taskbar

The Eudora taskbar appears along the bottom edge of the window work area in the main 

Eudora window, and normally shows the QUALCOMM logo at the right.

 Sample Eudora taskbar and status bar

The Eudora taskbar displays a button for each normal Eudora window that is open or 

minimized. The taskbar provides a convenient way to switch between normal windows by 

clicking buttons, without having to display the different windows from the Window menu.

The Eudora taskbar is modeled after the Windows 98/XP and Windows NT 4.0 system 

taskbars, which usually appear at the bottom of the screen — but there are important 

differences, as noted below.

To show or hide the Eudora taskbar 

1. From the Tools menu, choose Options.

2. Scroll through the category list and select Display. 

The Display options window appears.

Select or deselect Show MDI task bar option.

Any normal Eudora window that is open or minimized is represented by a button on the 

taskbar. This includes composition messages, received messages, mailbox windows, and any 

tool windows or tabbed windows that are in the normal state. Any open tool or tabbed windows 

that are in the docked or floating state are not represented as buttons on the taskbar.

If a tabbed window is represented by a button on the taskbar, the button shows the name and 

icon associated with the active tool window in that tabbed window.

Click a taskbar button to make that normal window active. The window comes to the front of 

the stack of all normal Eudora windows.

If you right-click a taskbar button, the standard Windows context menu displays, letting you 

Restore, Minimize, Maximize, or Close that normal window.
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If you right-click an exposed area of the taskbar (not on a button), the standard Eudora drop-

down context menu displays.

If you drag an object over a taskbar button and pause for several seconds, Eudora activates 

the normal window associated with that button. For a tabbed window, Eudora activates the 

tabbed window with the indicated window active. You can then complete the drag and drop 

operation into the normal window. For a tabbed window, you can further pause the pointer over 

one of the inactive window tabs, and that window becomes active and you can complete the 

drop.

Each taskbar button displays both the window icon and the window title of the normal window. 

If there is not enough room to display the entire title, Eudora truncates the title and places an 

ellipsis (...) to indicate the truncation. If you pause the mouse pointer over such a button, 

Eudora displays the entire window title in a tooltip.

If you have many normal windows open or minimized, the taskbar buttons shrink so that all 

buttons are visible. When the bar becomes sufficiently crowded, the QUALCOMM logo is 

hidden to make room.

Note that, unlike with the Windows 98/2000/XP and Windows NT 4.0 taskbars, you cannot 

move the Eudora taskbar to another edge of the main Eudora window; it always stays at the 

bottom of the window work area. You also cannot resize the taskbar as a separate item. It 

resizes automatically, however, when you resize the main Eudora window.

A New Mail notification icon in the Windows 98/XP/NT 4.0 System Tray (clock area) also tells 

you when new mail has arrived. If you hold the mouse over the icon, a tooltip tells you how 

many messages you have. If you double-click the icon, Eudora is brought to the foreground. 

The icon goes away when you click the mouse button, or press a key, inside the Eudora 

window.

New Mail notification icon
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Filter Report Window

Eudora generates a filter report if the “Generate Filter Report” option is selected in the Getting 

Attention options window. This report can be viewed in the Filter Report window. See Getting 

Attention on page 334. 

To open the Filter Report window

• From the Tools menu, choose Filter Report. Or, if the Filter Report window is in 
a visible tabbed window, click its tab.

Sample Filter Report window

If the generation of a filter report is enabled via the option mentioned above, then each time a 

filter operation is performed, Eudora adds the entry or entries to the Filter Report window and 

activates the window.

The Filter Report window displays three columns of data.

• Mailbox—Lists the names of the mailboxes into which messages have been filtered 

during the current Eudora session. Each listing represents one filter operation for 

that mailbox.

• Messages—Lists the number of messages filtered into each mailbox in the Mailbox 

column during the filter operation.

• Time—Lists the time that the messages were filtered into each mailbox in the 

Mailbox column during the filter operation.

By default, the entries in the window are sorted by time. However, you can click the column 

headings and sort the display by mailbox names (Mailbox) or by the number of messages 

filtered (Messages).
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NOTE: Whenever new entries are added to the list, Eudora always appends them to the 

bottom of the list in order of arrival, ignoring the current sort order. Simply click a column 

heading to re-sort.

Select one or more entries in the list and double-click the selection, or press Enter, and Eudora 

opens the mailbox windows associated with those selections.

The Filter Report listing is a cumulative log of the filter actions for the current Eudora session. 

Eudora automatically clears the log when you quit the program.

Closing the Filter Report window does not erase the contents of the filter report. Only quitting 

Eudora erases this information.

File Browser Window

Use this window to browse the Windows desktop. For example, you can use this window to 

find files to attach to new outgoing messages.

To open the File Browser window

1. From the Tools menu, choose File Browser. Or, if the File Browser window is in a 

visible tabbed window, click its tab.

Sample File Browser window
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The File Browser window performs some, but not all of the functions of the standard Windows 

98/XP and Windows NT 4.0 Explorer programs.

NOTE: The File Browser window is not an exact replica of Windows Explorer.

The File Browser window contains three controls:

• Drive Selector (top box)—A drop-down list in this field contains a fixed set of high-

level folders on your system, just like the corresponding control in Windows Explorer. 

The Drive Selector field determines what appears in the Folder Browser (middle 

section). When you first launch Eudora, the Drive Selector automatically sets itself 

to the drive containing your Windows folder. Note that the first entry in the drop-down 

list is a shortcut called “My Attachments” that points to your Eudora attachments 

folder.

• Folder Browser (middle section)—This is a tree control that displays the folder 

hierarchy whose root is the selection entered in the Drive Selector field. For 

example, if in the Drive Selector box you choose the C: drive, then the Folder 

Browser displays the folder tree-hierarchy branching down from the C: drive folder. 

Right-click a folder item in the Folder Browser to display the standard Windows 

context menu for that folder.

• File List (bottom section)—This is a list control that displays the files contained in 

the folder selected in the Folder Browser. You can select one or more file items in 

the list, then right-click the selection to display the standard Windows context menu 

for those files. (Eudora does not fill in the “Send To” submenu on the context menu.) 

When selecting multiple items, use the Shift key to select a range of items, and use 

the Ctrl key for disjoint selections.

The File List control shows these four columns:

• Name—Displays the name of the file and the icon associated with the file.

• Type—Based on the file name extension, displays the file type as set in the Options 

dialog box of Windows Explorer.

• Size—Displays the size of the file in kilobytes (K), where 1K = 1,024 bytes.

• Modified—Displays the date and time that the file was last modified.

As in Windows Explorer, you can click any of the four column headings to sort the listing by 

the data in that column.
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You can also resize the widths of the columns by dragging the separator line between the 

column heading labels. Position the pointer over the separator until you see a splitter cursor, 

then drag the line to left or right.

In the File List control, double-click an item in the Name column, or select one or more items 

in the column and press Enter to open the selected items. For program files, this action 

launches the program. For document files, this action generally launches the registered 

viewing or editing application for that document. Eudora displays an error dialog box if it is 

unable to open a file in this way.

To adjust the relative heights of the Folder Browser and File List controls, position the pointer 

over the separator bar between the Folder Browser and File List controls until the splitter 

cursor appears, then click and drag the separator up or down. Note that the File Browser 

window maintains a minimum height for the Folder Browser and File List controls, so you 

cannot close them all the way.

To manually refresh the File Browser window display, right-click anywhere in the File Browser 

window but not on a Folder Browser item or File List item, then choose “Refresh” from the 

drop-down context menu. 

TIP: A good place to right-click is in the Drive Selector box. Alternately, press the F5 key while 

keyboard focus is in the File Browser window.

You can select one or more files in the File List control and drag them to a message 

composition window to attach those files to that outgoing message. This is especially handy if 

you keep the File Browser window docked and open. For multiple file selections, use the Shift 

key to select a range, and use the Ctrl key to make disjoint selections.

You can also select one or more items in the File List control and drag them to another 

application that can receive such files.

In general, the File Browser window lets you drag items out of the window (copying them rather 

than moving them), but the window is not a proper drop target; you cannot drop items into the 

window that you’ve dragged from elsewhere on your desktop. In particular, you cannot move 

files by dragging them to a target folder in the Folder Browser control. You also cannot drag 

and drop items within the File Browser window (from one control to another, for example). You 

can, however, manage the files and folders in the window using the commands on the 

window’s context menu, such as Cut, Copy, Paste, and Delete. To display the drop-down 

context menu to use these commands, you must first select the file you want then right-click.
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Background Tasks (multi-threading)

In Eudora, you can retrieve, send, and compose mail at the same time! While sending and 

retrieving mail, you can compose a message, access Directory Services to look up addresses, 

edit stationery and signatures, read mail, etc. because retrieving and sending mail now occurs 

in the background. 

The Task Status window is used to display sending and receiving activity as it happens. For 

example, when you check and send mail simultaneously, the progress of these functions are 

displayed in the Task Status window. Also, you can send messages from different personalities 

at the same time.

The Background Tasks options found in Options under the Tools menu allow you to set 

parameters that determine how background tasks behave, and what kind of information you 

want to see in the Task Status window. In other words, you can configure the behavior of 

background tasks. Also, you can set the Task Status and/or the Task Error windows to be 

brought to the front of other windows in Eudora when activity occurs.

In the Background Tasks options window, you can indicate the number of seconds of user 

inactivity before your newly retrieved mail is actually processed by Eudora. If you have 

automatic mail checking set up in the Checking Mail options, Eudora will retrieve the mail in 

the background from the incoming server at those time intervals. But Eudora will not process 

it until there is no user activity performed on your computer for the amount of seconds you 

indicate in the Background Tasks options window. An envelope displayed on the status bar, 

located at the lower right-hand corner of the Eudora window, indicates that there is retrieved 

mail to be processed; that is, messages to be filtered and placed in mailboxes.

Technical Note. In the background, Eudora retrieves and sends mail; in the foreground, 

Eudora processes attachments and applies filters.

If you check your mail manually, it is retrieved from the server immediately and delivered to 

Eudora without waiting for user inactivity. However, if you do a manual check and then perform 

a task in Eudora while Eudora is retrieving your mail, Eudora will wait for user inactivity before 

processing your newly retrieved mail. When this occurs, the envelope displays on the status 

bar until the user inactivity time specified has been reached.

NOTE: The envelope that displays on the status bar only indicates that mail is waiting to be 

processed. It does not mean that you have new mail waiting on the server. When your mail is 

processed, user inactivity time is needed for your mail to be filtered and attachments decoded. 

Your inactivity allows you to decide when you want your mail processed.
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Envelope displayed on the status bar

If you click once on the envelope, the mail is processed. If you right-click on the envelope, a 

drop-down list appears. 

Envelope’s drop-down list

• To send or retrieve your messages in the background, choose Process All 
Waiting Tasks . 

• To display the Task Status showing background activity, choose Show Task 
Status .

Task Status Window

The Task Status window displays background activity: retrieving mail from incoming servers 

and sending mail to outgoing servers. Mail can be retrieved and sent from each of your 

personalities simultaneously. Progress information is described in Background Tasks on 

page 336.

To access and display the Task Status window

1. From the Tools menu, choose Task Status. Or, if the Task Status window is in a 

visible tabbed window, click its tab.The Task Status window appears.

Task Status window

Notice the progress indicators on the status bar located at the right-hand bottom of 

the Eudora window. A progress bar and spinning black and white ball indicate that 

background tasks are occurring.
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Progress bar and task progress indicator

On the progress bar or spinning indicator, click to display the Task Status window. 

Right-click to display the indicator’s drop-down list.

Task indicator’s context menu

• Choose Stop All Tasks to cancel the tasks currently occurring.

• Choose Go offline to disconnect from the server. An alert window appears 
letting you know that you are offline and cannot connect to the server. This is 
useful if you are using a laptop computer.

• Choose Show Task Status to display the Task Status window.

You can see if your sent messages are sent, queued, or processing in your Out 

mailbox.

The following icons display to the left of the message name in your Out box:

Following are field descriptions for columns in the Task Status window.

Task—(default) An icon and its description displays in this column indicating what function 

Eudora is performing. In the above example, the Send icon appears. 

Persona—This column is available only if have set up more than one personality. If checked, 

the Personal column displays the personality name for the given task.

Status—(default) Displays a general description of the tasks current status, for example, 

“Logging into POP server.”

Details—Displays more information of the tasks’ status including network protocol commands. 

Message is sent.

Message is queued.

Message is processing.
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Progress—(default) Displays a progress bar indicating the overall progress of the tasks.

Task Error Window

The Task Error window displays an error message as it occurs. In the example below, a 

password error appears. You can indicate if you want the Task Error window brought to the 

front when an error occurs. See Background Tasks on page 336. 

To access and display the Task Status window

1. From the Tools menu, choose Task Errors. Or, if the Task Error window is in a 

visible tabbed window, click its tab.The Task Error window appears.

Task Error window displaying an error

Notice the task error icon  on the Eudora tool/status bar at the lower- right of the main Eudora 

window. Click this icon to display the Task Error message. To expand the message, click 

Details.

Following are field descriptions for the Task Error details window.

Persona—The personality name associated with this error appears.

Title—The name of the Eudora function when this error occurred.

Status—The name of the system function when this error occurred.

Info—More information on this error appears, if any.

Time—The time and day of this error appears.
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Link History 
(Sponsored and Paid modes only)

Link History is a new option on the Tools menu that displays Internet web site URLs, 

attachments, and ads that have appeared in Eudora.

To display your link history

1. From the Tools menu, choose Link History. 

The Link History window appears.

Link History window

2. To view a link in the list, double-click the item or click to highlight it, then click View. 

To remove the link from the list, click Remove.

If you right-click in the Link History window, a context menu appears.

Link History context menu
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Copy—copies the link item to the clipboard.

View—displays the link item’s web site page.

Remove—deletes the link item. 

Change Date Display—displays a submenu allowing you to set reminders when to see the 

link, bookmark the link, or sort the link items by date.

Change Date Display submenu

NOTE: The items in this window expire and do not appear after 30 days.

Statistics Window 
(Sponsored and Paid modes only)

You can now display and print your Eudora usage statistics. These statistics keep track of how 

many messages you receive and send in a particular day, week, month, or year. You can also 

see how many attachments were received and sent as well as how many messages were 

read. In the Sent Email section, you can see how many messages you have replied to, 

forwarded, and redirected during a specific timeframe.

You can also view statistics and charts based on the emails that SpamWatch scores as being 

Junk. Accuracy of statistics is based on your usage of the Junk and Not Junk commands to 

train and correct SpamWatch.

NOTE: Eudora usage statistics are statistics for you only. No statistical information is sent to 

QUALCOMM or any other location.

To display the Statistics window

1. From the Tools menu, choose Statistics. 

The Statistics window appears.
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Sample Statistics window showing received email for one day 

(Sending mail usage not shown.)

Statistics window showing Eudora usage in general

2. From the drop-down menu, choose to see email usage statistics for the Day, 

Week, Month, or Year.

3. To see more statistical information, for example Attachments received, check the 

More Statistics box.
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NOTE: To change the color, graph type, and other settings for the Statistics window, go to 

Statistics (Sponsored and Paid modes only) on page 354 for more information.

Printing the Statistics Report

To print the information in the Statistics window

• With the Statistics window open, go to the File menu and choose Print. 

Your Statistics report will print.
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The Address Book is where you keep information about individuals or groups that you 

correspond with. Each entry in the Address Book includes a name for a person or group, their 

full email address (email addresses for groups), a full name, any contact information including 

both home and work information, other email addresses and information, and any notes. You 

can also use the Address Book to put names on the Recipient List, and to address a new 

message. See Using the Recipient List on page 252.

To open your Address Book

1. From the Tools menu, choose Address Book, or press Ctrl+L, or click the Address 

Book icon  on the toolbar.

Address Book with sample entries
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All of the names are kept in address books, so you can group your names by putting them in 

different address books. Eudora Nicknames is the default address book, and the example 

above shows an additional address book called “Family.”

To show or hide the names in an address book, click the book icon to the left of the file name. 

If the book is closed, the names are hidden; if the book is open, the names appear.

You can use the View By drop-down menu to display the names by different criteria, for 

example by Last Name. If you want to view the entries by Last Name, choose Last Name from 

the View By drop-down list. If you view by a field that does not contain any data, the entry 

appears as the nickname enclosed in brackets preceded by spaces:  <<Dad>>.If you view by 

a field that doesn’t contain any data, the entry appears with << >>.

NOTE: Eudora remembers your selection in the View By field when you quit and restart the 

program.

You can do the following in the address book window:

• You can also start typing in the list of entries, and the appropriate entry is selected 

when you enter enough unique characters to identify it.

• To page up and down in the list of entries, use the arrow keys. To resize the list, drag 

the divider.

• To move the keyboard focus back and forth between the left and right sides of the 

Address Book, press F6.

• To move quickly through the tabbed panels on the right side of the Address Book, 

use the Ctrl+Tab, Ctrl+PgUp, Ctrl+PgDn, Ctrl+Home, and Ctrl+End keys.

Printing Your Address Book

To print your Address Book entries

• While the Address Book is opened, from the File menu, choose Print.
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Searching for Your Address Book Entries

To search for entries in your address book

1. With your address book open, press Ctrl+Shift+F or from the Edit menu, choose 

Text, then Find Text. 

2. In Find dialog, enter the nickname of the person you are searching for. 

That person’s entry appears.

Creating an Address Book within your Address Book 
(Sponsored and Paid modes only)

To create an address book within your Address Book

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address 

Book is an inactive window in an open tabbed window group, click its tab.

2. Click New Book. 

The New Address Book dialog box appears.

New Address Book dialog box

3. Enter a name for the new address book in the text box and click OK. 

The address book appears on the list, and you can now add people and group to 

your newly created address book.

Adding a Person to the Address Book

To create a new entry or entries to be included in the newly created address book

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address 

Book is an inactive window in an open tabbed window group, click its tab.
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2. In the Address Book, choose which address book (if more than one is set up) in 

which you want this person’s information listed, for example “Family.” 

3. Either click New in the Address Book, or right-click anywhere in the entry list to 

display the drop-down list and choose New. 

A new entry appears in the address book column (left side).

Address book - adding a new person

4. In the Nickname field (right side of window), enter what you want to call this person. 

A nickname, sometimes called an alias, is an easily remembered, shorter 

substitute for the email address in the entry. Nicknames can be used in place of 

proper email addresses in the To, Cc, and Bcc header fields of outgoing messages. 

A nickname entered here should be the name you wish to type in a header field 

(To, Cc, Bcc) when composing an email message. For example, although your 

Dad's name is John Smith, you can enter "Dad" as the nickname. So when you 

address a message, you can just enter "Dad" in the header field.
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NOTE: You cannot use the actual email address as the nickname. It must be 

different.

5. If you want the nickname on your recipient list, check the Recipient list box. 

Once the person is on the recipient list, the name is bolded in the address book list. 

6. To create the entry, click anywhere or press Enter. 

7. Click the Personal tab. 

The Personal dialog appears.

Personal dialog box

8. In the Full Name field, type the real name or an informal name for the person. If 

there is just one address for the entry, this name and the address are included in 

the "To:" field for your recipient to see.

9. In the First Name and Last Name fields, type the first and last name of the person. 

You can interchange the first and last names by clicking .

10. In the This nickname will expand to the following addresses text field, enter at least 

one complete email address for this person. If this person has more than one 

address, enter the additional addresses here if you want him or her to receive your 

messages at each address. 
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Make sure this field contains no other information except addresses and 

nicknames, or your messages will be addressed incorrectly.

It is recommended that you have no more than 2,000 nicknames per nickname file. 

If the files are too large, they may appear collapsed in the address book, but you 

can still use all the nicknames when addressing messages. If you have a large 

number of entries, you might want to consider using a Ph or LDAP server.

11. To save your changes to the Address Book, from the File menu choose Save.

Adding a Group to the Address Book

You can set up a group as an address book entry by adding the group’s email addresses or 

nicknames (if already set up in your address book) in the Personal dialog box.

To create a new group in an address book

1. From the Tools menu, choose Address Book, or press Ctrl + L. Or, if the Address 

Book is in an inactive window in an open tabbed window group, click its tab.

2. In the Address Book, choose which address book (if more than one is set up) in 

which you want this group's information listed. Click New.

3. Type the nickname in the Nickname text field on the right side of the window, for 

example "My buddies." 

The nickname entry appears in the list, and you can now add information for this 

entry.

4. When finished, click anywhere or press Enter and the nickname appears in the list.

5. Click the Personal tab. 

The Personal dialog box appears.
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Address Book Personal dialog box (group)

6. In the Full Name field, type the a descriptive or an informal name for the group. This 

name is included in the "To" field for your recipient to see.

7. In the This nickname will expand to the following addresses text field, type the 

complete email address for each person included in the group. Separate multiple 

addresses with commas or carriage returns (this is the only place you can use a 

carriage return to separate addresses). You can also use nicknames in this field, 

but be sure that any nicknames you use are defined by their own entry. You can 

use a mixture of nicknames and complete email addresses.

NOTE: Make sure this field contains no other information except addresses and 

nicknames, or your messages will be addressed incorrectly.

8. If you want to put this group on your recipient list, check the Recipient List box.

The group’s name is bolded in the address book list.
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Adding Entry Information

In the Eudora Address Book, there are several dialogs in which you can add information for a 

person or a group. These text fields may be used liberally when entering information. 

Following is a description of each dialog. Personal dialog is described in the Adding a Person 

to the Address Book on page 235.

To enter Home information for this entry

1. In the left side of the window, choose the entry for whom you want to enter 

information. His or her nickname appears in the Nickname field.

2. Click the Home tab. 

The Home dialog box appears.

Address Book Home dialog box

3. In this dialog box, you can type postal information, phone numbers, and a web site 

address for this person. All fields are optional.

4. If you'd like to swap the Home and Work information, click Swap with Work.

5. If the information listed here is this person's main information, check the Primary  
Information box.
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To enter work information

1. Click the Work tab. 

The Work dialog box appears.

Work dialog box

2. In this dialog, you can type the person's work information, including title, company 

name, postal address, phone numbers and a web site address for this person's 

company. All fields are optional.

3. If you'd like to swap the work and home dialog information, click Swap with Home.

4. If the information listed here is this person's main work information, check the 

Primary Information box.

To enter other information

1. Click the Other tab. 

The Other dialog box appears.
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Other dialog box

2. In this dialog, you can type other email addresses, phone numbers, and web site 

addresses for this person. All fields are optional.

To enter more information on this person

1. Click the Notes tab. 

The Notes dialog box appears.



243

Using the Address Book

Notes dialog box

2. In this dialog, you can type anything you want. This is good place to enter 

information such as the person's birthday and other important dates specific to this 

person.

To save your changes to the Address Book

• From the File menu, choose Save or press Ctrl+ S. Or if you close the Address 
Book, click Save in the warning dialog.

NOTE: If your Address Book has duplicate entries, Eudora recognizes only the 

topmost entry of the duplicates.

Changing, Deleting, Moving, Copying and Saving 
Entries

• To change the nickname for an entry, see the next section, “Renaming a Nickname.” 

• To change an Address Book entry, choose the entry from the list and edit the fields 

in any of the address book’s dialog boxes as appropriate.
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• To delete an entry or an address file, select it from the list and click the Delete button 

or press the Delete key. Or, right-click it and select Delete from the drop-down list. 

You cannot remove the Eudora Nicknames file.

• If a nickname file is set to read-only, meaning you cannot change it, you cannot move 

or copy entries into it, or delete an entry from it.

• To save your entries, from the File menu, choose Save. Your address book entries 

are saved.

NOTE: You save your address book entries in CSV format. This allows you to save the entire 

contents of your address book as a single CSV formatted file. With your address book open, 

from the File menu, choose Save As. The Save As dialog appears for you to save the .csv file. 

To save only selected address book entries, hold the Ctrl key down when selecting entries.

To move or copy an entry to another address book

1. Right-click the address book entry to display the drop-down list.

2. From the drop-down list, choose Move To to move an entry or Copy To to copy an 

entry. 

The Choose a Nickname File dialog box appears so that you can select the file to 

which you want to move or copy the entry.

Choose a Nickname File dialog box

3. You can move an entry (or entries) to a different file by dragging it, or copy it by 

holding down the Shift or Ctrl key and then dragging it.

You cannot move an entry into the file it is already in, but you can copy an entry 

into its file. A “Copy of [Entry]” is created.

4. To save your changes, from the File menu, choose Save. 

TIP: Add a button for the File menu’s “Save” ctrl to your main toolbar as a handy 

way to save Address Book changes.
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Renaming a Nickname

To change the nickname for an Address Book entry

1. Set the View By field to Nickname and make sure the desired entry appears in the 

list.

2. Click the nickname for the entry, pause, and click it again. You can then edit the 

nickname in the edit box that appears.

Alternately, click the nickname once to highlight it, then in the Nickname field in the 

Personal dialog box, enter the new nickname and press Enter.

NOTE: If you change a nickname, be sure to correct any entries that reference that 

nickname.

Addressing a New Message from the Address Book

You can open and address a new message from the Address Book using the To:, Cc:, and Bcc: 

buttons.

To create a new message from the Address Book

1. In the Address Book entry list, choose the entry you want to address the message 

to. To choose multiple entries in sequence, hold down the Shift key, or to select 

entries non-consecutively, hold down the Ctrl key

2. Click To:, Cc:, or Bcc: at the bottom of the Address Book. 

A new composition window appears with the selected nickname(s) inserted in the 

recipient field. 

NOTE: Also, you can double-click an entry to enter that nickname in a header field. A new 

composition window is opened and the nickname is entered in the To: field automatically. If a 

composition window is open when you double-click, the nickname is entered in the header 

field that last had keyboard focus.

To address the message with the completely expanded address or addresses for 
that entry, rather than the entry’s nickname (the addresses are listed in the 
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Address(es) field for the entry)

1. From the Tools menu, choose Options.

2. Scroll and choose Miscellaneous. 

The Miscellaneous dialog box appears.

3. Turn on the Automatically Expand Nickname option.

Once the composition window appears, you can use the To:, Cc:, and Bcc: buttons to insert 

additional nicknames into the corresponding fields, subject to the following restrictions.

• If the Address Book is a docked or floating window, either alone or as part of a tabbed 

window group, the To:, Cc:, and Bcc: buttons apply to the topmost composition 

window, if any. 

• If the Address Book is a normal window, either alone or as part of a tabbed window 

group, the To:, Cc:, and Bcc: buttons apply to the composition window, if any; that is, 

immediately under either the Address Book or the tabbed window group containing 

the Address Book. 

Make Address Book Entry Command

The Make Address Book Entry command is used to create entries in your Address Book and 

is especially helpful for making group entries.You can use this command from anywhere in 

Eudora, including open messages, open mailbox windows, the Address Book, and the 

Directory Services window.

To use the Make Address Book Entry command, do one of the following:

• In an open window, go to step 1.

• In an open mailbox window, first select the message summary or summaries you 

want in the address book, then go to step 1.

1. From the Special menu, choose Make Address Book Entry. 

The Make Address Book Entry dialog box appears.
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Make Address Book Entry command and dialog box

2. In the Nickname text box, Eudora enters the name in the email address or the 

message. You can change it if you like.

3. In the Full Name field, Eudora enters the full name as it appears in the email 

address of the message. You can change it if you like.

4. In the First Name and Last Name fields, Eudora enters the first and last name of 

the person as it appears in the email address or the message. You can change it if 

you like.

5. In the This nickname will expand to the following address field, Eudora enters the 

email address as it appears in the message. You can change the email address if 

you like.

If you choose multiple message summaries in the mailbox window, addresses are 

taken from each message and all are put in the new entry.

If the open or selected message is an outgoing message, the new entry will include 

all of the addresses in the To:, Cc:, and Bcc: fields.

If the open or selected message is an incoming message, the new entry will include 

the address in the From: field.

6. If you have more than one address book, in the In the Address Book drop-down list, 

choose the address book in which you want to place this nickname. You cannot 

make a new address book using the Make Address Book Entry command.

7. If you want to put the nickname on your Recipient List, check the Put it on the 
recipient list box.

8. If you want to put the nickname on your BossWatch List, check the Put it on the 
BossWatch list box.
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9. When finished, click OK. 

The new entry is now in your address book.

NOTE:  If your new nickname has the same name as an existing nickname, a prompt appears 

asking if you want to add the address(es) to the existing nickname or replace the existing 

nickname with the new address(es).

Also, when you use the Make Address Book Entry command in an open message or mailbox 

window, Eudora uses your current Replying settings. If the Reply to all By default setting is 

turned on, the new entry will include all of the recipients of the message plus the sender. 

However, if the Include yourself setting is turned off and the current message is an incoming 

message, your address is not included in the new entry.

Creating a Group from the Address Book

You can take several of your existing nicknames and group them together under one 

composite nickname. For example, you can quickly combine your Family, Friends, and School 

nicknames under a composite nickname called Everybody. The Everybody entry contains the 

nicknames Family, Friends, and School, rather than their expanded email addresses. 

However, if you address a new outgoing message to Everybody, it will be sent to all of the 

email addresses contained in the Family, Friends, and School entries.

To make entries from the Address Book

1. From the Tools menu, choose Address Book. Or, if the Address Book is in a group 

of tabbed windows, click its tab. 

The Address Book window appears.

2. Choose several different entries in the entry list (hold down the Shift key to select 

multiple entries in sequence, or the Ctrl key to make nonsequential selections).

3. From the Special menu, choose Make Address Book Entry. 

The Make Address Book Entry dialog appears.
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Make Address Book Entry dialog box

4. In the Nickname text box, type a nickname for the new entry.

5. In the Full Name field, type a descriptive name for this group.

6. In the This nickname will expand to the following address field, Eudora displays the 

nicknames you selected from the Address Book. You may add more nicknames 

and email addresses if you'd like.

7. If you have more than one address book, in the In the Address Book drop-down list, 

choose the address book in which you want to place this group.

8. If you want to put the group on your Recipient List, check the Put it on the 
recipient list box. 

9. If you want to put the nickname on your BossWatch List, check the Put it on the 
BossWatch list box.

10. When finished, click OK. 

The new group is now in your address book.

NOTE:  If your new group has the same name as an existing group name, a prompt appears 

asking if you want to add the address(es) to the existing name or replace the existing name 

with the new address(es).

Finish Address Book Entry Command

By using the Finish Address Book Entry command, you can enter a unique portion of a 

nickname in the To:, Cc:, or Bcc: fields of a message.
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To use the Finish Address Book Entry command to complete a nickname in your 
message

1. In the To:, Cc:, or Bcc: field, type a unique portion of the nickname.

2. From the Edit menu, choose Finish Address Book Entry. 

The nickname drop-list for that letter appears.

3. Choose the desired nickname from the list.

To insert the real addresses for the entry instead of the nickname

• Hold down the Shift key and from the Edit menu, choose Finish & Expand 
Address Book Entry. 

To set this auto-expansion to happen all the time (so that you don't have to hold 

down the Shift key), check the Automatically Expand Nicknames box in the 

Miscellaneous options in Options under the Tools menu.

For an alternate way to complete nicknames, see the section, Using Automatic Name 

Completion (Sponsored and Paid modes only) on page 39.

Using the BossWatch List

The BossWatch List is your list of recipients you wish to call special attention to when 

composing messages.

To add a nickname to the BossWatch List

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address 

Book is an inactive window in an open tabbed window group, click its tab.

2. Click to select the desired entry in your Nickname list. 

3. On the right side of the window, check the BossWatch List box, or right-click the 

selected item to display the drop-down list.

BossWatch List checkbox in the Address Book
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4. From the drop-down list, choose Add to BossWatch List. The entry’s nickname is 

added to the BossWatch List, and the entry is displayed with a red exclamation 

point in the Address Book list.

To remove an entry from the list

1. Open the Address Book.

2. Click to select the desired entry in your Nickname list.

3. Right-click the item to display the drop-down list.

4. From the drop-down list, choose Remove From BossWatch List. The entry’s 

nickname is removed from the BossWatch List and the entry’s icon no longer 

displays a red exclamation point in the Address Book list. 

Including Nicknames on the Recipient List

To include a nickname in the Recipient List

1. Right-click the appropriate Address Book entry in the list to display the drop-down 

list. 

2. From the drop-down list, choose Add to BossWatch List. 

The nickname for the selected entry is included on the BossWatch List, and the 

entry is displayed with a red exclamation point in the Address Book list.

To remove a nickname from the BossWatch List

1. Right-click the item in the Address Book list to display the drop-down list.

2. From the drop-down list, choose Remove From BossWatch List. 

The nickname for the selected entry is removed from the BossWatch List, and the 

entry’s icon no longer displays a red exclamation point in the Address Book list.

You can add or remove multiple nicknames to or from the BossWatch List by selecting multiple 

entries before right-clicking. Hold down the Shift key to select multiple entries in sequence, or 

the Ctrl key to select entries non-consecutively.
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Using the Recipient List

The Recipient List is your list of recipients to whom you often send mail.

To add a nickname to the Recipient List

1. From the Tools menu, choose Address Book, or press Ctrl+L. Or, if the Address 

Book is an inactive window in an open tabbed window group, click its tab.

2. Click to select the desired entry in your Nickname list. 

3. On the right side of the window, check the Recipient List box, or right-click the 

selected item to display the drop-down list.

Recipient List checkbox in the Address Book

4. From the drop-down list, choose Add to Recipient List. The entry’s nickname is 

added to the Recipient List, and the entry is bolded in the Address Book list.

To add an email address to the Recipient List

1. Open the Address Book.

2. Select the text that makes up the full address. 

3. From the Special menu, choose Add as Recipient.

The recipient’s email address is added to your Recipient List.

To remove an entry from the list

1. Open the Address Book.

2. Click to select the desired entry in your Nickname list.

3. Right-click the item to display the drop-down list.

4. From the drop-down list, choose Remove From Recipient List. The entry’s 

nickname is removed from the Recipient List and the entry is unbolded in the 

Address Book list. Or, select the item you wish to remove from the Remove 

Recipient submenu under the Special menu.
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To open a new message addressed to someone on your Recipient List

1. From the Message menu, choose New Message To, Forward To, or Redirect To. 

2. From the displayed list, select the nickname. A new message window appears 

addressed to the nickname you selected.

To insert a recipient into a message that you have already opened

1. Move the cursor to where you want the recipient.

2. From the Edit menu, choose Insert Recipient. 

The Insert Recipient submenu appears.

3. From the Insert Recipient submenu, choose the recipient. 

The recipient you choose is inserted into the opened message.

To insert the real address(es), instead of a nickname

1. Hold down the Shift key and from the Edit menu, choose Insert Recipient. 

The Insert Recipient submenu appears.

2. From the Insert Recipient submenu, choose the recipient. The real address of the 

recipient is inserted in the message. To set this to happen all the time, select the 

Automatically expand nicknames option in the Miscellaneous options window.

More than one recipient from the Recipient List can be added to the To:, Cc:, and Bcc: fields 

of any message. If you use the Insert Recipient submenu, commas are added where 

necessary.

Including Nicknames on the Recipient List

To include a nickname in the Recipient List

1. Right-click the appropriate Address Book entry in the list to display the drop-down 

list. 

2. From the drop-down list, choose Add to Recipient List. 

The nickname for the selected entry is included on the Recipient List, and the entry 

is bolded in the Address Book list.
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To remove a nickname from the Recipient List

1. Right-click the item in the Address Book list to display the drop-down list.

2. From the drop-down list, choose Remove From Recipient List. 

The nickname for the selected entry is removed from the Recipient List, and the 

entry is unbolded in the Address Book list.

If you change a nickname, the Recipient List is updated as appropriate. For details about using 

the Recipient List, see Using the Recipient List on page 252.

NOTE: You can add or remove multiple nicknames to or from the Recipient List by selecting 

multiple entries before right-clicking. Hold down the Shift key to select multiple entries in 

sequence, or the Ctrl key to select entries non-consecutively.
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Using Central Address Book Files on a Server

You can set up central Address Book files on a server and configure Eudora clients so that 

they refer to the central files.

NOTE: You should be an expert user or an administrator to perform this function.

First, be sure the files are plain text, have a .txt extension, and are formatted as follows: one 

nickname on each line with the real addresses separated by commas, and one line for notes 

and info with the Notes text following the Info data. For example:

alias Wow joe@wow.com,lisa@wow.com,chris@wow.com 
note Wow <fax: 222.2223><phone: 222.2222><address:1234 Street> 
<name:Wow Inc.>My favorite company

Then, for each client application, add an “ExtraNicknameDirs” entry to the [Settings] section 

of the Eudora.ini file. This entry should be followed by the list of directories that contain 

Address Book files, separated by semicolons (;). Any Address Book files located in those 

directories are added to the Address Book. You will need to exit and re-open Eudora to see 

the new entries.

Using Address Book Files Not Created by Eudora

To use an Address Book file that was not created in Eudora, put the file in the Nickname 

directory located in your Eudora folder, and be sure the format is as shown in the previous 

section “Using Central Address Book Files on a Server.” You will need to exit and reopen 

Eudora to see your new entries in the Add ress Book. 

NOTE: You can migrate your address book from Netscape Messenger, Outlook Express, 

Microsoft Outlook to Eudora. See Importing Settings to Create a Personality on page 123. 
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Opening Directory Services

Eudora lets you look up information about people on the Internet, within your company, and in 

your Eudora Address Book using four directory service protocols. 

• Ph 

• Finger 

• Lightweight Directory Access Protocol (LDAP) 

• Eudora Address Book

To use directory services to search for someone

1. From the Tools menu, choose Directory Services. Or, if the Directory Services 

window is an inactive window in a visible tabbed window group, click its tab. 

The Directory Services window appears.

Directory Services window with an example query
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The directory service protocols available for your search are listed in the Protocols section of 

the window. For more information, see Using Directory Service Protocols on page 263. 

The databases you can use to look up your target individual are listed in the Databases list. 

For more details, see Using Directory Service Databases on page 264, Adding a New 

Database (Server) on page 265, Modifying a Database on page 275, and Deleting a Database 

on page 276. 

Keeping the Directory Services Window on Top

To keep the Directory Services window on top so that you can easily continue using it, select 

the “Keep On Top” option located at the bottom of the left pane. Eudora remembers the state 

of this option when you quit and restart the program.

NOTE: The behavior of this option is subject to the restrictions in the section Considering the 

State of the Window on page 263.

Making a Query

You can look someone up on the Internet, within your company, or in your Eudora Address 

Book. open the Directory Services window

NOTE: If you are using Eudora in Light mode, you cannot make multiple or simultaneous 

queries.

To make a query on someone

1. From the Tools menu, choose Directory Services. 

The Directory Services window appears.

2. In the Databases list, select the database(s) you want to search in your query.

To select a database, click the checkbox to the left of the database until a 

checkmark appears in the box. You can select multiple databases, and you can 

use multiple protocols. You must select at least one database in the list for Eudora 

to perform the query.

NOTE: Eudora remembers which databases you’ve selected when you quit and 

restart the program.
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3. In the Query field, type a text string you want to search against.

If one or more of your selected databases use a protocol other than Ph, your entry 

in this field is always interpreted as a name. If you have only Ph servers selected 

as your databases, you can enter any commands that Ph will interpret.

4. To start the query, press Enter or click Start. 

The query begins, and the Start button changes to Stop. 

To stop the query before it is completed, click the Stop button. When the query is 

completed, or if you click Stop to cancel the query, the Stop button changes back 

to Start.

Automatic Name Completion in Directory Services 
(Sponsored and Paid modes only)

When looking up names in Eudora’s Directory Services, Eudora remembers the name and 

places it in a directory services history file. So whenever you begin typing a name, a drop-

down list of names from your history file displays alphabetically. Just select the desired name 

from the list, and the name’s information appears. Following is an example of the auto name 

completion function.

Directory Services Auto Name Completion
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Reading Query Results

Your query results are listed in the left half of the Directory Services window, in the results list 

(top view) and the details pane (bottom view). You can resize the two views relative to each 

other by dragging the separator up or down.

The results list consists of one-line summaries of the “hits” or successful targets of your query. 

These are listed by four columns: 

• Name—indicates the username (or other name) of the target.

• Email—is the email address of the target. 

• Phone—is the target’s telephone number. 

• Database—tells you in which of your selected databases the target was found.

Click a column heading to sort the results list alphabetically or numerically by that column. 

Shift-click to sort in reverse order.

To resize the columns, drag the divider line to the right of the desired column to the left or right. 

Note that the columns resize dynamically during a query, to accommodate the width of each 

target’s data.

The Status field displays the status of your query, such as Ready, Connecting, Getting Data, 

etc. and the number of items found as shown in your summary list. This number is updated 

dynamically until the query is complete or you stop it.

If the results list does not fit in the available viewing space, scroll bars appear to let you 

navigate through the remaining part of the list.

To view the details of a result in the details pane, select the result in the results list by clicking 

once on it. The full data appears in the details pane. If nothing is selected in the results list, the 

details pane is blank. If multiple summaries are selected in the results list, the details pane lists 

the details for each item, with each item separated by a divider line.

To select multiple items in the results list, use the Shift key to select a continuous range, or use 

the Ctrl key to make non-consecutive selections.

Scroll bars appear in the details pane if the displayed information cannot fit in the viewing 

space.
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Addressing a Message from the Directory Services 
Window

You can create and address a message with the query results in the Directory Services 

window.

To create a new message

NOTE: Make sure there are no outgoing messages already open. 

1. Perform your query.

2. Click to select one or more summaries in your results list. 

3. Click the To:, Cc:, or Bcc: button.

A new message is created, and it is addressed appropriately with the selected 

query results.

To add an address to an existing message

NOTE: Make sure the message you want to address is active.

1. From the Tools menu, choose Directory Services, or if the Directory Services 

window is an inactive window in a visible tabbed window group, click its tab. 

The Directory Services window appears.

2. Perform the query.

3. Click to select one or more summaries in the results list. 

4. Click the To:, Cc:, or Bcc: button. 

The addresses from the selected query results are added to the appropriate field 

of the current message.

NOTE: The behavior of the To:, Cc:, and Bcc: buttons is subject to the restrictions 

in Considering the State of the Window on page 263.
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Making an Address Book Entry from Query Results

You can make a nickname from your query results in the Directory Services window and at the 

same time add the entry to your Address Book.

To make a nickname from your query results

1. From the Tools menu, choose Directory Services, or if the Directory Services 

window is an inactive window in a visible tabbed window group, click its tab. 

The Directory Services window appears.

2. Perform the query.

3. Click to select one or more summaries in the results list. 

4. From the Special menu, choose Make Address Book Entry. 

The Make Address Book Entry window appears so that you can name the 

nickname. 

The real name and email address for each selected query result is included in the new entry.

NOTE: The use of this command from this window is subject to the restrictions in Considering 

the State of the Window on page 263.

Printing Your Query Results

You can print and print preview the results of your query as shown in the details pane.

First perform your query, then select one or more summaries in the results list. The details 

pane lists the details of each selected item, with each item’s details separated by a divider line.

To preview your query details for printing

• From the File menu, choose Print Preview. 

The Print Preview window appears, showing how the query details will look 

when printed.

To print your query details

• From the File menu, choose Print.
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NOTE: The use of these commands from this window is subject to the restrictions in the next 

section, “Considering the State of the Window.” 

Considering the State of the Window

The behavior of some Eudora features internal and external to the Directory Services window 

depends on the state of the window. For definitions of window states, see on Managing 

Windows in Eudora on page 197. 

When the Directory Services window is in the docked or floating state, either alone or as part 

of a tabbed window group, the following applies.

• Keep on top setting in the window is ignored.

• To:, Cc:, and Bcc: buttons in the window apply to the topmost composition window, 

if any.

• Special menu’s Make Address Book Entry command, and the File menu’s Print 

Preview and Print commands apply to the Directory Services window only if the 

keyboard focus is in that window.

• When the Directory Services window is in the normal state, either alone or as part of 

a tabbed window group, the following applies.

• Keep on top setting in the window is obeyed.

• To:, Cc:, and Bcc: buttons in the window apply to the composition window, if any, 

immediately under the Directory Services window or the tabbed window containing 

it.

• Special menu’s Make Address Book Entry command and the File menu’s Print 

Preview and Print commands apply to the Directory Services window only if it is the 

topmost normal window and is active, Or if the tabbed window containing it is the 

topmost normal window and the Directory services tab is active.

Using Directory Service Protocols

Protocols are used to access in Directory Services to find information on persons by entering 

their name, email address, etc. The Protocols section of the Directory Services window lists 

the directory service protocols available to you to use when looking up individuals via these 

services.
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Eudora comes with four installed protocols.

• Ph 

• Finger 

• LDAP (Lightweight Directory Access Protocol) 

• Eudora Address Book

NOTE: The Eudora Address Book protocol does not appear in the list until you have created 

an Address Book in Eudora.

Click the column heading, Registered Drivers, to sort the protocols alphabetically. Shift-click 

the column heading to sort in reverse order.

You can resize the column by dragging the divider line to the right of the column heading to 

the left or right.

The use of the New Database button shown in this section of the window, is described under 

Adding a New Database (Server) on page 265.

Using Directory Service Databases

The Databases section of the Directory Services window lists the databases that are available 

to you for searching for individuals over the Internet, within your company, or in your Address 

Book.

Eudora comes with these servers already configured by default.

• ldap.bigfoot.com

• ldap.switchboard.com

• ldap.whowhere.com

• ldap.infospace.com

• ldapbiz.infospace.com

• ldap.four11.com
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• Eudora Nicknames—or the name of your nicknames file. This last item appears only 

if you have a Eudora Address Book set up.

You can modify or delete these databases, and you can also create new databases. See the 

following sections for more information.

You use the databases in this list to perform your lookup queries. To perform a query, you must 

first select one or more databases in the list. To select a database, click the checkbox to the 

left of the database name until a checkmark appears in the box. If no databases are selected, 

you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click a column heading to sort this list by that column, alphabetically. Shift-click the column 

heading to sort in reverse order.

To resize columns, position the mouse pointer over the divider line to the right of the desired 

column, and drag the line to the left or right.

The use of the Modify button in this section of the window is described in Modifying a Database 

on page 275. The use of the Delete button is described in Deleting a Database on page 276.

Adding a New Database (Server)

In addition to the default directory service databases that already come configured with 

Eudora, you can add new Ph, Finger, and LDAP databases for your Directory Services 

queries. By adding a new database, you can then query that database for names, email 

addresses, phone numbers, etc. Databases are created from the Protocols section of the 

window, and they must be created using one of these three listed protocols.

TIP: You must be able to identify the server by its description and its host name before you can 

add it to Directory Services.

NOTE: You cannot create a new database using the Eudora Address Book protocol in the list. 

Nickname files must be created from the Address Book window. See on Using the Address 

Book on page 233 for more details. 
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Ph Database

Ph is an online, fully indexed, fast-access white-pages directory service developed and freely 

distributed by the Computer and Communications Services Office at the University of Illinois 

at Urbana.

To add a new Ph database 

1. In the Protocols list, click the Ph protocol to select it. 

2. Click New Database. Or, just double-click Ph in the Protocols list. 

The New Database window, General panel, appears.

Ph Database window, General panel

3. In the General panel, enter a descriptive name for the Ph server, its Host Name or 

IP address of the Ph server, and the Port in the respective fields. The default port 

for Ph is 105. Don’t change this port number unless you know for certain that the 

port number is not 105. 

4. Select the Attributes tab to display the Attributes panel. 

The Attributes pane appears.
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Ph Database window, Attributes panel

In the Attributes panel, you can add, edit, or remove attributes that display in the Results List 

(top-half of left window) and in the Details List (bottom-half of left window). Following is an 

example of a Results and Details List.

 Results and Details List (left pane of Directory Services window)

Results List

In the Results List, the data associated with the Ph attributes you name appear in the columns 

on the left pane of the Directory Services window. You do this by mapping attributes to one of 

the three special Present A field selections: Name, Email(w), and Phone(w). See step 5.

Results List

Details List
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For example, if you want to display the data associated with the Ph attribute “Full_Name” in 

the column named “Name” in the Results List, add an attribute mapping for “Full_Name” with 

“Name” selected as the “Present As” value.

Details List

Any attribute name can be renamed before it appears in the Details List. This is done via the 

Present As field. Simply replace the text in the Details List with alternate text.

For example, if your Ph server is configured to display an attribute called Full_Name but you 

want only Name to display, you need to map “Full_Name” to “Name” using the “Present As” 

field. Therefore, any Ph query you perform on that server would display the “Full_Name” data 

in the Name column in the Results List.

To manage the attribute list:

1. So one of the following:

• To add an attribute mapping to the attributes list, click Add. 

• To edit an attribute mapping, click the attribute on the list and click Edit. Edit the 
attribute name. 

• To remove an attribute mapping, click to select it and then click Remove. 

Add an Attribute 

2. When you are finished making entries or changes, click OK. 

The attributes are added to or changed in the database. 
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Attributes panel showing new attribute

If you added a new database, the database is added to the Databases list with its 

checkbox.

Finger Database

Finger is an Internet directory service similar to Ph. 

To add a new Finger database

1. In the Protocols list, click the Finger protocol to select it. 

2. Click New Database. Or, just double-click Finger in the Protocols list. 

The New Database window, General panel, appears. 

3. Finger Database window, General panel
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4. In the General panel, enter a descriptive name for the server, the Host Name or IP 

address of the server, and the Port in the respective fields. The default port for Ph 

is 79. Don’t change this port number unless you know for certain that the port 

number is not 79.

5. To create the new Finger database, click OK. 

A Finger database is created.

LDAP Database

LDAP means Lightweight Directory Access Protocol. An LDAP server is a service that 

provides information about individuals. You can look up virtually anyone on the Internet using 

public LDAP servers. And furthermore, you can add new LDAP servers to query in Eudora.   

To add a new LDAP database 

1. In the Protocols list, click the LDAP protocol to select it. 

2. Click New Database. Or, just double-click LDAP in the Protocols list. 

The New Database window, Network panel, appears.

LDAP Database window, Network panel

3. In the Network panel, enter a descriptive name for the server, the Host Name or IP 

address of the server, and the Port number in the respective fields. If you select the 

This server requires me to log on option, new fields appear in which to enter an 

Account name and a Password. However, most LDAP servers do not require you 

to log in. Enter values in these fields if you have specific instructions from your 

LDAP administrator to so do. 
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4. Select the Attributes tab to display the Attributes panel.

 LDAP Database, Attributes panel

1. In the Attributes panel, you can add, edit, or remove attribute mappings using the 

buttons displayed just below the window. You use the Attribute list to manage how 

information appears in the query results list and query results details portion of the 

screen. 

2. To add an attribute mapping, click Add. 

The Add Attribute list appears. 

LDAP Database window, Attributes panel, Add Attribute

3. In the Attribute Name text box, enter the name for the attribute you wish to add a 

mapping for, for example, cn for common name. You must know the raw field 

names for the particular LDAP server you are adding.
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Listed are the most common raw LDAP field name attributes. 

c — Country, expressed in a two-letter country code, for example US (United 

States), CA (Canada), UK (United Kingdom), FR (France), etc. 

st — State or province, expressed in a two-letter state code, for example, California 

(CA), Massachusetts (MA), Ontario (ON). etc. Also, if a country is considered a 

“state,” for example, France, then this field can show a city name, such as Paris.

l — Location, that is a city, county, etc., for example San Diego, Montreal, London, 

Paris, etc.

mail — Person’s email address. More than one email address may be listed, and 

more than one search listing may be returned for an individual with multiple email 

addresses.

gn — Also Givenname. The person’s first name and/or middle initial, or any part of 

the person’s name before the last name, for example, John W, A Raymond, 

etc.Titles are sometimes given, such as Dr., Ms., etc. 

sn — Person’s surname or last name. Suffixes are sometimes given, such as Jr., 

III, M.D., Esq., etc.

cn — Person’s common name. This includes the given name: first, middle initial, 

prefix and the person’s last name including suffixes.

o — Organization, which includes companies, universities, non-profit 

organizations, government agencies, etc.

4. In the Presented As text box, enter the text for the attribute you wish to see 

displayed on the query results list, or click the down arrow to display some common 

attribute names.

NOTE: Three of the four columns in the query results list window can be assigned 

to any attribute you wish, but you cannot change the name of the column heading. 

To change the attribute that is assigned to each column, enter an attribute in the 

Attribute Name field, such as, cn, sn, gn, etc. Then select either Name, Email(w), 

or Phone(w) in the Present As list, which corresponds to the Name, Email, and 

Phone columns in the Results List. You cannot change what appears in the 

Database column. It always contains the name of the server where the data was 

found.

For example, if you want to display “cn” in the Name column, “TelephoneNumber” 

in the Phone column, and “mail” in the Email column, you would set up the 

attributes like this.
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Attribute Name Present As (from drop-down list)

cn Name 

Telephone NumberPhone(w) 

mail Email(w) tribute Name

In the Details portion of the Results window, you can assign more readable 

attribute names.

Attribute Name   Present As (from drop-down list)

l Location 

st State 

If you were to assign the names above, “State:Texas” would display instead of 

“St:Texas.”

In the attribute list, check the only display these attributes box if you want to limit 

what appears to only those attributes that are mapped. 

NOTE: In the Present As drop down list, there is a choice called Not Displayed. If 

you choose Not Displayed, you can prevent a particular attribute from being 

displayed. For example, mapping the c (country) attribute to Not Displayed will 

have c removed from the displayed results in the Details List. This is useful if there 

is an usually long or confusing attribute you don’t want to display in the window.

5. Select the Search Options tab to display the Search Options panel.

LDAP Database window, Search Options panel
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6. On the Search Options panel, specify the Search timeout by moving the bar 

indicator. You can adjust the bar indicator for a short to long timeout.

7. In the Maximum number of matches to return text box, you can select the up arrow 

to increase or the down arrow to decrease the number of matches you’d like to see 

displayed. Or select the No Limit option to specify unlimited matches.

8. In the Search Base text box, you can specify a part of the LDAP server to limit your 

search. See your LDAP administrator to specify the value in this field. However, the 

default is usually sufficient. 

9. In the Worldwise Search Filter, you enter a type of search filter to form word 

queries. cn=*^0* is the default.   The ^0 is substituted for each word to form a set 

of word queries. The purpose of this filter is to form a term for a word and then 

(AND) the terms together. Examples appear below.

Query: John Smith

Configuration: default (cn=*^0*)

Filter:  
(& (cn=*John*)(cn=*Smith*) )

Records in which “cn” attributes contain “john” and “smith” are returned. Using the 

wildcard asterisks (*) before and after “john” and “smith” would return matches 

such as “Johnathon Smithson.” If you wish to search whole words, remove the 

wildcard asterisks. The above example would also return records such as "John 

Dean Smith" and "Smithers Johnson."

Query: John Smith

Configuration: ( | (cn=*^0*)(sn=*^0*)(gn=*^0*)(givenname=*^0*))

Filter:  
(& 

(|(givenname=*John*)(cn=*John*)(sn=*John*)(gn=*John*))  

(|(givenname=*Smith*)(cn=*Smith*)(sn=*Smith*)(gn=*Smith*)) 

) 

The default search filter in this example would possibly return more records than 

the default because it searches more fields for a substring match of the word.

10. In the Whole-query Search Filter, you enter a type of search filter to create a term 

for the whole query. You can set this filter as an alternate (OR) for the worldwise 

search filter results. Examples appear below. 

Query: John Smith: whole query search filter
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Configuration:  
whole word (cn=*^0*)  
word-wise (|(cn=*^0*)(sn=*^0*)(gn=*^0*)(givenname=*^0*))

Filter:  
(| 
 (cn=*John Smith") 

 (& 
     (|(givenname=*John*)(cn=*John*)(sn=*John*)(gn=*John*)) 

     (|(givenname=*Smith*)(cn=*Smith*)(sn=*Smith*)(gn=*Smith*)) 
 ) 
) 

11. Select the Log tab to display the Log panel.

LDAP Database window, Log panel

12. In the Log panel, specify whether you want to generate log files and if so, how to 

store them; specify whether you want to enable logs for Protocol interactions and/or 

a Configuration data load/store. 

13. Enter a Log file name or select one using the Browse button. And if you want new 

logs to replace the old ones, select the Overwrite existing log file option. 

14. When all your information is entered in the New Database window, click OK. 

A new LDAP database is created with its checkbox.

Modifying a Database

You can modify any Ph, Finger, or LDAP database in your Databases list.
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NOTE: You cannot modify a Eudora Address Book database from the Directory Services 

window, but you can view the path where the file is stored. Nickname files must be modified 

from the Address Book. See Using the Address Book on page 233 for more details. 

To modify an existing database

NOTE: You can only modify one database at a time. Multiple selections disable the 

modify feature.

1. Click the database name or icon in the Databases list to select it.

2. Click Modify. Or, just double-click the database in the list. 

The Modify Database window appears with its text boxes containing information 

from the selected database.

3. In the Modify Database window, make your changes.

4. To save the changes and close the window, click OK, or click Apply, save the 

changes and leave the window open. You can then make additional changes and 

save or discard them.

The Modify Database window will differ depending on the protocol you’ve selected. For details 

on the fields of the different dialogs, see Adding a New Database (Server) on page 265. 

NOTE: If you attempt to modify a Eudora Address Book database, the Modify Database 

window merely displays the path where the address book file is stored.

Deleting a Database

To delete a database

1. Click the database name or icon in the Databases list to highlight the item

2. Click Delete. You are prompted to confirm the delete. Click Yes and the database 

is removed from the list. Click No and the deletion is cancelled, and the database 

remains.

You can delete multiple databases at once; use the Shift key to select a range in the list, or use 

the Ctrl key to select items non-consecutively.
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This section describes Eudora’s menu commands. Each menu is illustrated, and each 

command is described. Additional commands are available by pressing the Shift key while 

choosing menu commands.

If there is a shortcut to the menu command, it appears to the right of the command on each 

menu. Just press Ctrl and the appropriate keyboard character to access that command. 

File Menu

This menu provides basic file and mail functions.

File Menu

New File—Create a new text file.

Open File...—Open an existing text file.

Open Attachment—Open the attachment on the cursor line (Shortcut: Enter).
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Close—Close the current window. 
[Shift] Close—Close all windows.

Save—Save the changes to the topmost window. 
[Shift] Save—Save the changes to all open windows.

Save As...—Save the current message(s) to a text file.

Save As Stationery—(Sponsored and Paid modes only) Save the current message to a 

stationery file. (Stationery files have the .sta extension and, by default, are saved in your 

Stationery directory.)

Send Queued Messages—Send all messages that have been queued for delivery. 
[Shift] Send Queued Messages—Display the Mail Transfer Options dialog box.

Check Mail—Pick up new mail from the incoming mail server (POP or IMAP). 
[Shift] Check Mail—Display the Mail Transfer Options dialog box.

Print Setup...—Display the Print Setup window, where you can set the printing options.

Print Preview—Display the Print Preview window, giving a preview of how the current item(s) 

to be printed will look when printed.

Print...—Print the current message(s) or window.

Print One—Sends the item immediately to the printer. One copy of the item is printed.

Import —Display the Import Mail & Addresses dialog box to import your messages and 

address book from Netscape Messenger 4.0 or Microsoft’s Outlook ‘98 and Express 5.0.

Exit—Exit (quit) the Eudora application.
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Edit Menu

This menu provides text editing tools.

Edit menu

Undo—Reverse the most recent action taken. (In the example above, the last action was 

typing.) You can undo the last 50 actions in reverse order.

Redo—Redo the most recent action that was undone with the Undo command. You can redo 

up to the last 50 actions (depending on how many were undone).

Cut—Delete the selected text and place it on the clipboard.

Copy—Copy the selected text and place it on the clipboard.

Paste—Paste the contents of the clipboard.

Paste Special—Paste copied text as unformatted, Rich Text Format (RTF), Eudora standard, 

or Hyper Text Markup Language (HTML) text
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Paste As Quotation—Paste the contents of the clipboard as quoted text. Preceding each line 

of text is a quote character, which is a right angle-bracket (>) if there are no styles, or an 

“excerpt bar” (|) if there are styles.

Clear—Delete the selected text.

Text—Apply text styles to the selected text or paragraph. Includes such commands as 

Typewriter (fixed-width font), Bulleted List, Clear Formatting (remove all styles), and Make 
Hyperlink (create a clickable link from a piece of text, or an embedded graphic to a URL).

Insert—Insert objects in the body of a composition message. Includes the commands 

Picture... (insert an embedded graphic file), Downloadable Picture... (inserts a link to a 

graphic URL), and Horizontal Line (insert a horizontal rule as a separator).

Insert Emoticon—Insert a smiley or other graphical depiction of your emotions into the text 

of your messaeg

Select All—Select the entire contents of a message or a mailbox.

Wrap Selection—Insert carriage returns into the selection, as appropriate.

Finish Address Book Entry (Sponsored and Paid modes only)—Complete the partial text of 

a nickname.

Insert Recipient—Insert the chosen recipient. (The submenu lists the recipients on your 

Quick Recipient List.)

Find—Search for the designated character string.

Sort—Sort the message summaries in ascending order in a mailbox by the selected column. 
[Shift] Sort—Sort the message summaries in descending order by the selected column.

Check Spelling (Sponsored and Paid modes only)—Perform a spelling check on the entire 

message or the selected text (displays the Check Spelling dialog box). 
[Shift] Check Spelling—Perform an inline spelling check on the entire message or the 

selected text (highlights misspelled words in red double-underline: right-click a highlighted 

word to correct the spelling).

Message Plug-ins—Launch the installed message plug-in, as appropriate. See Plug-ins 

(Extended Messaging Services) on page 407 for more details. 
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Mailbox Menu

This menu lets you open a mailbox or bring an open mailbox to the front. It also lets you create 

new mailboxes and mail folders.

Mailbox menu

In—Open the mailbox where incoming messages are stored until deleted or transferred to 

another mailbox.

Out—Open the mailbox where messages you compose are stored, where queued messages 

are held until actually sent, and where copies of sent messages may be initially stored.

Junk—Open the junk mailbox, where junk mail is stored automatically for Paid mode 

customers with SPAMWatch turned on.

Trash—Open the mailbox where deleted messages are stored.

Recent—Select to open a recently used mailbox.

New...—Display the New Mailbox dialog box to create a new mailbox.

[Your Mailboxes]—Open the selected mailbox that you have created, or create a new 

mailbox in a folder that you have created. Below the New... command on the Mailbox menu, 

all of your top-level mailboxes are listed, followed by all of your top-level mail folders. (Mail 

folders can contain other mail folders as well as mailboxes.) Navigate through the menu 

system to open a mailbox that resides within a folder, or to create a new mailbox within that 

folder, using the New command on the folder submenu.

Message Menu

This menu lets you create, send, and delete messages.
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NOTE: If you hold down the Shift key while selecting any of the message composition 

commands in the top half of the Message menu — from New Message down to and including 

Redirect To — the Message Options dialog box appears, which lets you select the Personality 

and optional Stationery for the message.

Message menu

New Message—Open a new message composition window.

Reply—Reply to the sender of the current message.

Reply to All—Reply to the sender and all original recipients of the current message.

Forward—Forward the current message to someone else.

Redirect—Redirect the current message to someone else.

Send Again—Resend a message rejected by the mail system. You can also use this 

command to resend saved or copied messages to avoid retyping message body text or 

message header text. However, if you try to resend a received message with an attachment. 

The attachment is not included in the newly sent message.

New Message To—Send a message to someone on your Quick Recipient List.
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Forward To—Forward a message to someone on your Quick Recipient List.

Redirect To—Redirect a message to someone on your Quick Recipient List.

New Message With—Open a new message window with the selected stationery.

Reply With—Open a reply message with the selected stationery. Reply to the sender of the 

message only.

Reply to All With—Open a reply message with the selected stationery. Reply to the sender 

and all original recipients of the message.

Send File or Attach file—Attach a file to the current message or a new message, respectively.

Attach—Use an attachment plug-in to create and attach a special file to the current message 

or a new message. Example: A QUALCOMM PureVoice voice-message attachment. See 

Plug-ins (Extended Messaging Services) on page 407. 

Send Immediately or Queue For Delivery—Send the message right now, or put it in the 

queue to be sent the next time queued messages are sent depending on whether Immediate 
send is selected in the Sending Mail options. See Sending Mail on page 302. 

Change—Change the queuing, status, priority, label, server status, or personality of the 

selected messages or current message. 

Changing the personality changes the associated stationery and signature.

Junk—Transfer a message to the Junk mailbox.

Not Junk—Filter a message out of the Junk mailbox into its designated mailbox.

Delete—Transfer the current message into the Trash mailbox (POP server), or mark the 

message for deletion (IMAP server).

UnDelete—Unmark the message for deletion (IMAP server only).

Purge Messages—Remove all messages marked for deletion (IMAP server only). Removes 

these messages from both your PC and the IMAP server.
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Transfer Menu

This menu lets you transfer the current message(s) to another mailbox, either an existing 

mailbox or a new mailbox that you create.

NOTE: Holding down the Shift key while selecting any of the items on the Transfer menu 

transfers a copy of the current message(s) to the selected mailbox and leaves the original 

messages where they are.

Transfer menu

In—Transfer the current message(s) to the In mailbox.

Out—Transfer the current message(s) to the Out mailbox.

Junk—Transfer the current message(s) to the Junk mailbox. (Does not train Junk scoring)

Trash—Transfer the current message(s) to the Trash mailbox.

Recent—Transfer the current message(s) to a recently used mailbox of your choice.

New...—Display the New Mailbox dialog box to create a new mailbox and transfer the current 

message(s) into that mailbox, all in one step. You can specify to create the mailbox only, and 

not transfer the messages.

[Your Mailboxes]—Transfer the current message(s) into the selected mailbox that you have 

created, or into a new mailbox that you create. Below the New command on the Transfer 

menu, all of your top-level mailboxes are listed, followed by all of your top-level mail folders. 

(Mail folders can contain other mail folders as well as mailboxes.) Navigate through the menu 

system to transfer the current message(s) to a mailbox that resides within a folder, or to create 

a new mailbox within that folder and transfer the current message(s) into that mailbox, all in 

one step, using the New command on the folder submenu.



285

Using Menu Commands

Special Menu

This menu lets you use additional Eudora functions.

Special menu

Filter Messages—Filter the open message or the selected message(s) against all the manual 

filters in your Filters list. Useful for filtering messages after you have received them, especially 

after creating new filters. 

Make Filter—Open the Make Filter dialog box to create a simple transfer filter based on 

information in the open message or the selected message(s).

Make Address Book Entry...—Create an Address Book entry from the current message, the 

Address Book, or the Directory Services window.

Add as Recipient—Add the selected text, usually a full email address, to your Quick Recipient 

List.

Remove Recipient—Select a recipient from this submenu to remove the recipient from your 

Quick Recipient List.

Empty Trash—Delete all messages from the Trash mailbox. As a result of this action, these 

messages are completely removed from your computer.

Compact Mailboxes—Reclaim unused space in all mailboxes.
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Forget Password(s)—Make Eudora forget your passwords, so that next time mail is checked 

for one of your password-controlled mail accounts, the password must be entered first. Useful 

if you step away from your desk in a non-secure area.

Message Plug-ins Settings...—Open the Installed Message Plug-ins dialog box, which lets 

you set the options for those installed message plug-ins that have settable options. In the open 

Installed Message Plug-ins dialog box, click the desired plug-in (scroll through the list if 

necessary) and then click the Settings... button, which will only be available if the plug-in has 

settings. In the displayed Plug-in Settings dialog box, set the options you want and click OK to 

save your changes and close the dialog box. When you are finished setting your plug-in 

options from the Installed Message Plug-ins dialog box, click the Close button to close the 

dialog box. Example: QUALCOMM’s PureVoice voice-messaging plug-in gives you the option 

to begin recording automatically, as soon as you launch the plug-in. See Plug-ins (Extended 

Messaging Services) on page 407 for more information. 

Tools Menu

All of Eudora’s tool windows and the options dialog boxes can be opened from this menu, as 

well as the Options dialog box. Select a tool window name to open that window, or select 

Options... to open the Options window and set your options

Tools menu
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Filters—Display the Filters window, which lets you create, modify, and remove message 

filters.

Filter Report—Display the Filter Report window, which provides a report of all filter operations 

(transfers to mailboxes) since the last time Eudora was opened. Note: For these filter reports 

to be generated, you must turn on the Generate filter report option in the Getting Attention 

options. See Getting Attention on page 334.  This option is turned off by default.

Mailboxes—Display the Mailboxes window, which lets you manage your mailboxes and mail 

folders.

File Browser—Display the File Browser window, which lets you browse through your desktop 

and drag attachments to new messages and otherwise (partially) manage your files and 

folders. The File Browser window is not a full replica of MS Windows Explorer.

Stationery (Sponsored and Paid modes only)—Display the Stationery window, which lets you 

create, manage, and apply your stationery files. See Using Stationery (Sponsored and Paid 

modes only) on page 109. 

Signatures—Display the Signature window, which lets you create, manage, and apply your 

signatures. See Using a Signature on page 105. 

Personalities (Sponsored and Paid modes only)—Display the Personalities window, which 

lets you create, modify, manage, and apply your personalities. See Using Multiple 

Personalities (Sponsored and Paid modes only) on page 115. 

Task Status—Display the Task Status window, which lets you see Eudora checking mail for 

and sending mail from each of your personalities simultaneously. 

Task Error—Display the Task Error window, which lets you see a detail summary of any error 

that may occur while in Eudora.

Address Book—Display the Address Book window, which lets you create, manage, and apply 

entries that contain nicknames (shorthand names for groups of email addresses) and 

associated information. In the Address Book window, you can also create multiple Address 

Book files for storing nickname entries. Nicknames provide a quick and convenient way to 

address e-mail, especially to multiple recipients and to people you correspond with frequently. 

See Using the Address Book on page 233. 
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Directory Services—Display the Directory Services window, which lets you look up people 

on the Internet, on your local network (e.g., within your organization), or in your Eudora 

Address Book(s). The Directory Services window is similar to an Internet “White Pages.” See 

Using Directory Services on page 257. 

Link History (Sponsored and Paid modes only)—Display the Link History window, which 

displays active links you have received in Eudora (including ads if you are using Eudora in the 

Sponsored mode). You can activate the link and view its information in this window. See Link 

History (Sponsored and Paid modes only) on page 228. 

Statistics (Sponsored and Paid modes only)—Display the Statistics window, which displays 

your Eudora usage by day, week, month, or year.

Reset Tools...—Reset the toolbar and windows positions back to the default. A dialog will 

appear asking you to confirm that this is what you would like to do.

ESP Groups (Sponsored and Paid modes only)—Display the ESP Groups window to create 

and maintain ESP groups. See Eudora Sharing Protocol on page 369. 

Options...—Display the Options windows, which lets you set preferences for a variety of 

categories in Eudora. In the open Options window, click a category in the category list, then 

set the options for that category. Click OK to save your changes and close the window. You 

can make changes in multiple categories before clicking OK. See Setting Eudora Preferences 

on page 292 for descriptions of all the options in all categories. 

Window Menu

All of Microsoft Windows’ standard Window menu options are listed in this menu including the 

names of all normal Eudora windows that you currently have open (tabbed window groups are 

listed by the currently active window in the tabbed group). Note that this menu does not apply 

to docked or floating Eudora windows. See Managing Windows in Eudora on page 197 for 

more information on normal, docked, floating, and tabbed windows. 
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 Window menu

Cascade—Display all open normal Eudora windows in a cascading fashion (diagonally offset 

from each other in a stack).

Tile Horizontal—Display all open normal Eudora windows in a tiled (edge to edge) fashion 

with horizontal edges touching (top to bottom).

Tile Vertical—Display all open normal Eudora windows in a tiled (edge to edge) fashion with 

vertical edges touching (left to right).

Arrange Icons—Arrange all Eudora window icons, representing minimized normal Eudora 

windows, in a line at the bottom of the Eudora main window work area. These icons are also 

represented by buttons on the Eudora taskbar.

Send To Back—Send the topmost open normal Eudora window to the back of all displayed 

windows. A tabbed window group is considered a single window for this purpose.

[Your Windows]—All normal Eudora windows that are open appear here. Tabbed windows 

are represented as single windows, identified by the currently active window in the group. 

Select the desired window to bring that window (or the tabbed group containing it) to the front 

of all displayed windows.

Help Menu

Go to this menu to get help, read a tip, change mode, register, insert system configuration, or 

see information about this release. 
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Help menu

Topics—Display the online Help contents.

Context Sensitive Help—Display context-sensitive Help. Selecting this command attaches a 

question mark icon to the mouse pointer. You then click any screen object in Eudora (icon, 

menu command, text field, etc.), and a Help window appears containing help for that object.

Technical Support—Display a Eudora Help window containing information on getting more 

help and, optionally, contact information for the Eudora Technical Support group. See 

Technical Support on page 27 for more information on how to obtain technical support directly 

from the Eudora Technical Support group if you are eligible to receive it.  If you are eligible for 

this support, and you complete the registration process, contact information for the Eudora 

Technical Support group will be displayed in this help window.

Report A Bug—Displays a new composition window addressed to Windows Eudora Bugs at 

Qualcomm. If you are having technical problems with Eudora, just answer the questions in the 

email message.

Tip of the Day—Display the Tip of the Day window.

Payment & Registration—Display the Payment and Registration dialog box, which lets you 

change operating mode and register your copy of Eudora. SeeChanging Eudora Modes on 

page 25 and Registering Eudora on page 27 for registration instructions. 

Insert System Configuration—Insert text containing detailed information about your system 

configuration into the message body of a new composition message. Eudora-related 

configuration files may also be attached to the composition message when you select this 

command. Use this feature when reporting bugs or when corresponding with the Eudora 

Technical Support group.
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About Eudora...—Display the About Eudora screen, which contains information on this 

release, a link to the Eudora web site, and developer and support team credits. It also displays 

your registration number and name.
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To display category windows where you can specify how you want to use Eudora, select 

Options from the Tools menu. By selecting or turning off criteria on these windows, you 

customize Eudora to suit your needs.

The many Options categories are described in this section. When you first install Eudora, the 

Options windows contain preset settings.

After you totally finished changing the settings in all categories, click OK. Your settings will be 

changed.

NOTE: For your convenience, some options appear in more than one category. For example, 

your return address appears in both the Getting Started options window and the Sending Mail 

options window. Changing an option in one category changes the option in all categories in 

which it appears.

For advanced users only: if you need to use an Esoteric Settings plug-in, copy 

esoteric.epi from the Extra stuff subdirectory into your main Eudora directory. This will 

allow an interface to several features in your options settings. You will notice additional icons 

appearing at the end of the category list in Options.
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Getting Started

On the Getting Started options window, you can determine the minimum information 

necessary to send and receive mail. The information here is for your “dominant” personality, 

which is your principal email account.

To display the Getting Started options window

1. From the Tools menu, choose Options.

2. Click the Getting Started icon. 

The Getting Started options window appears.

Getting Started options window

Select the options you want to change. Following are the descriptions of the options:

Real name—This is the real name assigned to your principal account, generally your first and 

last name. The text you enter here is included in the From: field of all your outgoing messages 

from this account. It identifies you to your recipients.
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Email address—This is the email address used in outgoing messages and recipients’ replies, 

if this address is different from your incoming mail account. The address you enter here is 

included in the From: field of all your outgoing messages from this account, and when a 

recipient replies to a message from this account, the reply is sent to this address. If you do not 

enter an address in this field, Eudora uses your incoming mail account as the return address. 

Incoming mail accounts are usually of the form username@incomingmailserver. For example, 

suppose your incoming mail account is jcamp@pop.myfirm.com but your email address is 

jcamp@myfirm.com. This is slightly different. You would then enter jcamp@myfirm.com in 

this field.

NOTE: If you do enter an address in the Email Address field, first test the address to be sure 

that mail sent to it is indeed delivered to you. If you use an invalid email address, no one will 

be able to reply to your mail.

Mail Server (Incoming)—This is the name of the incoming-mail server for your principal email 

account. All incoming messages to your primary account are routed through this server. Use 

the Incoming Mail options window to specify whether this server uses POP (Post Office 

Protocol) or IMAP (Internet Message Access Protocol). A sample server name might be 

pop.myfirm.com.

User Name—This is the name you use to log in to your primary email account for accounts 

that require a user login. For example, in the incoming mail account 

jcamp@pop.myfirm.com, the user name is jcamp. All accounts require a user name.

SMTP server (outgoing)—This is the name of the outgoing mail server for your principal 

email account. All outgoing messages sent from your primary account are routed through this 

server. If the computer that your primary incoming mail account is selected also runs an SMTP 

server, you can leave this field blank. SMTP stands for Simple Mail Transfer Protocol.

Allow Authentication—Eudora can log in to an SMTP server when sending mail, just like it 

does for receiving mail. Not all SMTP servers require or allow such authentication. Eudora will 

attempt authentication to servers that allow it. The preferred SMTP authentication method is 

CRAM-MD5. If CRAM-MD5 is not available, LOGIN or PLAIN will automatically be used. See 

Using SMTP Authentication on page 72.
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Checking Mail

The Checking Mail options determine how Eudora checks for and receives incoming mail 

messages sent to your principal email account (dominant personality). 

To display the Checking Mail options window

1. From the Tools menu, choose Options.

2. Click the Checking Mail icon. 

The Checking Mail options window appears.

Checking Mail options window

Select the options you want to change. Following are the descriptions of the options:

Mail Server—This is the name of your incoming-mail server as entered in the Mail Server 

(Incoming) field of the Getting Started options. See Getting Started on page 293 for more 

details. 

User Name—This is the login name you entered in the User Name field of the Getting Started 

options. See Getting Started on page 293 for more details. 
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Check for mail every _ minute(s)—If you enter a number greater than zero in this field, then 

at regular intervals, Eudora automatically checks your incoming mail server for new mail and 

transfers to your PC any mail addressed to your primary account. The number you enter here 

specifies the number of minutes between automatic mail-checks. It’s a good idea to set this at 

no less than 15 minutes. Checking mail more frequently may overwork your incoming mail 

server. This option only works when Eudora is running. Entering 0 in this field turns off 

automatic mail-checking.

Don’t check without a network connection—If you select this option, Eudora will not 

attempt to retrieve mail unless you are connected to a network. 

Don’t check when using battery—If you select this option and your PC is running on battery 

power, mail is not automatically checked even if automatic mail-checking is selected; that is, 

the Check for mail every _ minute(s) field has a number greater than zero in it.

Send on check—If you select this option, any messages that are queued in the Out mailbox 

are sent when a mail-check is performed, whether the mail-check is automatic or manual. If 

this is turned off, messages queued in the Out box are not sent during a mail check.

Secure Sockets when Receiving—Use the drop-down menu to choose a SSL security 

setting for your dominant personality when receiving messages.

Following is a description of each option on the SSL drop-down menu:

Never—Do not use SSL for server authentication and mail transfer security, even 

if SSL is available on the server. 

If Available STARTTLS (default)—Use SSL for server authentication and mail 

transfer security by having Eudora automatically invoke the STARTTLS command 

method to start SSL, that is, if the server supports STARTTLS. If your server 

doesn’t support STARTTLS, mail transfers will occur successfully, but they will not 

be secured with SSL.

Required, Alternate Port—Use SSL for server authentication and mail transfer 

security by having Eudora automatically use the older style alternate port method 

for starting SSL. If your server does not support SSL on the appropriate ports, mail 

transfers will fail. 

Required STARTTLS—Use SSL for server authentication and mail transfer 

security by having Eudora automatically invoke the STARTTLS command method 

to start SSL. If your server does not support STARTTLS, mail transfers will fail. 
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NOTE: If you use SSL and cannot make a connection when receiving or sending 

mail, you may need to check with your ISP to update any invalid SSL certificates. 

However, to override any issues with SSL when retrieving or sending mail, choose 

Never from the drop-down menu to make a successful connection.

Last SSL Info— Click to display the most current information for an SSL 

connection between a server and Eudora since the last time you started Eudora. 

The Eudora SSL Connection Information Manager window appears with SLL and 

certificate information. 

WARNING: If you display the SSL information windows, make certain you don’t 

change any of the field information unless you are familiar with SSL.
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Incoming Mail

The Incoming Mail options determine how Eudora receives incoming messages addressed to 

your primary email account (dominant personality). The options configure the incoming mail 

server name that is entered in the Mail Server (Incoming) field in the Getting Started options 

window. 

To display the Incoming Mail options window

1. From the Tools menu, choose Options.

2. Click the Incoming Mail icon. 

The Incoming Mail options window appears.

Following are field descriptions for Incoming Mail:

Server configuration—Specify which email protocol the incoming mail server uses: POP 

(Post Office Protocol) or IMAP (Internet Message Access Protocol). If you are not sure which 

server to use, ask your email administrator.

The options in the rest of this window depend on whether you’ve chosen POP or IMAP in this 

field. Options for both configurations are described below.
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When Server configuration = POP:

Incoming Mail options window (POP)

Leave mail on server—If you select this option, Eudora copies incoming messages to your 

PC and leaves the message on the POP server. If this is turned off, Eudora transfers incoming 

messages to your PC and deletes the message from the POP server. For important 

information concerning this option, see Leaving Mail on the Server on page 86. 

Delete from server after _ day(s)—If you select this option, mail will be saved for 

the number of days you specify before being deleted from the POP server. It is a 

good idea not to leave copies of your messages on the POP server indefinitely, as 

this will create mail storage problems on the server.

Delete from server when emptied from Trash—If you select this option, any 

messages that are deleted from your Trash mailbox are also deleted from the POP 

server. 

Skip messages over _ K in size—If you select this option, messages over the specified size 

are downloaded only in part. These messages include the first few lines and a statement that 

says the message is not complete. This can be useful on slow connections.

NOTE: If you want to retrieve the full message after it has been partially retrieved, right-click 

on the message and change the server status.
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Offline—If you select this option, Eudora won’t attempt to make any connections. This is a 

good option to have selected if you’re using Eudora on a laptop computer that is not 

continuously connected.

Authentication style—This specifies which POP account authentication technology to use 

for this account: Passwords, Kerberos, APOP, or RPA. Ask your email administrator which one 

to use if you are not sure. Use RPA for CompuServe.

Server configuration = IMAP:

Incoming Mail options window (IMAP)

IMAP Mailbox Location Prefix—This specifies the mailbox location prefix that IMAP will use 

when locating your mailboxes on the incoming mail server. An example prefix is /usr/mail. Ask 

your email administrator what to enter here if you are not sure.

For new mail, download—These options (you must choose one) let you control the way 

incoming mail is downloaded from the IMAP server.

Minimal headers only—If you select this option, only a limited set of message 

headers, and nothing else, is downloaded for each incoming message. (That 

means the remaining message headers, the message body, and any attachments 

are not initially retrieved for the message.) By accessing each part of the message, 

you can retrieve the remaining portion from the server.
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Full message except attachments over _ K—If you select this option, the full 

message (full set of message headers and the message body) and any 

attachments smaller than the specified size are downloaded for each incoming 

message. Also, any attachments larger than the specified size are not downloaded 

with the message. To download all of your IMAP attachments, enter a large 

number in this field. If you enter 0 in the text box, all attachments regardless of size 

are retrieved.

When I delete a message—These options (you must choose one) let you control the way you 

want your deleted messages handled.

Mark it as deleted—Select this option to mark your messages on the IMAP for 

deletion. These messages are not removed from the server until you choose to 

remove them. See Deleting a Message from the Server on page 88. 

Move it to (mailbox)—Select this option to move your deleted messages to a 

specific mailbox. The default is your Trash mailbox.   

Authentication style—This specifies which IMAP account authentication technology to use 

for this account: Passwords, Kerberos, or CRAM-MD5. Ask your email administrator which 

one to use if you are not sure. CRAM-MD5 is the default. If CRAM-MD5 is not detected, 

Eudora will use Passwords.
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Sending Mail

The Sending Mail options determine how Eudora sends your outgoing messages from your 

primary email account (dominant personality). 

To display the Sending Mail options window

1. From the Tools menu, choose Options.

2. Click the Sending Mail icon. 

The Sending Mail options window appears.

Sending Mail options window

Select the options you want to change. Following are the descriptions of the options:

Email address—This is your return email address, if different from your incoming mail 

account. See Getting Started on page 293 for more details. 

Domain to add to unqualified addresses—This is the domain name that Eudora 

automatically adds to an unqualified address in messages sent from your primary account. An 

unqualified address is an address that doesn’t have the @ sign followed by a domain name. 

This can be used to save time when addressing large numbers of messages to users in the 

same domain.



303

Setting Eudora Preferences

SMTP server—This is the name of the outgoing mail server for your principal email account. 

All outgoing messages sent from your primary account are routed through this server. If the 

computer that your primary incoming mail account is on also runs an SMTP server, you can 

leave this field blank. SMTP stands for Simple Mail Transfer Protocol.

SMTP Relay Personality—Choose the personality from the drop-down list that you previously 

set up as your SMTP Relay. This feature allows you to send all your mail through your primary 

ISP’s server.

Allow authentication—Eudora can log in to an SMTP server when sending mail, just like it 

does for receiving mail. Not all SMTP servers require or allow such authentication. Eudora will 

attempt authentication to servers that allow it. The preferred SMTP authentication method is 

CRAM-MD5. If CRAM-MD5 is not available, LOGIN or PLAIN will automatically be used.   

Immediate send—If you select this option, the rightmost button in the toolbar of the message 

composition window is labeled Send. Clicking this button immediately sends the message to 

the SMTP server. If this option is turned off, the button is labeled Queue and clicking on it 

places the message in the Out mailbox marked ready for delivery (Q).

Send on check—If you select this option, any messages from your primary account that are 

queued in the Out mailbox are sent when mail is checked for this account, whether the mail-

check is automatic or manual.

Use Submission Port—If you select this option, when sending mail, Eudora will connect to 

the outgoing mail server on the new ‘submission’ port 578 instead of the old SMTP port 25. 

Using the submission port requires authentication to be turned on.

Secure Sockets when Sending—Use the drop-down menu to choose a SSL security setting 

for your dominant personality when sending messages.

Following is a description of each option on the SSL drop-down menu:

Never—Do not use SSL for server authentication and mail transfer security, even 

if SSL is available on the server. 

If Available STARTTLS (default)—Use SSL for server authentication and mail 

transfer security by having Eudora automatically invoke the STARTTLS command 

method to start SSL, that is, if the server supports STARTTLS. If your server 

doesn’t support STARTTLS, mail transfers will occur successfully, but they will not 

be secured with SSL.
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Required, Alternate Port—Use SSL for server authentication and mail transfer 

security by having Eudora automatically use the older style alternate port method 

for starting SSL. If your server does not support SSL on the appropriate ports, mail 

transfers will fail. 

Required STARTTLS—Use SSL for server authentication and mail transfer 

security by having Eudora automatically invoke the STARTTLS command method 

to start SSL. If your server does not support STARTTLS, mail transfers will fail. 

NOTE: If you use SSL and cannot make a connection when receiving or sending 

mail, you may need to check with your ISP to update any invalid SSL certificates. 

However, to override any issues with SSL when retrieving or sending mail, choose 

Never from the drop-down menu to make a successful connection.

Last SSL Info—Click to display the most current information for an SSL connection between 

a server and Eudora since the last time you started Eudora. The Eudora SSL Connection 

Information Manager window appears with SLL and certificate information. 

WARNING: If you display the SSL information windows, make certain you don’t change any 

of the field information unless you are familiar with SSL.
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Composing Mail

The Composing Mail options determine what Eudora features are available to you when 

composing messages.

To display the Composing Mail options window

1. From the Tools menu, choose Options.

2. Scroll and click the Composing Mail icon. 

The Composing Mail options window appears. 

Composing Mail options window

Default Stationery (Sponsored and Paid modes only)—This is the default stationery to be 

used in all outgoing messages from your dominant account. Select a stationery file from the 

drop-down list, or select <No Default> for no default stationery. If a stationery file is selected, 

that file is used when you open new messages from this account (except with the Redirect or 

Send Again commands). The message toolbar in the composition window is set according to 

how the stationery message was saved, regardless of how the options below are set. But, you 

can always change them after you open the message. See Creating New Stationery on 

page 111. 
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When not using Stationery (Sponsored and Paid modes only)—The values you choose for 

the following options apply only when you are not using a default stationery file, that is, when 

the “Select a default Stationery for new messages” option, above, is set to <No Default>, if you 

have selected a default stationery file from the drop-down list, then the values below are 

ignored. Instead, Eudora uses their corresponding values that were set when the stationery 

file was saved. So, for example, if you choose default stationery that uses a custom signature 

and you set the default signature drop-down list below to your Standard signature, your 

Standard signature will be ignored and the custom signature will be used.

Word wrap—If you select this option, Eudora automatically inserts carriage returns in long 

lines when a message is sent, creating roughly 76 characters per line. This makes the 

message legible on the recipient’s computer. It is a good idea not to include your own carriage 

returns within paragraphs if you have this option on. Use carriage returns only to create new 

paragraphs. We strongly recommend that you leave this option selected. The default 

stationery overrides this option (see above).

Keep copies—If you select this option, a copy of each message you send is kept in the Out 

mailbox. If this option is turned off, outgoing messages are put in the Trash mailbox after they 

are sent. Default stationery overrides this option (see above).

May use quoted-printable—If you select this option, Eudora uses quoted-printable encoding 

when necessary, such as when sending messages that contain special characters or long 

lines of text. If this option is turned off, quoted-printable encoding is never used. We 

recommend that you leave this option selected. Default stationery overrides this option.

Tabs in body of message—If you select this option, pressing the Tab key within the message 

body inserts a tab. If it is turned off, pressing the Tab key within the message body moves the 

cursor to the To: field. Default stationery overrides this option (see above).

Show signature while composing—If you select this option, you will see the signature you 

have previously set up in the message composition window. If off, you will not see the 

signature. To set up a signature, see Using a Signature on page 105. 
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Internet Dialup

The Internet Dialup options determine how Eudora manages your Internet telephone 

connection. 

To display the Internet Dialup options window

1. From the Tools menu, choose Options.

2. Click the Internet Dialup icon. 

The Internet Dialup options window appears.

Internet Dialup options window

Have Eudora connect using Dial-up networking—If you select this option, the specified 

dial-up connection (referred to in Windows NT 4.0 as a "phonebook entry") is used when 

Eudora does any network operation. This option is available only if you have installed the dial-

up networking services with Windows 98/XP or Windows NT 4.0.

When Eudora established the connection:

Hang-up after receiving and sending—If you select this option, the connection 

terminates each time mail is retrieved and sent.

Close connection on Exit—If you select this option, the phone connection 

terminates when you exit Eudora.
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Entry:—Use the drop-down list to select a dial-up connection in this field. You must 

have dial-up networking set up in Windows.

New—Select to create a new dial-up networking entry. See the online user 

manual for information on creating a dial-up networking entry.

Edit—Select to edit the current entry displayed in the Entry field box. For 

example, you would edit phone number. 

Only do automatic mail checks when a network connection is already established—If 

you select this option, Eudora will do an automatic mail check only if you are connected to a 

network.
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Replying

The Replying options determine how replies are created.

To display the Replying options window

1. From the Tools menu, choose Options.

2. Scroll and click the Replying icon. 

The Replying options window appears.

 Replying options window

Select the options you want to change. Following are the descriptions of the options:

Map Ctrl+R to “Reply to All”—If you select this option when you hold down the Ctrl key and 

press R, a new message is created addressed to all of the recipients of the original message 

as well as the sender.

Copy original’s priority to reply—If you select this option, your replies use the same priority 

as the original message.

Automatically Fcc to original mailbox (Sponsored and Paid modes only)—If you select this 

option, replies are automatically copied to the same mailbox that contains the original 

message with the exception of the In box replies which are copied to the Out box.
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Include signature on reply—If you select this option, your default signature will be included 

on all of your replies automatically.

Quote only the selected text—If you select this option, only the text you highlight in a 

received message will appear on the reply message. 

Generate multiple messages on Reply to multiple messages—Check this box if you want 

individual reply messages to be sent to each sender of each concentrated message instead 

of one message being sent to all the senders. 

When replying to all—This specifies how to address a reply. If Include yourself is selected, 

when you Reply to all as described above, your address is left in the address list of the new 

message and you receive a copy of your own reply. If this option is turned off, the default, your 

address is removed from the reply message and you do not receive a copy of the reply. 

To determine who you are for the Include yourself option, Eudora uses the “me” nickname. You 

create the “me” nickname in your Address Book. If you do have a “me” nickname, Eudora uses 

the contents of the Login Name, Mail Server, and Return Address from the Getting Started 

options. 

If Put original To:recipients in Cc: field is on (the default is off), the addresses of the original 

message recipients are moved from the To field to the Cc field of the reply-to-all message. 

Only the address of the original sender is placed in the To field. If this option is off, all of the 

addresses are placed in the To f ield of the reply message.
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Attachments

The Attachments options determine how Eudora sends and receives file attachments. 

To display the Attachments options window

1. From the Tools menu, choose Options.

2. Scroll and click the Attachments icon. 

The Attachments options window appears.

Attachments options window

Select the options you want to change. Following are the descriptions of the options:

Encoding method—This specifies what default encoding method to use for attached 

documents: MIME, BinHex, or Uuencode. To change the method for just the current message, 

use the Attachment Type popup in the outgoing message window. For details, see Attaching 

a File to a Message on page 49. 

Attachment directory—This specifies what directory will receive incoming attachments. To 

specify a folder, single-click the folder name button. A dialog box appears prompting you to 

select a folder. The default folder is the Attach sub-folder of your Eudora Pro folder.
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Put text attachments in body of message—If you select this option, Eudora puts any plain-

text attachment you send directly within the message body, as if it were typed in manually.

Receive MIME digest as a mailbox attachment—If you select this option, Eudora automatically 

creates a mailbox specifically for email messages from a mailing list that supports MIME 

digests.

Delete attachments when emptying Trash—If you select this option, Eudora automatically 

deletes an attachment received with a message when that message is deleted from your 

system; that is, when the message is emptied from the Trash. The attachment must still be in 

the folder defined as the Attachments Folder. If you want to save an attachment but delete the 

message, move the attachment to another folder or turn off this option.

Delete automatic attachments—This specifies how to handle attachments to automatically 

generated messages, such as is created with the “Insert System Configuration” command.

Never—If you select this option, automatic attachments are never deleted from the 

attachment directory.

After sending message—If you select this option, automatic attachments are 

deleted from the attachment directory when their corresponding messages are 

sent.

When message emptied from Trash—If you select this option, automatic 

attachments are deleted from the attachment directory when their corresponding 

messages are emptied from the Trash.
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Fonts

The Fonts options determine how Eudora displays and prints text. Note that the choices 

available for each option, and the default, may depend on the fonts installed in your system. 

To display the Fonts options window

1. From the Tools menu, choose Options.

2. Scroll and click the Fonts icon. 

The Fonts options window appears.

Fonts options window

Select the options you want to change. Following are the descriptions of the options:

Message—These fields list the proportional and fixed-width fonts to be used for displaying the 

text in your received and composition messages and in the message preview pane in mailbox 

windows. Also included are the size of each font and the use of proportional or fixed-width font 

by default.

Proportional—Specify the proportional font to use in message windows and the 

preview pane. Spacing is adjusted according to each character’s width.

Fixed-width—Specify the fixed-width font to use in message windows and the 

preview pane. Every character requires the same amount of space.
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Use proportional font by default—If you select this option, message windows 

and the preview pane use your specified proportional font by default. If this option 

is turned off, message windows and the preview pane use your specified fixed-

width font by default.

Size—Specify the size of the font to be used for text in message windows and the 

preview pane.

Printer—These fields list the font and size to be used when printing any text from Eudora 

using the Print... command messages, text files, signature files, etc.

Font—Specify the font to use when printing text from Eudora.

Size—Specify the font size to use when printing text from Eudora.

Screen—These fields list the font and size to be used when displaying any Eudora screen text 

other than that displayed in received and composition messages and the message preview 

pane. This includes text files, signature files, and message summaries in mailbox windows.

Font—Specify the font to use when displaying all other screen text in Eudora.

Size—Specify the font size to use when displaying all other screen text in Eudora.
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Display

The Display options determine how Eudora displays various objects in the main Eudora 

window and the category icons in the Options list. 

To display the Display options window

1. From the Tools menu, choose Options.

2. Scroll and click the Display icon. 

The Display options window appears.

Display options window

Select the options you want to change. Following are the descriptions of the options:

Show toolbar—If you select this option, Eudora displays the main window toolbar.

Show toolbar tips—If you select this option, holding the mouse pointer over a button in the 

main window toolbar displays a very brief description of that button’s function.

Show cool bars—If you select this option, the main window toolbar buttons have a flat look 

and only become raised when you position the mouse pointer over the button. If this option is 

turned off, the main window toolbar buttons always have a raised look.
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Show large buttons—If you select this option, the main window toolbar buttons appear large.

Show status bar—If you select this option, Eudora displays a status bar at the bottom of the 

main window. The status bar provides a brief description of menu items and toolbar buttons. 

Also information about background tasks, if running, appears.

Show category icons—This option allows you to turn the Category icons in Options on and 

off.

Show MDI task bar—If you select this option, Eudora displays the Eudora taskbar at the 

bottom of the window work area. This taskbar contains buttons for all open and minimized 

normal Eudora windows, such as mailboxes, email, and Address Book. 

Automatically download HTML graphics—If you select this option, Eudora will fetch and 

display images from the web that are embedded in a received email message using Eudora’s 

internal HTML viewer.

Display attached images inline—If you select this option, Eudora will display attached 

graphic files within the body of the message.

Display emoticons as pictures—If you select this option, Eudora will display emoticons as 

graphic icons. 

Minimize Eudora to the system tray—If you select this option, Eudora will display as an icon 

in the system tray when minimized instead of in the Windows Taskbar.

Always show icon in system tray—If you select this option, the icon for Eudora will display 

in the system tray whenever Eudora is open.
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Viewing Mail

The Viewing Mail options determine how Eudora displays incoming and outgoing message 

windows and the message preview pane in mailbox windows. 

To display the Viewing Mail options window

1. From the Tools menu, choose Options.

2. Scroll and click the Viewing Mail icon. 

The Viewing Mail options window appears.

Viewing Mail options window

Select the options you want to change. Following are the descriptions of the options:

Message Window—These options determine how Eudora displays received and composition 

messages.
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Use Microsoft’s viewer—If this is turned off, Eudora displays advanced 

formatting, graphics, and multimedia in incoming and outgoing messages, using its 

own built-in viewer. If you select this option, Eudora takes full advantage of the 

Web browser capabilities of Microsoft’s Internet Explorer 3.0 or later by showing 

Web content right in incoming and outgoing messages or linking to the Internet, 

without your having to open the Web browser. This option is available only if you 

have Microsoft’s Internet Explorer version 3.0 or higher installed and available on 

your system.

Use separate settings from Internet Explorer—If this setting is turned on, 

Eudora will keep its own display settings separate from Internet Explorer. If this is 

turned off, changes to Eudora display settings will also change the settings in the 

Internet Explorer browser. 

Message window width—This specifies the width of new and received message 

windows (in characters). This option has no effect on what your mail looks like 

when it is sent. When mail is sent, Eudora wraps at or before 76 columns.

If you use a proportional font, Eudora sets the window width based on the average 

width of the characters in the font.

Message window height—This specifies the height of new and received 

message windows (in lines).

NOTE: If the “Zoom windows when opening” option is selected, received message 

window heights are automatically adjusted to the height of the message text.

Preview Pane—These options determine the visibility and behavior of the message preview 

pane that appears at the bottom of mailbox windows.

Show message preview pane—If you select this option, Eudora displays the 

message preview pane in mailbox windows. The preview pane previews a single 

selected message. A splitter between the preview pane and the message 

summary list lets you resize the preview pane relative to the list.

Mark previewed messages as read after _ second(s)—If you select this option 

and the “Show message preview pane” option is turned on, the message currently 

selected in the mailbox window and previewed in the preview pane is automatically 

marked as read (blank in the Status column) after the specified number of seconds. 

If this option is turned off, a previewed message will not automatically be marked 

as read. Note: You can use the Shift+Space shortcut to convert a message back 

and forth between the Unread ( ) and Read status.
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Automatically open next message—If you select this option, deleting or transferring the 

current message opens the next message in the mailbox, but only if that message is unread.

Zoom windows when opening—If you select this option, new message windows 

automatically open to their “zoomed” size. The zoomed size is computed on a window-by-

window basis. For message windows, zoomed size is just long enough to display all of the 

message (but no longer than the main window), and as wide as the Message window width 

setting. Composition windows zoom to the height specified by the Message window height 

setting.

Allow executables in HTML content—If you select this option, you are able to run programs 

such as Java™ Applets, JavaScript™, VB Script™, and ActiveX™ Controls that are 

embedded in an HTML message. For security reasons, you may want to leave this option 

turned off. 



320

Setting Eudora Preferences

Mailboxes

The Mailboxes options determine how Eudora displays various objects in mailbox window 

columns. It also allows you to configure Eudora to select and drag message(s) for mailbox 

transfers.

To display the Mailboxes options window

1. From the Tools menu, choose Options.

2. Scroll and click the Mailboxes icon. 

The Mailboxes options window appears.

Mailboxes options window

Select the options you want to change. Following are the descriptions of the options:

Show Mailbox Columns—These options determine which columns appear in mailbox 

windows. Select an option to display that column in all mailbox windows. The options are 

Status, Junk, Priority, Attachment, Label, Who, Date, Size, Server status, MoodWatch and 

Subject.

Show mailbox lines—If you select this option, lines appear in the message summaries 

portion of mailbox windows: horizontal lines to separate message summaries, and vertical 

lines to separate columns.
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Show count of selected messages in Size box—If you select this option, a column is added 

to the size box in the lower left hand corner of a mailbox table of contents. The first column of 

the size box will display the number of messages that are selected.

Close messages with mailbox—If you select this option, all opened messages in a mailbox 

will close automatically when you close the mailbox.

Select newly inserted messages (FUMLUB)—If you select this option, the first message of 

the most current block of unread messages is highlighted in the Table of Contents window 

when new messages are added to a mailbox, for example, when receiving new messages as 

a result of a mail check. FUMLUB means First Unread Message of the Last Unread Block. For 

example, you may have a series of unread messages in a mailbox scattered throughout your 

Table of Contents. The first message of the last block of unread messages listed in your Table 

of Contents is selected. 

Show no more than _ items in the Recent mailbox menus [default 10]—Enter the 

maximum number of mailboxes you would like to see in the Recent mailbox menus. Set this 

option to 0 to disable the Recent mailbox menus.

When dragging in a mailbox: 

Allow drag and drop transfers—If you select this option, you can transfer a 

message to another mailbox using drag and drop: select one or more messages in 

a mailbox, drag them to another mailbox, and drop them in the target mailbox. Also, 

you can drag and drop messages to a mailbox displayed in the Mailboxes window.

Allow drag-select of messages—If you select this option, you can click and drag 

on adjacent messages to select them as a group in the Table of Contents window. 

This allows you to transfer a group of messages to a mailbox or to delete them if 

the “Allow drag and drop transfers” is selected. The drag select works only if the 

drag starts on an unselected (not highlighted) message.
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Styled Text

The Styled Text options determine when to use style information in outgoing and incoming 

messages.

To display the Styled Text options window

1. From the Tools menu, choose Options.

2. Scroll and click the Styled Text icon. 

The Styled Text options window appears.

Styled Text options window

Select the options you want to change. Following are the descriptions of the options:

Show formatting toolbar—If you select this option, the formatting toolbar appears by default 

in new message windows. If this is turned off, the formatting toolbar is hidden by default in new 

message windows. This toolbar lets you easily format text styles in new messages.
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When sending mail with styled text (HTML)—This specifies what to do with HTML text 

styles when you send mail. The styles are delivered to your recipients using the Hyper Text 

Markup Language (HTML) format. However, the styles your recipient sees depends on how 

well their email software supports this standard. HTML is the text formatting standard used in 

the World Wide Web by Web browsers and newer email applications. HTML allows you to use 

enriched text, which includes different fonts, color, sizes, bold, etc. Also, HTML lets you imbed 

pictures and create bullet lists in the emails you send.

Send plain and styled version in message, Send styled text only, Send plain 
text only—These options only apply to messages that have some styled content. 

Plain text messages are always sent as just plain text. If a message does have 

styled text, then these options control which versions of the message are sent: an 

HTML version, a plain text version, or both an HTML and a plain text version in the 

same message. If you send plain and styled text, your recipient will be able to view 

your message even though their email program does not support HTML; they view 

the message in plain text only.

Ask me each time—If you select this option, you are warned when you try to send or queue 

a message with text styles. And you are given the option to send just a plain text version, just 

an HTML version, or both in a single message.

When the body of a message has no styles, but the signature does has styles: Send the 
signature with styles—If you select this option, signature with styled text is sent with a 

message that has no styled text. If this is turned off, then the signature is sent but the text 

styles are removed.

NOTE: If selected, the signature becomes one with the message. However, if an attachment 

is included with you message, this option turns off. 
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Spell Checking 
(Sponsored and Paid modes only)

The Spell Checking options control the behavior of Eudora’s built-in spelling checker when it 

performs a spelling check on the body of a message composition window, a text file, or a 

signature file. You can also change these options from the Spelling Options dialog box, 

accessed by clicking the Options button in the Check Spelling dialog box (accessed via the 

Edit menu). 

To display the Spell Checking options window

1. From the Tools menu, choose Options.

2. Scroll and click the Spell Checking icon. 

The Spell Checking options window appears.

Spell Checking options window

Select the options you want to change. Following are the descriptions of the options:

Ignore capitalized words—The spelling checker ignores words that begin with a capital letter, 

such as proper nouns.

Ignore words with all capitals—The spelling checker ignores words that contain all capital 

letters, such as acronyms.
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Ignore words with numbers—The spelling checker ignores words that contain numbers.

Ignore words with mixed case—The spelling checker ignores words that contain a mixture 

of uppercase and lowercase characters.

Report doubled words—The spelling checker reports words that appear twice in sequence 

in text and identifies them as Doubled words.

Suggest words—If you select this option, then when the spelling checker encounters an 

unknown word, it displays Eudora’s suggestions for the correct spelling of the word in the 

Suggestions field of the Check Spelling dialog box. You can also select any combination of the 

suggestion options: Phonetic words (off by default), Split words (on by default), Typographic 

words (on by default).

NOTE: If Eudora has no suggestions for the word in its dictionary, then no suggestions are 

listed.

Check spelling:

Automatically as you type—If you select this option, misspelled words will 

automatically be double-underlined and highlighted once you press the Spacebar 

after typing a word.

Only when requested—If you select this option, you can invoke the spell checker 

if you wish after you type your message. 

Outgoing messages:

Ignore original text—The spelling checker ignores any text that is preceded by a 

quote mark, which is an excerpt bar (|). Eudora assumes that this text was originally 

from another message, and therefore does not need to be spell-checked.

Warn me when sending/queueing message with misspellings—If you select 

this option, Eudora displays a warning if you attempt to queue or send a message 

in which it has detected spelling errors.
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Auto-Completion 
(Sponsored and Paid modes only)

The Auto-completion options determine how you will use the name auto-completion feature to 

complete names and email addresses in the To:, Cc:, and Bcc: fields on the message headers 

of your outgoing messages. Eudora completes the names by looking for the names in either 

your history file or address book. 

To display the Auto-completion options window

1. From the Tools menu, choose Options.

2. Scroll and click the Auto-completion icon. 

The Auto-completion options window appears.

Auto-completion options window

Select the options you want to change. Following are the descriptions of the options:

History File—Select to make available the names from your history file to auto-complete in 

the To:, Cc:, and Bcc: fields in the message header. Turn off to not display names and email 

addresses from your history file in the drop-down name list. 

The history file consists of names and email addresses that appear in the To:, Cc:, and Bcc: 

fields in the messages you send, reply to, or forward. 



327

Setting Eudora Preferences

Address Book—Select to make available the nicknames you’ve previously set up in your 

address book to auto-complete in the To:, Cc:, and Bcc: fields in the message header. Turn off 

to not display nicknames from your address book in the drop-down name list.

Plug-in Addresses—Select this option to make available the email addresses stored 

elsewhere in Eudora, for example in ESP.

Don’t auto-complete, just list matches—Select this option if you don’t want Eudora to auto-complete 

your email address as you type it. If you choose this option, you need to just type one letter, and all email addresses 

that start with that letter from your address book and history list appear in a drop-down list for you to choose from.

Use drop down list for completion choices—Select to display the drop-down name list 

when you begin to type a name in the To:, Cc:, or Bcc: fields. Turn off to not display the drop-

down name list.

Names should appear in alphabetical order—Select to display names in the drop-down list 

in alphabetical order. Turn off to display names based on usage.

Add the from lines of replied-to messages—Select to add the name appearing in the From: 

field from a received message that you replied to. This name and email address goes into your 

history file. 

Time to wait before popping up Auto-completion box in milliseconds—Enter the number 

of milliseconds you want to wait before the auto-completion drop-down list appears for you to 

choose a name. The larger the number, the longer the wait. Zero indicates that the name list 

will appear immediately.

Maximum number of entries to keep in history:—Enter the number of names you want to 

keep in your history file at any given time. As you add names, the old entries are removed 

leaving the amount of names equal to the number you entered in this field. 
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Date Display

The Date Display options determine how Eudora displays message dates in the Date column 

of mailbox window message summaries.

To display the Date Display options window

1. From the Tools menu, choose Options.

2. Scroll and click the Date Display icon. 

The Date Display options window appears.

Date Display options window

Select the options you want to change. Following are the descriptions of the options:

Display dates using—This specifies what time zone to use to display dates. 

Sender’s timezone—If selected, messages appear with the sender’s time and 

date, as determined by the sender’s time zone. 

Local timezone—If selected, messages appear with your time and date, based on 

your local time zone.
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Date formats [default: Fixed]—These options and fields specify how to display message 

dates whether with a fixed or an age-sensitive format and the specific formatting for the 

selected option. A fixed format means that all dates appear under the same formatting rule. 

An age-sensitive format means that message dates appear differently depending on how old 

the messages are. Formatting is entered in the text fields using the format key at the bottom 

of the Date Display Options window (discussed further below).

Fixed [defaults: %1 %2 %4]—If you select this option, all message dates appear 

using the formatting entered in the edit field, based on the formatting key (see 

below). The default format (%1%2%4) specifies that all message dates will be in 

this format: message time followed by message date followed by message time 

zone (but only if the message did not originate from your local time zone). Example: 

02:56PM11/21/97-0800.

Age-sensitive—If you select this option, message dates appear differently based 

on the age of the messages. The three age categories are RECENT, OLD, and 

ANCIENT. The age of a message is measured from the date and time at which the 

message was composed or sent, based on the sender’s email package, and this 

depends on your setting for the Display dates using option. RECENT messages 

are all those that are "younger" than the hours you specify in the Hours to be OLD 

field. ANCIENT messages are all those that are older than the "expiration time" 

entered in the Hours to be ANCIENT field. OLD messages are all those ages which 

falls between that of RECENT and ANCIENT messages: they are older than the 

number of hours specified in the Hours to be OLD field, but younger than the 

number of hours specified in the Hours to be ANCIENT field. The date display 

format for all messages falling in the RECENT, OLD, and ANCIENT categories is 

determined by your entry in the RECENT format, OLD format, and ANCIENT 

format fields, respectively.

RECENT format [default: %1]—Your entry in this field determines the format in 

which the dates of RECENT messages appear. RECENT messages are all those 

younger than the number in the Hours to be OLD field. The default RECENT format 

of %1 and the default Hours to be OLD of 24 means that all messages from the 

past 24 hours appear with the time.

Hours to be OLD [default: 24]—Your entry in this field determines the point at 

which RECENT messages become OLD messages. The default entry of 24 hours 

means that messages become OLD after one day.
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OLD format [default: %3]—Your entry in this field determines the format in which 

the dates of OLD messages appear. OLD messages are those that are older than 

the Hours to be OLD but younger than the Hours to be ANCIENT. The default OLD 

format of %3, the default Hours to be OLD of 24, and the default Hours to be 

ANCIENT of 168 means that all messages older than one day and younger than 

one week appear with the day of the week.

Hours to be ANCIENT [default: 168]—Your entry in this field determines the point 

at which OLD messages become ANCIENT messages. The default entry of 168 

hours means that messages become ANCIENT after a week.

ANCIENT format [default: %2]—Your entry in this field determines the format in 

which the dates of ANCIENT messages appear. ANCIENT messages are all those 

older than the number in the Hours to be ANCIENT field. The default entry of %2 

and the default Hours to be ANCIENT of 168 means that all those messages older 

than a week appear with the date.

NOTE: Use the format key displayed at the bottom of the window to determine how to program 

entries in the Fixed field and the format fields (RECENT, OLD, and ANCIENT). In each field, 

enter %1 to stand for the Time, enter %2 to stand for the Date, enter %3 to stand for the Day 

of the week, and enter %4 to stand for the Time zone, but only if the message did not originate 

from the local time zone. Separate each entry with a space to improve readability of the display 

output: for example, %1%2%4.
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Labels

The Labels options determine the title and color of the seven labels that can be used to 

categorize messages.

To display the Labels options window

1. From the Tools menu, choose Options.

2. Scroll and click the Labels icon. 

The Labels options window appears.

Labels options window

To change a label title, type the new title in the field to the right of the label number. 

To change a label color, single-click the label number to display the Color dialog 

box.
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     Color dialog box

You can select from one of the pre-defined Basic colors or create your own Custom colors. To 

assign a basic color to a label, select the color and click OK. To create a custom color, click 

Define Custom Colors to display the custom colors palette.

Custom colors palette 

To define a custom color

1. Select one of the 16 custom color boxes. 

2. Using the mouse pointer, click anywhere on the color palette to select the color Hue 

and Saturation. Use the color control bar to the right of the color palette to adjust 

the color. 

3. When you are satisfied with the color, click Add to Custom Colors. 
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4. Once you have completed creating the custom colors, select the desired label color 

and click OK.
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Getting Attention

The Getting Attention options determine what Eudora does when it is running in the 

background and wants your attention, or when new mail arrives.

To display the Getting Attention options window

1. From the Tools menu, choose Options.

2. Scroll and click the Getting Attention icon. 

The Getting Attention options window appears.

Getting Attention options window

Select the options you want to change. Following are the descriptions of the options:

Use an alert dialog box—If you select this option, an alert dialog box notifies you when new 

mail is received. You will see the alert dialog box only if Eudora is in the foreground.

Open mailbox—If you select this option, mailboxes are automatically opened when new mail 

arrives in them, and the first unread message of the last unread batch of messages is selected.
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Play a sound—If you select this option, a sound is played when Eudora needs attention. To 

select a sound file, click the long, horizontal button below the “Play a sound” option (the button 

is blank by default). Browse until you find your sound file. When the “Select sound file” dialog 

box appears, select a sound and click Open. To switch back to the default mail arrival sound, 

click Use Default.

Generate filter report—If you select this option, a filter report is generated when filters are 

used. Filter reports appear in the Filter Report window, accessed from the Tools menu. Note 

that this option must be on for such reports to appear in that window. 

NOTE: These notifications can be changed on a per message basis using Filters. See Filtering 

Messages on page 161. 
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Background Tasks

The Background Tasks allow you to set parameters that determine how background tasks 

behave and what kind of information you want to see in the Task Status window. In other 

words, you can configure the behavior of background tasks. Also, you can set the Task Status 

and/or the Task Error windows to be brought to the front of other windows in Eudora when 

activity occurs. See Task Status Window on page 225 and Task Error Window on page 227. 

In the Background Tasks options window, you can indicate the number of seconds of user 

inactivity before your newly retrieved mail is actually processed by Eudora. If you have 

automatic mail checking set up in the Checking Mail options, Eudora will retrieve the mail in 

the background from the incoming server at those time intervals. But Eudora will not process 

it until there is no user activity performed on your computer for the amount of seconds you 

indicate in the Background Tasks options window. An envelope displayed on the status bar, 

located at the lower right-hand corner of the Eudora window, indicating there is retrieved mail 

to be processed; that is, messages to be filtered and placed in mailboxes.

Technical Note. In the background, Eudora retrieves and sends mail; in the foreground, 

Eudora processes attachments and applies filters.

 To display the Background Tasks options window

1. From the Tools menu, choose Options.

2. Scroll and click the Background Tasks icon. 

The Background Tasks options window appears.
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Background Tasks options window

Select the options you want to change. Following are the descriptions of the options:

Task Status Columns—These options determine which columns appear in the Task Status 

window. Check the box next to the field column that you want to display. The options are Task, 

Persona, Status, Details, and Progress.

Task—Displays an icon with a short description of the tasks’ actions.

Persona—This column is available only if there is more than one personality set up. If 

checked, the Personality column displays the personality name for the given task.

Status—Displays a general description of the tasks current status, for example, “Logging into 

POP server.”

Details—Displays more information of the tasks’ status including network protocol commands. 

Progress—Displays a progress bar indicating the overall progress of the tasks.
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Wait for _ seconds of user inactivity before processing/filtering downloaded 
messages—[default: 20 seconds) If Eudora is retrieving mail automatically in the background, 

the amount of time set in this field indicates the idle time Eudora waits before delivering mail 

to your mailboxes and folders. For example, if you are composing a message and Eudora is 

retrieving mail in the background, Eudora will not deliver the mail until you stop typing for the 

amount of time indicated here. If the you set the time for 5 seconds, Eudora delivers your mail 

if you stop typing for at least 5 seconds. This field is beneficial if you don’t want to be 

interrupted too frequently while using Eudora. If the number in this field is large, you’ll get fewer 

interruptions. 

Bring error window to front—Select this option to have the Task Error window brought to the 

front when an error occurs.

Bring task status window to front—Select this option to have the Task Status window 

brought to the front when a task occurs, for example sending or receiving mail.
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Automation

The Automation options let you control and exchange information with Eudora from other 

programs that support the Windows Automation Interface, such as Microsoft Visual Basic. 

These options give you external access to Eudora mail folders, mailboxes, and messages, and 

to the Eudora application itself. With automation enabled, you can create, delete, and move 

Eudora mail folders, mailboxes, and messages, as well as get notification of these three 

operations when they are performed manually. You can also get lists of the subfolders under 

folders and of the messages within mailboxes. For more information on the automation 

feature, see the following Web site, click the following URL.  
http://eudora.qualcomm.com/developers, where you can find up-to-date automation 

SDKs (Software Developer’s Kits) and documentation.

To display the Automation options window

1. From the Tools menu, choose Options.

2. Scroll and click the Automation icon. 

The Automation options window appears.

Automation options window

http://eudora.qualcomm.com/developers 
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Select the options you want to change. Following are the descriptions of the options:

Automation enabled from this machine—If you select this option, you can perform the 

automation operations described above from the computer on which Eudora is installed.

Warn on Automation auto-send of messages—If you select this option, a warning will 

appear if any message is sent automatically. For example, if you have a message set to be 

sent a certain time, a warning appears just before the message is sent. Another advantage is 

that if a virus ever tries to replicate itself using your address book entries, this warning will 

appear.
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Extra Warnings

The Extra Warnings options determine whether you are warned before making a possible 

mistake. Most of the warnings appear with an option to stop that warning from being displayed 

again. You can toggle warnings to be either on or off.

To display the Extra Warnings options window

1. From the Tools menu, choose Options.

2. Scroll and click the Extra Warnings icon. 

The Extra Warnings options window appears.

Extra Warnings options window

Select the options you want to change. Following are the descriptions of the options:

Delete unread mail—If you select this option, you are warned if you try to delete mail that is 

marked unread.

Delete queued mail—If you select this option, you are warned if you try to delete mail that is 

queued to be sent (marked  or  for timed-queue) in the Out mailbox.

Delete unsent mail—If you select this option, you are warned if you try to delete messages 

that are marked sendable (with a bullet in the Out mailbox) but not yet sent.
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Delete _ or more messages at a time [default: 50]—If you select this option, you are warned 

if you try to delete a group of messages containing more messages than the specified number.

Delete a message from the Search results—If you select this option, you are warned if you 

try to delete messages from the Find Messages search results window.

Queue a message with no subject—If you select this option, you are warned if you try to 

queue a message that contains no text in the Subject line. It is considered a point of email 

etiquette to give each message a subject.

Queue a message bigger than _ K [default: 500]—If you select this option, you are warned 

if you try to queue or send a message that is greater in size than the specified number. This 

number must be between 0 and 1000000 (one million, no commas). This size includes 

messages and attachments. 

Quit with messages queued to be sent—If you select this option, you are warned if you try 

to quit Eudora while there are still queued messages in your Out mailbox.

Empty the Trash mailbox—If you select this option, you are warned if you try to empty the 

Trash mailbox (one way is using the Special menu Empty Trash command). Once messages 

are deleted from the Trash, they are completely gone from your system.

Start Eudora and it’s not the default mailer—If you select this option, you are warned if you 

try to start Eudora when it’s not the default mailer. When Eudora is the default mailer, <mailto:> 

commands open a Eudora message, regardless of what application the command is in.

Launch a program from a message—If you select this option, you are warned if you try to 

launch a program from a message. For security reasons, you should never launch a program 

sent to you from an unknown source, or if you’re not expecting a program without performing 

a virus check on the file. Do not launch any program if you don’t know the sender.

Launch a program externally—If you select this option, a warning alerts you to be careful 

when opening an attachment outside of Eudora, for example directly from the Attachments 

directory or from a Eudora Sharing Protocol (ESP) directory.

Forward files that are not in the attachment directory—If you select this option, Eudora will 

warn you when you forward a message and files are attached that do not reside in your 

attachment directory.
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Enter an invalid server when creating a new personality—If you select this option, Eudora 

validates the connection to your mail server when creating a new personality, and will warn 

you if it is unable to connect to the server name you have entered.
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MAPI

The MAPI options control the Eudora MAPI Server. Eudora’s MAPI support allows you to 

quickly attach documents to email messages directly from the application that created the 

document. Without MAPI, you must first save the document, remember what folder the 

document is in, switch to Eudora, and then remember to manually attach the document to the 

outgoing message. MAPI streamlines this process dramatically. 

To email the current open document from your word processor, select the Send command from 

your word processor’s File menu. This automatically activates Eudora and attaches a 

snapshot of the open document to a new composition message. The MAPI system 

standardizes how messages are handled by client applications so that each client application 

does not need to have a custom code for each target messaging application. MAPI 

accomplishes this by providing a standard application program interface used by all MAPI-

enabled client applications. An additional MAPI feature supported by Microsoft Office 

applications is the ability to add a “routing slip” to a Word, Excel, or PowerPoint document. This 

routing slip contains a list of email recipients obtained from the MAPI subsystem. Once a 

document has an embedded routing slip, then it can be semi-automatically routed as an 

attachment via email to all recipients listed in the routing slip. Once the routing is complete, the 

annotated document is returned back to the original sender.

NOTE: Close all other MAPI applications before changing Eudora’s status as a MAPI server.

To display the MAPI options window

1. From the Tools menu, choose Options.

2. Scroll and click the MAPI icon. 

The MAPI options window appears.
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MAPI options window

Select the options you want to change. Following are the descriptions of the options:

Use Eudora MAPI server—If “Never” is selected, the Eudora MAPI server is turned off and is 

never automatically loaded. If “When Eudora is running” is selected, the Eudora MAPI server 

is selected when Eudora is running. If “Always” is selected, the Eudora MAPI server is selected 

and is always loaded on startup.

Delete MAPI attachments—If “Never” is selected, MAPI attachments are never deleted from 

the attachment directory. If “After sending message” is selected, MAPI attachments are 

deleted from the attachment directory when their corresponding messages are sent. If “When 

message emptied from Trash” is selected, MAPI attachments are deleted from the attachment 

directory when their corresponding messages are emptied from the Trash.
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Send single MAPI file attachment as inline attachment (TXT and HTML files only)—
Select this when you need to have the MAPI client send a single TXT or HTML file as an 

attachment with no body text. Eudora turns off the “Text As Attachment” button in the outgoing 

message toolbar (if it is selected), so that the document is sent to the recipient as inline text in 

the message body. This allows MAPI clients, such as Internet Explorer, to pass Web pages 

and other HTML and TXT documents right into the body of the Eudora message. (The “Text 

As Attachment” button, if turned on in the outgoing message toolbar, instructs Eudora to attach 

text files, such as TXT and HTML, to the message rather than incorporating the text into the 

message as part of the message body. The default state of this button is controlled by the “Put 

text attachments in body of message” option in the Attachments options. See Attachments on 

page 311. 
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Advanced Network

The Advanced Network options control some of Eudora’s advanced network functions.

WARNING: Consult your email administrator before modifying any of these options.

To display the Advanced Network options window

1. From the Tools menu, choose Options.

2. Scroll and click the Advanced Network icon. 

The Advanced Network options window appears.

Advanced Network options window
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Select the options you want to change. Following are the descriptions of the options:

Network open timeout _ seconds [default: 300]—This option lets you set the number of 

seconds before an attempt to make a network connection will time out. For some servers 

(especially those with heavy loads), the attempt to establish the network connection can take 

longer than it takes to send data back and forth once the connection has been made. A familiar 

example: When you are browsing the World Wide Web, you may find that it takes a while to 

connect to a server, but then, once you have connected to the server, the Web page can seem 

to download quickly. This option therefore gives you the ability to set a different (and usually 

longer) timeout for establishing the network connection. This setting is different from the 

setting for the timeout after the connection has been made. The latter timeout is set via the 

“Network timeout after _ seconds” option, below.

Network timeout after _ seconds [default: 300]—This option lets you set the number of 

seconds before an established network connection will time out. See the discussion above for 

the Network open timeout _ seconds option.

Network buffer size of _ bytes [default: 4096]—This option lets you set the size, in bytes, of 

the buffer that Eudora uses to transfer information to and from the server.

NOTE: If you are having trouble transferring large messages, the size of this buffer may be 

decreased.

Cache network info—This option causes Eudora to remember the results of previous 

database functions when using the Winsock connection method. This speeds up database 

functions within a single Eudora session.

Unload Winsock DLL after closing socket—If you are using Winsock dialer, select this 

option if you like to have your computer dial and hang-up between functions, for example 

sending and receiving mail. 
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Kerberos

These options control the Kerberos authentication system. If your network uses Kerberos for 

authentication, the appropriate options are provided by your email administrator.

To display the Kerberos options window

1. From the Tools menu, choose Options.

2. Scroll and click the Kerberos icon. 

The Kerberos options window appears.

Kerberos options window

Select the options you want to change. Following are the descriptions of the options:

Kerberos Authentication—Turn on Kerberos 5 to authenticate the POP, IMAP, and SMTP 

protocols. 

Kerberos 4 (POP only)—Turn on Kerberos 4 to authenticate POP only.

Kerberos POP3 port—This is the port that the Kerberos POP server is listening on.

Realm—This is the network realm that the Kerberos server resides in.
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Service name [default rcmd]—This is the type of service that you’re requesting.

Service format [default: %1.%4@%3]—This is the name of the ticket that Eudora requests 

from the Kerberos server. The formatting key below this field indicates what to enter. Enter %1 

to stand for the service name entered in the Service name field; enter %2 to stand for the full 

domain name of the POP host; enter %3 to stand for the realm entered in the Realm field; enter 

%4 to stand for the name of the POP host.

For more information about Kerberos, see the following Web site. Click the following URL: 

http://web.mit.edu/kerberos/www/index.htm

http://web.mit.edu/kerberos/www/index.html 
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MoodWatch (Sponsored and Paid modes only)

In the MoodWatch options window, you can determine at what level you wish your messages 

to be monitored before a warning appears telling you that, perhaps, your message content 

may be offensive to your recipient. Also, you can set MoodWatch to monitor incoming and 

stored messages for offensive content.

If you don't want to use MoodWatch at all, you can turn it off in this window. Also, you can 

choose if you want to use MoodWatch for incoming messages only, outgoing messages only, 

or both.

To display the Extra Warnings options window

1. From the Tools menu, choose Options.

2. Scroll and click the MoodWatch icon. 

The MoodWatch options window appears.

MoodWatch options window

Select the options you want to change. Following are the descriptions of the options:

Enable MoodWatch—If checked, MoodWatch is on. To turn MoodWatch off, just uncheck the 

box.
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Warn when queueing/sending—The following options warn you when MoodWatch detects 

anything that may be offensive in your message. 

Message seems like it might be offensive—Turn this option on to set 

MoodWatch to its most sensitive level. If your message has some content that 

looks like it might be offensive (one chili pepper appearing), you will be warned 

when you queue it.

Message is probably offensive—Turn this option on to set MoodWatch to a 

medium sensitivity level. If your message has some content that looks like it is 

offensive (two chili peppers appearing), you will be warned when you queue it.

Message is on fire—Turn this option on to set MoodWatch to a low sensitivity 

level. If your message has some content that is offensive (three chili peppers 

appearing), you will be warned when you queue it.

Never—Turn this option on to never display a warning in your outgoing messages, 

despite offensive text in its content.

Delay when queuing/sending—The following options allow you to delay sending an 

offending message giving you time to “cool off.” During the delay period, you can either delete 

the message or send it. After the delay period is over, your message will be sent.

Message seems like it might be offensive—Turn this option on to delay a 

message to be sent when MoodWatch is at its most sensitive level. If your 

message has some content that looks like it might be offensive (one chili pepper or 

more appearing), your message will sit in your Out box for ten minutes before 

Eudora sends it.

Message is probably offensive—Turn this option on to set MoodWatch to a 

medium sensitivity level. If your message has some content that looks like it is 

offensive (two chili peppers or more appearing), your message will sit in your Out 

box for ten minutes before Eudora sends it.

Message is on fire—Turn this option on to set MoodWatch to a low sensitivity 

level. If your message has some content that is offensive (three chili peppers 

appearing), your message will sit in your Out box for ten minutes before Eudora 

sends it.

Never—Turn this option on to never delay your outgoing messages being sent, 

despite offensive text in its content. This is the default.
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Scanning incoming mail

Scan new mail as it arrives—Turn this option on to allow MoodWatch to scan all 

of your incoming mail. MoodWatch determines the level of offensive text contained 

in the message. MoodWatch then displays one, two, or three chili peppers in the 

MoodWatch column of the mailbox where the message resides.

Scan stored mail in the background—Turn this option on to allow MoodWatch 

to scan all of your stored messages. MoodWatch determines the level of offensive 

text contained in each message. MoodWatch then displays one, two, or three chili 

peppers in the MoodWatch column of the mailbox where the message resides.
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Statistics (Sponsored and Paid modes only)

In the Statistics options window, you can choose the color and graph type you prefer when 

displaying and printing the Statistics window found in the Window menu. The Statistics window 

displays your email usage, that is the statistics on received, sent, and general Eudora usage. 

You can display this information for the current or previous day, week, month, or year.

To display the Statistics options window

1. From the Tools menu, choose Options.

2. Scroll and click the Statistics icon. 

The Statistics options window appears.

Statistics options window

Choose the settings you want to change. Settings are described below.

Series—This column lists the different timeframes displayed in the Statistics window. Current 

refers to the current day, week, month, or year, as selected in the Statistics window. Previous 

refers to the previous day, week, month, or year, as selected in the Statistics window. Average 

is the cumulative average that occurs on a day-to-day basis. For example, if you choose to 

view your statistics for each day, the current graph would be today, and the previous graph 

would be yesterday. The average graph would indicate the cumulative average since you 

began keeping statistical information in Eudora.
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Color—Choose the color you wish to represent the current, previous, and average criteria.

Graph Type—Choose the graph type you prefer to display for the current, previous, and 

average criteria. The graph type you choose will appear in the color you chose in the Color 

column. The graph types you can choose are a line, a solid (filled) area, a graph bar, a circle, 

diamond, or a square.

Count IMAP messages in Inbox only—Turn this option on if you want Eudora, for statistical 

purposes, to count only the IMAP messages received in the Inbox. Turn this option off if you 

want Eudora to count all received IMAP messages regardless of which mailbox they are 

received into. If you use shared IMAP folders, you’ll probably want to leave this turned on; 

otherwise. messages that are not really addressed to you may get counted.

Reset Statistics—Click this button to reset your statistical usage. All historical information on 

your Eudora usage is deleted. Statistical information will then begin from that moment on. 
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Miscellaneous

The Miscellaneous options determine additional Eudora capabilities that are not categorized 

with other functions.

To display the Miscellaneous options window

1. From the Tools menu, choose Options.

2. Scroll and click the Miscellaneous icon. 

The Miscellaneous options window appears.

Miscellaneous options window

Select the options you want to change. Following are the descriptions of the options:

Switch messages with: 

Unmodified arrow keys—If you select this option and if there is an incoming 

message window open on the screen, the up or left arrow key closes the current 

message and opens the previous message in the mailbox. The down or right arrow 

key closes the current message and opens the next message in the mailbox. If this 

option is turned off, the arrow keys can be used to move the cursor (insertion point) 

within messages and in the preview pane.
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NOTE:  The preview pane will get updated to correspond to the current message 

in focus. This can be an easy way to read your mail. To enable the preview pane, 

see Viewing Mail on page 317. 

Even if you select this option, the arrow keys do not switch messages if there is an 

outgoing message topmost on the screen.

Ctrl+arrow keys—If you select this option, you can switch messages by holding 

down the Ctrl key and pressing the arrow keys. The switching behavior is described 

above under the Unmodified arrow keys option. The Ctrl+arrow keystrokes do not 

work when composition windows are open on the screen.

Alt+arrow keys—If you select this option, you can switch messages by holding 

down the Alt key and pressing the arrow keys. The switching behavior is described 

above under the Unmodified arrow keys option. The Alt+arrow keystrokes do work 

when composition windows are open on the screen.

Empty Trash when exiting—If you select this option, the Trash mailbox is emptied when you 

exit Eudora. If this is turned off, the Trash is only emptied when you select “Empty Trash” from 

the Special menu.

Say OK to alerts after _ second(s) [default: 120]—If you select this option, any alerts that 

announce a problem with the network communication automatically go away after the 

specified number of seconds. Many network problems are temporary, so this allows Eudora to 

try the communication again. This is most useful if you have automatic mail-checking enabled 

for any of your accounts.

Turbo redirect by default—If you select this option, the behavior of the Redirect command is 

changed. If you frequently redirect mail to a particular person, make that person’s email 

address correspond to a nickname and also add it to your recipient list in your Address Book. 

When you get an email message that you want to redirect, select the message, then choose 

Redirect to from the Message menu, and select the recipient. The message gets queued as a 

redirected message to the recipient, and the original received message gets deleted. This 

method can be used to redirect a large number of messages.

If this option is turned off, then selecting Redirect to a recipient will open the message and wait 

for you to send/queue the message. The original message is kept, but its status is changed to 

“redirected.”
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Include outdated ‘Return-Receipt-To’ (Sponsored and Paid modes only)—If this is turned 

off, Eudora uses the “Disposition-Notification-To:” header in return receipt requests to request 

that you be sent a notification when your message appears by the recipient. If you select this 

option, Eudora also sends the Return-Receipt-To: header in return receipt requests. This 

header is understood by some older mail delivery systems, and may return you a receipt when 

your message is delivered to your recipient’s mailbox. The Return-Receipt-To: header cannot 

give you any information about whether or not your recipient displayed your mail, and is not 

supported by many newer mail delivery systems. Your recipient must specify that he/she wants 

to send you a return receipt for you to receive it.

Automatically expand nicknames (Sponsored and Paid modes only)— If you select this 

option, nicknames in message headers are replaced with the real addresses when you switch 

fields. If turned off, the nickname is expanded when the message is sent.

Auto-save messages every _ minutes—Enter the number of minutes between auto-save 

intervals. In case of a system shut-down, the messages saved are from the most current auto-

save. You can find your saved messages in your Out mailbox.

Hide address books from simple viruses—If this option is on, Eudora uses .nnt as the file 

extension for address book file so that viruses that look for .txt files won’t find them. If this 

option is turned off, address book files are stored with .txt extensions.
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Junk Mail (Paid mode only)

You can change the Junk Mail options in the Junk Mail options window. In this window, you 

can determine at what junk score level you wish your messages to be filtered and adjust other 

junk mail options. 

To display the Junk Mail options window

1. From the Tools menu, choose Options. 

2. Scroll and click the Junk Mail icon. 

The Junk Mail options window appears.

Junk Mail options window

Select the options you want to change. Following are the descriptions of the options:

Junk Threshold—Eudora distinguishes junk mail by a scoring system. You can adjust this 

scoring threshold by using the slide bar indicator. If you slide the arrow to a lower number, 

Eudora filters out more junk mail but may also mistakenly filter more valid mail to the Junk 

mailbox. If you slide the arrow to a higher number, Eudora filters less junk mail but is less likely 

to incorrectly filter valid mail. The default setting is 50. 
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Junk & Address Books 

Mail isn't junk if the sender is in an address book—Check this box to indicate 

that mail coming from people in your address book(s) should never be marked as 

junk mail. 

NOTE: The following field does not work unless you check the Mail isn’t junk if the 

sender in an address book box.

Put Not Junk-ed senders in address book—Check this box to indicate that 

senders of valid mail found in the Junk mailbox are to be added to your address 

book when you select Not Junk from the Message menu. Future mail from this 

sender will never be filtered to the Junk mailbox again. This function works with the 

previous field. 

Junk Mailbox 

Automatically place junk in Junk mailbox—Check this box if you want Eudora 

to filter what it considers junk mail to the Junk mailbox. If this is not checked, junk 

mail appears in your In box and is scored. To see the junk mail score, go the 

Mailboxes option in the Tools menu and check the Junk box (located under the 

Show Mailbox Columns section).

Junk mailbox is never marked unread—Check this box if you don’t want your 

junk mailbox to indicate that it contains unread mail. 

Trimming Junk Mailbox 

Remove mail that is at least _ days old—Enter the number of days you'd like 

Eudora to keep junk mail in the Junk mailbox. Eudora scans the Junk mailbox 

periodically and removes the messages after the set number of days you enter in 

this field.

Warn before removing—Check this box if you want Eudora to warn you that junk 

mail messages are about to be removed from the Junk mailbox.
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Junk Mail Extras (Paid mode only)

You can further change the Junk Mail options in the Junk Mail Extras options window. 

To display the Junk Mail Extras options window

1. From the Tools menu, choose Options. 

2. Scroll and click Junk Mail Extras. 

The Junk Mail Extra options window appears.

Junk Mail Extras options window

Select the options you want to change. Following are the descriptions of the options:

Only remove junk whose score is at least _—A message is moved from the In mailbox to 

the Junk mailbox if the score is at least the number you enter here.

Junking assigns a score of _—When you indicate in Eudora that you would like a message 

to be junked, the score you enter here is assigned to that message. 

Trim old junk to _—You can select where they would like the Junk mail to be stored when it 

is removed from the Junk mailbox, for example another mailbox or Trash.
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Add 'Not Junk'ed senders to address book—.If Put not junked senders in the address book 

is turned on under Junk Mail Options, this option adds addresses of "Not Junk'ed" senders into 

the address book entered here. Important – you must create an Address Book file with the 

same name. 

If Mail isn’t junk if sender is in an address book is selected from the Junk Mail Options list, any 

future email from this sender is not considered junk mail.

Delete fetched junk from server—This option removes junk'ed mail from the email server if 

the mail is being left on the server.

Use Ctrl-J for Junk—If this option, the ctrl-J hotkey maps to junking a message. If this option 

is off, ctrl-J is used for manually filtering messages.
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Content Concentrator  
(Sponsored and Paid modes only)

You can change how the concentrated messages appear in the message window and preview 

pane. 

To display the Content Concentrator options window

1. From the Tools menu, choose Options. 

2. Scroll and click the Content Concentrator icon. 

The Content Concentrator Options window appears.

Content Concentrator options window showing drop-down menu

Select the options you want to change. Following are the descriptions of the options:

Single Message Profiles 

Preview Pane—The profile of single concentrated messages as they appear in the 

preview pane. Choose one of the options from the drop-down menu. Compact is 

the default. Following are the options: 

None—Turns off Content Concentrator. There is no change in the message 

format. 
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Compact—Message is truncated; that is, excess headers and text are removed 

and replaced with ellipses and a snip indicator. Only the To:, From:, Subject:, 

and CC: of the header fields appear.

Terse—Message is truncated further; only the From: field of the header appears 

in the message and the concentrated text. 

Message Window—The profile of single concentrated messages as they appear 

in the message window. Choose one of the options from the drop-down menu. 

None is the default. 

Multiple Messages 

Profile—The profile of multiple concentrated messages as they appear in the 

preview pane. Choose one of the options from the drop-down menu. None is the 

default. 

Maximum # to Concentrate—Enter the maximum number of messages you 

would like to group. Keeping this number small is recommended because 

concentrating a large number of messages can take time. The default is 20 

messages.

Require matching subjects or senders—Check this box if you want subjects and 

senders to match when selecting messages to group. 

Generate multiple messages on reply—Check this box if you want individual 

reply messages to be sent to each sender of each concentrated message instead 

of one message being sent to all the senders.
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BossWatch (Paid mode only)

The BossWatch options determine how BossWatch will alert you to messages being sent to 

addresses that match your designated criteria. 

To display the BossWatch Options window

1. From the Tools menu, choose Options.

2. Scroll and click the BossWatch icon. 

The BossWatch Options window appears.

BossWatch Options window

Warn me additionally with a dialog—If you select this option, Eudora will display a warning 

dialog when you click the Send or Queue button on messages that match your BossWatch 

criteria.

When sending to more than _ recipients—If you select this option, Eudora will warn you with 

a dialog if you are sending to more recipients than the number entered in this setting, as well 

as to addresses on your BossWatch list. 
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NOTE: You must have enabled Warn me additionally with a dialog for the above setting to 

have any effect.

When I do a Reply All—If you select this option, Eudora will warn you with a dialog when you 

queue a message where Reply to All was used to generate the reply, as well as to addresses 

on your BossWatch list. 

NOTE: You must have enabled Warn me additionally with a dialog for the above setting to 

have any effect.

Speak Addresses—If you select this option, Eudora uses the Microsoft Text-to-Speech 

engine to read the addresses that match your BossWatch criteria.

When sending to more than _ recipients—If you select this option, Eudora will warn you by 

speaking the names of your recipients if you are sending to more recipients than the number 

entered in this setting, as well as to addresses on your BossWatch list. 

NOTE: You must have enabled Speak Addresses for the above setting to have any effect

When I do a Reply All—If you select this option, Eudora will warn you by speaking the email 

addresses of your recipients when you queue a message where Reply to All was used to 

generate the reply, as well as to addresses on your BossWatch list. 

NOTE: You must have enabled Speak Addresses for the above setting to have any effect

Domain Warnings—

Outside domain—If you enter a domain in this setting, Eudora will warn you when 

you are sending to a recipient whose address is not within the domain specified. 

Multiple domains may be entered separated by commas.

Inside domain—If you enter a domain in this setting, Eudora will warn you when 

you are sending to a recipient whose address is within the domain specified. 

Multiple domains may be entered separated by commas.

Color code BossWatch addresses using this color:  —If you select this option, 

Eudora will underline addresses from your BossWatch list in your composition window, as well 

as outline the Send or Queue button, with the selected color. You can click on the color to 

customize it.
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Find Messages (Paid mode only)

The Find Messages options determine how Eudora’s ultra-fast indexed search functionality 

will work.

To display the Find Messages options window

1. From the Tools menu, choose Options.

2. Scroll and click the Find Messages icon. 

The Find Messages Options window appears.

Find Messages Options

Use fast (indexed) search powered by X1—This setting turns on the indexed search 

capabilities within Eudora. If this setting is turned off, Eudora will revert to the slower, old-style 

search.

Index Now—Click this button to go through all mailboxes to update the existing index.

Re-Index Email...—Click this button to discard current index files, and begin indexing Eudora 

mail.

NOTE: You should only need to use Index Now and Re-Index Email buttons if indexed search 

is not working properly. Most users should never need to use these buttons.
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Show index update progress in Task Status window when more than _ updates are 
pending—If this option is checked, Eudora will will show a message in the Task Status window 

when there are more index updates to process than the number specified. Default setting is 

100.

Include deleted IMAP messages in search results—If this option is checked, Eudora will 

display deleted IMAP messages in the search results if those messages match the search 

criteria, even though the IMAP mailbox might be configured to hide deleted messages. If this 

option is disabled, Eudora will not display deleted IMAP messages in the search results. 
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Eudora Sharing Protocol (ESP) is a Eudora feature that allows a group of people, called a 

share group, to collaborate and share a common set of files. ESP automatically gives each 

member of the share group a copy of those files, and when one of the members changes a 

file, it brings all the other members' copies up to date automatically. ESP also makes it easy 

for the members of a share group to send email messages to each other. Unlike other 

collaboration tools, ESP uses only email to keep everyone in sync on the shared files, so 

there's no need to maintain and administer a shared server. 

ESP allows you to create and manage share groups within Eudora, on both Windows and Mac 

platforms. If you send and receive email through Eudora, you can belong to an ESP share 

group.

When you join an ESP group, you designate a shared folder on your hard drive. Eudora uses 

the shared folder to keep the most current copies of your group’s documents together. You and 

each member of your group have copies of the shared documents. When you or a member of 

your group adds, deletes, or updates a document, ESP automatically adds, deletes, or 

updates all copies of the document in all of the members’ shared folder.

You can use ESP for projects at work and for family members at home to help them stay in 

touch. For example, you can create a share group by inviting members of your family to share 

their most current photos with each other. When one member of the family adds a digitized 

photo to his or her shared folder, all members of the family can see it. It’s like maintaining a 

family album that can be shared with members of family no matter where they live. 

When communicating between members of your group, email messages from the group 

members are automatically routed to the mailbox of your choice. However, you can assign only 

one mailbox per group.

You do ESP functions from the ESP Groups window found on the Tools menu. These are the 

basic tasks in creating and maintaining a share group:

• Create a share group.

• Assign the share group a mailbox in Eudora and shared folder on your hard drive, 

for example, your C drive.
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• Invite members to join the share group.

• Configure how ESP will update the shared folders.

• Configure how your group members are notified of changes to the shared folder.

• Maintain group membership by inviting or deleting members, or by synchronizing all 

shared folders.

However, you may be asked to join a share group. If so, answer the invitation and the you can 

create a new shared folder and mailbox. 

NOTE: You can only belong to a group on one computer. For example, you can use your home 

computer to set up a group for family photos, and you can use your work computer to set up 

a group for a work related project. However, you cannot use both your home and work 

computer to view your family photos in your family group. If you try to do that, one or both 

computers will miss some of the photos.

However, if you have two different email addresses, you can belong to a share group on more 

than one computer. If you check mail with one email address at work and a different address 

at home, you just need to invite yourself to the share group twice, once for each address. Once 

you’re in the group with one account, you can send an invitation to your other account yourself. 

ESP will treat your two accounts as two different share group members, and each will receive 

all the updates.

Installing ESP

ESP should install automatically into the Eudora Plugins folder. However, if you need to install 

ESP yourself:

• To install ESP on Windows, copy the ESP.dll file to the Plugins folder, located in your 

Eudora folder. 

Tips on Using ESP

Although ESP is a valuable tool for you and your group when working on the same document 

or file, there are some limitations. Here are a few tips on using ESP that will make working on 

group files more efficient.
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• Do realize that the ESP folder is shared. If you take a file out of the shared folder, it 

will be removed from each member's shared folder.

• Do invite people to be in your group. Some of them might have to become familiar 

with ESP before becoming full members. As they are gaining experience, tell them 

how to become full members.

• Do use ESP to keep a shared list of current email addresses for group mailings. ESP 

updates email addresses when you change the email address for a personality. 

When saved in the ESP Groups window, ESP asks you if you want to update both 

your ESP's information and other members' information or just update your ESP 

information. If you choose both, an email message is sent to all group members and 

automatically updates your changed email address.

• Do use ESP as a mini-mailing list for, perhaps, a family, group of friends, coworkers 

and so on. The list of email addresses stays current in all of the members' lists when 

the addresses are modified.

• Don't put large files in ESP. Other members of your group may have mail systems 

with limits on file size.

• Don't put files in ESP where group members need to work on them at the same time. 

ESP works best when one member works on one file at a time.

• Don't put files in ESP that need to be updated in realtime. There will be a few minute 

delay in updated group files.

Creating an ESP Group

You can create an ESP group and then invite members to join it. All members of an ESP group 

are of equal importance. Although you are creating the ESP group, it does not mean that you 

are its leader.

When you create a group, ESP assigns the group a unique identifier, which avoids any naming 

conflicts.

To create a new group:

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.
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ESP Groups window

2. In the ESP Groups window, click New (located at the bottom of the window). 

The Share Group Settings dialog box appears.

Share Group Settings dialog box

3. Choose Create a brand new share group, then click Next. 

The Share Group Name dialog box appears.
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Share Group Name dialog box

4. In the Share Group Name text box, type the name of your group, then click Next.

The Share Group Description dialog box appears.

Share Group Description dialog box

5. In the Share Group Description text box, type a brief description of the group 

purpose or file contents; then click Next. 

The Share Group Mailbox dialog box appears.
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Share Group Mailbox dialog box

6. Do one of the following:

• If you want to create a new mailbox for all group messages, choose Transfer to 
New Mailbox and type the name of the mailbox in the text box.

• If you want all group messages to go to an existing mailbox or a new mailbox in 
a different location, choose Transfer to Existing Mailbox, then click the long 
gray button. A list of your existing mailboxes appears. Right-click to create a 
mailbox in a different location. Click to select a mailbox, then click OK to enter 
it in the text box.

NOTE: You can’t transfer messages to either the In mailbox or a mailbox already 

assigned to another group. 

7. Click Next. The Share Group Folder dialog box appears.
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Group Folder dialog box

8. Do one of the following:

• If you want to create a new folder to store all group files, choose Use New 
Folder and type the name of the folder in the text box.

• If you want to create a new folder in a location other than the one shown under 
Use New Folder, switch to My Computer or Windows Explorer, create the 
folder, and switch back to Eudora. Choose Use Existing Folder to navigate to 
the folder you’ve just created, then choose it.

• If you want to store all group files in an existing folder, choose Use Existing 
Folder and click the long gray button. A list of your existing folders appears. 
Click one of the folders and to enter it in the field, click OK.

NOTE: You can’t use a folder already assigned to a group or a folder that’s inside 

of another folder already assigned to a group.

9. Click Next. 

The Success dialog box appears. 

10. Click Finish. 

Your new share group is created.

The share group name appears in the list view attachment of the groups window.



376

Eudora Sharing Protocol

Creating an ESP Group (Advanced Setup)

After you feel comfortable creating groups, you can bypass it and enter the group information 

directly. 

To use the Advanced Group Setup function:

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. Click New (located at the bottom of the window). 

The Share Group Settings dialog box appears.

Share Group Settings dialog box

3. Choose Skip directly to advanced share group setup. 

The New Group dialog box appears.
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New Group dialog box (same dialog box as the Eudora tab) 

4. Type the new group name in the Group Name text box.

5. Click the Shared Folder long gray button and choose a folder for this group. Click 

OK. 

6. Click the Mailbox long gray button and choose a mailbox for this group messages. 

Click OK.

7. Click the Personality long gray button and choose the Eudora personality you 

want linked with this group. Click OK.

8. In the Description text box, type a brief description of the group function or 

contents (optional).

9. Click OK. 

ESP adds the new share group to your list of groups. The share groups you create are listed 

in the ESP Groups window in the left column.

Inviting Members to Join Your Group

To be fully functional, your group must contain members in addition to yourself. Once you invite 

someone, you can determine at what level a role they will play within the share group. You can 

invite members to the group who can receive only the group messages. 
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To invite users to join your group:

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. In the left column, choose the Group name to which you want to invite members. 

3. Click the User tab. 

The User dialog box appears.

4. Click Invite. 

The Share Group Role Settings dialog box appears.

NOTE: To add a user to receive the group messages only, press the Shift key while 

clicking Invite. The Advanced Add dialog box appears where you can enter the 

person’s name and email address. The user’s name and email address is stored 

in your Users list, but ESP doesn’t send an invitation. This user receives only email 

messages that have the group shared documents as attachments. 

Share Group Role Settings dialog box
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5. You can determine which tasks each invitee to your group can do. In the Initial Role 

area, choose of the following roles:

• No Preference

• Full Membership (user sends and receives updates). This allows the person 
you invite to receive from and send files to the group, either automatically or 
manually.

• Broadcasting Member (user only sends updates, ignores any incoming 
updates). This allows the person you invite to send files top the group only, 
either automatically or manually. Incoming files are ignored.

• Receiving Member (user never sends updates, but processes incoming 
updates). This allows the person you invite to receive files from the group only. 
Any changes you make to the shared folder are ignored.

The system default is No Preference.

6. In the Notifications area:

• If you want ESP to notify the person you invite when updates are coming into 
your shared folder, check the Ask before processing any updates INCOMING 
TO my shared folder box. This box is checked by default. 

• If you want ESP to notify the person you invite when updates are going out of 
your shared folder, check the Ask before processing any updates 
OUTGOING FROM my shared folder box. This box is checked by default.

• If you want ESP to warn the person you invite when the potential member 
attempts to change role type, check the Prefer that user does not change role 
(displays warning) box. If checked, the member can change role type but is 
discouraged to do so.   

7. Click OK. 

A message window opens that contains an invitation message for the selected 

group. This message has a special attachment containing the group invitation. 

8. In an open message window, enter the email addresses of the invitee(s) in the To: 

header. 

When an invitee accepts the invitation, information contained in the attachment creates a 

group entry in the invitee’s Groups window and prompts him or her to specify a group folder 

and mailbox. ESP sends an RSVP message back to the inviter. The inviter then sends an 

updated copy of the membership list to all the members.
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Configuring Shared Folder Settings

Every group member needs a shared folder on his or her hard drive to store documents, 

schedules, messages, illustrations, images, or any other file the members deem necessary for 

sharing. ESP allows you and your group members to determine how often ESP checks each 

member’s shared folder for updates, and how the information in the shared folders is backed 

up.

To configure shared folder settings for your group

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. In the left column, choose the Group name whose shared folders you want to set. 

3. Click the Settings tab. 

The Settings dialog box appears.

Settings dialog box

4. Check the Check shared folder for changes every _ minutes box and specify 

the time interval at which you want ESP to check the shared folder for group 

updates. If this option is not checked, ESP won’t check the shared folder. The 

system default is for ESP to check the shared folder every 10 minutes.

5. If you want ESP to automatically create a backup when other members update files 

in the shared folder, check the Auto-Backup updated documents box. The box 

is checked by default.



381

Eudora Sharing Protocol

6. If you want ESP to automatically back up deleted documents from the shared 

folder, check the Auto-Backup deleted documents box. The box is checked by 

default.

7. In the Store up to _ previous versions text box, indicate the number of previous 

document versions you want Eudora to store.The system default is one version.

Configuring Group Change Notifications

You can specify the role you want to play in the group, which determines whether or not you 

can send or receive updates to the shared folder. When you’ve determined your ESP role, you 

can then decide how you want ESP to handle updates to the shared folder and group 

membership.

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. In the left column, choose the Group name whose change notifications you want to 

set for your role. 

3. Click the Notifications tab. 

The Notifications dialog box appears.

Notifications dialog box
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4. Click one of the following in the Role area: 

• Full Membership (user sends and receives updates). This allows you to 
receive from and send files to the group, either automatically or manually.

• Broadcasting Member (user only sends updates, ignores any incoming 
updates). This allows you to only send files to the group, either automatically or 
manually. Incoming files are ignored.

• Receiving Member (user never sends updates, but processes incoming 
updates). This allows you to only receive files from the group. Any changes you 
make to the shared folder are ignored.

• Custom Member (use the settings in the Advanced tab). Go to step 6.

The Full Member role is the default.

5. In the Notifications area:

• If you want ESP to notify you when updates are coming into your shared folder, 
check the Ask before processing any updates INCOMING TO my shared 
folder box. This box is checked by default. 

• If you want ESP to notify you when updates are going out of your shared folder, 
check the Ask before processing any updates OUTGOING FROM my 
shared folder box. This box is checked by default.

• If you want ESP to monitor any of the group actions, check the Log any group 
actions box. The box is checked by default. A log file is created and placed in 
a subfolder in the Eudora folder.

• If you want ESP to notify you prior to changes in the group’s membership, check 
the Ask before responding to a membership update box. The box is checked 
by default.

• If you want ESP to record all changes to group membership, check the Log any 
membership update box. A log file is created and placed in a subfolder in the 
Eudora folder.The box is checked by default.

6. If you chose Custom Member as your role, you must click the Advanced tab to 

display the Advanced dialog box to configure your role settings. In this dialog box, 

you are required to make various decisions about how you want ESP to handle 

modifications to the shared folder. It also enables you to choose how ESP should 

track group membership. 
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Advanced dialog box

7. In the Shared Folder Action (Custom Member) area:

• Determine which type of incoming or outgoing items—New Items, Updated, or 
Deleted Items—you want ESP to handle.

• From the drop-down lists, choose one of the following:

• To have ESP notify you before specific files in the shared folder are added, 
updated or deleted, choose Ask first.

–To have ESP modify specific files in the share folder automatically, choose  
Do file updates.

–To have Eudora ignore proposed updates to specific files in the shared 

folder automatically, choose Ignore file updates.

• If you want Eudora to record the activity for each type of incoming or outgoing 
item, check the Log box. 
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NOTE: The system default options from the drop-down menus for all incoming and 

outgoing menus correspond to the last chosen options you selected in the 

Notifications dialog box. The Role buttons combined with the Ask before 

processing any updates INCOMING TO my shared folder and Ask before 

processing any updates OUTGOING FROM my shared folder are then equal to the 

choices in the drop-down menus. The Advanced tab dialog box allows you to add, 

update, and delete settings independently of each other. Whereas in the 

Notifications dialog box, while simpler, keeps the settings locked. For example, you 

could use the Advanced tab dialog box to specify that you want to be asked when 

a delete occurs, but not when additions and updates occur. 

8. To set a group secret word or phrase, click Set Shared Secret. 

The Set Shared Secret dialog box appears.

Shared Secret dialog box

9. In the text box, enter a secret word or phrase that will be known only to you and the 

other members in your group. You will need to share the secret word or phrase with 

the other group members. The secret word or phrase is used to make the 

transmission of file changes more secure so that ESP can verify any incoming file 

changes were actually sent by a group member.

NOTE: If your shared secret does not match the shared secret of other group 

members, you will get a security error when you receive file changes from them. 

So if you choose to use a shared secret word or phrase for improved security, be 

sure that all group members set the exact same shared secret word or phrase. The 

secret word or phrase is case-sensitive. 

10. When finished, click OK. 
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Maintaining ESP Group Members

In the User dialog box in the Groups window, you can maintain your group members by 

deleting them from the group, inviting new members, or by syncing the selected member’s 

shared folder.

To maintain group members:

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. In the left column, choose the group whose users you wish to maintain.

3. Choose the Users tab. 

The Users dialog box appears, and a list of members of the selected group 

appears.

User dialog box

4. In this dialog box, you can do all of the following:

• Invite—To invite a new ESP member to join the group, click Invite. See Inviting 

Members to Join Your Group on page 377.
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• Delete—To delete group members, choose the member’s name and click 

Delete.You should use this function to delete invalid members. To preserve group 

participation and communication, use the Delete function sparingly. In most 

situations, the departing group member uses the Leave function to notify all group 

members of the departure from the group. The Delete function bypasses this 

process.

•  Sync Folder—To send the entire contents of your shared folder to another group 

member, choose the member’s name and click Sync Folder.   

NOTE: ESP updates email addresses when you change the email address for a personality. 

When saved in the ESP Group window, ESP asks you if you want to update both your ESP's 

information and other members' information or just update your ESP information. If you 

choose both, an email message is sent to all group members and automatically updates your 

changed email address.

Joining an ESP Group

ESP manages group membership through a shared mailing list, allowing group members to 

share files and messages. ESP creates the mailing list through a series of processes, called 

invitations, ensuring that each member of the group has explicit knowledge of group 

membership by acknowledging and approving each new member.

To join an existing group

1. Wait for an email message from one of the group members inviting you to join their 

group. 

The Join ESP Share Group dialog box automatically appears after Eudora is done 

receiving the email message. 

Join ESP Share Group

2. To join the group, click Join. If you don’t want to join, click Cancel.
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ESP prompts you to join the group by opening the New Group Wizard. Choose a folder to store 

your copies of the shared documents and a mailbox to receive messages associated with the 

group. See Creating an ESP Group on page 371 for details.

ESP processes the invitation, adds you as a member of the group, and sends an RSVP 

message to the member who invited you to join. When the inviter's copy of ESP receives your 

acceptance, you'll be sent a membership update message which will add the other group 

members to your list.

NOTE: Until you receive an introduction from another group member, ESP doesn’t associate 

those members with you as part of the group.

When all introduction messages are received and answered, you are a member of the group.

Leaving an ESP Group

When you want to leave a group, ESP removes the group from your list of available groups 

and sends a message to the other group members asking them to remove you from the group.

To leave a group

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. In the left column, choose the name of the group you want to leave. 

3. Click Leave (located at the bottom of the Groups window). 

The Leave Share Group dialog box opens.

Leave Share Group dialog box

4. In the Leave Group dialog box, click Leave. 
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ESP creates a message to other group members announcing your departure from the group. 

This message’s attachment deletes you from other group members’ membership lists. 

Until you save changes to the ESP Groups window, you can cancel your departure from the 

group. Just choose the share group that you had planned to leave and click Rejoin, which is 

what the Leave button will be renamed when you chose this group. 

If you're sure you want to leave the group, then save changes to the ESP Groups window by 

either closing the window and choosing Save in the displayed dialog box or by choosing Save 

from the File menu. ESP will send a message to other group members announcing your 

departure from the group.

Working with Shared Folders

Use the shared folder like any folder in Windows by adding, modifying, or deleting files as 

needed.

To open the shared folder:

1. From the Tools menu, choose ESP Groups.

2. In the left column, choose the name of the group you want to open and click Open 
Folder. 

The Save Changes dialog box opens if you have any unsaved changes to the 

shared folder. If not, the shared folder opens, allowing you to access its files.

ESP periodically scans the folder for changes, according to your settings, and sends the 

updated files to other group members. 

To update the shared folder of another group member manually, choose the member from the 

Users dialog box and click Sync Folder. This sends the entire contents of the shared folder to 

the selected member.

As ESP receives periodic changes to the shared folder from other users, it incorporates the 

changes according to the settings you chose for the group (for example, with or without 

notification, and with or without archiving).
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Changing ESP Group Information

ESP allows you to change the configuration of a share group to meet the changing needs of 

its members. The same tabs (User, Eudora, Settings, Notifications, and Advanced) you used 

to create a share group and configure its attributes can be used to change those of an existing 

group.

To make changes to an existing share group:

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. In the left column, choose the group you wish to change.

3. Click any of the tabs and make your changes in their respective dialog boxes.

4. When finished, click OK.

Configuring Global ESP Settings

You can control the type of messages received by the shared folder through the use of filters 

and automatic processing actions. 

NOTE: It is recommended that you retain the default settings. 

To configure your group settings:

1. From the Tools menu, choose ESP Groups. 

The ESP Groups window appears.

2. Click Settings (located a the bottom of the Groups window). 

The Group Setting dialog box appears.
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Group options window box

3. In the ESP Automatic Filters Precedence area, choose Run automatic filters 
before user filters or the Run automatic filters after user filters. Depending on 

which option you activate, ESP filters incoming messages into the shared folder 

either before or after your own filters take effect. To run the automatic ESP filters 

before your personal filters is the default.

4. In the Automatic Actions area, check the Allow automatic processing of 
incoming attachments box if you want the shared folder updated automatically 

with email message attachments as specified in the Settings dialog box. The 

default is to automatically process incoming attachments.

5. If you want your shared folders scanned automatically at the frequency you 

specified in the Settings dialog box, check the Allow automatic scanning of 
shared folders box. The system default is to allow automatic shared folder 

scanning.

Using the ESP Mailbox and Folder

When you create or choose a mailbox for the ESP group, two tabs appear in the window as 

well as an icon. One contains all the messages in the mailbox, and other contains the shared 

folder and its files. The icon displays the ESP menu. 

Following is an example of an ESP mailbox.
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Sample ESP mailbox window 

When you click the Mailbox tab, messages associated with this group appear. While in the 

ESP mailbox, you can perform all the tasks and functions as in any other Eudora mailbox.

When you click the Folder tab, a browser window appears containing the shared folder and 

its files. 

When you click , the ESP menu appears. From this menu, you can choose to perform for 

the group. 

Following is an example of an ESP Folder displaying the ESP menu.
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Sample ESP Folder window and ESP menu

To display the ESP menu, click . Following are the descriptions of the options on the ESP 

menu:

New Message—Opens a new composition window addressed to the group for you to type a 

message.

Open Folder—Opens your shared folder in a new window.

Invite—Invites a new member or members to join the group. See Inviting Members to Join 

Your Group on page 377.

ESP Groups—Opens the ESP Groups window.

Update Others—Updates the files in other members’ shared folders.

 The file management icons are described below:

Displays one page back

Displays one page forward

Moves up one directory level
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Displays the properties for the selected file

Deletes the selected file

Displays files with large icons

Displays files with small icons

Displays files in a list format

Displays file detail
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Eudora Modifiers

Many operations in Eudora can be implemented by holding down one or more “modifier” keys. 

Eudora uses the Shift, Ctrl, and Alt keys as modifiers. Keys you need to press are displayed 

between brackets ([ ]).

[Shift] + Check Mail—Displays the Mail Transfer Options dialog to define the interaction with 

your POP account.

[Shift] + Queue/Send—Opens the Change Queueing dialog.

[Shift] + Insert Recipient—Inserts the address(es) instead of the nickname.

[Shift] + [Ctrl] + ,—Expands the nicknames in the current field to their real addresses (the 

cursor must be in the appropriate field).

[Shift] + Finish Address Book Entry—Finishes the Address Book entry with the address(es) 

instead of the nickname.

[Shift] + Sort command—Sorts in descending order.

[Shift] + Transfer—Puts a copy of the current message in the selected mailbox and leave the 

original where it is.

[Shift] + Wrap Selection—Removes the carriage returns from the selected text (unwrap).

[Shift] + Save—Saves changes to all open windows.

[Shift] + Close—Closes all open windows.

[Shift] + Exit—Sets all open windows to open again when Eudora is next started.
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[Shift] + Check Spelling—Performs an “inline” spelling check of the entire message or 

selected text. Misspelled words are highlighted in red double-underline. Right-click on a 

highlighted word and select the correct spelling from suggestions on a drop-down list.

[Shift] + [Space]—Switches the status of the open incoming message, or one or more 

selected incoming messages, from “read” to “unread” or from “unread” to “read.”

[Ctrl] + [Space]—Resets the current or selected text in the message body of a composition 

window to the default character formatting.

[Ctrl] + Drag window or toolbar—Temporarily suspends docking while dragging a dockable 

window or the main toolbar.

[Alt] + Drag toolbar button—Moves the button on the toolbar.



397

Using Modifiers and Shortcuts

Eudora Shortcuts

The shortcuts for Eudora functions are as follows:

[Ctrl] + 0 Opens Out mailbox

[Ctrl] + 1 Opens In mailbox

[Ctrl] + 6 Checks spelling

[Ctrl] + ’  Pastes as quotation

[Ctrl] + > Adds one level of quotes

[Ctrl] + .     Removes one level of quotes

[Ctrl] + , Finishes address book entry (nickname)

[Ctrl] + A Selects all

[Ctrl] + B Makes text bold

[Ctrl] + C Copies to clipboard

[Ctrl] + D Deletes

[Ctrl] + E Sends immediately or Queues for delivery

[Ctrl] + F Opens Find Messages window

[Ctrl] + [Shift] + F Opens Find Text dialog box

[Ctrl] + H Attaches document

[Ctrl] + I Makes text italic

[Ctrl] + J Filters messages OR filters Junk mail messages

[Ctrl] + [Shift] + J Filters a message out of the Junk mailbox into the designated 

mailbox.



398

Using Modifiers and Shortcuts

[Ctrl] + K Makes address book entry (nickname)

[Ctrl] + L Opens Address Book

[Ctrl] + M Checks mail

[Ctrl] + N Opens a new message

[Ctrl] + O Opens file

[Ctrl] + P Prints

[Ctrl] + Q Exits (quits) Eudora

[Ctrl] + R Replies to the message

[Ctrl] + [Shift] + R Replies to all 

[Ctrl] + S Saves current window

[Ctrl] + T Sends queued messages

[Ctrl] + U Underlines text

[Ctrl] + V Pastes from clipboard

[Ctrl] + W Closes window

[Ctrl] + X Cuts to clipboard

[Ctrl] + Y Opens Directory Services

[Ctrl] + [Shift] + Y Opens Directory Services and performs a lookup on selected text

[Ctrl] + Z Undo

[Ctrl] + [tab]  Switches between opened mailboxes and messages 

[Shift] + F4   Tiles windows horizontally
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[Shift] + F5    Cascades Windows

[Shift] + F10  Opens right-click drop-down menu for selected item

[Shift] + [Space] Toggles current message status between Read and Unread

[Alt] + A  Jumps to Attached line in Composition window; Sorts by Attachments 

in the Table of Contents

[Alt] + B Jumps to Bcc line in Composition window

[Alt] + C Jumps to Cc line in Composition window

[Alt] + D Sorts by Date in table of contents window

[Alt] + [Shift] + D Sorts by reverse Date in table of contents window

[Alt] + E  Opens the Edit Menu

[Alt] + F  Opens the File Menu

[Alt] + H  Opens the Help Menu

[Alt] + K  Sorts by size in table of contents window

[Alt] + [Shift] + K  Sorts by size reversed in table of contents window

[Alt] + L  Sorts by Labels column in table of contents window

[Alt] + [Shift] + L  Sorts by Labels column reversed in table of contents window

[Alt] + M  Opens the Message Menu

[Alt] + O Jumps to the To line in Composition window; sorts by Who column in 

table of contents window

[Alt] + [Shift] + O Sorts by Who column reversed in table of contents window

[Alt] + R  Opens the Transfer Menu; Jumps to From line in Composition window
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[Alt] + S  Opens the Special Menu

[Alt] + T  Opens the Tools Menu

[Alt] + U  Jumps to Subject line in Composition window

[Alt] + V  Sorts by server status in table of contents window

[Alt] + [Shift] + V Sorts by reversed server status in table of contents window

[Alt] + W  Opens the Window Menu

[Alt] + X  Opens the Mailbox Menu

Arrows Moves from one message to another in a mailbox (depends on your 

settings in Miscellaneous Options).

[Enter] Selects the outlined button in any dialog, alert, or window; opens the 

selected messages or open/edit the selected item(s); or opens the 

attachment on the cursor line.

[Space] Opens a selected message summary or close the current message. 

For long messages, scrolls the message down one page.

[Esc] Stops any operation currently in progress.

[Delete] Deletes the selected text or item.

F1 Displays help and context-sensitive help.

F2 Renames the selected item in a tool window (e.g., the Mailboxes 

window or the Address Book).

F3 Finds again.

[Alt] + F3 Enters the selected text in the Find window.

F5 Refreshes the view in the File Browser window.
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F6 Toggles between the two halves of any split window (in composition 

windows, the Address Book, the Filters window, and, when the 

preview pane appears, mailbox windows).

[Ctrl] + [Alt] + F6 Sends the topmost window to the back of all displayed windows.

F7 Shows or hides one half of a split window (current window only): in 

composition windows, shows/hides the message header; in mailbox 

windows, shows/hides the message preview pane (if it is set to 

display).

[Home] Scrolls to the beginning of the mailbox window or to the beginning of 

the line in a message.

[End] Scrolls to the end of the mailbox window or to the end of the line in a 

message.

[Page Up]  
[Page Down] Scrolls up or down through the window.
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Right Mouse Button

The commands that are available from the right mouse button are generally the same as those 

on the main menu and toolbar; the right mouse button simply offers another access method.

To use the right mouse button commands, position the mouse pointer over a Eudora window 

and click the right mouse button (called a right-click), then select a command from the popup 

menu that appears. The contents of the popup menu vary depending on which window you 

are in and what tasks you might need to perform while in that window.

Right-click in an open incoming message and select View Source (if available) from the popup 

menu to view the formatting of the HTML text in a text file. Right-click in the message and 

select Send to Browser (if available) to view the HTML message in your Web browser.

If you want to turn the main toolbar or the status bar on or off in the main Eudora window, right-

click on the gray area of the toolbar or status bar and select the item you want to show or hide: 

Toolbar or Status Bar.

If you have Eudora minimized as a button on the Windows 98/2000/ME/XP/NT 4.x Taskbar, 

you can check for new mail without maximizing the Taskbar button. To do so, place the mouse 

pointer over the Eudora Taskbar button, click the right mouse button, and select Check Mail.

Mail Storage

When you install Eudora, it creates a number of files and directories within the assigned 

directory. In addition, Eudora creates additional files and directories as needed for mailboxes, 

signatures, stationery, nicknames (Address Books), and other functions. The major Eudora 

files and directories are described.

EudPriv/Ads/AdCache Directory

All ad files downloaded to Eudora are kept in this directory.
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Attach Directory

Incoming attachments are saved in the Attach directory until you specify another directory 

using the Attachment directory button in the Attachment Options (Tools:Options:Attachments). 

See the Receiving Attachments on page 82 for more details.

DirectoryServices Directory

Eudora uses the DirectoryServices directory to store the dll files for the Directory Services 

protocols that you use in the Directory Services window. See Using Directory Services on 

page 257 for more details on these protocols.

Embedded Directory

Eudora uses the Embedded directory to store JPEG image files that you insert into the body 

of outgoing messages using the Insert Picture... command under the Edit menu. Eudora 

deletes these files from this directory when the messages containing the images are emptied 

from the Trash mailbox. See Inserting Objects in Message Text (Sponsored and Paid modes 

only) on page 47 for more details.

Filters Directory

Filters are saved in the Filters directory. See Filtering Messages on page 161 for more details 

on creating and using filters.

Imap Directory

Eudora uses the Imap directory to store your IMAP mailboxes and messages.

Nickname Directory (Address Books)

Address Book entries are saved in the Nickname directory, in the default Eudora Nicknames 

file. If you have created additional Address Book files, they are kept under their own name in 

the Nickname directory. See Using the Address Book on page 233 and Using the Recipient 

List on page 252 for more details on creating and using Address Book files and Address Book 

entries (nicknames).
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Plugins Directory

The EMSAPI plug-ins are kept in the Plugins directory. See the section Plug-ins (Extended 

Messaging Services) on page 407 for more information. 

Sigs Directory

The Standard and additional signature files are kept in the Sigs directory. These files are stored 

with the .txt extension. See the Using a Signature on page 105 and Signature Window on 

page 105 for more details on creating and using signatures.

Stationery Directory

Your stationery files are kept in the Stationery directory. Stationery files are stored with the .sta 

extension. See Using Stationery (Sponsored and Paid modes only) on page 109 and 

Stationery Window on page 109 for more details on how to create and use stationery files.

descmap.pce

Mappings between mailbox names and file names are stored in the descmap.pce file.

Eudora.cnt, Eudora.hlp

The Eudora.cnt and Eudora.hlp files contain, respectively, the table of contents information 

and the help text for Eudora’s online help topics, accessed when you select Topics from the 

Help menu. These two files must be kept in the same directory.

Eudora.exe

Eudora.exe is the Eudora application executable file. You may find it convenient to keep a 

shortcut of this file on your Windows desktop: double-click on the shortcut icon to open 

Eudora.

Eudora.ini

Your Options information is saved in the Eudora.ini file, along with other information. For more 

information, see the “EUDORA.INI Settings File” topic in the Help Topics dialog of the online 

help (Contents tab), accessed by selecting Topics from the Help menu. Also see Setting 

Eudora Preferences on page 292. 
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eudora.log, eudorlog.old

Eudora can keep records of all mail transfers. These records are kept in the eudora.log and 

eudorlog.old files. The eudorlog.old file is overwritten and a new eudora.log file is created 

when the eudora.log file reaches its approximately 100K maximum size. To enable logging, 

set the LogLevel entry in the [Debug] section of the Eudora.ini file. For more information, see 

the [Debug] section of the “EUDORA.INI Settings File” online help, accessed by selecting 

Topics from the Help menu.

filters.pce

Names and extensions for Eudora filters are saved in the filters.pce file.

finger.ini, LDAPInit.ini, ph.ini

The finger.ini, LDAPInit.ini, and ph.ini files are used to store settings information for the Finger, 

LDAP, and Ph protocols used in the Directory Services window.

in.mbx, out.mbx, trash.mbx

These files hold your mail. You’ll see files like these for every mailbox you create.

NOTE: These files are in UNIX mail format.

Mail folders that you create are stored as directories with the .fol extension. Mail 

folders contain mailboxes and other mail folders.

in.toc, out.toc, trash.toc

These files are the tables of contents for your mailboxes. They make it much faster for Eudora 

to access your mail. You’ll see files like these for every mailbox you create.

lmos.dat

This file contains information about the messages on your mail server. (lmos = leave mail on 

server.)

nndbase.toc

This file is the table of contents for your nicknames. Extra nickname files are stored in the 

Nickname directory (see above).
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nndbase.txt

Your nicknames are saved in the nndbase.txt file. Note that this file contains the nicknames 

only, while the files in the Nickname directory (see above) contain the full data for each 

Address Book entry—which includes the nickname and more.

Readme.txt

This file contains the Eudora Readme, a text file that contains important, release-current 

information and instructions that might not be included in the Eudora User Manual, the Eudora 

Quick Start Guide, or the Eudora Online Help.

*.tlx, *.clx

Dictionary information is stored in the .tlx and .clx files.

Plug-ins (Extended Messaging Services)

Plug-ins are special add-ons that can be installed to add features to Eudora. For example, you 

could use a language conversion plug-in to translate a message to another language, a 

security plug-in to automatically secure a message, or a text manipulation plug-in to change 

lowercase to uppercase. Plug-ins interface to Eudora using the Extended Messaging Services 

Application Programming Interface (EMSAPI).

To make plug-ins available to Eudora, put them in the Plugins directory in your Eudora 

directory, then restart Eudora. Depending on the plug-in type, it will be available in Eudora in 

the following ways:

• The Message Plug-ins submenu (under the Edit menu) typically includes plug-ins 

that are used to modify the text of a message. These are referred to as on-request 

plug-ins. Some samples of these types of plug-ins are available with Eudora: Sort, 

UpperLower, and Unwrap.

• Icons in the message window are typically for plug-ins that are used to manipulate 

messages as they are sent or when they are received. These are referred to as on-

transmission and on-display plug-ins.

• The Tools menu typically includes plug-ins that are used to do tasks that are not 

directly related to Eudora functions. These are referred to as tools plug-ins.
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• The Attach submenu (under the Message menu) typically includes plug-ins that are 

used to create and attach particular files to a message. These are referred to as 

attachment plug-ins. (Example: QUALCOMM’s PureVoice voice-messaging plug-in, 

for recording and attaching voice messages to your outgoing messages.)

• Plug-ins that are automatically used when a message is received are not available 

through the user interface. These are referred to as on-arrival plug-ins.

To see all of your currently installed plug-ins, select Message Plug-ins Settings... from the 

Special menu. The Installed Message Plug-ins dialog appears. If an installed plug-in has any 

settings options, you can use the Settings... button to change them. For information about 

available plug-ins, send e-mail to <eudora-rep@eudora.com> or visit the World Wide Web 

site <http://www.eudora.com>.

The Messaging Application Program Interface (MAPI)

MAPI is an interface that lets you send email messages from any MAPI-compatible 

application, such as your Web browser, word processor, spreadsheet, graphics application, 

etc. 

MAPI-compatible applications have a Send or Send Mail option in the File menu. When you 

select the option, the Eudora MAPI server displays a new outgoing message with your current 

document attached. All you need to do is address the message, type any details you want to 

include in the body of the message, and click Send or Queue.

To run the Eudora MAPI server, set the options in the MAPI category of the Eudora Options 

windows. To display the MAPI Options, select Options... from the Tools menu and click on the 

MAPI category. See MAPI Technical Report on page 413.  

You have several options in the MAPI Options dialog for loading the Eudora MAPI server. You 

can set it to always run or to run only when Eudora is running, or you can specify that it never 

run. These three options open or exit the server as soon as you select them.

NOTE: When you are running the Eudora MAPI server, Microsoft Exchange will not work. If 

you need to use Exchange, turn off the Eudora MAPI server.



409

General Reference

You also have several options for saving or deleting MAPI attachments. When you use MAPI 

to attach a file and send a message, that file is immediately copied into the Attach directory (or 

a directory you have specified). You can use the MAPI options to save those copies (never 

delete them), or to delete them after sending their corresponding messages, or to delete them 

when their corresponding messages are emptied from the Trash.

Last, you have an option to send a single MAPI text file attachment (TXT and HTML files only) 

as an inline attachment — text in the body of the Eudora message — rather than as a “rider,” 

or normal attachment, to the message. So, for example, you can pass a Web page from your 

Web browser directly into the body of a Eudora message, for your recipients to read right in 

the message itself: they don’t have to open an attachment.
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Mail Transport

Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your outgoing mail to your 

SMTP server machine, which in turn uses SMTP to send your mail to the world at large. Mail 

from the world at large arrives on your incoming Post Office Protocol (POP) or Internet 

Message Access Protocol (IMAP) mail server, where it waits for Eudora to pick it up with either 

POP version 3 or IMAP version 4. The mail Eudora sends and receives is constructed in 

accordance with RFC 822 and RFC 2045 (MIME).

Eudora mail transport overview, POP (similar for IMAP)

Outgoing Mail

When you send an email message to someone, Eudora uses SMTP to send the mail to your 

local SMTP server computer. That computer then sends the mail to your addressee’s 

computer, also (usually) by means of the SMTP protocol.

Your Macintosh POP/SMTP 
Server

The World at Large

POP 
Check Mail

SMTP 
Send Queued Messages

SMTP

Your PC

Check Mail

Send Queued Messages
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Why doesn’t Eudora talk directly to your addressee’s computer? For one thing, it would take a 

lot longer for your mail to leave your computer because your computer would have to call up 

each addressee’s computer and deliver your mail. For another, some computers are “hard to 

find”; it’s much better to let another computer “hunt” for your addressee than to make your 

computer do it. Finally, sometimes your addressee’s computer won’t be available when you 

want to send mail. The SMTP server handles this by holding your mail until the other computer 

is ready to accept it, eliminating the inconvenience of having unsent messages hanging 

around on your computer.

Incoming Mail

When somebody sends you mail, other computers use the SMTP protocol to deliver the mail 

to your POP or IMAP server. Your POP or IMAP server puts mail in your “mail drop,” where it 

stays until the Eudora program picks it up. When you check your mail, Eudora uses POP 

version 3 or IMAP version 4 to pick up your mail and move it to your computer.

Why doesn’t Eudora use SMTP to receive your mail? SMTP works best when the computers 

it knows about are always ready for mail. Unless you wanted to run Eudora 24 hours per day, 

seven days a week, SMTP wouldn’t work very well for you. It also doesn’t work well in lab 

environments, where you might use any number of different computers.

More Information

If you want to know more about the Internet in general, consult the book Internetworking with 

TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 0-13-470154-2 025.

If you want to know more about SMTP, RFC 822, POP version 3, MIME,  and IMAP, the official 

standards are:

RFC 821, “Simple Mail Transfer Protocol” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages” by Dave Crocker

RFC 1939, “Post Office Protocol, Version 3” by Marshall Rose

RFC 2045, “Multipurpose Internet Mail Extensions” by Ned Freed and Nathaniel  
Borenstein
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RFC 2060, “Internet Message Access Protocol, Version 4 Rev 1” by Mark Crispin

You can find the RFCs on the web in several different places: 

• http://www.rfc.net/

• http://www.faqs.org/rfcs/

• http://www.ietf.org/rfc.html

• http://www.rfc-editor.org/rfcsearch.html
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Where to Get More Information on MAPI

For more information, supplementary to this technical report, visit our online MAPI FAQ at the 

web site <http://www.eudora.com/developers>.

What Does MAPI Do?

Eudora’s MAPI support allows users to quickly attach documents to email messages directly 

from the application that created the document. Without MAPI, users must first save the 

document, remember what folder the document is in, switch to Eudora, and then remember to 

manually attach the document to the outgoing message.

MAPI streamlines this process dramatically. To email the current, open document from your 

word processor, select the Send command from your word processor’s File menu. This 

automatically activates Eudora and attaches a snapshot of the open document to a new 

composition message.

The MAPI system standardizes how messages are handled by client applications so that each 

client application does not have to have custom code for each target messaging application. 

MAPI accomplishes this by providing a standard application program interface used by all 

MAPI-enabled client applications.

An additional MAPI feature supported by Microsoft Office applications is the ability to add a 

“routing slip” to a Word, Excel, or PowerPoint document. This routing slip contains a list of 

email recipients obtained from the MAPI subsystem. Once a document has an embedded 

routing slip, then it can be semi-automatically routed as an attachment via email to all 

recipients listed in the routing slip. Once the routing is complete, the annotated document is 

returned back to the original sender.

MAPI Overview

Let’s start with a picture:
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A MAPI client application is any 16-bit or 32-bit Windows application that knows how to access 

the standard MAPI messaging functions in a library known as a DLL (Dynamic Link Library). 

The functions in the MAPI DLL allow a MAPI client application to transparently and generically 

access a MAPI service provider. A MAPI service provider is the application that handles the 

receipt, transmission, and storage of messages. Examples of MAPI client applications (“front-

ends”) include Microsoft Word and Microsoft Excel. Examples of MAPI service providers 

(“back-ends”) include Microsoft Exchange and Microsoft Fax.

All 16-bit client applications use the 16-bit MAPI.DLL and all 32-bit client applications use the 

32-bit MAPI32.DLL. The MAPI and MAPI32 DLLs are “twins” which contain the same list of 

MAPI functions—they are parallel implementations of the 16-bit and 32-bit MAPI functions. 

These DLLs are provided by Microsoft as standard components of Windows 98/2000/ME/XP 

and Windows NT. The MAPI DLLs are normally installed in the Windows 98/2000/ME/XP 

SYSTEM directory (SYSTEM32 for Windows NT).

Eudora Pro

16-bit MAPI

client application

32-bit MAPI

client application

MAPI.DLL MAPI32.DLL
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When a MAPI client application wishes to send a document, it simply loads the appropriate 

MAPI library (DLL) and calls the defined MAPI functions. The MAPI DLL takes care of routing 

the messaging and authentication requests to the appropriate MAPI service provider 

application, displaying the address book user interface, and returning address book and 

messaging data to the MAPI client application. The MAPI DLL also provides an optional user 

interface for user authentication. For example, the user may need to supply a user name and 

password to the mail system in order to “log on” to the mail system. (The Eudora 

implementation of MAPI does not implement authentication since Eudora itself requires 

authentication to access the POP3 and IMAP4 servers.)

Eudora Implementation of MAPI

Eudora implements a subset of the full MAPI library by providing two “replacement DLLs” for 

the standard Microsoft MAPI DLLs. The Eudora EUMAPI.DLL is a replacement for the 16-bit 

Microsoft MAPI.DLL and the Eudora EUMAPI32.DLL is a replacement for the 32-bit Microsoft 

MAPI32.DLL. The Eudora MAPI DLLs must be located in the same directory as the Eudora 

program.

The Eudora MAPI DLLs implement the standard Simple MAPI functions detailed in the MAPI 

specification. The MAPI specification also defines Extended MAPI functions, however, the 

Eudora MAPI DLLs implement only the Simple MAPI subset.

NOTE: The Eudora MAPI implementation requires all MAPI client applications to use only the 

Simple MAPI functions supported by the Eudora MAPI DLLs.

MAPI client applications which use only the basic Simple MAPI calls will generally not be able 

to tell the difference between the Eudora MAPI DLL functions and the Microsoft MAPI DLL 

functions.

It is important to understand that MAPI client applications load the MAPI DLL libraries at 

runtime whenever they need to access the MAPI functions. Each client application expects to 

find either the 16-bit MAPI.DLL file or the 32-bit MAPI32.DLL file in a common, application-

independent location (generally the Windows SYSTEM directory). Therefore, it is not sufficient 

to copy the EUMAPI.DLL and EUMAPI32.DLL Eudora DLL files into the Windows SYSTEM 

directory alongside the standard Microsoft MAPI.DLL and MAPI32.DLL files. For client 

applications to find the Eudora MAPI DLLs, the DLL files must be named MAPI.DLL and 

MAPI32.DLL. This creates a conflict since most Windows installations will have the MAPI.DLL 

and MAPI32.DLL files preinstalled in the Windows SYSTEM directory to support Microsoft 

Exchange.
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NOTE: Eudora is able to swap the Eudora EUMAPI and EUMAPI32 DLLs with the Microsoft 

MAPI and MAPI32 DLLs when the user launches Eudora, and is able to unswap the Eudora 

MAPI DLLs when the user exits Eudora.

This approach gives the user the most flexibility and preserves the user’s ability to use 

Microsoft Exchange and/or Microsoft Fax when Eudora is not running. If we “permanently” 

install the Eudora MAPI DLLs over the existing Microsoft MAPI DLLs, then applications (such 

as the Microsoft Fax service bundled with Microsoft Exchange) which rely on the Microsoft 

MAPI DLLs will no longer work. This is clearly unacceptable for users who need to use MAPI 

for both Microsoft Exchange and Eudora.

Eudora MAPI Startup Procedure

When launched, Eudora runs the following “swap” procedure when the user has selected 

either the “Always” or the “When Eudora is running” MAPI Server option in Eudora (see MAPI 

Technical Report on page 413 for more information; )

1. Check to see whether or not the Eudora MAPI DLLs are already installed in the 

Windows SYSTEM directory. If so, then you are finished.

2. Check for existing Microsoft MAPI.DLL and MAPI32.DLL files. If found, rename 

MAPI.DLL to MAPI.000 and rename MAPI32.DLL to MAPI32.000. (If a MAPI.000 

file already exists, then Eudora uses MAPI.001, MAPI.002 etc.)

3. Copy the EUMAPI.DLL and EUMAPI32.DLL files from the Eudora program 

directory to the Windows SYSTEM directory as MAPI.DLL and MAPI32.DLL, 

respectively.

Eudora MAPI Shutdown Procedure

When shutdown, Eudora runs the following “unswap” procedure when the user selects either 

the “When Eudora is running” or “Never” MAPI Server option in Eudora (see MAPI Technical 

Report on page 413).

1. Check to see whether or not the Eudora MAPI DLLs are already installed in the 

Windows SYSTEM directory. If not, then you are finished.

2. Delete the Eudora MAPI.DLL and MAPI32.DLL files.



417

MAPI Technical Report

3. Rename the MAPI.000 and MAPI32.000 files, if any, to MAPI.DLL and 

MAPI32.DLL, respectively. (If a MAPI.001, MAPI.002, etc. file exists, then Eudora 

renames the one with the highest number.)

Eudora DLL Swapping Restrictions

It is important to note that there are several restrictions with the above Eudora swap and 

unswap procedures: The Eudora swap and unswap procedures can only run successfully if 

the MAPI.DLL and MAPI32.DLL are not currently “in use” by one or more MAPI client 

applications.

When a MAPI client application loads a MAPI or MAPI32 DLL file, Windows “locks” the DLL 

file while the library is loaded into memory to show that the file is “in use.” Eudora can normally 

detect that the MAPI.DLL and/or MAPI32.DLL files are “in use.” If Eudora detects that a MAPI 

or MAPI32 DLL is locked, it displays an error message and skips the swap or unswap 

procedure.

When Eudora is forced to skip the swap or unswap procedure, this means that the MAPI DLLs 

are in the wrong “state” with respect to Eudora — that is, 1) the Microsoft MAPI DLLs could be 

installed even after Eudora starts, or 2) the Eudora MAPI DLLs could be installed even after 

Eudora shuts down. To prevent this from happening, use the following procedure when using 

Eudora MAPI:

1. Start Windows.

2. Start Eudora.

3. Start any MAPI client applications.

4. Send attachments to Eudora via the installed Eudora MAPI interface.

5. Shutdown all MAPI client applications.

6. Shutdown Eudora.

7. Exit Windows.
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Once Eudora’s MAPI DLLs get into the wrong “state” with respect to Eudora, you cannot 

correct the state mismatch until all MAPI client applications unload the MAPI DLLs and 

Windows is able to unlock the DLL file. Since the MAPI DLLs are shared by multiple MAPI 

client applications, Windows does not unlock the MAPI DLL file until the last MAPI client 

application is shut down. Therefore, to force all MAPI client applications to unload the DLLs, 

you must shutdown all MAPI client applications.

NOTE: When running 16-bit MAPI client applications under Windows NT, then Eudora cannot 

detect the lock placed on the MAPI DLLs by Windows unless the SHARE program is running. 

This means that Eudora can inadvertently perform the DLL swap and/or unswap procedures 

while the MAPI DLL is loaded into memory. This almost always causes Windows to become 

unstable and can lead to crashes in MAPI client applications as well as in Windows itself.

NOTE: If you run 16-bit MAPI client applications under Windows NT, then you should always 

run the SHARE program.

The good news is that Windows 98/2000/ME/XP implements the SHARE functionality without 

requiring you to explicitly run the SHARE program. By default, Windows NT only implements 

the SHARE functionality for 32-bit applications. If you are running a 16-bit application under 

Windows NT, then you must run the SHARE program explicitly.
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What Is MIME?

MIME stands for Multipurpose Internet Mail Extensions. MIME serves two major purposes — 

it allows mail applications to tell one another what sort of data is in mail, and it also provides 

standard ways for mail applications to encode data so that it can be sent through the Internet 

mail system.

MIME Encoding

The Internet uses the SMTP protocol to move mail around. SMTP is limited to the US-ASCII 

character set (see the “Mail Transport” section of this manual). This is a problem for people 

who speak languages other than American English and so need accented characters or non-

American English letters, or for people who want to use special symbols like the bullet.

MIME provides a way around this restriction. It offers two encodings, “quoted-printable” and 

“base64.” These encodings use US-ASCII character codes to represent any sort of data you 

like, including special characters or even non-text data.

Quoted-printable is used for data that is mostly text, but has special characters or very long 

lines. Quoted-printable looks just like regular text, except when a special character is used. 

The special character is replaced with an “=” and two more characters that represent the 

character code of the special character. So, a bullet in quoted-printable looks like “=95.”

However, there are some other things that quoted-printable does. For one, since it uses an “=” 

to mean something special, equals signs must themselves be encoded (as “=3D”). Second, 

no line in quoted-printable is allowed to be more than 76 characters long. If your mail has a 

line longer than 76 characters, the quoted-printable encoding will break your line in two, and 

put an “=” at the end of the first line, to signal to the mail reader at the other end that the two 

lines are really supposed to be one. Finally, a few mail systems either add or remove spaces 

from the ends of lines. So, in quoted-printable, any space at the end of a line gets encoded (as 

“=20”) to protect it from such mail systems.

Let’s try an example. Here’s a passage of text that you might type on your computer
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«Il est démontré, disait-il, que les choses ne peuvent être autrement; 
car tout étant fait pour une fin, tout est nécessairement pour la 
meilleure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+Il est dimontri, disait-il, que les choses ne peuvent btre autrement; 
car tout itant fait pour une fin, tout est nicessairement pour la 
meilleure fin.;

This corruption happens because SMTP cannot handle the special characters. However, if 

you and your recipient both have MIME, quoted-printable encoding would be used, and your 

text would show up properly:

«Il est démontré, disait-il, que les choses ne peuvent être autrement; 
car tout étant fait pour une fin, tout est nécessairement pour la 
meilleure fin.»

While your mail was actually in transit, however, it would have looked like:

=ABIl est d=E9montr=E9, disait-il, que les choses ne  
peuvent =EAtre =autrement; car tout =E9tant fait pour une fin, tout est 
n=E9cessairement =  
pour la meilleure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail system. However, 

Base64 makes no attempt to be legible, and is most appropriate for non-text data.

MIME Labeling

The other important part of MIME is that it lets mailers communicate what kind of data is in a 

message (or part of a message). The primary mechanism used for this is the Content-Type 

header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts; the content type, the content subtype, and 

the parameters. In this case, the content type is “text,” meaning the message contains mostly 

legible text. The content subtype is “plain,” which means there aren’t any formatting 

commands or anything like that embedded in the text. Finally, “charset=iso-8859-1” is a 

parameter; in this case, it identifies the character set the message uses.
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The major content types are:

text, legible text

image pictures and graphics

audiosound

video moving pictures

message, messages, or pieces of messages

multipart,several different kinds of data in a single message

Practical Issues

There are really only two things you sometimes need to do with Eudora and MIME. One is that 

it may occasionally be necessary to turn off quoted-printable encoding. Another is that you 

may want to know how to define mappings between computer file extensions, MIME types, 

and Macintosh types.

Turning Off Quoted-Printable Encoding

Eudora automatically uses quoted-printable encoding if your mail contains special characters. 

Eudora also uses quoted-printable encoding for attached plain text files. If your recipients don’t 

have MIME, quoted-printable may hurt more than it helps. If that’s the case, just turn off the 

QP button in the message Toolbar when you are sending text files to those recipients.

Mapping Between File Extensions, MIME Types, and Macintosh Types

Since Eudora needs to have the appropriate extensions on attachment filenames in order to 

open them up from the message, Eudora has the ability to map between file extensions, MIME 

types and subtypes, and Macintosh creators and types. Messages received by Eudora can 

grab the MIME type/subtype and/or Macintosh creator/type from an attachment and map that 

into the correct file extension. Also, on outgoing messages, Eudora can make sure that 

attachments are encoded with the correct MIME type/subtype and/or Macintosh creator/type 

depending on the file extension of the attachment being sent.
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Eudora knows about some MIME types. However, since new MIME types are being defined 

all the time, it may be necessary to add to Eudora’s knowledge from time to time. Adding new 

mappings between the various types only requires editing the EUDORA.INI file with a text 

editor (like the one that comes with Eudora).

There is a section in the EUDORA.INI file labeled [Mappings], followed by some entries, one 

per line. Each entry is called a map. A map defines when the mapping should occur (which 

can be “in,” “out,” or “both”), followed by an equals sign and five parameters. These five 

parameters are (in order) the computer file extension, the Macintosh creator code, the 

Macintosh type, the MIME type, and the MIME subtype. Here are some sample entries:

[Mappings]
both=gif,,,image,gif
both=mpg,,,video,mpeg
both=doc,MSWD,,,
in=xls,XCEL,,,
out=xls,XCEL,XLS4,,
both=eps,,EPSF,application,postscript

A map marked “in” only tries to match the map to messages that you receive. A map marked 

“out” only tries to match the map to messages that you send. A map marked “both” tries to 

match the map to both incoming and outgoing messages.

The first map above says that any incoming MIME message that has a part type of “image” 

and subtype of “gif” will get saved to a file with the extension “.gif.” It also specifies that 

outgoing messages that have an attachment with the file extension “.gif” will get the MIME type 

of “image” and subtype of “gif” if the encoding method of the message is MIME. The second 

map is similar to the first map in structure, but uses a different file extension and MIME type 

and subtype.

You can use map entries to move between computer file extensions and Macintosh creator 

and type as well. The third map says that if an incoming message has an attachment with the 

Macintosh creator “MSWD” (which is the Macintosh creator for Microsoft Word) then the file 

extension of the attachment when saved to disk should be “.doc” (the file extension that Word 

for Windows uses). Since the map is marked as “both,” it will also give attachments with the 

extension “.doc” on outgoing messages the Macintosh creator of “MSWD” if the encoding 

method of the message is BinHex.
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Note that the Macintosh type from this map is empty. This allows multiple types to be 

recognized with just one mapping. This is nice for “in” maps because it allows you to cover a 

range of creator/type pairs with one map. You must be careful in using this type of map with 

an “out” or “both” mapping, though, because an outgoing attachment that matched this map 

would have a Macintosh creator, but no Macintosh type. Some Macintosh applications cannot 

open files with a missing type. Microsoft Word for the Macintosh can open files without a type, 

so this map is fine being marked “both.”

Microsoft Excel for the Macintosh is an example of a program that can't open a file with an 

empty type. This is why there are two maps for Excel (the fourth and fifth maps above). The 

incoming map for Excel is like the one for Microsoft Word, but the outgoing map explicitly 

defines the Macintosh type.

The last map shows that you can have both Macintosh creator/type and MIME type/subtype 

in one entry. This map says that if an incoming message has an attachment that is encoded in 

MIME and has the “application/postscript” type/subtype, or has a BinHex attachment with the 

Macintosh type of “EPSF,” then the resulting file will have an “.eps”extension. Similarly, if an 

outgoing message has an attachment with the extension “.eps” and if the MIME encoding is 

being used for the message, then the attachment will get the “application/postscript” MIME 

type/subtype. If the message was using the BinHex encoding, then the attachment would get 

the Macintosh type of “EPSF.”

But what happens if an attachment matches more than one map? Eudora will try and find the 

best match. For example, if you had the following [Mappings] section:

[Mappings]
in=xls,XCEL,,,
in=xlc,XCEL,XLC3,,

and you received a message with an attachment that had a Macintosh creator of “XCEL” and 

a Macintosh type of “XLC3” (a Microsoft Excel Chart), then the file would get an extension of 

“.xlc” since the first map only matched the Macintosh creator, but the second map matched 

both the Macintosh creator and type.

Eudora can receive attachments that have both a MIME type/subtype and a Macintosh 

creator/type. Eudora understands attachments with the MIME type/subtype 

“application/applefile,” which has Macintosh creator/type information embedded in it. With this 

type of attachment, Eudora will consider a match with the Macintosh creator/type as a “better” 

match than a match with the MIME type/subtype.
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Finally, if an incoming attachment matches two different maps to the same degree (e.g., both 

maps have the same MIME type/subtype with different file extensions), then Eudora will use 

the file extension in the first matching map.
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Anonymous FTP (ftp.eudora.com)

QUALCOMM’s Eudora Division has an anonymous FTP server, ftp.eudora.com, that has 

information and software related to Eudora. These are located within the eudora directory. 

Included are POP3, Ph, and password changing servers, the srialpop program, current 

product information, dialup files, and more. Also look under the directory  
eudora/eudorapro/windows/extras.

Eudora Information

The information in this manual was correct at the time of printing. However, things happen very 

quickly in the electronic world, meaning that some of this information may already be out of 

date. For the very latest information about Eudora, send email to eudora-info@eudora.com.

Obtaining an Internet Email Server

Post Office Protocol (POP) and Internet Message Access Protocol (IMAP) Servers are 

available for a variety of platforms. If you would like to run a POP or an IMAP server on your 

own system, we suggest the following servers:

• Windows NT – QUALCOMM’s Eudora WorldMail™ Server. WorldMail supports 

POP3 and IMAP4 as well as LDAP and Ph directory services. Microsoft Windows NT 

4.x Server or Workstation is required.

• Macintosh – QUALCOMM’s Eudora Internet Mail Server™ (EIMS). EIMS supports 

POP3 as well as Ph directory services. EIMS requires a Macintosh 68030 or higher 

(Mac IIx, IIcx, SE/30, or better) or a PowerPC®.

• UNIX – QUALCOMM’s QPopper. QPopper 3.0 is available via anonymous ftp from 

ftp.eudora.com. QPopper versions are available for a number of UNIX systems.

• VAX/VMS – VAX/VMS systems may try either the Multinet package from TGV, or 

IUPOP3, available via anonymous FTP from ftp.indiana.edu.
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For information on QUALCOMM’s family of Internet Email Servers, send e-mail to 

<eudora-rep@eudora.com> or visit the World Wide Web site <http://www.eudora.com>.

Ph Server Source Code

A server for the Ph protocol is available via anonymous FTP from ftp.eudora.com.

Password Change Server

Three sample UNIX servers for Eudora’s Change Password... command (on the Special 
menu) are available via anonymous FTP from ftp.eudora.com.

Windows Sockets Products

Demos of Windows Sockets 1.1 compliant stacks and applications are available via 

anonymous ftp from papa.indstate.edu in the directory winsock-l. 

For those with World Wide Web (WWW) browsers, try the following sites. Click the URL to 

display website.

The Consummate Winsock Applications list: http://cws.internet.com/ 
The Ultimate Collection of Winsock Software: http://www.tucows.com/ 
Stardust Technologies: http://www.stardust.com/wsdir/ 
WinSite: http://www.winsite.com

Kerberos

You can get the necessary files and information for setting up Kerberos authentication in 

Eudora from ftp.eudora.com in the directory  
eudora/eudorapro/windows/extras/kerberos. Be sure to read the installation instructions to 

ensure that Kerberos is set up properly.

To learn more about the Kerberos authentication system, click on the following URL to display 

website. http://web.mit.edu/kerberos/www

http://cws.internet.com
http://www.tucows.com/
http://www.stardust.com/wsdir/
http://www.winsite.com
http://web.mit.edu/kerberos/www
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Spelling Dictionaries

There are additional spelling dictionaries that are compatible with Eudora’s built-in spelling 

checker. They are available via anonymous ftp from ftp.eudora.com in the directory 

eudora/eudorapro/windows/extras/dictionaries. To configure Eudora to use these 

dictionaries, look at the online help (select Topics from the Help menu) under EUDORA.INI 
File, [Settings] MainLexfiles.

Developer Information

If you are a software developer and are interested in how to have your application used or 

integrated with Eudora, click on the following URL:  
http://www.eudora.com/developers

ftp://ftp.eudora.com
http://www.eudora.qualcomm.com/developers
ftp://ftp.eudora.com/eudora/eudorapro/windows/extras/dictionaries/
http://www.eudora.com/developers/
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Dialup Eudora

As of version 4.0, Eudora no longer supports the built-in Serial Dialup (shell) connection 

method found in previous versions of Eudora. Eudora now requires that you use the Microsoft 

SLIP/PPP Dialup Networking connection method that is a standard feature of both Windows 

98/2000/ME/XP and Windows NT 4.x.

The Microsoft SLIP/PPP Dialup Networking facility offers the following advantages over the 

retired Eudora Serial Dialup feature:

• TCP/IP running on top of SLIP/PPP is inherently more reliable than a Serial Dialup 

connection because reliable, end-to-end data transmission is an integral feature of 

TCP/IP.

• A SLIP/PPP dialup connection is application-independent and supports TCP/IP, IPX, 

and NetBEUI protocols. Eudora Serial Dialup was not generic and applied 

specifically to checking and sending mail with Eudora.

• A SLIP/PPP connection supports transmission of binary data, as required by the 

IMAP4 protocol.

• Microsoft Dialup Networking supports a wider range of modem hardware, and 

navigation scripts are generally modem-independent.

As with the old Serial Dialup function, Eudora can use Microsoft Dialup Networking to 

automatically dial your mail server, check and/or send mail, and then automatically hang up 

the connection.

General Steps

Following are the general steps necessary to set up Microsoft Windows to use Microsoft Dialup 

Networking. If you have already set up Microsoft Dialup Networking and can successfully 

connect to your Internet Service Provider, then skip to the section “Configuring Eudora to Auto-

Dial the Phonebook Entry” following:

• Make sure you have a SLIP/PPP account – You must arrange for SLIP/PPP 

account access through your Internet Service Provider. If you can choose between 

SLIP and PPP, we recommend PPP.
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• Install your modem – Configure Microsoft Windows so that it recognizes your 

modem hardware.

• Install networking components – Configure your MS Windows networking 

software to include the TCP/IP protocol.

• Install Dialup Networking components – Configure your MS Windows networking 

software to include the Microsoft Dialup Networking tool and the Remote Access 

Services.

• Define a Phonebook entry – The Microsoft Dialup Networking tool lets you create 

multiple “phonebook” entries, one for each of your Internet Service Providers. 

Configure the Phonebook entry to automatically dial the modem, establish a 

SLIP/PPP session, and, if applicable, auto-configure your IP address and DNS 

server address(es).

• Configure Eudora to auto-dial – Eudora can use a Dialup Networking Phonebook 

Entry to automatically dial your mail server, check and/or send mail, and hang up the 

connection when the mail transfer is complete.

Configuring Dialup Networking under Windows 
98/2000/ME/XP

Dialup Networking is an optional component of Windows 98/2000/ME/XP. Before configuring 

Dialup Networking, you should install your modem and make sure the 

Windows 98/2000/ME/XP networking software includes support for the TCP/IP protocol. 

Consult your Microsoft documentation for details on installing your modem, configuring the 

TCP/IP protocol, and installing the Dialup Networking tools.

After you install Dialup Networking, follow these steps to define a new 
Phonebook entry:

1. Double-click on the My Computer icon to open an Explorer window. Then double-

click on the Dialup Networking icon to open the Dialup Networking folder.

2. Double-click on the Make New Connection button to display the Make New 

Connection Wizard.

3. Enter the name you want to associate with your Internet Service Provider. Also, 

select your modem in the drop-down list. Then click Next.

4. In the edit box, enter the phone number for your Internet Service Provider. Then 

click Next.
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5. Click Finish on the last page of the New Connection Wizard to complete the 

creation of the Phonebook entry.

6. In the Dialup Networking folder, right-click on the icon for the Phonebook entry you 

have just created, and select the Properties command.

7. While testing your new Phonebook entry, configure Dialup Networking to display a 

terminal window after your modem has connected to the remote computer. To do 

this, click the Configure… button to display the modem configuration properties. 

Select the Options tab, then check the Bring up terminal window after dialing 

option. Click OK to accept the change.

8. Back in the Properties dialog for your Phonebook entry, click the Server Type… 

button to display the Server Types dialog. In the Type of Dial-Up Server drop-

down list, select either SLIP or PPP as appropriate. Also, uncheck the NetBEUI 
and IPX network protocols, but make sure that the TCP/IP protocol is checked. 

Finally, uncheck the Log on to network and Enable software compression 

options.

9. In the Server Types dialog, click the TCP/IP Settings… button to display the 

TCP/IP Settings dialog.

10. If your Internet Service Provider has assigned you a specific (static) IP address, 

select the Specify an IP address option, then enter that address in the field. 

Otherwise, if your provider assigns IP addresses dynamically via  Dynamic Host 

Configuration Protocol (DHCP), then keep the default Server assigned IP 
address setting.

11. If your Internet Service Provider supports DHCP, then the name server addresses 

will automatically be configured by DHCP, and you should keep the default Server 
assigned name server addresses setting. Otherwise, select the Specify name 
server addresses option, then enter the server addresses assigned by your 

Internet Service Provider. Click OK to accept the TCP/IP Settings changes.

12. Back in the Server Types dialog, click OK to accept the changes.

13. Back in the Phonebook Entry Properties dialog, click OK to accept the changes.

14. You should now be back in your Dialup Networking folder. Double-click on your 

new Phonebook entry to dial your Internet Service Provider. Your modem should 

immediately dial the phone number defined in your Phonebook entry, and Windows 

98/2000/ME/XP should prompt you for your username and password.
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15. Once your modem negotiates the connection with the remote system, you typically 

then have to “log in” to that remote system by entering the username and password 

assigned to you by your Internet Service Provider. Some systems require that you 

first press Enter to display a login prompt, then enter the username and password. 

In any event, once you are “logged on” (authenticated), some providers 

automatically start your SLIP or PPP session, while others require that you take an 

extra step, such as typing ppp, to initiate a PPP session. Carefully note the exact 

steps you must take in order to manually log in and establish a SLIP/PPP session: 

you will need this information in order to automate the login process, as described 

in “Defining a Login Script.”

Configuring Dialup Networking using Windows NT 4.x

Dialup Networking is an optional component of Windows NT 4.x. Before configuring Dialup 

Networking, you should make sure Windows NT recognizes your modem and also make sure 

your Windows NT networking software includes support for the TCP/IP protocol. Consult your 

Microsoft documentation for details on installing your modem, configuring the TCP/IP protocol, 

and installing the Dialup Networking tools. To properly configure TCP/IP, you may need some 

information from your Internet Service Provider regarding your IP address and your DNS 

server(s).

After you install Dialup Networking, follow these steps to define a new 
Phonebook entry:

1. Double-click on the My Computer icon to open an Explorer window. Then double-

click on the Dialup Networking icon to launch the Dialup Networking tool.

2. Click the New… button to display the New Phonebook Entry Wizard.

3. Enter the name you want to associate with your Internet Service Provider, then 

click Next to display the Server page.

4. Most Internet Service Providers use a terminal server or a Unix server to support 

dialup users. Therefore, you should generally check all three boxes to indicate that 

(1) you are calling the Internet, (2) it is okay to send your plain text password, and 

(3) the server expects login information. Ask your email administrator or your 

Internet Service Provider if you are unsure about these settings. 

5. Click Next to display the Modem or Adapter page.

6. Select your modem from the list, then click Next to display the Phone Number 

page.
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7. In the edit box, enter the primary phone number for your Internet Service Provider. 

If your provider has alternate phone numbers, click the Alternates… button and 

enter the alternate phone numbers. Click Next to display the Serial Line Protocol 

page.

8. Select PPP or SLIP as appropriate to your Internet Service Provider (most 

providers now support PPP), then click Next to display the Login Script page.

9. When initially testing dialup connections to your Internet Service Provider, we 

recommend that you select the Display a terminal window option. Once you can 

manually establish a dialup connection, you can then automate the dialup 

connection with a login script (see “Defining a Login Script” later for details). Click 

Next to display the IP Address page.

10. If your ISP has assigned you a specific (static) IP address, then enter that address 

in the field. Otherwise, if your provider assigns IP addresses dynamically via 

DHCP, then keep the default Server assigned IP address setting. Click Next to 

display the Name Server Addresses page.

11. If your ISP supports DHCP, then the name server addresses will automatically be 

configured by DHCP and you should leave the default addresses of 0.0.0.0. 

Otherwise, enter the server addresses assigned by your Internet Service Provider. 

Click Next to display the final page of the Phonebook Wizard.

12. Click Finish to create your new Phonebook entry.

13. Back in the Dialup Networking tool, select your new Phonebook entry in the drop-

down list, then click Dial to dial your Internet Service Provider. Your modem should 

immediately dial the phone number defined in your Phonebook entry.

14. Once your modem negotiates the connection with the remote system, you typically 

then have to “log in” to that remote system by entering the username and password 

assigned to you by your Internet Service Provider. Some systems require that you 

first press Enter to display a login prompt, then enter the username and password. 

In any event, once you are “logged on” (authenticated), some providers 

automatically start your SLIP or PPP session, while others require that you take an 

extra step, such as typing ppp, to initiate a PPP session. Carefully note the exact 

steps you must take in order to manually log in and establish a SLIP/PPP session: 

you will need this information in order to automate the login process, as described 

in “Defining a Login Script.”
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Defining a Login Script

Here is a sample login script for an Annex terminal server:

proc main
transmit "^M"
waitfor "Annex username:" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit $USERID + "^M"
waitfor "Annex password:" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit $PASSWORD + "^M"
waitfor "Permission granted" until 30
if FALSE == $SUCCESS then

goto Failure
endif
transmit "ppp" + "^M"

Failure:
set screen keyboard on
halt

Done:

endproc

Based on your experience with manually connecting to your Internet Service Provider, you 

may need to change the Annex username: and Annex password: strings to match the 

prompts displayed by the machine to which you are connecting. You may or may not need to 

transmit the ppp command after the system accepts your username and password. The 

Dialup Networking tool automatically replaces the $USERID and $PASSWORD variables with 

your Dialup Networking username and password so that you don’t expose your username and 

password in an unencrypted plain text file.

To use this login script, you must first save the file to a known location on your disk. By 

convention, Dialup Networking script files have an SCP file extension.

To use the script under Windows 98/2000/ME/XP:

• Launch the Dial-up Scripting Tool found on the Start:Programs:Accessories menu.
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• Select the Phonebook entry from the Connections list box and enter the script 

filename in the File name field.

• Click the Apply button to accept your changes.

• Click the Properties button to display the properties dialog for your Phonebook 

entry.

• Click the Configure button to display the modem properties dialog. Then select the 

Options tab.

• Uncheck the Bring up terminal window after dialing option. Now click OK to 

accept your changes.

• Back in the properties dialog for your Phonebook entry, click OK to accept your 

changes.

• To use the script under Windows NT 4.x:

• Open the Dialup Networking tool, and from the dropdown list select the Phonebook 

entry you want to change.

• Click the More button, then select the Edit entry and modem properties… item 

from the button menu.

• In the Edit Phonebook Entry dialog, select the Script tab, click the Run this script 
option, and then enter the name of your saved login script.

This script is compatible with both Windows 98/2000/ME/XP and Windows NT 4.x Dialup 

Networking tools. If the login sequence fails, then the script will halt, leaving you free to attempt 

a manual login via the popup Dialup Networking terminal window.

Creating a Desktop Phonebook Shortcut

You may find it convenient to create a desktop shortcut to your Phonebook entry, something 

we recommend.

To create a Phonebook shortcut under Windows 98/2000/ME/XP:

1. Open the Dialup Networking folder, then drag a Phonebook icon to your Windows 

desktop.

2. To rename the shortcut label, select the shortcut icon and press F2, or just click on 

the shortcut label twice, slowly.
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To create a Phonebook shortcut under Windows NT 4.x

1. Open the Dialup Networking tool, click the More button, and select the Create 
shortcut to entry… item.

2. Choose a name for the shortcut in the Save dialog, then save the shortcut to your 

Desktop folder.

To test the Dialup Networking connection, double-click on the shortcut icon on your Desktop. 

Once your Phonebook entry successfully and automatically creates a TCP/IP connection to 

your Internet Service Provider, you are ready to configure Eudora to automatically dial the 

Phonebook entry.

Configuring Eudora to Auto-Dial the Phonebook Entry

If you connect to your Internet Service Provider with a modem, you can easily configure 

Eudora to automatically “dial on demand” using Microsoft Dialup Networking. Eudora only 

needs a connection to your provider when performing network operations such as checking or 

sending mail, or when performing a directory services lookup. When Eudora is configured to 

auto-dial, it automatically hangs up the connection when the network operation is complete.

Before you can configure Eudora to auto-dial, you must create and configure a Microsoft 

Dialup Networking Phonebook entry to automatically connect to your Internet Service Provider 

(see the procedures above).

To auto-dial a Dialup Networking Phonebook entry, start Eudora, select Options... from the 

Tools menu to display the Options dialog, then click on the Advanced Network category. 

Check the Automatically dial & hangup this connection option. In the Entry list, select the 

Phonebook entry you want to dial. In the Username edit box, enter the username, if any, that 

is required to log in to your Internet Service Provider (this is the value that is substituted for the 

$USERID variable in your Dialup Networking script). Check the Save password option if you 

want Eudora to save your Dialup Networking password in the Eudora.ini file. If you leave the 

Save password option turned off, then Eudora will prompt you to enter your password each 

time it auto-dials the Phonebook entry.

To test the auto-dial capability, make sure your modem is not already connected, then select 

the Check Mail command from the File menu in Eudora. Eudora will automatically dial your 

Internet Service Provider, log in, establish a TCP/IP connection, transfer any new mail, and 

automatically hang up when the mail transfer is complete.
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X1 Search Queries

When performing searches using the Ultra Fast indexed search feature (Paid mode only), you 

can perform complex queries using the functionality of X1. This section describes how to 

create such advanced queries to get the most out of your Eudora.

Columns

A column is a grouping of data within the indexed database. Advanced users can utilize the 

“matches X1 query” verb in the Search window to perform complex searches.

Available columns with Eudora search are: attachment, attachmentcount, bcc, body, cc, date, 

from, headers, id, imapflags, junk, label, mailboxname,  mailboxpath,  priority, size, status, 

subject, to, and who.

Basic Search Rules

Let’s begin with a simple scenario. In the Find Messages window, we select “Anywhere” for 

the Search category, and “matches x1 query” for the verb. The table below lists various text 

the user enters in the search text box and the results of such a search.

‘Anywhere’ ‘matches x1 query’ Result

the a word starting with "the" in any column.

the= the exact word "the" in any column.

-the no occurrences of any word starting with "the" in any column.

NOT the (Same as `-the`.  "NOT" must be all caps.)

-the= no occurrences of the exact word "the" in any column.

NOT the= (Same as `-the=`.)

a AND b a word starting with "a" and a word starting with "b" in the same 
column.  ("AND" must be all caps.)

a b (Same as `a AND b`.  AND is the default operator.)
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You can also search on a specific column by selecting that column in the search category drop 

down list. For the next example, we will select “Subject” in the search category

a & b (Same as `a AND b`.)

a OR b a word starting with "a" or a word starting with "b" in any column.  
("OR" must be all caps.)

a | b (Same as `a OR b`.)

subject:the a word starting with "the" in the "subject" column. (More on 
"column specifiers" below.)

(a | b) & c (Performs `a | b` first, then AND's with `c`.)

a | (b & c) (Performs `b & c` first, then OR's with `a`.)

a | b & c (Same as ̀ a | (b & c)`.  AND's have higher precedence than OR's 
so they are performed first even though they come later in the 
expression. See precedence rules below.)

"the big d" the prefix phrase "the big d".  It will match "the big dog" and "the 
big date".

"the big d"= the exact phrase "the big d".  It will not match "the big dog" or "the 
big date", only "the big d" where "d" is a complete word.

"the big d " (Same as `"the big d"=`.  Any non-alpha-numeric characters in a 
phrase search mean "exact word".)

a@b.com (Same as the phrase search `"a b com"`.  All puncuation is 
stripped, then prefix phrase search. See punctuation rules 
below.)

a NEAR b (Same as `a AND b`, but "a" and "b" must be "near" each other, 
a max of 10 words in between.)

b NEAR a (Same as `a NEAR b`.)

a NEAR/5 b (Same as `a NEAR b`, with a max of 5 words in between "a" and 
"b".)

a /20 b (Same as `a NEAR/20 b`.)

a PRE b (Same as `a AND b`, but "a" must preceed "b".)

a PRE/5 b (Same as ̀ a PRE b`, with a max of 5 words inbetween "a" and "b".  
See more "proximity" search examples below.)

‘Anywhere’ ‘matches x1 query’ Result
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Special Searches 

`-`, `=` and `-=` have special meaning when they are for a column search (either by entering 

them in a column search box or with a main search box column specifier like ̀ subject:=`). Once 

you start typing more characters immediately after them, they loose their speciality and follow 

other rules. i.e. `-the` is `NOT the`. `=10` would follow normal punctuation rules (discussed 

below) and turn into just `10`. `-=10` would turn into `NOT =10` which is `NOT 10`. NOTE: 

When searching using these special searches, you might notice extra results when searching 

for `-` or `-=`. You might see some "empty" results that you thought you were filtering out. The 

problem is that those values contain spaces or other invisible characters so they look empty, 

but they are not and therefore belong in the "non empty" search that `-` and `-=` give. 

Parenthesis () and [] 

If parenthesis are not "balanced", we try to recover in the best possible way: 

Not enough closing parens? We add them internally at the end of the search expression to 

balance them. So `(a (b | c` is equivalent to `(a(b|c))`. 

‘Subject’ ‘matches x1 query’ Result

(anything from above) (Same as above but for the ‘Subject’ column only.)

- something (items with non-empty ‘Subject’columns).

= nothing (items with empty ‘Subject’ columns).

-= (Same as `-`.  See Special Searches below.)

NOT anything (all items; no effect.  You might think it would be the same as 
`-`, but `-` is special that way.  "NOT" requires something after it.)

from:the (Normal punctuation rules apply.  It will notsearch the "From" column 
for "the" since you're already in a ‘Subject’ column search.)
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Not enough opening parens? We treat the extra closing parens as normal punctuation. So `a 

b | c))d` is equivalent to `a b | c d`. In this case you might think it should be `a b | "c d"` since 

we've noted before that punctuation between terms (like `a@b.com`) turns it into a phrase 

search. The exception to that rule is extra parenthesis. Parenthesis are only used to group 

terms and then thrown away. Or in this case, just thrown away. However, they do serve a 

purpose to separate "c" from "d", just like space. NOTE: ( = [, and ) = ]. In other words, you can 

mismatch your parenthesis. i.e. `(a [b | c)]` is equivalent to `(a (b | c))` and is therefore 

balanced. 

Order Of Operations (Precedence Rules) 

1. Parenthesis are done first, 

2. then proximity (NEAR, PRE, NEAR/n, PRE/n, /n), 

3. then negation (-, NOT), 

4. then intersection (&, AND), 

5. then union (|, OR). 

Example: `NOT a OR b AND c NEAR d` is equivalent to `-a | (b & (c NEAR d))`. 

Numbers 

A search for `1,234,567.89` is equivalent to `1,234,567.89 OR 1234567.89`. In other words, 

the commas in a number are optional so we search for both. 

Negative Numbers 

A search for `-123` is equivalent to `NOT 123 OR "-123"`. In other words, the negative sign 

could mean logical negation or as actually the prefix of a number less than zero, so we search 

for both. 

Multiple Negative Searches 

`NOT NOT a` is equivalent to `a`. Same with `NOT -a` and `--a`. But `-NOT a` is equivalent to 

`-"NOT" & a`. 



440

X1 Search Queries

Spacing 

In general, extra spaces are ignored except when found within double quotes. Some operators 

need to be surrounded by spaces for them to be interpreted in their special way. But when the 

next character is an open paren, no extra space is required. i.e. `a &(b | c)`, `NOT(this | that)`, 

etc. Same for quotes. i.e. ̀ this AND"that and the other"` Normal words work too. i.e. ̀ this(that)` 

is identical to `this AND that`. 

Maximum Word Length 

There is a maximum size for any word we'll index and this will affect searches. The maximum 

length of any string of characters we index is 39. So if you search for a word longer than that, 

you will get no results even if you are sure the word exists in a document somewhere. Since 

most words have far fewer characters, this is not a problem. And usually longer "words" have 

punctuation in them, and if any of those words between the punctuation are less than 40 

characters, they will be indexed and searchable. For example, you might search for a URL: 

`http://www.thisdomainislongbutlessthan40characters.com/some/path/file.html` It has no 

spaces and could be typed as one term by the user to search for in the main search box. It is 

longer than 39 characters as a whole so the entire "word" is not indexed itself (even if we did 

index punctuation) but many of the subpieces are, so if you were to type this "word" to search 

for, it also is broken up internally using normal punctuation rules and the search would work. 

When the results are highlighted, you will see it highlight the sub pieces and not the whole 

thing. This is discussed more below. 

Master Search Field Rules

"columnName:" notation allows column-specific searches to be represented in the main 

search box. Double-quotes can be used to prevent this parsing of colon items (examples 

below), and also denote phrase searches. Parenthesis control boolean combination, and can 

control the range of a "columnName:" specifier as shown below. 

For example, the search: 

From:lee

The colon notation with no space after the colon, indicates this is a column specifier. It's the 

same as typing "lee" into the From column's search area. But this notation allows other 

combinations like: 

To:lee OR cc:lee
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Note in the above that two different columns are combined. Any space terminates the special 

column-specific handling. So the following finds the word "box" in any column (including 

content), but the word "gift" only in the subject column: 

Subject:gift box

One exception: a space is allowed when starting out with a NOT: 

Subject:NOT spam 

(this is the same as `Subject:-spam`, or `-Subject:spam`)

To make a multi-word search within a column, one can use either quotes or parens or brackets: 

Subject:(gift box)
Subject:[gift box]
Subject:"gift box"

The last quoted version acts a little differently since it specifies a phrase search, meaning the 

two words must be adjacent and in that order. The paren/bracket versions just mean AND, 

namely that the two words must occur in the column, in any order and position. 

Special case, consider this search expression: 

Subject:

Since there is nothing after the column specifier, it is not treated as a column specific search 

at all. Rather, it is a search using normal punctuation rules. In this example, the search is for 

the actual text "Subject:" in any column (following our punctuation rules, see below). 

The name of the column may be abbreviated in various ways. Column name specifiers:

are case insensitive; 

may not contain spaces, so to specify for a column whose name has a space (like Attachment 

Count), the user must leave out the space and write for instance AttachmentCount?; 

may be abbreviated as any prefix of the name, so ̀ Subject:` would work for Subject?, as would 

`su:`. In case of ambiguity as to which column is meant, the column specifier chooses the first 

one in alphabetical order. So `s:` would mean `Size:` rather than `Status:` or `Subject:`. 
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If no column name is matched, the expression is searched using normal punctuation rules. i.e. 

`subjict:x1` is equivalent to `"subjict x1"`. 

More Punctuation Rules

All punctuation is treated as spaces. In a search, however, they signal a phrase search without 

having to use double quotes. i.e. `re-search` is equivalent to the search `"re search"`. 

Initial punctuation is converted into spaces, except for strings of minus signs. So `!@#$abc` 

turns into ` abc` and we ignore strings of spaces so that is equivalent to just `abc`. `--a`, 

however, is a double negative `a` search. 

Phrase searches are by default "prefix" phrase searches. So ̀ "a b c"` will find "a b cat", but ̀ "a 

b c"=` will ONLY find "a b c" where "c" is not a prefix. 

Example Search Results

email@abcd-efg.com "email abcd efg com"

me@emailaddr.net "me emailaddr net"

c:\mydrive/is/over/here "c mydrive is over here"

1,234,567 "1 234 567" OR 1234567

123-45-6789 "123 45 6789"

-123 NOT 123 OR "-123"

"-123" (literal "negative 123" search)

cats-and-dogs= "cats and dogs"=

B&B "b b"

1+2 "1 2"

a.m. "a m"=

i.e. "i e"=

0.0 "0 0"

U.S.A. "u s a"=

it's "it s"

there's "there s"

something. something=
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Proximity Searching

/3 is equivalent to NEAR/3 

`a NEAR b` = `a NEAR/10 b` and matches "a [ten words] b", 10 is the default for NEAR and 

PRE with no /n argument after it. 

`a / b` = `a b`. i.e. a lone / sign not the same as `a NEAR b` 

`a NEAR/ b` = `a NEAR b`, the straggler / sign will be ignored. 

`a /3 b` = `b /3 a`. i.e., it's a commutative operator, order doesn't matter. 

`a PRE/3 b` is similar to `a NEAR/3 b`, but "a" must preceed "b" to match. 

`a= NEAR/0 b=` can be written using phrase search syntax: `"a b"= OR "b a"=` 

`a= PRE/0 b` = `"a b"`, not commutative, "a" exact match, "b" prefix match. 

`a PRE/0 b` is not the same as `"a b"` since it will match "alpha beta" and "a butterfly" while 

the phrase search will only match the latter ("a" exact). 

`x/4` is not a NEAR operation, it's equivalent to `"x 4"` 

`/3/6` is not a NEAR operation, it's equivalent to `"3 6"` 

`"a NEAR b"` is not a NEAR operation, it's a phrase search with 3 terms: "a", "near", and "b". 

Some stranger examples: 

Example 1: `a AND b NEAR c`

NEAR has higher precedence than AND, this is equivalent to: `a AND (b NEAR c)`

[b]hello[/b] "b hello b"=

var=1000 "var 1000"

DEF_VALUE=2 "def value 2"

Example Search Results
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Example 2: `a NEAR b NEAR c`

This is a single strung-together NEAR operation.  So all of the following will match:

    "a ..... b ..... c"
    "a ...c. b ......."
    "c ..... b ..... a"
    "c ...a. b ......."
    "....... b .a..c.."
    "a..b.[more than 10 words].b..c"

In other words, "a is near b but so is c", order doesn't matter.  The search expression could 

also be written as `(a NEAR b) AND (b NEAR c)`.

Example 3: `(a NEAR b) NEAR c`

That 2nd NEAR is meaningless so the 2nd NEAR is taken literally: `(a NEAR b) AND "NEAR" 

AND c`

Example 4: `a NEAR "b c"`

The word "a" is near the phrase "b c".  `"a b" NEAR "c d"` is also an valid proximity search.

Example 5: `a NEAR NOT b`

Makes no sense, treated as: `(a NEAR "NOT") AND b` since NEAR and PRE have higher 

precedence than OR, AND, and NOT.

Example 6: `a NEAR (NOT b)`

Makes no sense, treated as: `a AND "NEAR" AND NOT b` since parenthesis have highest 

precedence.
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EUDORA.INI Settings File

The EUDORA.INI file is where Eudora keeps most of the settings. It is a standard Windows 

INI file, and may be edited with any text editor. 

NOTE: Since Windows caches information from INI files in memory while the program is 

running, you should never change the EUDORA.INI file while Eudora is in use. If you need to 

make a change, first quit Eudora, then edit the file, and then restart Eudora.

The EUDORA.INI file is divided into a number of sections, the following of which appears by 

default:

• [Settings]

• [Mappings]

• [Window Position]

• [Tool Bar]

• [DirectoryServices]

• [Debug]

Optional Sections

The following sections will appear in the INI file only when the appropriate conditions are met 

or the appropriate items created:

[Personalities] This section appears only when you have created alternate email accounts 

(personalities).

[Stationery] This section appears only when you have created stationery files.

[Open Windows] This section appears only when there are windows currently open in Eudora.
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[WazooBars] This section appears only when normal Eudora windows are currently open or 

minimized on the desktop (and thus buttons appear on the Eudora taskbar, which is what this 

section controls).

[Recent File List] This section appears only when files have been opened since the most 

recent Eudora startup.

NOTE: We strongly urge that you do not change the values in these optional sections of the 

INI file, and rather make any changes from the interface. For example, personalities can be 

created and edited from the Personalities window, and stationery can be created and edited 

from the Stationery window. Both windows are available from the Tools menu.

The values of the settings in each of these optional sections reflect the current values of the 

objects or conditions; there are no "default" values per se.

Name and Location of the INI File

The default name is EUDORA.INI and the default location is in the mail directory. But the name 

and location can be changed.

To specify a different INI file from the EUDORA.INI that is not in the mail directory, add a 

second parameter to the command line in the Program Item for Eudora, for example:

Command Line: c:\apps\eudora.exe c:\mymail c:\inis\myeudora.ini

To use a different INI file that is in the mail directory:

Command Line: c:\apps\eudora.exe c:\mymail myeudora.ini 
Command Line: c:\apps\eudora.exe c:\mymail\myeudora.ini

This is a way to have multiple settings for one set of mailboxes, nicknames, etc. For example, 

you may have multiple email accounts in which you receive mail, but want to collect mail from 

all of the accounts in one place. You could set up separate Program Items for each account 

(each having a different INI file on the command line), and switching between accounts would 

be as simple as double-clicking on a Program Item.

And for an even more tricky specification, if the first parameter is an INI filename without a 

path, then the mail directory is searched through the normal process of checking the EUDORA 

environment variable and then using the executable directory.
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Examples:

SET EUDORA=c:\mymail 
Command Line: c:\apps\eudora.exe myeudora.ini

will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI file.

SET EUDORA=myeudora.ini 
Command Line: c:\apps\eudora.exe

will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.

Default INI file

When an entry in the EUDORA.INI file is not found, Eudora will look in the DEUDORA.INI file 

located in the same directory as the EUDORA.EXE file. The [Mappings] section of the 

DEUDORA.INI file acts as though it was appended to the end of the [Mappings] section of the 

EUDORA.INI file.

Examples:

          SET EUDORA=c:\mymail

          Command Line: c:\apps\eudora.exe myeudora.ini

          will use c:\mymail as the mail directory and c:\mymail\myeudora.ini as the INI 

file.

          SET EUDORA=myeudora.ini

          Command Line: c:\apps\eudora.exe

          will use c:\apps as the mail directory and c:\apps\myeudora.ini as the INI file.
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Settings

Entry Default Value Description

AddressBookIsWhitelist 0 If this is 1 mail will not be considered junk if the sender 
appears in an address book.

AgeJunkOff 1 If this is 1 old junk will be trimmed from the Junk mailbox.

AgeJunkOffDays 30 The number of days before junk is considered old enough to 
trim.

AllowAttachDrag 1 Controls whether attachments inside received messages.

AllowClipboardHTML 0 Controls whether Eudora should use the HTML format when 
copying from the clipboard (caution:some applications put 
very bad HTML on the clipboard).  You can always use Paste 
Special to get at the HTML clipboard format.

AllowDefPlugins 1 Controls whether or not EMSAPI plug-ins can be 
automatically added to the toolbar.

AllowOverwriteMode 1 Controls whether or not toggling the Insert key puts the 
message editor into overwrite mode. Helpful for people who 
use the Ctrl+Insert and Shift+Insert accelerators for Copy and 
Paste and have a tendency to linger on the Insert key after 
letting go of the Ctrl/Shift key.

AltClickMoveSummary 1 When you hold down the <Alt> key while clicking on an item 
in a mailbox, all messages in that mailbox with the same item 
are selected (e.g. <Alt> clicking on a subject will select all 
messages in that mailbox with the same subject). If this switch 
is on, then the selected messages will be grouped together as 
well. You can temporarily turn this off by holding down the 
<Shift> key while doing the <Alt> click.

AlwaysConnected 0 Set to 1 if you have a constant Internet connection such as 
LAN or cable modem.

AlwaysEnableJunkMen
us

0 If this is 1 the Junk and Not Junk menu items will always be 
enabled.  If this is 0 they will be enabled only when appropriate 
(i.e., Junk is enabled only for messages not in the Junk 
mailbox and Not Junk is only enabled for messages in the 
Junk mailbox).

AutoCompAddrBookFirs
t

1 If 1 the auto-complete feature will list entries from the address 
books before entries from the history list.
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BackgroundColor Specifies an RGB triple (in hexadecimal) for the color to use 
for the "workspace" area of the main Eudora window. Can be 
used in conjunction with the BackgroundImage entry for 
choosing a color better suited for the image being displayed. 
Examples: white is "FFFFFF", black is "000000", and blue is 
"0000FF". This setting does *not* require QuickTime to be 
installed.

To install a new background color, you must open the 
Eudora.ini file and add a new header, for example:

[Decorations] 
BackgroundColor=0000FF

BackgroundImage 0 Specifies an image to be displayed in the "workspace" area of 
the main Eudora window (called "Application Background" in 
the Appearance tab of the Control Panel->Display options). It 
needs to be specified as a full path name. This setting requires 
QuickTime to be installed.

To install a new background color, you must open the 
Eudora.ini file and add a new header, for example:

[Decorations] 
BackgroundImage=

BackupStatisticsDaily 0 If this is set to 1, a backup copy of the Statistics data is made 
each day in the Eudora data directory. The name of the file is 
Stats<month>-<day>.xml, where <month> and <day> are 
replaced by the current month and day. For example, on 
September 7 it would be called Stats9-7.xml.

BadPasswordString password When the POP server returns an error on sending the PASS 
command, the password will only be erased when the error 
response includes this text. 

BlackTocLines 0 If on, and displaying lines is mailboxes, draw lines as black 
instead of gray.

CenterUnreadStatus 1 When on (1), centers the bitmap in Mailbox menu items that 
indicate that the mailbox has unread messages. If the display 
of this bitmap is not correct, turn this switch off (0). 

CheckOwnerFreq 0 How often (in seconds) Eudora should check the 
OWNER.LOK file to see if another instance of Eudora has 
been started on the same set of mailboxes.

CompactDisk% 5 What the amount of "wasted space" taken up by deleted 
messages in a mailbox as a percentage of total free disk 
space must be before the mailbox automatically gets 
compacted when closed. 

Entry Default Value Description
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CompactMailbox% 50 What the percentage of "wasted space" taken up by deleted 
messages in a mailbox must be before the mailbox 
automatically gets compacted when closed. 

CompactOutgoingPlugi
ns

0 Controls whether the outgoing EMSAPI plug-ins on the 
composition message window toolbar should be separate 
buttons or contained within one button that pops up a list of all 
outgoing plug-ins. By default, all outgoing plug-ins get their 
own toolbar button.

CompSummaryItalic 1 In mailboxes other than the Out mailbox, display the 
summaries of outgoing messages in italics. 

ConConEllipsisCenter    
...snip... 

Text for Content Concentrator to use at the center of 
concentrated text.

ConConEllipsisLead      
... 

Text for Content Concentrator to use at the beginning of 
concentrated text.

ConConEllipsisTrail      ... Text for Content Concentrator to use at the end of 
concentrated text.

ConConMessageWindo
wProfile 

None Type of content concentrating to use when viewing a message 
in a window.  Choices: Terse, Compact, None.

ConConMultipleMessag
eMaxNum 

 20 Maximum number of messages to contentrate.

ConConMultipleMessag
esProfile 

Terse Type of content concentrating to use when viewing multiple 
messages.  Choices: Terse, Compact, None

ConConMultipleMessag
esReplyProfile 

None Type of content concentrating to use when replying to multiple 
messages.  Choices: Terse, Compact, None.

ConConMultipleMessag
esRequireRelated 

1 If 1 will only concentrate messages with matching subjects or 
senders.

ConConMultipleReplyW
arnThreshold

50 Warn the user when they are replying to more than this 
number of messages.

ConConMultipleSubject
sSuffix    , etc. 

Text for Content Concentrator to use in subject line.

ConConPreviewProfile    
Compact 

Type of content concentrating to use when viewing a message 
in a preview pane.  Choices: Terse, Compact, None.

Entry Default Value Description
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ConnectionStatusCache
Time

2000 Time (in milliseconds) that Eudora will cache the online status 
before checking with the system again, which can help with 
some setups where checking the online status can be very 
intensive.

ConvertFormatFlowed 
to Excerpt

1,0 Turns the format-flowed feature on and off.

CtrlJMapping 0 Specifies which menu the Ctrl-J key sequence is mapped to.  
If 0 user has not specified which menu.  If 1 Ctrl-J will be 
mapped to the Junk menu.  If 2 Ctrl-J will be mapped to Filter 
Messages.

DaysBetweenJunkAge
Off 

1 The number of days to wait before checking if any junk is old 
enough to trim.

DeleteAttachedVCFs 0 Deletes any attachment with a .VCF extension (vCard files), 
which can be handy if people who send you lots of messages 
have their email client set up to automatically attach their 
vCard.

DeleteFetchedJunk  1 If this is 1 junk that has been fetched will be deleted from the 
server.  Applies only to POP accounts where mail is left on the 
server.

DesDllName des32.dll The name of the DLL implementing the DES encryption 
routines for use with Kerberos version 4, e.g., des32.dll

DisableStatistics 0 If this is set to 1, no Statistics data is saved.

DoPluginCompletion    1 Indicates whether to include nicknames generated by ESP 
(and potentially by other Eudora plugins) in the Auto-
Completion list. A value of 1 means to include them, and a 
value of 0 means don't include them.

EditAllHeaders 0 Controls whether or not the (by default, non-editable) From: 
and Attached: headers in the composition message window. 

EnrichedSoftLine 72 Number of characters sent on a line before adding a soft 
newline when sending styled text. 

EudoraPassPort 106 Default port number for the Eudora password-changing 
service (epass). 

Entry Default Value Description
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ExceptionHandling 1 Controls whether or not Eudora's exception handling code is 
called when a program exception occurs (can be helpful to 
turn off if the exception handling code is hiding the source of 
the problem)

ExcerptBars 2 HTML style sheet parameter for excerpt bars. Can use this to 
change the width, color, and style of excerpt bars.

(Only works when using the Microsoft viewer).

ExtraHeaders Extra headers that are sent with each outgoing message. If 
multiple headers are to be sent, separate each with "\r\n". For 
example, 
"ExtraHeaders=X-Header1: foo\r\nX-Header2: bar". 

ExtraNicknameDirs List of directories to search for additional nickname files. 
Multiple directories can be entered, separated by semicolons 
(;). 

FilterFromFolder When doing a Make Filter, the name of the mailbox folder to 
place the default named mailbox that is created when filtering 
based on whom the message is from.

FilterRecipFolder When doing a Make Filter, the name of the mailbox folder to 
place the default named mailbox that is created when filtering 
based on whom the message is to.

FilterSubjectFolder When doing a Make Filter, the name of the mailbox folder to 
place the default named mailbox that is created when filtering 
based on the subject of the message.

FilterTransferName 0 This controls how mailbox names should be displayed in the 
button that indicates which mailbox is the target of a transfer 
or copy filter action. 0 is the mailbox name only. 1 is the full 
path of each mail folder and the mailbox name. 2 is the full 
path to the filename of the mailbox. 3 is just he parent mail 
folder and the mailbox name.

FindMatchCase 0 "Match Case" check box in the Find dialog. 

FindSummariesOnly 0 "Summaries Only" check box in the Find dialog. 

FirstUnreadNormal 1 When checking mail on a POP server, download any mail that 
hasn’t been retrieved at this machine.

FirstUnreadStatus 0 When checking mail on a POP server, download only 
messages that haven’t been read on any machine.

Entry Default Value Description
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FixCurlyQuotes 1 If on, then if a message contains 7-bit characters except for 
directional quotes, then those directional quotes are turned in 
to regular non-directional quotes so that the message may be 
sent out as 7-bit (no quoted-printable encoding needed).

FlattenSpeaking 1 The Microsoft Text-To-Speech engine has troubles with non-
ASCII characters, so this setting will make non-ASCII 
characters get converted to their ASCII equivalents before 
being handed off to the TTS engine.

FontSizeTableLarge 10,12,14,16,20,
26,42

Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in the 
Fonts category of the Options dialog. The seven values in 
each list correspond to the Very Small, Small, Medium, Large, 
Larger, Very Large, and Humongous sizes that you can 
specify in a message composition window.

FontSizeTableLargest 11,14,16,18,22,
28,48

Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in the 
Fonts category of the Options dialog. The seven values in 
each list correspond to the Very Small, Small, Medium, Large, 
Larger, Very Large, and Humongous sizes that you can 
specify in a message composition window.

FontSizeTableMedium 8,10,11,14,18,2
4, 
36

Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in the 
Fonts category of the Options dialog. The seven values in 
each list correspond to the Very Small, Small, Medium, Large, 
Larger, Very Large, and Humongous sizes that you can 
specify in a message composition window.

FontSizeTableSmall 7,9,10,12,16,22
,28

Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in the 
Fonts category of the Options dialog. The seven values in 
each list correspond to the Very Small, Small, Medium, Large, 
Larger, Very Large, and Humongous sizes that you can 
specify in a message composition window.

FontSizeTableSmallest 7,8,9,10,12,16,
24

Font sizes used for displaying text in the built-in (non-
Microsoft) viewer. They correspond to the size schemes in the 
Fonts category of the Options dialog. The seven values in 
each list correspond to the Very Small, Small, Medium, Large, 
Larger, Very Large, and Humongous sizes that you can 
specify in a message composition window.

ForceSaveForStatistics 0 Forces the saving of the Statistics info, even if the disk drive is 
spun out.

Entry Default Value Description
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GssDllName   gssapi32.dll For a user to specify the GSS/K5 DLL name.

GuessParagraphs 0 "Guess Paragraphs" check box in the Save As... dialog. 

HTMLInPlainText 0 HTML text would be displayed in messages in the Out box

IdleTime 60 The number of seconds that Eudora has to be idle before it will 
consider performing an automatic mail check. 

IgnoreEMSDelete 0 If this is 0, ESP control messages devoid of "human friendly" 
content are automatically deleted to avoid cluttering up your 
ESP mailboxes. If this is 1, those messages are preserved.

IgnoreIdleOnManualCh
eck

0 Controls whether background tasks started manually (e.g. 
Ctrl+M to do a Check Mail) should be processed immediately 
after completing, or wait until a sufficient amount of user idle 
time (see TaskMgrWaitTime below). 

ImapIgnoreUIDPLUS 0 Specifies whether or not Eudora should ingore IMAP 
UIDPLUS responses.  If this is set to 1 IMAP junk handling will 
not work as expected.

IMAPLeafMenu 0 Controls whether IMAP mailboxes with no child mailboxes 
should be shown in the Mailbox/Transfer menus as an entire 
menu or just a menu item. Default is to just show it as a menu 
item. 

IMAPPort 143 Default port number for IMAP connections.

IMAPPreviewPane 1 Controls whether or not IMAP mailboxes have a preview 
pane. On slower networks, it may be desirable to turn off the 
preview pane for IMAP mailboxes, but still have the preview 
pane for local mailboxes. You can do that by keeping the 
normal Preview Pane option turned on, but turning this setting 
off (setting to 0).

IMAPRemoveOnDelete 0 Controls whether or not a message in an IMAP mailbox that is 
deleted will be removed from the server mailbox immediately. 
If this setting is off (the default), then you can remove 
messages from the server mailbox that have been marked to 
be deleted by using the Message->Remove Deleted 
Messages menu item. 

ImapSupportEMSAPI 1 Specifies whether IMAP accounts should support EMSAPI.

IncludeHeaders 0 "Include Headers" check box in the Save As... dialog. 

IncludeSigForward 1 Whether or not the default signature should be included when 
forwarding a message.

Entry Default Value Description
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IncludeSigRedirect 0 Whether or not the default signature should be included when 
redirecting a message.

IncludeSigReply 1 Whether or not the default signature should be included when 
replying to a message.

InteractiveSpellCheck 1 When doing a spell check, controls whether you get prompted 
with a dialog for each misspelled word, or each misspelled 
word gets marked with a double red underline (which then you 
can right-click on to get suggestions and other options for the 
misspelled word). If you hold down the Shift key while doing a 
spell check, the other method of spell checking will be 
performed. 

InterpretFormatFlowed 1 Turns format=flowed off and on.

JunkMailboxName Junk Specifies name for Junk m If this is 1 the Junk mailbox will 
never be marked as having unread mail in it.

JunkNeverUnread 0 If this is 1 the Junk mailbox will never be marked as having 
unread mail in it.

JunkTrimMbox Trash Specifies which mailbox to trim old junk to.  Changing this 
setting to "-" will cause old Junk to be deleted rather than 
being trimmed to a mailbox.

KerberosSetUserName 0 Uses KClient SetUserName() function to set user name in 
Kerberos system. Turning this switch on may cause Kerberos 
tickets to be invalidated. 

Krb4Dllname kerberos32.dll The name of the Kerberos version 4 DLL, e.g., kerberos32.dll

LastSettingsCategory 0 Last category that was displayed in the Options dialog. 

LexPath Directory in which the dictionary files for spell checking reside. 

MainLexFiles Main dictionary files. British dictionaries can be used by 
changing this to british.tlx,british.clx 

MainWindowState 1 The state of the Main Window (normal = 1, minimized = 2, or 
maximized = 3). The state is set when Eudora closes, and the 
Main Window is set to this state the next time Eudora starts 
up. 

ManualJunkScore 100 The score assigned to mail the user specifies as junk.  A 
setting of 0 means do not change the score when the user 
specifies mail as junk.

ManualNotJunkScore 0 The score assigned to mail the user specifies as not junk.

Entry Default Value Description
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MapiAutoSendSignatur
e

0 Controls whether messages sent through Eudora's MAPI will 
tack on the default signature.

MapiExcerptFixedText 1 Controls whether messages sent through Eudora's MAPI will 
convert plain text quoting in to excerpts so that messages are 
easier to read on different width screens (e.g. PCs vs. PDAs).

MaxConcurrentDialupTa
sks

2 The maximum number of checking/sending tasks that can 
occur simultaneously while using a Eudora specified dialup 
connection.

MaxConcurrentTasks 10 The maximum number of background tasks that can be 
running at the same time. Note that if you are connected over 
a modem (dialup networking connection) only one network 
task at a time will be run, otherwise network performance 
would suffer greatly. 

MaxMenus 30000 The maximum number of popup menus for mailboxes. These 
are equivalent to mailbox folders; that is, local mailbox folders 
that contain other mailboxes, or IMAP mailboxes that contain 
other mailboxes. Used when Eudora can’t be started due to 
the large number of popup menus created, which is limited by 
Windows. This will allow you to start up Eudora and run it long 
enough to remove some mailboxes so that fewer menus will 
be needed. Running for extended periods of time with this 
switch in Eudora.ini is not recommended. 

MDNSendAddress 0 Controls whether your return address should be used in the 
MAIL FROM command for return receipts. RFC 2298 says 
that it should be empty in order to prevent mail loops, but 
some SMTP servers reject that due to bad spam-prevention 
heuristics. 

MinAgeOffScore 0 The minimum score old junk must have before it will be 
trimmed.

MinScoreToJunk 50 The minimum score needed for mail to be considered junk.

MoodWatchCheckOrigin
al

0 Controls whether the original sender's (excerpted) text in the 
message should be used when calculating the MoodWatch 
score of a composition message.

MoodWatchCompBadW
ords

1 Controls whether or not phrases identified by the MoodWatch 
engine in composition messages should be highlighted by 
underlining.

MoodWatchDelayinMinu
tes

10 Time of the delay (in minutes) if MoodWatch is configured to 
delay the sending of messages.

Entry Default Value Description
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MoodWatchDeltaTime        

   

5 MoodWatchDeltaTime is how long Eudora must be idle, in 
seconds, before background MoodWatch scanning starts. .

MoodWatchInterval 1000 Number of milliseconds that Eudora will wait until checking the 
MoodWatch score after the user hits a key in a composition 
message.

MoodWatchThresholdTi
me 

1000 MoodWatchThresholdTime is how long it keeps scanning, in 
milliseconds, once scanning starts.

MultipleRepliesForMulti
pleSelection 

0 If 1 Eudora will generate separate reply messages for each 
selected message.  Otherwise Eudora will concentrate all 
messages into a single reply.

NetscapeURLDDE 1 If this setting is on, when clicking on a URL in a message and 
Netscape Navigator is running, then Eudora will send the URL 
to that open Navigator window.  If this setting is off (i.e. set to 
zero), then clicking on a URL in a message will send the URL 
to the system, which will invoke the default browser.  Some 
Navigator users may want to turn this setting off if they like the 
behavior of opening a new window (as opposed to reusing an 
existing browser window) when clicking on a URL in Eudora. 

NetworkOpenTimeout 60 The number of seconds Eudora will wait for a response to 
opening a connection before it gives up. 

NewMailUpdateFrequen
cy

25 Number of inital messages that have to be spooled before 
message processing begins.

NoAutoResponseHeade
rs

errors-to:,list- Allows for better detecting of mailbing list to whcih you should 
not auto-respond. As a default, “errors-to:,list-” is the value. 
Add any other headers that will identify it as a list (hence will 
not auto-respond via filters).

NoAutoSendPrecedenc
e

list,bulk When filtering incoming messages with precedence headers 
of list or bulk, do not automatically create new outgoing 
messages. 

NonJunkToAddressBoo
k 

1 If this is 1 and a message is the user specifies a message as 
not junk the sender of that message will be added to the 
address book.

NonJunkAddressBook Address book to add senders of not junked messages to.  If 
blank Eudora Nicknames will be used.

NoSplashScreen 0 If on, the opening splash screen will not be displayed. 

Entry Default Value Description
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Offline 0 Set to 1 to temporarily set Eudora offline; it will not perform 
automatic timed mail checks when offline.

OfflineLinkAction 0 Eudora displays the Offline Link Dialog if you click on an http: 
link while offline (not connected to the Internet). That dialog 
lets you choose what action should be taken regarding that 
link the next time Eudora is online: ask you if you want to 
launch the link, launch it without asking, bookmark the link in 
your browser, or remind you later. The dialog now has a 
checkbox that will make the action you choose the default 
from then on, which means you won't see the Offline Link 
Dialog any more. It defaults to 0 = ask, and the other values 
are 1 = launch, 2 = bookmark, and 3 = remind.

OldWABImport 0 Controls whether Eudora uses an older method of importing 
the Windows Address Book, which may do a better job of 
importing on some setups than the default method.

OpenRetryCount 5 Some external applications like to open up files that Eudora is 
using (e.g. virus checkers and backup software), so this 
setting controls how many times Eudora should try to open a 
file before it gives up.

OpenRetryInterval 250 Time (in milliseconds) Eudora waits before attempting to open 
a file again (see OpenRetryCount above).

OptionsHideCursor 1 Controls whether the cursor gets hidden to prevent flicker 
when switching between categories in the Tools->Options 
dialog, which causes a small minority of systems to lose the 
cursor while in the dialog.

OwnerLok 1 If this is non-zero, an OWNER.LOK file will be created on 
startup which helps to prevent possible corruption if multiple 
instances of Eudora are used on the same set of mailboxes.

PasswordChangeServe
r

The name of the server to use for changing passwords. By 
default this is the same as your POP server.

Entry Default Value Description
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PasswordOKWordList lock busy,own it, 
of memory, 
assign stream, 
ush of temp, 
being unlock, 
hangup,timeout,
not 
owned,quota, 
drop name,
recognition 
mode,accessibl
e by others,
regular 
file,flock,mailloc
k, 
few 
minute,locked 

A comma-separated list of words that if found in the response 
text from an error from the POP PASS command that will not 
cause the password to be erased (works in conjunction with 
the BadPasswordString entry above). POP servers 
sometimes fail after sending the PASS command for reasons 
other than your password was incorrect, and this entry allows 
greater control over when Eudora will decide to ask you again 
for your password. 

PhReturn A string that is appended to every Ph command before 
sending to the Ph server. For example, "PhReturn=return all" 
would return all fields of the records returned by the query, and 
"PhReturn=type=person" would return all matches to the 
query with the additional filter that the record is a person. 

POPPort 110 Default port number for the POP service (pop3).

PreventExecutableEmb
ededContent 

1 If this is 1 Eudora will prevent executable HTML embeded 
content.

PreviewHeaders To:,Subject:,Cc:
, Bcc:, X-
Attachments:

A comma-separated list of headers that should be shown in 
the preview pane. The matching is done on a prefix basis, so 
any header that begins with one of these values will be shown.

PreviewHeadersMaxLin
es

4 This is designed to keep preview pane headers to a minimum. 
This is most often used to control large To: or Cc: headers 
where someone inserts a large number of individual 
addresses.

PreviewMultiDelay 500 The number of milliseconds to delay before refreshing the 
preview display if a multiple messages are selected.

PreviewSingleDelay 250 The number of milliseconds to delay before refreshing the 
preview display if a single message is selected.

Entry Default Value Description
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PreviewSplitterPos 0 If non-zero, then if a mailbox hasn’t already specified a 
position for the splitter between the message list and the 
preview pane, then the splitter will be positioned this many 
pixels from the top of the mailbox window.

PreviewTableEnd </table>\r\n HTML markup for the end of the table that’s used to display 
the headers in a preview pane.

PreviewTableRowEnd </td></tr>\r\n HTML markup for the end of the table row that’s used to 
display the headers in a preview pane. Each header appears 
in a separate row of the table.

PreviewTableRowStart <tr bgcolor=%s 
text=%s><td>\r\
n

HTML markup for the start of the table row that’s used to 
display the headers in a preview pane. Each header appears 
in a separate row of the table.

PreviewTableStart <table 
cellspacing=

0 cellpadding=0 
width=100%% 
bgcolor=%s 
text=%s>\r\n

HTML markup for the beginning of the table that’s used to 
display the headers in a preview pane.

PrintHeaders 1 When on (1), printed messages get headers and footers. 

ProgressIdle 3 Number of seconds a foreground tasks continues before the 
Progress window is shown. This prevents a distracting flash of 
the Progress window for a task that may take a long time, but 
in this instance only takes a short time. 

QuoteEnd The string that gets inserted after the original text of a 
forwarded message. A newline is added before the string. 

QuotePrefix > The string that precedes all lines of the original message in a 
forwarded message 

QuoteStart The string that gets inserted before the original text of a 
forwarded message. A newline is added after the string. 

RasChooseBeforeEvery
Connection 

 0 If 1 Eudora will allow the user to choose a connection each 
time Eudora initiates Dial-up networking (Windows NT 4.0, 
2000 and XP only).

Entry Default Value Description
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RasUseExisting 
Connection

1 When switching from a task from one personality to a task of 
another personality and the two personalities have different 
dialup networking connection entries, whether or not the 
already connected dialup networking connection should be 
maintained or a new dialup networking connection made. It 
may be necessary to turn this setting off (set to zero) if you 
have personalities that check mail on servers that are behind 
firewalls, and require that you dial in directly in order to 
connect to the mail server. 

ReadMessageStyleShe
et

<STYLE 
TYPE=""text/cs
s"">\r\

n{font-family = 
""%s""}\r\nTT 
{font-family = 
""%s""}\r\nBLO
CKQUOTE.CIT
E {border-

left = solid 
%s}\r\nBLOCK
QUOTE.CITE 
{padding-left = 
0.5em}\r\nBLO
CKQUOTE.CIT
E {m

argin-left = 
0}\r\nBLOCKQ
UOTE.CITE 
{margin-top = 
0.5em}\r\n

HTML style sheet used for displaying received messages.

ReadRecieptAsk 1 Ask user for read receipts. 

ReadRecieptNo 0 Always deny read receipts without prompting.

ReadRecieptYes 0 Always return read receipts without prompting. 

RelayPersona Specifies which personality to use as SMTP relay personality.

RemoveSuspiciousLoca
lFileRefs 

1 If this is 1 Eudora will remove local file: references that appear 
to be suspicious.

ReplyAllAttribution At %1, %2 
you wrote: 

Attribution line when a Reply to All is done. 

Entry Default Value Description
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ReplyAttribution At %1, you 
wrote:

Attribution line when a Reply is done. 

ReplyEnd The string that gets inserted after the original text of a replied 
message. A newline is added before the string. 

ReplyPrefix > The string that precedes all lines of the original message in a 
replied message

ReplySelectOnlyIF \n.!? If doing a Reply with selection and if none of the characters in 
this list are in the selection, then Eudora will reply using the 
entire body of the message.

ReplyStart The string that gets inserted before the original text of a replied 
message. A newline is added after the string. 

ReservedDosNames aux,com1,com2
,com3,com4,co
n,lpt1,lpt2,lpt3,l
pt4,nul,prn

Reserved names of files that will not be used for filenames of 
attachments. These filenames are reserved for DOS, and can 
causes problems in actual files with these names are created. 

ReturnAddressFormat %1 < %2> Format of the From: field in outgoing messages. %1 is the 
Real name, and %2 is the Return address. 

SaveDialupPasswordTe
xt

Where your dialup password is saved (in an encrypted format) 
if you have the Save Password switch turned on. 

SavePasswordText Where your POP password is saved (in an encrypted format) 
if you have the Save Password switch turned on. 

SaveStatisticsInterval 15 The Statistics data is saved to disk at intervals of this many 
minutes.

SearchAllmapAccounts 0 Controls whether all of your mailboxes in all IMAP accounts 
will be looked at when searching, or just the mailboxes in the 
IMAP account that you start the search in (applies to local 
mailboxes as well, i.e. a search starting in a local mailbox will 
only search your local mailboxes if this setting is off).

SeenIntro 1 You can make the introduction window return by changing the 
value to 0.

SendCharset Specifies which charset to indicate for outgoing messages.  If 
left blank Eudora will choose an appropriate charset (e.g., 
"USASCII").

SendXAttachHeader 0 Controls whether or not the X-Attachment: header should be 
sent out with outgoing messages that contains attachments.

Entry Default Value Description



463

Eudora.ini File

SeparateMSHTMLSetti
ngs

0 Controls whether Eudora keeps its settings for the MS Viewer 
in a different part of the registry so that they don’t conflict with 
IE (or any other app that uses MSHTLML), which can be 
handy for having the default font size be different in Eudora 
than in IE.

ShowAttachmentIcons 1 Controls whether or not icons representing attachments 
should be shown in the body of the message. 

ShowMeTheErrors 0 Controls whether or not to show the error dialog immediately 
on send/receive errors. By default, errors are listed in the Task 
Errors window, and that window is brought to the foreground. 

ShowProgress 1 Show/hide the Progress window. 

ShowProgressInactive 0 If Eudora is not the foreground application, this controls 
whether the Progress window should be shown or not.

ShowSelectedSummary
Count

0 Adds an extra number to the beginning of the numbers listed 
in the compact button in the lower-left corner of the mailbox 
summary display that shows how many message summaries 
are currently selected in that mailbox.

ShowTipOfTheDay 0 Determines whether to display the Tip of the Day when 
Eudora is launched.

SMTPAuthAllowed 0 Allows you to add authentication to your SMTP server.

SMTPAuthBanished CRAM-MD5 It should contain a comma-separated list of authentication 
schemes whose use is to be disallowed. The security 
conscious should set it to "LOGIN,PLAIN", as this ensures 
that your SMTP server password will always be strongly 
encrypted when it goes over the network. Users of 
IPSWITCH's Imail SMTP server should set it to "CRAM-MD5" 
so as to avoid a bug of theirs. 

SmtpAuthK5INI 1 If this is 1 SMTP will use Kerberos 5 authentication if that 
personality's POP/IMAP is set to use Kerberos 5.

SMTPAuthRequired 0 Allows you to require authentication when gaining access to 
your SMTP server.

SMTPPort 25 Default port number for the SMTP service (smtp). 

SMTPRecipientWrap 72 Column at which recipient headers (To: and Cc:) are wrapped 
when sending a message. 

Entry Default Value Description
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SpoolRenameRetryCou
nt 

10 Number of times to try to rename a spool file.  This is designed 
to help Eudora recover from cases where a virus scanner like 
McAfee has locked access to the *.tmp file.

SpoolRenameRetryInter
val 

300 Number of milliseconds to wait before attempting to rename a 
spool file.  This is designed to help Eudora recover from cases 
where a virus scanner like McAfee has locked access to the 
*.tmp file.

SSLAltPortReceiveVersi
on 

0 Applies to POP and IMAP. Uses same values as 
SSLReceiveVersion.

SSLAltPortSendVersion 0 Applies to SMTP. Uses same values as SSLReceiveVersion.

SSLIMAPAlternatePort 993 Specifies IMAP alternate port only.

SSLPasswordAlternate
Port

106 Specifies password alterernate port only.

SSLPasswordUse 0 Use SSL for password changes or not. If used, the 
corresponding “receive” settings apply.

SSLPOPAlternatePort 995 Specifies POP alternate port only.

SSLReceiveAllowRegE
xp

1 Specifies POP and IMAP only.

Specify whether you want to allow the usage of Regular 
Expressions in hostname matching in CN from the certificate 
subject or not. For example, if you are connecting to a server 
cgate.qualcomm.com that has a certificate with CN as 
*.qualcomm.com, then SSL will succeed if you have the value 
for this setting set as 1. A value of zero will require the server 
to have a certificate with CN=cgate.qualcomm.com causing 
SSL to fail because of hostname mismatch.

SSLReceiveAllowVersio
n2

1 Specifies POP and IMAP only.

SSLReceiveIgnoreExpC
ert

0 Specifies POP and IMAP only.

SSLReceiveMinEncrypti
on

0 Specifies POP and IMAP only.

SSLReceiveMinKeyExc
hangeLength

0 Specifies POP and IMAP only.

Entry Default Value Description
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SSLReceiveVersion 6 (default)

0=Undetermine
d

1=SSL_Version
_3_0_With_2_0
_Hello

2=SSL_Version
_3_0_Only

3=TLS_Version
_1_0_Only

4=TLS_Version
_1_0_With_2_0
_Hello

5=SSL_Version
_2_0

6=SSL_Version
_3_0

7=TLS_Version
_1_0

Specifies POP and IMAP only.

SSLSendAllowRegExp 1 Specifies SMTP only.

Specify whether you want to allow the usage of Regular 
Expressions in hostname matching in CN from the certificate 
subject or not. For example, if you are connecting to a server 
cgate.qualcomm.com that has a certificate with CN as 
*.qualcomm.com, then SSL will succeed if you have the value 
for this setting set as 1. A value of zero will require the server 
to have a certificate with CN=cgate.qualcomm.com causing 
SSL to fail because of hostname mismatch.

SSLSendAllowVersion2 1 Specifies SMTP only.

SSLSendIgnoreExpCert0 Specifies SMTP only.

SSLSendMinEncryption 0 Specifies SMTP only.

SSLSendMinKeyExcha
ngedLength

0 Specifies SMTP only.

SSLSendVersion 6 Specifies SMTP only.

SSLSMTPAlternatePort 465 Specifies SMTP only.

Entry Default Value Description
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SpoolDirTemp 0 Controls whether Eudora should use the temp directory on 
your local hard drive for spooling messages when sending 
and receiving, which can increase performance when your 
data directory resides on a network drive.

StatBarBlink 0 Controls whether or not the icon shown in the status bar for 
tasks that are waiting or have errors should blink. 

StatBarErrorAnimationR
ate

250 Controls the speed of the animated icon in the status bar for 
tasks that are currently waiting (units in milliseconds between 
images). 

StatBarGraphWidth 100 The width (in pixels) of the background task progress bar that 
shows up in the status bar. Set to zero to prevent the progress 
bar from being displayed. 

StatBarErrorRunningAni
mationRate

125 Controls the speed of the animated icon in the status bar for 
tasks that currently have errors (units in milliseconds between 
images). 

StatBarWaitingAnimatio
nRate

500 Controls the speed of the animated icon in the status bar for 
tasks that are currently waiting (units in milliseconds between 
images). 

StationerySignatureRule
s

1 Signature precedence is as follows: User's selection; 
Stationery's signature; Personality's signature. Set this to 0 to 
put Personality's signature before Stationery's. 

StripDuplicateAddresse
s

1 When replying to a message, controls whether or not 
duplicate copies of your email address will be removed from 
the To: and Cc: headers. This helps to avoid buildup of your 
email address in email conversations. 

SwitchFindKeyAccl 0 If on, Ctrl+F will open the Find Text window, and the 
Ctrl+Shift+F will open the Find Message window. By default, 
it’s the opposite. 

SwitchPreviewWithTab 1 When on, pressing the <Tab> key in a mailbox will switch 
focus between the message list and the previewed message.

Entry Default Value Description
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TabooHeaders X-
UID,Received,S
tatus,X-UIDL, 
Message,In- 
Reply,X-
Priority,Mime-
Version,Content
-X-Persona, 
Resent-
Message,Refer
enes,Return,X-
400,Mail-
System,Errors-
To,X-List, 
Delivery, 
Disposition, 
X-Juno, 
Precedence, 
X-Attachments, 
X-MSMail, 
X-MimeOLE 

A comma-separated list of headers (without colons) that 
should not be shown when the "Show all headers" switch (the 
"Blah Blah Blah" icon) is off for a message. The matching is 
done on a prefix basis, so any header that begins with one of 
these values will not be shown. 

TabSpaces 0 If on, then when the Tab key is pressed while the cursor is in 
the body of the message, spaces are inserted instead of a tab 
character. 

TabStop 8 How many spaces to insert for a <Tab> in the body of a 
composition message. 

TaskErrorKeepAll 0 When set, Eudora will not automatically remove errors from 
the task error list.

TaskErrorLinesPerRow 3 Number of lines for each error in the Task Errors window.

TaskErrorRemoveFrom
List

1 Controls whether or not to remove errors from the Task Errors 
window after seeing the corresponding error dialog. 

TaskMgrWaitTime 20 The number of seconds in which the user has to be idle in 
Eudora (which is defined as pressing any key or mouse 
button) before background tasks are processed (see 
IgnoreIdleOnManualCheck above for an exception case). 

TaskStatusGraphBorder
Color

0,0,0 RGB color of the border of the progress bar in the Task Status 
window. 

TaskStatusGraphCompl
eted Color

18,106,254 RGB color of the completed portion of the progress bar in the 
Task Status window. 

Entry Default Value Description
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TaskStatusGraphRemai
nColor

129,207,254 RGB color of the remaining portion of the progress bar in the 
Task Status window. 

TaskStatusRecvGraphC
ompletedColor

18,106,254 RGB color of the completed portion of the progress bar in the 
Task Status window for receiving mail.

TaskStatusRecvGraphR
emainColor

129,207,254 RGB color of the remaining portion of the progress bar in the 
Task Status window for receiving mail. 

TimeZone TimeZone=xxxn
nnyyy

Where xxx, yyy are timezone abbreviations like PST, PDT, 
CDT, and nnn is the offset in hours WEST of GMT (those that 
are east of GMT shoud enter a negative number here). xxx is 
the timezone during Standard Time and yyy is the timezone 
during Daylight Savings Time. If you do not change your 
clocks during Daylight Savings Time, leave yyy blank. Here 
are some samples: TimeZone=PST8PDT TimeZone=MET-1

If you don’t specify a TimeZone entry, then a Date: header will 
not be put in outgoing messages, which is fine for most 
because their mail server will insert the correct Date: header. 
If you don’t get messages bounced because of a missing 
Date: header, then leave the TimeZone entry alone.

TocDateLeeway 10 Number of seconds that the date on a mailbox .TOC file can 
be behind the .MBX file that Eudora will not flag as being out 
of date. Helpful for network file systems, especially Windows 
NT Server which seems to have problems correctly time/date 
stamping files. 

ToobarDisplayFix 0 Setting this to 1 causes the icons to be imaged from a device-
independent bitmap to resolve issues with video drivers that 
cannot display Eudora’s toolbar icons. Setting this to 2 limits 
the toolbar to the icons that are in the default toolbar. 

TreeControlAutoExpand
Delay

1000 Delay (in milliseconds) in which Eudora will wait before auto-
expanding an item in a tree control.

TreeControlAutoScrollD
elay

100 Delay (in milliseconds) in which Eudora will wait before auto-
scrolling a tree control.

TypeToSelectSubject 0 When on, typing characters in the summaries of a mailbox 
window will attempt to match words in the Subject field. 
(Default behavior is to match the Who field.)

UnreadExpires 5 The number of days after which a message is no longer used 
to determine if a mailbox has unread messages in it. 

URLHelper The full path of the application used to launch URLs. 

Entry Default Value Description
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URLHighlight 1 Display URLs in blue underline style. 

UsePOPCAPA 1 Whether or not Eudora should send the CAPA command to 
the POP server. Used only to see if the server supports the 
MANGLE command modifier. See UsePOPMangle.

UsePOPMangle 0 Whether or not Eudora should use the MANGLE modifer to 
the TOP command in a POP connection. MANGLE can 
produce some better results for messages that are large, 
giving a summary for the attachments in the message. 

UsePOPSend 0 If UsePOPSend is on, Eudora will send mail using the POP3 
extended command XTND XMIT. Since this is an optional 
command for POP3, many POP3 servers do not support this 
command (Berkeley's popper, however, does). There are pros 
and cons to using POP3 to send your mail. It provides a level 
of security since it requires a username/password pair to send 
mail messages, unlike SMTP. It is faster than SMTP, 
especially when checking for new mail at the same time. It 
doesn't check for valid recipients until the entire message is 
sent, and some implementations (Berkeley's popper, for 
example) won't tell you which recipients are invalid and will 
send the message to the valid recipients anyway. 

UseQuickTime 1 If off, Eudora will never attempt to use QuickTime to display 
images. Useful for situations where QuickTime is causing 
instability in the system.

UseJunkMailbox 0 If this is1, junk mail will automotically be placed in the Junk 
mailbox.

UserChangeLex uchange.tlx Filename of user-defined list of words to change when spell 
checking. 

UseRelay 1 If this is 1, sending messages for all personalities will use the 
SMTP settings for the relay personality.

UserIgnoreLex uignore.tlx Filename of user-defined list of words to ignore when spell 
checking. 

UserSuggestLex usuggest.tlx Filename of user-defined list of words to suggest when spell 
checking. 

Warn BeforeAging 1 If this is 1, the user will be warned before old junk is trimmed.

WarnLaunchExtenstion User-supplied list of extra file extensions that Eudora should 
warn when trying to launch an attachment (Eudora has a 
string resource that contains the default list of extensions that 
should be used to warn).

Entry Default Value Description
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WarnLaunchRemove User-supplied list of file extensions that should be removed 
from the default list of extensions to warn when trying to 
launch an attachment.

WarnMapiAutoSend 1 If 1 (on), Eudora provides a warning dialog when a simple 
MAPI client tries to send a messages through Eudora without 
showing any UI to the user. The was also added to the 
Tools/Options/MAPI dialog. 

WebLinkReminderLater
NumMinutes

360 When you get a link reminder, if you select Remind Me Later, 
the minimum wait until the next reminder.

WhenOpeningComposit
ionWindowSelectAfter

0 When on, (if WhenOpeningCompositionWindowSelectAll  and 
WhenOpeningCompositionWindowSelectBefore are off) 
messages from the Out mailbox open with the insertion point 
at the end of the message.

WhenOpeningComposit
ionWindowSelectAll

0 When on, messages from the Out mailbox open with the 
original text selected.

WhenOpeningComposit
ionWindowSelectBefore

1 When on, (if WhenOpeningCompositionWindowSelectAll  is 
off) messages from the Out mailbox open with the insertion 
point at the top of the message.

WhenReplyingSelectAll 0 When on, reply messages are opened with the original text 
selected.

WhenReplyingSeparate
WithLine

0 Causes a blank line to be inserted between the cursor and the 
quoted message when either WhenReplyingTypeBefore or 
WhenReplyingTypeAfter is being used.

WhenReplyingTypeAfter0 When on, (if WhenReplyingSelectAll and 
WhenReplyingTypeBefore are off) reply messages open with 
the cursor below the quoted text.

WhenReplyingTypeBefo
re

1 When on, (if WhenReplyingSelectAll is off) reply messages 
open with the cursor above the quoted text.

WholeSummaryLabelC
olor

1 When on, the entire summary of a message that has a label is 
drawn in that label’s color. When off, only the text in the Label 
column appears in the label’s color. 

WordWrapColumn 76 When the "Word wrap" switch is on, this is the column in which 
lines in outgoing messages are wrapped. 

WordWrapMax 80 When the "Word wrap" switch is on, this is the length at which 
a line in an outgoing message is considered too long and must 
be wrapped. 

Entry Default Value Description
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Mappings

This is a sample [Mappings] section. It is not a default for Eudora if you have a missing or 

empty [Mappings] section. The [Mappings] section contains information for mapping between 

computer file extensions, Macintosh creator and type, and MIME type and subtype for 

attachment files (in that order). Entries marked "in" work on only incoming messages, and 

entries marked "out" work on only outgoing messages. Entries marked "both" work on both 

incoming and outgoing messages.

For a more detailed explanation, see MIME Labeling on page 420.  

out=txt,ttxt,TEXT,text,plain 
both=doc,MSWD,,application,msword 
in=xls,XCEL,,, 
out=xls,XCEL,XLS4,, 
both=xlc,XCEL,XLC3,, 
both=xlm,XCEL,XLM3,, 
both=ppt,PPT3,SLD3,, 
both=wp,WPC2,.WP5,application,wordperfect5.1 
both=zip,,,application,zip 
both=rtf,,,application,rtf 
both=ps,,,application,postcript 
in=eps,,EPSF,, 
out=eps,dPro,EPSF,application,postscript 

WordWrapOnScreen 0 If this is on (set to non-zero), then the composition window will 
automatically wrap text on the screen at the number of 
characters specified in WordWrapColumn, regardless of the 
width of the window.

WrapMenus   1 If this is set to 0, menus that are too long for the screen will not 
wrap, and you may not be able to see all the menu items. On 
Windows 98/2000/Me, the operating system supports 
scrolling menus, which you might find more attractive.

Entry Default Value Description
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both=mpg,,,video,mpeg 
both=jpg,,,image,jpeg 
both=gif,,,image,gif 
both=tif,,,image,tiff 
both=pct,,PICT,, 
both=mac,MPNT,PNTG,,

Window Position

This section saves the positions of the standard windows (not your mailbox windows and 

message windows).

Entry Default Value

CheckSpellingWindowPosition 0,0,0,0

DebugTraceWindowPosition 110,185,635,500

FilterReportWindowPosition 10,10,500,300

FiltersWindowPosition 60,345,580,480

FindWindowPosition 60,345,580,480

InputDialogWindowPosition 50,100,358,450

MailboxesWindowPosition 80,80,565,415

MainWindowPosition 0,0,640,480

NicknamesWindowPosition 50,5,590,475

PhWindowPosition 10,40,630,440

ProgressWindowPosition 0,0,0,0

Signature2WindowPosition 10,60,630,240

SignatureWindowPosition 10,60,630,240

TextFileWindowPosition 0,0,600,460
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Tool Bar

This section reflects the current settings of the main Eudora toolbar. If you create additional 

Eudora toolbars, then additional [Tool Bar] sections will appear in the INI file.

We strongly recommend that you do not change any of the settings in the [Tool Bar] section(s) 

of the INI file, and that you instead make any changes to any Eudora toolbar from the toolbar 

customization dialog (Customize dialog). This dialog is accessed by right-clicking anywhere 

on the toolbar and selecting Customize... from the drop-down menu. For more information, 

see Eudora Toolbar on page 212.

The [DirectoryServices] section controls the use of the Directory Services window (accessed 

from Eudora's Tools menu) and its associated databases. For more information on Directory 

Services, see its dedicated section in the Eudora User Manual.
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NOTE: Of the entries listed below, only those marked with an asterisk (*) are user-settable.

Entry
Default 
Value Description

OldKeepOnTopPCCovert
ed

 

 What in pre-4.0 versions of Eudora used to be 
[Settings] AddressKeepForeground is now 
KeepOnTop in this section. KeepOnTop saves the 
check state of the "Keep On Top" check button in 
the Directory Services window. Eudora uses this 
entry (OldKeepOnToPConverted) to determine if 
the AddressKeepForeground entry from a pre-4.0 
version of Eudora has been mapped to the current 
version. When Eudora 4.x is run for the first time, it 
sets the KeepOnTop entry (described below) equal 
to the value of AddressKeepForeground. In 
addition, it also sets this entry equal to 1 so that the 
next time Eudora is run, it reads the check state 
from KeepOnTop rather than from 
AddressKeepForeground. 

PanesY*

 

 This entry reflects the height of the Directory 
Services window when Eudora was last shut 
down. 

LeftPaneX*

 

 This entry reflects the width of the left pane of the 
Directory Services window when Eudora was last 
shut down. 

RightPaneX*

 

 This entry reflects the width of the right pane of the 
Directory Services window when Eudora was last 
shut down. 

KeepOnTop*

 

 This entry reflects the check state of the "Keep On 
Top" check button in the Directory Services 
window when Eudora was last shut down. 

LDAP:ldap.bigfoot.com*

 

 This entry reflects the check state of the LDAP 
database "ldap.bigfoot.com" when Eudora was 
last shut down. The check state of other LDAP 
databases is reflected in similar entries.  
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Ph:ph.bigfoot.com*

 

 This entry reflects the check state of the Ph 
database "ph.bigfoot.com" when Eudora was last 
shut down. The check state of other Ph databases 
is reflected in similar entries.  

Eudora Address  
Book:Eudora Nicknames* 

 

 This entry reflects the check state of the Eudora 
Address Book database "Eudora Nicknames" 
when Eudora was last shut down. The check state 
of other Eudora Address Book databases is 
reflected in similar entries. 

Finger:hostname. 
domain.com*

 

 This entry reflects the check state of the Finger 
database "hostname.domain.com" when Eudora 
was last shut down. The check state of other 
Finger databases (or daemons) is reflected in 
similar entries. 

DIRSERV-Major

 

 This entry reflects the major version of DirServ.dll 
that was last registered. Combined with the minor 
version of this DLL (see the next entry below), 
Eudora at run time determines whether the DLL is 
a newer version than the one last registered so that 
it can register the new COM objects, if any, in the 
newer DLL. 

DIRSERV-Minor

 

 This entry reflects the minor version of DirServ.dll 
that was last registered. See the description above 
for DIRSERV-Major. 

ISOCK-Major

 

 This entry reflects the major version of ISock.dll 
that was last registered. A similar description as 
the one in DIRSERV-Major above applies. 

ISOCK-Minor

 

 This entry reflects the minor version of ISock.dll 
that was last registered. A similar description as 
the one in DIRSERV-Major above applies. 
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EUDORABK-Major

 

 This entry reflects the major version of 
EudoraBk.dll that was last registered. A similar 
description as the one in DIRSERV-Major above 
applies.  

EUDORABK-Minor

 

 This entry reflects the minor version of 
EudoraBk.dll that was last registered. A similar 
description as the one in DIRSERV-Major above 
applies.  

LDAP-Major

 

 This entry reflects the major version of Ldap.dll that 
was last registered. A similar description as the 
one in DIRSERV-Major above applies. 

LDAP-Minor

 

 This entry reflects the minor version of Ldap.dll that 
was last registered. A similar description as the 
one in DIRSERV-Major above applies. 

PH-Major

 

 This entry reflects the major version of Ph.dll that 
was last registered. A similar description as the 
one in DIRSERV-Major above applies. 

PH-Minor

 

 This entry reflects the minor version of Ph.dll that 
was last registered. A similar description as the 
one in DIRSERV-Major above applies. 
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Debug

The [Debug] section controls aspects of the Eudora log file. The Eudora log file is a handy tool 

for debugging network connections, especially when using the dialup connection method.

Entry
Default Value 

 

Description

 

LogFileName

 

EUDORA.LOG

 

The name of the log file. 

 

LogFileSize

 

1000

 

The size (in KB) of the log file that, when reached, will 
cause the log file to be copied to the file 
EUDORLOG.OLD and a new log file to be started. 

 

LogLevel

 

11 (which is bits 1, 
2, and 4)

 

A bit-mapped value telling what type of information to 
log: 
Bit 1 (1): Sending of a message 
Bit 2 (2): Receipt of a message 
Bit 3 (4): Dialup script navigation commands 
Bit 4 (8): Alert messages 
Bit 5 (16): Progress messages 
Bit 6 (32): All bytes sent 
Bit 7 (64): All bytes received 

Bit 8 (128): Corrupt mailbox TOC file messages

Bit 9 (256): Basic EMSAPI translator messages

Bit 10 (512): Advanced EMSAPI translator messages
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What to Do First

Occasionally, you may encounter a problem or bug when using Eudora. This section includes 

information to help you solve those problems. You can also check the Eudora Technical 

Support Web Pages, click the following URL:  
http://eudora.qualcomm.com/techsupport/

If you are having problems, try the following:

• Be sure that you have the current release of Eudora.

• Be sure that your incoming mail account (POP or IMAP) is set correctly. This mail 

account may be different from your e-mail address, so double-check to see that you 

have entered the proper information in the Return address, Mail Server 
(Incoming), and Login Name fields of the Getting Started options 

(Tools>Options>Getting Started). Incoming mail accounts are usually of the 

following format:  
loginname@mailservername

• Be sure your SMTP server is set correctly in the SMTP server field of the Sending 

Mail options (Tools>Options>Sending Mail). This server may or may not be the same 

computer as your POP server. See Sending Mail on page 302. 

• Be sure you are entering your password correctly, paying attention to uppercase and 

lowercase letters (make sure the [Caps Lock] key is off).

• Be sure the date is correct on your computer, especially the year.

• Be sure Eudora can find your winsock.dll. If Eudora cannot find it, be sure the 

Path line in your AUTOEXEC.BAT file includes the directory that contains the 

winsock.dll. Or, if you do not want to edit your AUTOEXEC.BAT file, try copying 

your winsock.dll into your Eudora directory.

• Run ScanDisk to check for problems on the hard drive.
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If you’re having trouble with your mailboxes (especially with repeated requests to rebuild a 

mailbox’s table of contents), quit Eudora and find the mailbox’s .toc file in the Eudora directory. 

Change the .toc extension to .000, then open Eudora and see if the problem persists.

On Windows 98/XP: If you’re having other problems, especially crashes, remove all of the 

items in your Startup directory (C:\Windows\Start Menu\Programs\StartUp), then restart 

Windows while holding down the F8 key. In the Startup menu, select Safe Mode. Then open 

Eudora and see if the problem persists.

Errors

The following are possible errors and alerts you could receive from Eudora, and suggestions 

for fixing them.

“-ERR Maildrop lock busy”

This usually happens after your PC has “hung” during a mail check and you are now 

attempting to re-connect to the mail server. The best thing to do is to contact your e-mail 

administrator and report that you have a POP3 server process that needs to be disconnected.

“503 Need RCPT (Recipient)”

You must include at least one recipient in the To: field of your outgoing message in order for 

the message to be delivered. If you have a nickname in the To: field, be sure that in the 

Address Book at least one e-mail address or valid nickname is included in the Address(es) tab. 

If the Address(es) tab is blank, there are no recipients and this causes the error.

“Error getting a network socket. Cause: no buffer space available (10055)”

The buffers the error message is referring to are TCP buffers. TCP/IP stacks need buffers in 

which they can store data that goes to/from the network. Since at a low level the data has to 

be sent to a hardware device, the buffers generally have to be in low memory (i.e., < 1MB). 

This is valuable space for most users, so most TCP/IP stacks have a way of controlling how 

many of these buffers the user wants allocated. If you’re using a lot of other network 

applications at the same time (especially the X Window System, which uses a buffer for each 

window), then you might get this error. The other time this error might occur is when the TCP/IP 

stack is not correctly marking buffers as being unused, so you have a buffer not being used 

that the stack thinks is being used.
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“Could not rename lmos.tmp to lmos.dat”

Quit Eudora, and go to your Eudora directory. Find the files called lmos.tmp and lmos.dat 

and delete them both (lmos.tmp may not be there: that’s not a problem). On your next mail 

check you may get some mail that you have already received, but that should only happen 

once.

“This recipient is not acceptable to your SMTP server” or “Relay Denied”

This error messages displays if you have multiple personalities and have any relay restrictions 

to stop spam messages turned on. 

Any relay restricitons come from your ISP. Contact your ISP and ask them to turn the relay 

restrictions off.

Formatting and Printing

The following are possible formatting and printing problems, and suggestions for fixing them.

You received a message containing columns and the columns are not lining up 
correctly.

Your message font is probably a proportional font. Change your display font in the Fonts 

Options (Tools>Options>Fonts): set the “Fixed-width” option to a non-proportional font (such 

as Courier New or Courier), and uncheck the “Use proportional font by default” option.

You have a message that is printing with strange line breaks.

When most e-mail programs send out messages, they insert hard returns at around 75 to 80 

characters. (If they didn’t, some e-mail applications would be able to display only the first 80 

characters or so of a very long line of text.) What’s happening with your message is that the 

width of the line that fits on the printed page is shorter than 75 to 80 characters, so the hard 

returns end up in the wrong place.

The solution is to make the print font smaller, or choose a print font in which the letters are 

printed closer together—like Helvetica instead of Courier New, for example. To do this, change 

the Font and Size options in the Printer section of the Fonts options (Tools>Options>Fonts). 

See Fonts on page 313. 



482

Troubleshooting

Miscellaneous

The Password checks for sending mail, not just for checking mail.

SMTP servers, which are used to send mail for most e-mail accounts, do not require a 

password for access the way a POP server does. However, if the POP daemon your server is 

using is descended from the UC Berkeley POPper, you can use the POPSend protocol, which 

routes SMTP calls through the POP server, so that the POP server will require the password.

If you turn this feature on in your POP server, add this line to the [Settings] section of the 

Eudora.ini file:

UsePOPSend=1

This means you will have to enter your password to send as well as check mail. However, this 

is not terribly secure, because users who know what they are doing can simply remove that 

.ini file line or uncheck the “Use XTND XMIT” option and disable the feature. It protects you 

against inexperienced but unscrupulous users.
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Address Book. The Address Book is where you keep information about individuals or groups 

that you correspond with.

Alias. Another name for an existing user’s address. In Eudora, an alias is also called a 

nickname.

Application Configuration Access Protocol (ACAP). ACAP is a protocol which allows 

applications to store and retrieve arbitrary configuration data from a central server.

Attachments. Any file can be attached to and sent with a Eudora message. Most of the time, 

an attached document functions like a “rider” to the email message, and does not appear 

within the message text. Instead, the name of the document is displayed automatically in the 

Attached field in the message header. 

Authenticated Post Office Protocol (APOP). APOP is an MD5-based login command that 

does not send passwords in clear text over the network.

Automation. You can control and exchange information with Eudora from other programs that 

support the Windows Automation Interface, such as Microsoft Visual Basic. These options 

give you external access to Eudora mail folders, mailboxes, and messages, and to the Eudora 

application itself.

BinHex. This is an attachment decoding method best used for recipients on a Macintosh with 

an email reader that is not MIME-compliant.

Blind Carbon Copy (Bcc). In this header field, you enter email addresses or nicknames of 

people to whom a blind copy of the message is to be sent. These recipients are not displayed 

in the message header, and the recipients in the To or Cc fields will not know that a copy went 

to these addresses. 

Body. The part of an email message that contains the main text of the message. The body can 

contain text, graphics, sound, and video clips.
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BossWatch. Eudora’s feature to help you catch yourself before you send a message to 

someone you’ll wish you hadn’t.

Browser. A World Wide Web client that is able to send and receive messages using HTTP 

and read and format HTML documents.

Challenge-Response Authentication Mechanism-Message Digest 5 (CRAM-MD5). The 

CRAM-MD5 algorithm is an encryption strategy for exchanging passwords between the 

Internet mail server and a client. Using CRAM-MD5, passwords are not sent in clear text.

Client. A computer or software program that accesses resources over the Internet. It is also 

an application that requests a server to perform a function. In the Internet mail environment, 

the term client indicates a mail user agent, for example, Eudora.

Content Concentrator. Eudora’s feature to streamline messages by hiding the quoted parts 

of replies, and concatenating multiple messages in a thread.

Context menu. The context menu appears when you press the right button on your mouse. 

Context menus usually contain options that allow you to do tasks without going to the menu 

bar.

Daemon. Daemons are generally server programs. They run continuously and are available 

when clients wish to initiate a session. However, an SMTP daemon periodically acts as a client 

when it needs to forward messages that are not to be delivered locally.

Dialup Networking. This is a specified dialup connection (referred to in Windows NT 4.0 as 

a "phonebook entry") used when Eudora does any network operation. This option is available 

only if you have installed the dial-up networking services with Windows 98/XP or Windows NT 

4.0.

Distribution list. A group of recipients to whom users can refer by a common name (for 

example, a distribution list called Marketing). When users address a message to a distribution 

list, all members of the distribution list receive the message.

Domain. In general, a group of computers and other devices under the management of a 

single administrator or administrative entity. In Windows NT, a domain is a group of servers 

that share common security policy and user account databases. In the Internet, a domain 

identifies a range of IP addresses and mail-forwarding information. See DNS.
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Domain Name System (DNS). The naming service used by Internet Mail to support message 

routing. It maps domain addresses to IP addresses so Internet messages can be delivered to 

a particular server.

Emoticon. Characters used to indicate an emotion or expression. In internet communication, 

emoticons such as smiley faces can add an extra level of context to email messages.

Eudora Sharing Protocol (ESP). Using this protocol, you can create and maintain groups 

whose members share files in a shared folder without using a server.

File Transfer Protocol (FTP). Using this protocol, you can transfer files over the Internet.

Filters. A filter in Eudora sorts your mail as it is being delivered. You set up filter parameters 

for your specific needs, for example, all messages from your father can be filtered to your 

mailbox named DAD. 

Finger. This is a directory services protocol. The Finger protocol is a server that allows you to 

search for a person’s information, such as email address, phone number, etc.

Folder. This is a file you create in Eudora where you can add mailboxes. You can name 

folders, for example FAMILY and your mailboxes can be named DAD, MOM, SIS, etc.

Folder Carbon Copy (Fcc). You use Fcc to place a copy of your message in a mailbox or 

folder you designate.

Forward. This a Eudora function where you can forward an incoming message and its 

attachments to another person. 

Gateway. In general, software that translates information between one protocol and another.

Header. The part of an email message that precedes the message. It contains information 

such as the originator, recipient, and subject of the message. Also, it is used as an individual 

header filed, such as the To header.

Home page. An HTML document that resides in a data directory and is the primary starting 

point for anyone navigating that directory. 
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Hypertext Markup Language (HTML). HTML is used to create Web pages. A Web client 

interprets HTML and displays documents and graphics accordingly. HTML also allows 

document authors to establish hypertext links between documents in various locations on the 

Internet and to create forms and image maps that enable users to interact with Web 

documents. Eudora uses HTML to send and receive styled text.

Hypertext Transfer Protocol (HTTP). HTTP is the standard way of transferring information 

across the World Wide Web. It supports a variety of media and file formats across a variety of 

platforms.

Internet. A giant, global network made up of many smaller networks all connected using the 

TCP/IP protocol. The Internet is the network of networks which spans the globe. TCP/IP is 

generally the network and transport protocol stack used to connect networks, but protocol 

translating gateways enable non-TCP/IP networks to connect to the Internet as well.

Internet directory. A directory that runs over TCP/IP and is widely implemented on the 

Internet. A directory implementing Ph, LDAP, and Finger is an Internet directory.

Internet Engineering Task Force (IETF). IETF is the standards-setting body of the Internet.

Internet Message Access Protocol (IMAP). IMAP allows Eudora to access and manipulate 

electronic mail messages on a server, and it permits manipulation of remote mailboxes so they 

function like local mailboxes. IMAP4 provides a richer and more complex set of functionality 

than the POP3 protocol. IMAP is also called an Incoming server.

Internet Service Provider (ISP). An ISP is the organization or company that provides you with 

Internet access and email availability. For example, America Online (AOL) is an ISP.

IP address. The address that serves as a unique identifier of computers on the Internet. It is 

a sequence of four small integers (each less than 256). When written, the numbers are 

separated by periods, for example: 210.170.2.45. The DNS converts IP addresses to the more 

familiar domain names.

Java. This is a programming language that allows software developers to write programs to 

run on any computer platform, regardless of the operating system.

Kerberos. This is one of many authentication systems Eudora uses. If your network uses 

Kerberos for authentication, the appropriate options are provided by your email administrator
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Lightweight Directory Access Protocol (LDAP). LDAP is a protocol that provides an online, 

fully indexed, fast access white-pages directory service developed and freely distributed by the 

Regents of the University of Michigan. LDAP is included in Eudora’s Directory Services.

Mailbox. A location that stores messages for a single user. 

Mailing List. This is usually a special interest group you can join on the Internet to receive and 

send information. Once you belong to a mailing list, you can receive messages anyone sends 

to this list. If you send email to the mailing list, every member of the list receives your message. 

Message Application Program Interface (MAPI). Eudora’s MAPI support allows you to 

quickly attach documents to email messages directly from the application where you created 

the document. Without MAPI, you would have to save the document, remember what folder 

the document is in, switch to Eudora, and then remember to manually attach the document to 

the outgoing message.

Message store. A collection of mailboxes. 

Multi-Purpose Internet Mail Extensions (MIME). The is an attachment decoding method 

best used for recipients with MIME-compliant email readers, regardless of what operating 

system they are using. MIME is a set of extensions to the Internet Mail standards that supports 

the inclusion of multi-part and multimedia files, such as sound and video, in email messages.

Network. A group of connected computers that can communicate with one another. Networks 

enable computers to share files and resources and exchange messages.

Nickname. In Eudora, a nickname is entered instead of an email address. For example, in the 

Address Book where nicknames are set up, you can enter the nickname TERRY for 

terry@aol.com. When you write a message, you can enter TERRY in the To field instead of 

Terry’s entire email address. Nicknames are also called aliases.

Personality. This is an alternate email account. In Eudora, you can access mail from several 

email accounts at the same time. However, you must set up each account separately using 

Eudora’s personality functions.

Ph. Ph (Phone book) is a protocol providing an online, fully indexed, fast access white-pages 

directory service developed and freely distributed by the Computer and Communications 

Services Office at the University of Illinois at Urbana. 
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POP3. The Post Office Protocol 3 is a protocol that provides a simple, standardized way for 

users to access mailboxes and download messages to their computers. POP3 is also called 

the Incoming server.

Postmaster. A special type of user responsible for maintaining the mail delivery system for a 

particular group of computers. A postmaster is responsible for following up on queries from 

users and other postmasters. Internet standards require that the postmaster account be valid 

at every domain.

RAS. Windows NT Remote Access Service. This Windows 98/XP and NT service, when 

configured correctly, allows your computer to connect to your ISP via a modem. You set this 

up in Dial-Up Networking. 

Redirect. This means that incoming messages can be sent to a new recipient “by way of” you, 

maintaining the original sender’s address in the From field. 

Request for Comments (RFC). In the Internet community, RFCs are a numbered sequence 

of documents generally describing protocols for Internet communication. An Internet standard 

protocol is also given a STD number in addition to an RFC number. Only RFCs with a STD 

number are standards of the IETF. Some RFCs are historical or experimental and are not 

standards. Others have not yet reached standard status. Still others provide documentation 

about the Internet itself. 

RPA. This is one of many authentication systems Eudora uses. Use RPA if CompuServe is 

your ISP. 

ScamWatch. Eudora’s feature to identify phishing scams and alert you to suspicious URLs in 

messages. 

Server. An entity that provides a network service. A server can be hardware (such as a file 

server), software (such as a mail server), or services (such as a transportation service). A mail 

server is a program that accepts, relays, and delivers mail.

Shared folder. This is a folder that allows multiple users to receive mail in the same directory. 

Because all members of a shared folder can access messages in the shared folder, it is not 

necessary to duplicate the same message for multiple users. Only IMAP clients such as 

Eudora can access shared folders. ESP (Eudora Sharing Protocol) users can also share 

folders.
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Signature. A signature is a few lines of text automatically added to the end of an outgoing 

message when it is sent. A signature can be whatever you want, but it is mostly used to give 

contact information (telephone, address, etc.). You only use one signature at a time in a 

message.

Simple Mail Transfer Protocol (SMTP). SMTP is a protocol widely implemented on the 

Internet for exchanging email messages. SMTP is also called an Outgoing server.

Secure Multipurpose Internet Mail Extensions (S/MIME). A specification for secure email 

messages allowing authentication (digital signatures) and privacy (encryption).

SMTP AUTH. SMTP AUTH authenticates messages that are sent. This operates 

automatically in Eudora. The preferred SMTP authentication method is CRAM-MD5. If CRAM-

MD5 is not available, LOGIN or PLAIN will automatically be used.

SPAMWatch. Eudora’s SPAM filtering plugins. Junk mail is automatically identified and 

transfered to a Junk mailbox.

Stationery. Stationery files are templates you create for outgoing messages, for example, a 

generic response when you are on vacation.

Table of Contents (TOC). The TOC in Eudora is the list of messages and their data displayed 

in each mailbox or folder.

Transmission Control Protocol/Internet Protocol (TCP/IP). TCP/IP is a set of protocols for 

computer network communication. The protocols provide conventions for connecting networks 

and routing traffic between them. It supports local area networks as well as interconnections 

between local area networks. TCP/IP protocols are described in IETF RFCs and in numerous 

reference works.

Universal Resource Locator (URL). URLs are Internet addresses and links to pages and 

sites that reside on the World Wide Web. For example, to display the Eudora Web page on the 

Internet, you need the Eudora URL, which is www.eudora.com.

UNIX to UNIX Copy Protocol (UUCP). UUCP is a UNIX email protocol.

Uuencode. This is an attachment decoding method best used for recipients using PC or UNIX 

systems that are not MIME-compliant.
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Username. A character string by which users are known, for example dclifford. Username 

is also called Login name.

Winsock. Winsock is a connection method. There are two methods of making Winsock calls 

using TCP/IP stacks: blocking and asynchronous.

World Wide Web. Also known as the Web, the World Wide Web is a graphical interface to 

Internet resources. Web refers to the set of hypermedia pages accessible via the Internet.
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Symbols
 328
-, in the Status column 142
•, in the Status column 65, 70, 79, 141
Ð, in the Status column 73, 142
“me” nickname, for personal identification 100

A
About Eudora command 291
ACAP, definition 483
Account Settings dialog, adding a new 

personality 124
Add as Recipient command 252, 285
Add to Recipient List command 251, 252, 253
Address Book 233

Add as Recipient command 252
Add to Recipient List command 251, 252, 253
adding a group 238
adding a person 235
adding nicknames to the Quick Recipient List 

251, 253
addressing a message from 246
Bcc button 245
BossWatch list 250
Cc button 245
changing entries in 243, 245
command 235
copying entries in 243
creating a group from the address book 248
creating a message from 245
creating an address book within 235
creating new entries in 235
deleting entries 244
displaying entries in 234
Expand Nickname option 245
F6 key 234
file format 255
Home tab 240
Insert Recipient submenu 253
Make Address Book Entry command from 

246
move or copy an entry 244
moving entries in 243
New button in 235
Notes tab 242

Other tab 241
paging up and down 234
Personal tab 238
printing 234
recipient list 252
Remove From Recipient List command 251, 

252, 254
Remove Recipient submenu 252
removing nicknames from the Quick 

Recipient List 251, 254
renaming a nickname 245
resizing 234
Save command 238
To button 245
Using central Address Book files on a server 

255
View By field 234
window 233
Work tab 241

Address Book command 287
Address Book file storage 404
Address Book,definition 483
Advanced Network options 347
After sending message

how to enter in Options 312
Age-sensitive (in Options) 329
Age-sensitive date formats 144
Alias 483
Align Center button 36
Align Left button 36
Align Right button 36
Allow Authentication

how to enter in Options 294, 303
Allow Docking command 202, 204, 208, 211, 212
Allow drag and drop transfers

how to enter in Options 321
Allow drag and drop transfers option 159
Allow drag select of messages

how to enter in Options 321
Alternate personalities 115
ANCIENT format 330
and option 170
Any Header field

in Filters 168
Any Recipient field

in Filters 168
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APOP, definition 483
appears option 168
Application Configuration Access Protocol, 

definition 483
Arrange Icons command 289
As Normal option 171
Ask me each time

how to enter in Options 323
Attach Directory 82, 158
Attach directory 404
Attach submenu 283, 408
Attached field

in a forwarded message 98
in outgoing mail 39, 49
in redirected message 98

Attachment directory
how to enter in Options 311

Attachment directory for IMAP 93
Attachment directory option 404
Send File 283
Attachment Type popup 33
Attachments

attaching files to outgoing mail 49
automatically deleting 158
detaching from a message 49
dragging to attach 49
encoding 49
opening 82
receiving 82

Attachments column 143
Attachments Options

Attachment directory option 404
Delete attachments when emptying Trash 

option 158
Attachments, definition 483
Authentication style

how to enter in Options
IMAP server 301
POP server 300

Authentication style option 129, 131
Authentication, SMTP 72
Auto name completion

directory services 259
Auto name completion (message header) 39
Auto-Completion options 326
Auto-completion, how to delete an entry 41
Automatic spell check 55
Automatically as you type

how to enter in Options 325
Automatically expand nicknames

how to enter in Options 358
Automatically expand nicknames option 253
Automatically Fcc to original mailbox

how to enter in Options 309

Automatically open next message
how to enter in Options 319

Automation options 339
Automation, definition 483
Auto-Reply 174
Auto-save messages every _ minutes

how to enter in Options 358

B
Background tasks in Options 336
Bcc button

in Directory Services 261
in the Address Book 245

Bcc field
to copy outgoing messages 72

Bcc, definition 483
BinHex encoding 50
BinHex, definition 483
BLAH BLAH BLAH button 81
blank, in the Status column 141
Body field

in Filters 168
Body, definition 483
Bold button 35
Bold command 45
BossWatch List 250
BossWatch, definition 484
Bottom command 210
Browser, definition 484
Bulleted List button 37
Bulleted List command 45, 280

C
Cache network info

how to enter in Options 348
Cascade command 289
Cc button

in Directory Services 261
in the Address Book 245

Cc field
in Filters 167
in outgoing mail 38

Center command 45
Change Password command 77, 426
Change Queueing command 68
Change Queueing dialog 67, 68, 69
Change submenu 68, 283
Changing Eudora modes 25
Changing the concentration level in the preview 

pane 103
Check for mail every ? minute(s)

how to enter in Options 296
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Check for mail every ? minutes option 74, 127
Check mail

automatically 73
Delete server status 88
entering password 75
Fetch button 88
Fetch server status 88
Fetch then Delete server status 88
Forget Password(s) command 76
from Windows Taskbar 403
IMAP server management 91
Leave mail on server option 86
manually check 74
Minimal Headers Only option 91
minimum interval 74
Save password option 76
Skip Attachments over ? K option 92
Skip messages over ? K in size option 88
Trash button 88
with special instructions 89

Check Mail command 74, 76, 89, 278
Check Mail option 127
Check spelling

Check Spelling command 58
Check Spelling dialog

Add button 60
Change all button 59
Change button 59
Change To field 59
Edit Dictionary button 60
Ignore all button 59
Ignore button 59
Suggest button 60
Suggestions field 59
Unknown field 59

Check Spelling dialog box 58
Edit User Dictionary dialog

Add button 60
Clear button 60
Delete button 60

Spelling Options dialog
Ignore capitalized words 61
Ignore words with all capitals 61
Ignore words with mixed case 61
Ignore words with numbers 61
Report doubled words 61
Suggest words 61

Check Spelling command 280
Checking Mail 295
Checking Mail Options

Check for mail every ? minutes option 127
Save password option 76

Choose a Nickname File dialog 244
Clear command 280

Clear Formatting button 37
Clear Formatting command 45, 280
Client, definition 484
Clock icon, in the Status column 69, 142
Close button, in a docked window 203
Close command 278
Close messages with mailbox

how to enter in Options 321
Color button 36
Color submenu 45
columns 481
command 49, 283
Compact

all mailboxes 147
one mailbox 147

Compact Mailboxes command 147, 285
Composition window 32
Compound Sorting 179
Configuration option 129
Connect using Dial-up networking

how to enter in Options 307
contains option 168
Content Concentrator options 363
Content Concentrator, definition 484
Content Concentrator, how to use 101
Contents tab 405
Context menu, definition 484
Context menu, for tool windows 210
Context sensitive Help 19
Context Sensitive Help command 290
Contextual Filing 160
Copy & Unwrap command (Shift-Copy) 46
Copy command 279
Copy original’s priority to reply

how to enter in Options 309
Copy original’s priority to reply option 42, 97
Copy text and paragraph styles 46
Copy To action 173
Copy To command 244
Copying a message to a mailbox 158
CRAM-MD5

definition 484
CRAM-MD5, definition 484
Creating a new alternate account (personality) 

118
Creating a new tabbed window 208
Creating a vacation message 174
CSV format, saving entries in address book 244
Customize command 214
Customize dialog 214
Cut command 279
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D
Daemon, definition 484
Databases

creating 265
modifying 275

Databases list 258, 264
Databases, default (Directory Services) 264
Date column 144
Date Display Options 144
Date Display options 328
Date formats

how to enter in Options 329
Date formatting 144
Decoding attachments 50
Default Domain option 127
Default Signature option 127
Default Stationery

how to enter in Options 305
Default Stationery option 127
Delete all messages on server option 90
Delete all messages that have been retrieved 

option 90
Delete an auto-completion entry 41
Delete attachments when emptying Trash

how to enter in Options 312
Delete attachments when emptying Trash option 

158
Delete automatic attachments

how to enter in Options 312
Delete button 265
Delete command 93, 155, 156, 283
Delete from server after ? day(s)

how to enter in Options
POP server 299

Delete from server after ? days option 87, 129
Delete From Server button 81
Delete from server when emptied from Trash

how to enter in Options
POP server 299

Delete from server when emptied from Trash 
option 90, 129

Delete messages marked for deletion option 89
Delete queued mail

how to enter in Options 341
Delete server status 88, 144, 145, 173
Delete unread mail

how to enter in Options 341
Delete unsent mail

how to enter in Options 341
Deleting 276
Deleting a personality 131
Deleting a signature 108
Deleting mail

fromthe IMAP server 93
Deleting stationery 112
descmap.pce file 405
Detaching attachment 49
Diagonal arrow, in the Status column 99, 142
Dialup Networking, definition 484
Dictionary files 407
Directory Services

addressing a message from 261
auto name completion 259
Bcc button 261
Cc button 261
creating a new database 265
Databases list 258, 264
default databases 264
Keep On Top option 258
looking someone up 258
making a nickname from 262
making a query 258
modifying an existing database 275
previewing query details for printing 262
printing query details 262
Protocols list 263
Query field 259
reading your query results 260
Registered Drivers column 264
Start button 259
Status field 260
Stop button 259
To button 261
window state considerations 263

Directory Services command 288
Directory Services window 257
DirectoryServices directory 404
Display dates using

sender’s timezone (in Options) 328
Display Options

Show cool bars option 214
Show MDI task bar option 218
Show status bar option 214
Show toolbar option 214
Show toolbar tips option 214

Display options 315
Distribution list, definition 484
DNS, definition 485
Docked windows 200

close button 203
gripper bar 202
resize bar 203
zoom button 202

Docking
turning on 211

doesn’t appear option 168
doesn’t contain option 168
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Domain to add to unqualified addresses
how to enter in Options 302

Domain, definition 484
Dominant personality 126
Don’t check when using battery

how to enter in Options 296
Don’t check without a network connection

how to enter in Options 296
Don’t send option 69, 70
Don’t transfer, just create mailbox option 160
Download Options 130
Downloadable Picture command 280
Drag and drop transfers

how to enter in Options 321

E
Edit

incoming mail 84
outgoing mail 43

Edit menu
Insert Picture command 404

EIMS 425
Email Address

how to enter in Options 302
E-mail server (Internet)

how to obtain 425
Embedded directory 404
Empty the Trash mailbox

how to enter in Options 342
Empty Trash command 155, 285
Empty Trash when exiting option 155
EMSAPI 407
EMSAPI plug-ins 405
Encoding method

how to enter in Options 311
Encoding methods

BinHex 50
MIME 50
Uuencode 50

ends with option 168
Enter key 79
ERR Maildrop lock busy 480
Error getting a network socket 480
Esoteric Settings plug-in 292
ESP

creating a group 370
setting up one group on two computers 370

ESP (Eudora Shared Protocol)
User tab 378

ESP (Eudora Sharing Protocol)
advanced setup 376
configuring global settings 389
configuring group change notifications 381

configuring shared folder settings 377, 380
creating a group 371
definition 485
editing group information 389
installing 370
inviting members 377
joining a group 386
leaving a group 387
mailbox and folder 390
maitaining group membership 385
Notifications tab 381
Settings tab 380
Tips 370
working with shared folders 388

ESP Groups option 288
Eudora Address Book protocol 257
Eudora directory contents 403
Eudora Email

Introduction 15
latest version 26
registering 27
starting and quitting 31
What’s new in this version? 16

Eudora established the connection
how to enter in Options 307

Eudora information 425
Eudora Internet Mail Server (EIMS) 425
Eudora modes 25

changing 25
Eudora Modifiers 395
Eudora Nicknames file 404
Eudora Quick Start Guide 17
Eudora Readme file 407
Eudora Shortcuts 397
Eudora taskbar 218
Eudora WorldMail Server 425
Eudora.cnt file 405
Eudora.exe file 405
Eudora.hlp file 405
Eudora.ini file 405
Eudora.ini files

Debug 477
defaults 447
Mappings 471
Settings 448
Tool bar 473
Window position 472

EUDORA.INI Settings File 445
EUDORA.INI Settings File help topic 405
eudora.log file 406
eudorlog.old file 406
Excerpt bars

in quoted text with styles 96
Exit command 278
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Expand Nickname option 246
Extended Messaging Services 407
Extended Messaging Services Application 

Programming Interface 407
Extra Warnings Options 68

Try to delete unread, queued, or unsent mail 
155

Extra Warnings options 341

F
F1 key (for help) 19
F6 key in the Address Book 234
Fcc menu 38, 72
Fcc, definition 485
Fetch all message headers to In mailbox option 

90
Fetch button 81, 88
Fetch server status 88, 144, 173
Fetch then Delete server status 88, 144, 145
File Browser command 221, 287
File Browser window 221
File formats 47
File Transfer Protocol, definition 485
Filter icons 166
Filter Messages command 163, 166, 285
Filter Report command 220, 287
Filter Report window 171, 220
Filtering mail into the Junk mailbox 176
Filters

and option 170
appears option 168
automatically named 166
Conjunction popup 170
contains option 168
Copy To action 173
creating an auto-reply 174
definition 485
doesn’t appear option 168
doesn’t contain option 168
doesn’t intersect address book option 169
doesn’t intersect nickname option 168
ends with option 168
Forward To action 172
ignore option 170
intersects address book option 169
intersects nickname option 168
invoked from top to bottom 167
is not option 168
is option 168
Make Label action 170
Make Personality action 171
Make Priority action 170
Make Status action 170

Make Subject action 171
Match Type popup 168
Matching Text field 169
None action 170
Notify Application action 172
Notify User action 171
Open action 171
or option 170
Play Sound action 171
Print action 171
Redirect To action 172
re-ordering 166
Reply with action 172
Server Options action 173
Skip Rest action 173
speak action 171
starts with option 168
Transfer To action 173
unless option 170

Filters command 165, 287
Filters directory 404
Filters window 165
filters.pce file 406
Find 179

Stopping 181
Within a message 180

Find command 280
Find Messages in mailbox and folders 181
Find Next button 180
Find submenu 280
Find Text

in message summary area of mailbox 181
Find Text Again command 180
Find the latest version of Eudora 26
Finger Database 269
Finger protocol 257
Finger, definition 485
finger.ini file 406
Finish Address Book Entry command 249, 280
Fixed Width button 80
Fixed-width (fonts)

how to enter in Options 313
Fixed-width option 481
Float In Main Window command 200, 202, 204, 

208, 211, 212
Floating windows 203
fol directories 406
Folder, definition 485
Font popup 35
Font submenu 45
Fonts options 313
For new mail, download

how to enter in Options
IMAP server 300
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Forget Password(s) command 76, 286
Format Painter 34, 46
Format Painter button 34
Formatting text 43

Copy & Unwrap 46
Unwrap Selection 46
Wrap Selection 46

Forward command 98, 282
Forward To action 172
Forward To submenu 283
Forward, definition 485
Forwarded status (right arrow) 98
From field

in a forwarded message 98
in Filters 167
in outgoing mail 38
in redirected message 98

FTP, definition 485
ftp.eudora.com 425
Full message except attachments over ? K

how to enter in Options
IMAP server 301

Full message except attachments over ? K (IMAP 
server]

Incoming Mail options 92
FUMLUB 321

G
Gateway, definition 485
Generate filter report

how to enter in Options 335
Generate Filter Report option 220
Generate filter report option 287
Generic Properties tab 125
Getting Attention Options

and Notify User filter action 171
Generate Filter Report option 220
Open mailbox option 79
Play a sound option 79
Use an alert dialog box option 79

Getting Attention options 334
Getting Started Options

Mail Server (Incoming) option 73
Getting Started options 293
Graphic file formats 47
Gripper bar

on the main toolbar 212
Gripper bar, in a docked window 202
Group by subject 178
Guess Paragraphs option 195

H
Header, definition 485
Help 18
Help button 19
Help key (F1) 19
Help menu 289, 405

Payment & Registration 25
Tip of the Day 19
topics 19
Topics command 405

Help Topics dialog 405
Hide command 211
Hiding tabbed/tool windows 211
History file (auto completion) 40
Home page,

definition 485
Horizontal Line command 46, 280
Horizontal lines

inserting in outgoing message text 48
Hot link

in outgoing mail 54
Hot links

in incoming mail 85
Hours to be ANCIENT (in Options) 330
Hours to be OLD (in Options) 329
How should checking/sending be performed 

option 90
HTML 43
HTML formatting

viewing source 403
HTML graphics 316
HTML message

viewing in your Web browser 403
HTML, definition 486
HTTP, definition 486
Hyperlinking text and graphics 45
Hypertext Markup Language

definition 486
HyperText Markup Language (HTML) 43
Hypertext Transfer Protocol, definition 486

I
Icons

filters 166
IETF, definition 486
ignore option 170
Ignoring previously read messages 88
IMAP 95, 145

Deleting a message from the server 93
Imap directory 404
IMAP Mailbox Location Prefix

how to enter in Options (IMAP) 300
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IMAP Mailbox Location Prefix option 130
IMAP option 129
IMAP server 410

Full message except attachments over ? K 92
how to obtain 425
Macintosh 425
managing mail 91
UNIX 425
VAX/VMS 425
Windows NT 425

IMAP version 4 410
IMAP vs. POP 152
IMAP, attachment directory 93
IMAP, definition 486
Immediate send

how to enter in Options 303
Immediate send option 67, 68
Import Mail command 278
Import settings from other e-mail programs 123
Importing from Microsoft Outlook 22
Importing from Netscape Messenger 24
Importing from Outlook Express 21
In command 281, 284
In mailbox 79
in.mbx file 406
in.toc file 406
Include Headers option 195
Include outdated ‘Return-Receipt-To’

how to enter in Options 358
Include signature on reply

how to enter in Options 310
Include yourself option 96
Incoming Mail Options 86

Delete from server when emptied from Trash 
option 90

Skip messages over ? K in size option 88
Incoming Mail options 298

Full message except attachments over ? K 92
Incoming mail server 73
Incoming Mail tab 128
Incoming message window

Message body 81
Title bar 80
Toolbar 80

BLAH BLAH BLAH button 81
Delete From Server button 81
Fixed Width button 80
Pencil button 81
Priority popup 81
Retrieve From Server (Fetch) button 81
Subject field 81
Tow Truck icon 80

Incoming option 166
Indent In button 36

Indent Out button 37
Insert Emoticon 280
Insert Object button 37, 47
Insert Picture command 404
Insert Recipient submenu 253, 280
Insert submenu 47, 280
Insert System Configuration command 290
Inserting objects in outgoing message text 47
Installed Message Plug-ins dialog 286, 408
Installing ESP 370
Internet dialup options 307
Internet directory, definition 486
Internet e-mail server

how to obtain 425
Internet Engineering Task Force, definition 486
Internet Explorer 82
Internet Message Access Protocol 410
Internet Message Access Protocol (IMAP), 

definition 486
Internet Service Provider, defintion 486
Internet, definition 486
intersects nickname option 168
IP address, definition 486
is not option 168
is option 168
ISP, definition 486
Italic command 45
Italics button 35

J
Java, definition 486
Junk command 281, 283, 284
Junk Mail Extra options 361
Junk Mail options 359
Junk mailbox, filtering incoming mail 176
Junk menu option 176
Junk Score field

in Filters 168

K
Keep copies

how to enter in Options 306
Keep Copy button 72
Kerberos 426
Kerberos options 349
Kerberos, definition 486
Key-stroke shortcuts 397

L
Label column 143
Labels
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how to assign to messages 143
Labels options 331
Launch a program from a message

how to enter in Options 342
LDAP Database 270
LDAP protocol 257
LDAP, definition 487
LDAPInit.ini file 406
Leave mail on server

how to enter in Options
POP server 299

Leave mail on server option 87, 129
Leave server status 144, 145
Left arrow, in the Status colum 96
Left arrow, in the Status column 141
Left command 45, 210
Light mode 25, 26
Lightweight Directory Access Protocol 257
Lightweight Directory Access Protocol (LDAP), 

definition 487
Link History option 288
Link history window 228
lmos.dat file 406
lmos.tmp to lmos.dat 481
Login Name option 126, 479

M
Macintosh server (POP or IMAP)

how to obtain 425
Mail folder .fol directories 406
Mail folders

creating during transfer 159
creating in the Mailboxes window 151
creating using Mailbox menu 149
Make if a folder option 149
management on POP vs. IMAP server 152
New command 149, 151
removing in the Mailboxes window 152
renaming in Mailboxes window 151
storage 406

Mail Server (incoming)
how to enter in Options 294

Mail Server (Incoming) option 479
Mail storage 403

mail folders 406
mailboxes 406

contents 406
POP and IMAP servers 152

Mail Transfer Options dialog 70, 86, 89, 144
Delete all messages on server 90
Delete all messages that have been retrieved 

90
Delete messages marked for deletion 89

Fetch all message headers to In mailbox 90
How should checking/sending be performed 

90
Retrieve messages marked for retrieval 

option 90
Retrieve new mail 89
Send queued messages 89

Mailbox .mbx files 406
Mailbox .toc files 406
Mailbox, definition 487
Mailboxes

compacting all 147
compacting one 147
creating during transfer 159
creating in the Mailboxes window 151
creating using Mailbox menu 149
displaying columns 146
Make it a folder option 149
management on POP vs. IMAP server 152
message summaries 140
moving in the Mailboxes window 152
New command 149, 151
number of messages 146
opening 139
removing in the Mailboxes window 152
renaming in the Mailboxes window 151
resizing columns 146
size display 146
sorting messages in 177
space messages require 146
space wasted 146
transferring messages among 158

Mailboxes command 150, 151, 152, 216, 287
Mailboxes options 320
Mailboxes window 150, 216
Mailing List, definition 487
Mailing lists

creating a nickname 235
Main Toolbar 212
Make Address Book Entry command 246, 262, 

285
from Directory Services 262
from the Address Book 248

Make Filter command 161, 285
Make Filter dialog 161
Make Hyperlink button 37
Make Hyperlink command 45, 54, 280
Make it a folder option 149, 151
Make Label action 170
Make Personality action 171
Make Priority action 170
Make Status action 170
Make Subject action 171
Managing mail on the IMAP server 91
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Delete command 93
Minimal Headers Only option 91
refreshing the mailbox list 95
Remove Deleted Messages command 93
resynchronizing a mailbox or folder 94
Skip Attachments over ? K option 92
UnDelete command 93

Managing mail on the POP server
Delete from server when emptied from Trash 

option 90
Delete server status 88, 144, 145
Fetch button 88
Fetch server status 88, 144
Fetch then Delete server status 88, 144, 145
Leave mail on server option 86
Leave server status 144, 145
Mail Transfer Options dialog 89
Skip messages over ? K in size option 88
Trash button 88

Manual option 166
Manual spell check 57
Map Ctrl+R to “Reply to All”

how to enter in Options 309
Map Ctrl+R to “Reply to All” option 97
MAPI 408
MAPI options 344
MAPI, definition 487
Margins submenu 45
Mark it as deleted

IMAP server 301
Mark previewed messages as read after ? 

second(s)
how to enter in Options 318

Mark previewed messages as read after ? 
second(s) option 148

Matches regexp (case sensitive) 186
May use quoted-printable

how to enter in Options 306
mbx files 406
ME nickname 310
Menu, context

for tool windows 210
Message

how to enter in Options 313
Message body

in incoming mail 81
in outgoing mail 39

Message header
in incoming mail 81

Message Plug-ins Settings command 286, 408
Message Plug-ins submenu 280, 407
Message preview pane 79, 147
Message priority

how to set 42

Message store, definition 487
Message summaries 140

Attachments column 143
changing the subject of 84
Date column 144
Label column 143
Priority column 142
resizing columns 146
selecting 140
Sender/Recipient (Who) column 143
Server Status column 144, 145
Size column 144
Status column 141
Subject column 146
Who column 143

Message window height
how to enter in Options 318

Message window width
how to enter in Options 318

Message, creating an auto-reply 174
messages retrieved but not attachments 145
Microsoft Outlook, importing from 22
MIME 419, 487

Base64 encoding 419
Content-type header 420
Macintosh creators 421
Macintosh types 421
Mapping 421
Quoted-printable encoding 419
Types 421

MIME digest 312
MIME encoding 50
MIME, definition 487
Minimal headers only

how to enter in Options
IMAP server 300

Minimal Headers Only option 91, 130
Miscellaneous Options

Allow drag and drop transfers option 159
Automatically expand nicknames option 253
Empty Trash when exiting option 155
Turbo redirect by default option 99

Miscellaneous options 356
Modifiers 395
Modify button 265, 276
Mood Watch

options 351
MoodWatch 63

icons
in an outgoing message 35

in an outgoing message 35
incoming messages 64
outgoing messages 63

MoodWatch column 145
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Move it to (mailbox)
IMAP server 301

Move Message icon 80
Move To command 244
Multiple accounts in Eudora 115
Multiple PCs

checking mail from 86
Multiple personalities 115
Multi-Purpose Internet Mail Extension (MIME), 

definition 487
Multipurpose Internet Mail Extensions 419

N
name completion

directory services 259
Name completion (message header) 39
Need RCPT (Recipient) 480
Netscape Messenger, importing 123
Netscape Messenger, importing from 24
Netscape Messenger, migrating from 123
Network buffer size of _ bytes

how to enter in Options 348
Network open timeout _ seconds

how to enter in Options 348
Network timeout after _ seconds

how to enter in Options 348
Network, definition 487
Never

how to enter in Options 312
New button in Address Book 235
New button in Filters window 166
New command 149, 159, 281, 284
New Database button 264
New File command 277
New Mailbox dialog 149, 159
New Message command 32, 282
New Message To submenu 282
New Message With submenu 283
Next time queued messages are sent option 69
Nickname directory 404
Nickname, definition 487
Nicknames

“me” 100
adding to the Recipient List 251, 253
creating in the Address Book 235
removing from the Recipient List 251, 254
renaming 245

nndbase.toc file 406
nndbase.txt file 407
None action 170
Normal windows 198

and taskbar 218
Not Junk command 283

Not Junk menu option 176
Notify Application action 172
Notify User action 171

O
Offline

how to enter in Options
POP server 300

OLD format (in Options) 330
On or after option 69
Online Help 18
online help 18
Open action 171
Open Attachment command 277
Open File command 277
Open mailbox option 79
Options command 288
or option 170
Out command 281, 284
Out mailbox 69, 70, 158
out.mbx file 406
out.toc file 406
Outgoing message window

Message body 39
Message header

Bcc field 38
Cc field 38
From field 38
Subject field 38
To field 38

title bar 32
Toolbar 33

Align Center button 36
Align Left button 36
Align Right button 36
Attachment Type popup 33
Bold button 35
Bulleted List button 37
Clear Formatting button 37
Color button 36
Font popup 35
Indent In button 36
Indent Out button 37
Insert Object button 37
Italics button 35
Keep Copy button 34
Make Hyperlink button 37
Priority popup 33
Queue button 35
Quoted-Printable button 33
Return Receipt button 34
Send button 35
Signature popup 33
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Size button 35
Tabs in Body button 34
Text As Attachment button 33
Typewriter button 36
Underline button 36
Word Wrap button 34

Outgoing option 166
Outgoing server (SMTP) 303
Outlook ’97 & ’98, migrating from 123
Outlook 2000, importing 20, 123
Outlook 98, importing 20, 123
Outlook Express, importing 20, 123
Outlook Express, importing from 21
Outlook Express,migrating from 123

P
Paid mode 25, 26
Password

changing 77
server source code for 426

check when sending mail 482
entering 75
forgetting 76
remembering 76
Saving 76

Paste As Quotation command 280
Paste command 279
Paste Special command 279
Payment & Registration command 25
Payment and Registration command 290
Pencil button 81
Personalities 115

migrating from Outlook Express, Outlook ’97, 
Outlook ’98, Netscape Messenger 123

Personalities command 115, 134, 287
Personalities window 115
Personality

deleting 131
using in a message 135

Personality field
in Filters 168

Personality Name field 126
Personality,

defintion 487
Personality, adding via Account Settings dialog 

124
Ph

definition 487
server source code 426

Ph Database 266
Ph protocol 257
ph.ini file 406
Picture command 46, 280, 404

Pictures
inserting in outgoing message text 47

Plain command 45
Play a sound

how to enter in Options 335
Play a sound option 79
Play Sound action 171
Plug-ins 407
Plugins directory 405, 407
POP option 129
POP server 86, 410

how to obtain 425
Macintosh 425
UNIX 425
VAX/VMS 425
Windows NT 425

POP version 3 410
POP vs. IMAP 152
POP3, definition 488
Post Office Protocol 410
Post Office Protocol 3 (POP3), definition 488
Postmaster user, definition 488
Preview Pane 318
Preview pane 79, 147
Print action 171
Print command 82, 278

from Directory Services window 262
Print One command 278
Print Preview command 278

from Directory Services window 262
Print Setup command 278
Printer (fonts)

how to enter in Options 314
printing with strange line breaks 481
Priority column 142
Priority drop-down

default for replies 42
Priority levels 42
Priority Popup

in incoming mail 81
in outgoing mail 33

Priority popup
in composition window 42

Profile 26
Proportional (fonts)

how to enter in Options 313
Protocols list 258, 263
Purge Messages command 93, 283
Put text attachments in body of message

how to enter in Options 312

Q
Q, in the Status column 68, 70, 142
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QPopper 425
Query field 259
Query results (Directory Services) 260
Queue a message bigger than ? K

how to enter in Options 342
Queue a message with no subject

how to enter in Options 342
Queue button 35, 68
Queue For Delivery command 68, 283
Queue mail 67

Change Queueing command 68, 70
Change Queueing dialog 68
Don’t send option 69, 70
editing before sending 69
for a certain time 68
Immediate send option 67
Next time queued messages are sent option 

69
On or after option 69
Queue button 68
Queue For Delivery command 68
Right now option 69
Send Message Right now option 68
Send Queued Messages command 68
sending queued mail when checking mail 70
taking mail out of the queue 70

Queued (Q) status 68
Quick Recipient List 216, 280, 282, 285

putting nicknames in 251, 253
removing nicknames from 251, 254
Removing recipient from 251, 252

Quick Start Guide 407
QuickTime 47
Quit with messages queued to be sent

how to enter in Options 342
Quitting Eudora 31
Quoted-printable

Turning off 421
Quoted-Printable button 33

R
RAS, definition 488
Readme.txt file 407
Real name

how to enter in Options 293
Real Name option 126
Recent command 281, 284
RECENT format (in Options) 329
Recipient List 252

Add to Recipient List command 250, 252
Adding email address to 252
Insert & Expand Recipient submenu 253
Insert Recipient submenu 253

Remove From Recipient List command 251, 
252

Redirect
automatically put new message in the queue 

99
no signature 100
Turbo redirect by default option 99

Redirect command 98, 282
Redirect To action 172
Redirect To submenu 99, 283
Redirect, definition 488
Redirected status (diagonal arrow) 99
Redo command 279
Refresh command 223
Refresh Mailbox List command 95, 153
Registered Drivers column 264
Registering Eudora 27
Regular expression in Find Messages window 

187
Regular Expressions 173

Matches regular expressions in filters 169
Rejected messages, sending 100
Remove From Recipient List command 251, 252, 

254
Remove Recipient submenu 252, 285
Rename command 151
Renaming a mail folder 151
Renaming a mailbox 151
Replied status (left arrow) 96
Reply

Copy original’s priority to reply option 97
in a filter with stationery 113
Include yourself option 96
Map Ctrl+R to “Reply to All” option 97
Put original To recipients in Cc field option 97
Reply command 96
with stationery 112, 113

Reply command 96, 282
Reply to All command 97, 282
Reply to All With submenu 283
Reply with action 172
Reply With submenu 113, 283
Replying Options

Copy original’s priority to reply 42
Copy original’s priority to reply option 97
Include yourself 96
Map Ctrl+R to “Reply to All” option 97
Put original To recipients in Cc field option 97

Replying options 309
Reply-To field

in Filters 167
Requirements 15
Reset Tools... option 288
Resize bar, in a docked window 203
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Resynchronize Mailbox command 94, 153
Retrieve From Server (Fetch) button 81
Retrieve messages marked for retrieval option 90
Retrieve new mail option 89
Retrieve only message headers 90
Return Address option 126
Return address option 479
Return Receipt 34
Return Receipt button 34
RFC, defintion 488
Right arrow, in the Status column 98, 142
Right command 45, 210
Right mouse button 403
Right now option 69
Right-click

definition 403
RPA

definition 488

S
S/MIME Encrypter button 35
S/MIME Signer button 34
S/MIME, definition 489
Save As command 195, 278
Save As Stationery command 110, 111, 278
Save command 65, 278
Save mail as text

as a single file 195
Guess Paragraphs option 195
Include Headers option 195

Save password option 76
Saving messages 65
ScamWatch, definition 488
Screen (fonts)

how to enter in Options 314
Searching in Eudora 194
Searching the web from the toolbar 192
Select All command 280
Select newly inserted messages (FUMLUB)

how to enter in Options 321
Send Again command 100, 282
Send button 35, 67
Send Immediately command 67, 283
Send mail

all at once 67
at a certain time 68
Change Queueing dialog 67
Immediate send option 67, 68
Mail Transfer Options dialog 70
replies 96
Send button 67
Send Immediately command 67
Send Message Right now option 68

Send Queued Messages command 68, 70
sending queued mail when checking mail 70
with a password 482
with server instructions 70

Send Message Right now option 68
Send on check

how to enter in Options 296, 303
Send on check option 70
Send plain and styled version in message

how to enter in Options 323
Send plain text only

how to enter in Options 323
Send Queued Messages command 68, 70, 278
Send queued messages option 89
Send styled text only

how to enter in Options 323
Send the signature with styles

how to enter in Options 323
Send To Back command 289
Send to Browser command 403
Sendable (•) status 65, 70
Sender/Recipient (Who) column 143
Sending all Mail Through One Account 71
Sending Mail Options

Immediate send option 67
Send on check 70

Sending Mail options 302
Sending rejected messages again 100
Sent (Ð) status 73
Separator

adding to main toolbar 217
removing from main toolbar 217

Server
e-mail (Internet), how to obtain 425

Server configuration
how to enter in Options 298

Server option 128
Server Options action 173
Server Status column 144, 145
Server status popup 88
Server, definition 488
Settings button 286, 408
Shared folder, definition 488
Shift key

and toolbar buttons 215
Shift+Space 148
Shift+Space modifier

change to Read or Unread status 142
Show attachment icons

how to enter in Options 319
Show category icons

how to turn on and off in Options 316
Show cool bars

how to turn on and off in Options 315
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Show cool bars option 214
Show formatting toolbar

how to enter in Options 322
Show large buttons, how to turn on and off in 

Options 316
Show Mailbox Columns

how to enter in Options 320
Show mailbox lines option 141
Show MDI task bar

how to turn on and off in Options 316
Show MDI task bar option 218
Show message preview pane

how to enter in Options 318
Show message preview pane option 147
Show Single Tab command 209, 210
Show status bar

how to turn on and off in Options 316
Show status bar option 214
Show toolbar

how to turn on and off in Options 315
Show toolbar option 214
Show toolbar tips

how to turn on and off in Options 315
Show toolbar tips option 214
Show/hide signature

how to change in Options 306
Sidebars

in quoted text with styles 96
Signature

definition 489
deleting 108

Signature popup 33
Signature window 105
Signature, hide or show when composing 109
Signatures

and redirect 100
and stationery 109
changing 107
creating 106
storage 405

Signatures command 105, 109, 287
Sigs directory 405
Simple Mail Transfer Protocol 410
Simple Mail Transfer Protocol (SMTP), definition 

489
Size button 35
Size column 144
Size submenu 45
Skip Attachments over ? K option 91, 130
Skip messages over ? K in size

how to enter in Options
POP server 299

Skip messages over ? K in size option 88, 129
Skip Rest action 173

SMTP 410, 411, 419
SMTP AUTH, definition 489
SMTP Authentication 72
SMTP authentication

for personalities 127
SMTP Relay 71
SMTP Relay Personality

how to enter in Options 303
SMTP server

how to enter in Options 303
SMTP server (outgoing)

how to enter in Options 294
SMTP Server option 126
SMTP server option 479
SMTP, definition 489
Sort submenu 280
Sort, group by subject 178
Sorting 177
Sorting in ascending order 177
Sorting in descending order 177
Spacebar 79
SPAMWatch, definition 489
Speak action in Filters 171
Spell check as you type 55
Spell check manually 57
Spell Checking options 324
Sponsored mode 25, 26
SSL certificates 30, 133, 297, 304
SSL,dominant personality 29
SSL,drop-down menu 30, 132, 296, 303
SSL,other personalities 131
Start button 259
Start Eudora and it’s not the default mailer

how to enter in Options 342
Starting Eudora 31
starts with option 168
STARTTLS 30, 132, 133, 296, 303, 304
Stationery

defintion 489
deleting 112
modifying 112

Stationery command 287
Stationery directory 405
Stationery files

storage 405
Stationery messages

changing 112
creating 111
creating a default 113
deleting 112
opening 112
opening with a filter 113, 172

Stationery Window 109
Statistics 229
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changing settings 354
displaying Statistics window 229
printing 229, 231

Statistics option 288
Status

-, never sent 142
, read or unsendable 141
•, sendable or unread 65, 70, 79, 141
Ð, sent 73, 142
clock icon, timed 69, 142
diagonal arrow, redirected 99, 142
left arrow, replied 96, 141
not sent 142
Q, queued 68, 70, 142
right arrow, forwarded 98, 142

Status Bar command 403
Status column 141
Status field, of Directory Services 260
Stop button 259
Strike-through button 36
Styled Text options 322
Subject column 146
Subject field

changing in message summaries 84
in a forwarded message 98
in Filters 167
in incoming mail 81
in outgoing mail 38

System requirements 15

T
Tab key

switching fields with 37
Tab Location submenu 209, 210
Tabbed windows 197, 205

and taskbar 218
closing 209
creating 208
default 206
opening and activating 207
reorganizing 207
tab display 208

Table of Contents in Eudora, definition 489
Tabs

and the Save As command 195
Switching fields with 34

Tabs in Body button 34
Tabs in body of message

how to enter in Options 306
Tabs, windows

contents 209
location 209
showing and hiding 208

Task Error 336
Task Error command 287
Task Error window 227
Task Status 336
Task Status command 287
Task Status window 224
Taskbar buttons 218
Taskbar, Eudora 218
Technical Support command 290
Technical support information 27
Technical support number (858) 658-1292 28
Text As Attachment button 33
Text as Attachment button 50
Text submenu 44, 280
Text symbols, display 34
Tile Horizontal command 289
Tile Vertical command 289
Timed status (clock icon) 69
Tip of the Day 19
Tip of the Day command 290
Title bar

for incoming mail 80
for outgoing mail 32

tlx files 407
To button

in Directory Services 261
in the Address Book 245

To field
in a reply 96
in Filters 167
in outgoing mail 38

Attach File 49
toc files 406
Toolbar

adding a separator line 217
adding buttons 214
changing placement of a button 217
in incoming mail 80
in outgoing mail 33
main 212
removing a button 217
removing a separator line 217
show/hide 403
using Shift key 215

Toolbar command 403
Top command 210
Topics command 19, 290, 405, 427
Tow Truck icon 80
Transfer To action 173
Transferring mail to another mailbox

and creating a mailbox or folder 159
by dragging it 159
by dragging the Tow Truck icon 159
transferring a copy 158
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using the Transfer menu 159
Transferring mail to the Out mailbox 158
Transmission Control Protocol/Internet Protocol 

(TCP/IP) 489
Trash button 88
Trash command 281, 284
Trash mailbox 73, 155
trash.mbx file 406
trash.toc file 406
Try to delete unread, queued, or unsent mail 155
Turbo redirect by default

how to enter in Options 357
Turbo redirect by default option 99
Typewriter button 36
Typewriter command 45, 280

U
UnDelete command 93, 156, 283
Underline button 36
Underline command 45
Undo command 279
Universal Resource Locator (URL), definition 489
UNIX mail 406
UNIX server (POP or IMAP)

how to obtain 425
unless option 170
Unload Winsock DLL after closing socket

how to enter in Options 348
Unqualified name, adding domain 127
Unread (•) status 79
Unwrap Selection command (Shift-Wrap 

Selection) 46
URL

in outgoing mail 54
URL in a message 54
URL, definition 489
URLs

in incoming mail 85
Use an alert dialog box option 79
Use Directory button 83
Use Microsoft’s viewer

how to enter in Options 318
Use Microsoft’s viewer option 82
Use proportional font by default

how to enter in Options 314
User Name

how to enter in Options 294
Username, definition 490
Using a personality in a message 135
Using a Signature in a Message 108
using offline 95
UUCP, definition 489
Uuencode

definition 490
Uuencode encoding 50
Uuencode, definition 489

V
Vacation message, creating 174
VAX/VMS server (POP or IMAP)

how to obtain 425
View Source command 403
Viewing an incoming HTML message in your 

Web browser 403
Viewing HTML formatting 403
Viewing Mail Options 82

Mark previewed messages as read after ? 
second(s) option 148

Show attachment icons option 81, 82
Show message preview pane option 147
Use Microsoft’s viewer option 82

Viewing Mail options 317
Viewing Web pages 82

W
Warnings

Try to delete unread, queued, or unsent mail 
155

When message emptied from Trash
how to enter in Options 312

When not using Stationery
how to enter in Options 306

When replying to all
how to enter in Options 310

When sending mail with styled text (HTML)
how to enter in Options 323

Where do I find information? 16
Who column 143
Window context menu 210
Window states 197
Window tabs

contents 209
location 209
showing and hiding 208

Windows
docked 200
floating 203
normal 198
tabbed 197, 205

Windows NT server (POP or IMAP)
how to obtain 425

Windows Sockets 426
Winsock

definition 490
winsock.dll 479
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Word wrap
how to enter in Options 306

Word Wrap button 34, 46
World Wide Web, definition 490
WorldMail Server 425
Wrap Selection command 46, 280
Wrapped text 34

Z
Zoom button, in a docked window 202
Zoom windows when opening

how to enter in Options 319
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